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ABSTRACT OF THE DISSERTATION

Treatment of Experimental Asthma
Using a Novel Peptide Inhibitor of the Inducible T Cell Kinase

by

David M. Guimond

Doctor of Philosophy in Biology

University of California, San Diego, 2012

San Diego State University, 2012

Professor Constantine D. Tsoukas, Chair

! As central regulators of asthma pathogenesis, allergen-specific CD4+ T 

cells are recruited to the lungs and secrete sustained levels of Th2 cytokines 

upon reencounter with inhaled allergen leading to the development of the 

xxvi



hallmark indicators of asthma including airway hyperresponsiveness, mucus 

production and the recruitment of eosinophils to the affected lung tissue.  

Selectively upregulated in Th2 cells, Itk is a member of the Tec familiy of non-

receptor tyrosine kinases and is required for Th2 cell development and 

effector function.  Upon stimulation through the TCR, Itk associates with the 

adaptor protein SLP-76 and is recruited to the immunological synapse as part 

of a stable signaling complex leading to its subsequent enzymatic activation.

! As previously discovered using purified domain fragments, the Itk SH3 

domain binds to its specific polyproline ligand represented by the amino acid 

sequence QQPPVPPQRPMA located on SLP-76 with a reported affinity of 

0.77 mM (1).  By modifying this sequence with the addition of a polyarginine 

cell penetration motif, Grasis et al. recently demonstrated that the engineered 

peptide designated R9-QQP was effective as a competitive inhibitor of Itk 

activation (2).  In the current work, R9-QQP was translated to an OVA-

inducible model of experimental asthma.  Upon delivery in vivo, R9-QQP was 

demonstrated to specifically inhibit physiologically relevant parameters of 

airway inflammation and was further characterized as affecting the recruitment 

of eosinophils to the lung mucosa.  Consistent with the role of Itk, Th2 

cytokine secretion by lung draining lymph node cells was reduced upon 

restimulation with OVA in vitro.

! While current treatments are effective for most patients with clinical 

asthma, undesirable side effects as well as lack of effectiveness for some 
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patients underscores the need to develop additional therapeutic strategies 

that target the immunological basis of allergic disease progression.  By 

blocking an inducible and T cell-specific interaction, this study establishes the 

importance of the Itk–SLP-76 interaction in an allergic disease model as an 

attractive therapeutic target for the future development of biologically active 

small molecules inhibitors.
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1. INTRODUCTION

1.1. Asthma Pathogenesis and Treatments

! The word asthma was first used in Homer's Iliad and derives from the 

Greek verb aazein meaning to exhale with open mouth or to pant (3).  Around 

450 B.C., the word asthma adopted a clinical meaning in the writings of 

Hippocrates.  In 1892, asthma was first described in the modern medical 

literature to refer to symptoms including recurrent episodes of breathlessness, 

wheezing, chest tightness and coughing (4).  Currently, clinical asthma is 

understood to be a recurrent condition characterized by widespread restriction 

of the respiratory tract resulting from hyperresponsiveness of smooth muscle 

surrounding bronchioles and excessive secretion of mucus by goblet cells.

! Worldwide, asthma is a chronic condition that affects 300 million 

persons with the prevalence increasing by 50% each decade.  Of this global 

increase, the largest gains in prevalence are disproportionally attributed to 

developed countries possibly due to increased exposure to environmental 

pollutants as well as to the Western diet (5, 6).  In the US, asthma affects 35.5 

million individuals with 23% requiring emergency room treatment each year 

and with a mortality rate of 5,000 deaths per year.  In addition to the physical 

symptoms, the direct economic impact resulting from asthma in the US has 

been estimated to be between $300 - $1,300 per patient per year.
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! Asthma is a heterogeneous condition classified into atopic, non-atopic 

and intrinsic types of the disease each with a different etiology (7, 8).  

Although the exact causes remain unknown, a combination of genetic as well 

as environmental risk factors are associated with the condition.  Mediated by 

an underlying allergic reaction, atopic asthma is the most common form of the 

disease and is associated with elevated levels of IgE antibodies directed 

against household or environmental allergens.  Common examples of 

household allergens include food, animal dander and saliva, molds, and feces 

from dust mites and cockroaches.  Common examples of outdoor allergens 

include mold spores, pollens, grass and trees.  Risk factors for atopic / allergic 

asthma include mutations in genes affecting all aspects of the immune 

response from the initial uptake of allergen by antigen presenting cells such 

as macrophages and dendritic cells at the lung mucosa to the release of 

inflammatory intermediates by granulocytes such as eosinophils and mast 

cells during an asthma attack (9).  As central regulators of the immune 

response, genes involved in T helper type 2 (Th2) cell development and 

effector function have been associated with increased susceptibility to allergic 

asthma (9).  In particular, the inducible T cell kinase (ITK) is required for Th2 

cell function and its increased expression has been linked to human allergic 

rhinitis while its lack of expression by knockout mice leads to an attenuated 

asthma phenotype (10, 11).  In addition to the atopic form of the disease, non-

atopic asthma can occur without the involvement of IgE antibodies in 
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response to irritants including tobacco smoke, cold air, perfumes, exercise 

and upper respiratory tract infections while intrinsic asthma occurs with 

symptoms occurring spontaneously in susceptible individuals.
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1.1.1. Pathogenesis of Allergic Asthma

! Mediated by innate and adaptive cells of the immune system, an 

allergic response requires an initial sensitization to allergen that is latter 

triggered upon re-exposure to the same allergen.  In a typical allergic reaction, 

an immune response often occurs at a tissue location that is different from the 

initial site of exposure to allergen.  The development of atopic asthma occurs 

when an allergen is encountered by specialized antigen presenting cells 

(APC) of the innate immune system such as a macrophages or dendritic cells 

which reside at the lung mucosa.  Once an allergen is recognized and 

internalized by an APC, it is subsequently processed into small peptide 

components that are expressed on the surface of the APC in the context of 

major histocompatibility complex (MHC) class II molecules.  Next, an APC 

expressing allergen-derived peptide encounters a specialized cell of the 

adaptive immune system called a CD4+ T lymphocyte.  If a CD4+ T cell 

expresses a T cell receptor (TCR) that is specific for the allergen-derived 

peptide, it becomes activated and proliferates in response to signals received 

through its TCR.  In response to additional cytokine signaling received from 

the surrounding milieu, an activated T cell differentiates into a cell capable of 

secreting the type 2 cytokines IL-4, IL-5 and IL-13 named a T helper type 2 

(Th2) cell.  Once activated, Th2 cells migrate via the lymphatic circulation to 

mediastinal lymph nodes that drain the lung tissue.  Within the lung draining 

lymph nodes, Th2 cells recognize B lymphocytes which also present allergen-
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derived peptide in the context of MHC class II molecules.  Mediated by 

secretion of IL-4, a Th2 cell then instructs its cognate B cell to generate and 

secrete allergen-specific immunoglobulin E (IgE).

! IgE produced during the initial sensitization to allergen binds to high 

affinity FcεRI receptors on the surface of mast cells and dendritic cells which 

are recruited and maintained by factors secreted by airway epithelial cells 

(12).  During the early allergic response occurring between 1-30 minutes, 

binding of inhaled allergen by IgE on the surface of mast cells results in cross-

linking of FcεRI receptors followed by the immediate release of granules 

containing preformed histamine (13).  Histamine as well as leukotrienes and 

prostaglandins which are synthesized by mast cells following activation are 

effectors of the broncho-hyperresponsiveness that is characteristic of an 

asthmatic attack.  During the late allergic response occurring between 6-72 

hours, activated mast cells recruit inflammatory cells including macrophages, 

eosinophils and basophils to the site of allergen exposure mediated by 

secretion of inflammatory chemokines and cytokines (13).  In particular, 

secreted cytokines induce expression of the adhesion molecules ICAM1 and 

VCAM1 on the luminal surface of blood vessel endothelial cells leading to 

recruitment of eosinophils which express VLA4 (14).  Although their exact role 

in asthma pathogenesis is unclear, eosinophils are activated by IL-5 to release 

granules containing tissue-damaging enzymes and are correlated with 

disease severity (15-17).  In addition, activated mast cells secrete the 
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chemokines CCL17 and CCL22 that serve to recruit Th2 cells to the site of 

allergen exposure mediated by binding to chemokine receptor 4 (CCR4).  

Once recruited to the site of allergen exposure, Th2 cells secrete sustained 

levels of IL-4, IL-5 and IL-13.  The local secretion of IL-13 results in 

amplification and progression of the immune response including goblet cell 

hyperplasia, mucus production, bronchiole smooth muscle hyper-reactivity 

and epithelial wall remodeling.  Furthermore, allergen bound by IgE on the 

surface of mast cells amplifies the immune response through Fcε receptor 

mediated internalization, antigen presentation and activation of additional T 

cell clones.
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Figure 1:  Schematic diagram illustrates sensitization and challenge phases of 
asthma pathogenesis.
! A) First, inhaled antigen enters the lower respiratory tract.  B) Next, 
dendritic cells residing at the lung mucosa take up allergen and migrate to the 
draining lymph nodes (DLN).  C) In the DLN, dendritic cells present allergen-
derived peptide to naive CD4+ T cells, which proliferate and differentiation into 
Th2 effector cells.  Mediated by the secretion of IL-4, Th2 effector cells induce 
cognate B cells to secrete IgE, which circulates in the blood and is captured 
on the surface of mast cells.  D) Upon subsequent challenge, inhaled allergen 
binds to IgE captured on the surface of mast cells and, mediated by Fc 
receptor cross-linking, induces the release of preformed inflammatory 
intermediates, which results in airway hyperresponsiveness and mucus 
production.  In addition, allergen-specific Th2 cells are recruited to the lung 
tissue and, upon restimulation by macrophages, secrete Th2 cytokines, which 
sustain the inflammatory response and result in the recruitment and activation 
of eosinophils.
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1.1.2. Immunological Tolerance

! Immunological tolerance refers to the development of a protective as 

opposed to a pathological response to allergens (18, 19).  For example, while 

the development of asthma occurs in susceptible individuals when exposed to 

environmental allergens, healthy individuals are asymptomatic when exposed 

to the same levels of allergens (20).  Although the mechanism of tolerance to 

allergens is not completely understood, regulatory cells of the adaptive 

immune system such as inducible regulatory T cells (iTregs) play an important 

role.  iTregs are antigen-specific and secrete cytokines such as IL-10 and 

transforming growth factor β (TGF-β) which suppress inflammatory Th2 cells.  

Development of iTregs occurs in the periphery and requires antigen 

presentation and co-stimulation provided by dendritic cells along with IL-10- 

and TGF-β -mediated signaling (21, 22).  Consistent with their protective role, 

Treg function and the levels of the inhibitory cytokine IL-10 are reduced in 

individuals with asthma (23, 24).

! Epidemiological studies have associated an increase in the prevalence 

of asthma in developed countries with a reduction in the exposure to 

infectious diseases due to the widespread use of vaccines and antibiotics 

(25-27).  Rephrased, the hygiene hypothesis suggests that the immune 

response to pathogens encountered during childhood protects against the 

development of asthma.  In support of this concept, several investigators have 
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suggested that bacterial endotoxin as encountered in manure from farm 

animals may be important for this protective effect (28).

! One mechanism that may explain these observations is that toll-like 

receptor 4 (TLR4) expressed on dendritic cells in the lungs recognizes inhaled 

endotoxin and results in the expression of the inducible co-stimulatory 

molecule (ICOS) which is required for iTreg development.  Perhaps the 

hygiene hypothesis can be explained mechanistically as a lack of TLR-

mediated signaling in the absence of endotoxin exposure resulting in anergy 

as opposed to iTreg development and suppression of a Th2 response to 

allergen.

! Furthermore, inhaled allergens induce dendritic cells in the lungs to 

express indoleamine 2,3-dioxygenase (IDO) which metabolizes tryptophan 

leading to secretion of TGF-β (21).  Allergen-induced secretion of TGF-β then 

results in reduced secretion of the pro-inflammatory cytokine IL-6.  Thus, 

allergen exposure in this pathway promotes iTreg development mediated by 

inhibition of IL-6.

! In a different mechanism of tolerance referred to as immune deviation, 

non-allergic individuals generate allergen-specific IgG antibodies rather than 

the IgE isotype that is involved in asthma pathogenesis.  While the antibody 

isotypes produced are different, studies have indicated that the antigenic 

epitopes and therefore allergen immunogenicity is the same for both healthy 

and asthmatic individuals that are exposed to the same allergen (29, 30).  
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Rather than being influenced by the allergen itself, the generation of an IgG 

versus IgE antibody response appears to depend more on the cytokine milieu 

that is present during the development of a common progenitor T cell to 

become a Th1, Treg or Th2 effector, respectively.  A developmental fate 

resulting in the generation of Th1 or Treg effectors leads to the production of 

non-pathogenic IgG antibodies while the generation of Th2 effectors leads to 

the production of pathogenic IgE antibodies mediated by B cell helper 

function.
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Figure 2:  Schematic diagram of allergic asthma versus immunological 
tolerance.
! A) Imbalance of pathogenic Th2 effector cells leads to development of 
allergic asthma.  B) Increased production of antigen-specific Tregs leads to 
protective tolerance.
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1.1.3. Clinical Treatments

Corticosteroids:

! Inhaled corticosteroids (ICS) are the most common form of treatment 

for asthma and affect gene expression through simultaneous trans-activation 

and trans-repression of target genes resulting in immunosuppression.  

Corticosteroids diffuse through the plasma membrane and subsequently bind 

to and activate glucocorticoid receptor α (GRα) in the cytoplasm resulting in 

receptor acetylation.  Activated GRα molecules then homodimerize and 

translocate to the nucleus.  One pathway leading to immunosuppression is 

mediated by binding of GRα homodimers to glucocorticoid response elements 

(GRE) located in the cis-regulatory region of several anti-inflammatory genes.  

Once bound to DNA, GRα associates with transcriptional co-activator 

molecules such as cAMP responsive element binding protein (CBP) which 

acetylate histones leading to expression of responsive genes.

! For example, MAP kinase phosphatase 1 (MKP-1) is an anti-

inflammatory gene that is upregulated in response to corticosteroid treatment.  

Secretion of IL-4, IL-5 and IL-13 by activated Th2 cells requires 

phosphorylation of the transcription factor GATA3 by p38 MAP kinase 

(MAPK).  Phosphorylated GATA3 then translocates to the nucleus mediated 

by importin-α where in binds to DNA and regulates trans-activation of Th2 

genes.  MKP-1 inhibits trans-activation of Th2 genes by dephosphorylating 

GATA-3 thus preventing its nuclear import (31).  Furthermore, GRα competes 
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with phosphorylated GATA3 for binding to importin-α thus further reducing its 

access to the nucleus (31).  However, side effects of ICS treatment have been 

attributed to harmful GRα-mediated repression of beneficial genes.  One such 

example is the GR-α mediated repression of osteocalcin which is involved in 

bone synthesis.

! Another pathway leading to immunosuppression is mediated by binding 

of GRα to co-activator molecules located in the cis-regulatory region of genes 

regulated by the pro-inflammatory transcription factors NF-κB and activator 

protein 1 (AP-1).  In this pathway, GRα recruits histone deacetylases such as 

HDAC2 to the co-activator molecule CBP leading to histone deacetylation and 

trans-repression of many pro-inflammatory genes such as those coding for 

cytokines, chemokines, adhesion molecules and inflammatory enzymes.

! While corticosteroids are widely effective, patients with severe asthma 

and people who smoke do not respond well to ICS and some individuals are 

completely resistant to treatment (32, 33).  Corticosteroid insensitivity has 

been explained biochemically by ubiquitination and degradation of HDAC2 

due to oxidative and/or nitrative stress thus preventing its negative regulatory 

role mediated by GRα (34-38).  Other reports have associated corticosteroid 

insensitivity with phosphorylation of GRα by p38 MAPK and JNK leading to 

impaired nuclear localization and gene regulatory activity (39, 40).

β2-Adrenoceptor Agonists:
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! Short- and long-acting β2 agonists (SABA, LABA) activate the β2-

adrenergic receptor (β2AR) which is expressed on smooth muscle cells and 

triggers a signal transduction cascade leading to bronchodilation and thus 

opening of the blocked airways of asthma sufferers.  Activation of β2AR results 

in stimulatory G protein (Gs) -mediated activation of adenylyl cyclase (AC) 

which results in production of cyclic AMP (cAMP).  cAMP then activates 

Protein Kinase A (PKA) which activates myosin light chain phosphatase.  

Myosin light chain phosphatase then inhibits myosin light chain kinase 

resulting in muscle relaxation.  In another pathway, activated β2AR mediates 

opening of calcium-activated potassium channels resulting in reduced 

intracellular calcium, inhibition of myosin light chain kinase and 

bronchodilation.  In addition to affecting bronchodilation, cAMP activates 

exchange protein activated by cAMP (EPAC) which results in decreased 

smooth muscle cell proliferation (41).

! Besides the beneficial effects of β2 agonists, β2AR signaling is also 

associated with bronchoconstriction and activation of inflammatory genes.  

When coupled with heterotrimeric Gq proteins, activation of β2AR mediated by 

acetylcholine (ACh) and histamine leads to activation of phospholipase Cβ1 

(PLCβ1) that results in bronchoconstriction (42).  Furthermore, 

phosphorylated β2AR is down regulated after activation into clathrin-coated 

pits where it can associate with β-arrestin-2.  Association with β-arrestin-2 can 

lead to ubiquitination of β2AR followed by receptor degradation (43).  
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Alternatively, β-arrestin-2 can serve as an adaptor allowing β2AR to activate 

MAPK and PI3K signaling pathways leading to activation of inflammatory 

genes (44, 45).

Anti-Cholinergics:

! Anti-cholinergics are antagonists of muscarinic receptors expressed on 

smooth muscle and other airway cells.  Acetylcholine (ACh) released from 

nerve, epithelial and inflammatory cells binds to Gq-coupled muscarinic 

receptors resulting in activation of phospholipase C (PLC).  PLC then 

hydrolyzes phosphatidylinositol 4,5-bisphosphate (PIP2) to generate inositol 

1,4,5 triphosphate (IP3) which results in calcium (Ca2+) release from 

intracellular stores leading to muscle contraction, mucus secretion and 

structural remodeling (46).  Anti-cholinergics are less effective bronchodilators 

as compared to β2AR agonists and the two drugs combined have been 

reported to have a synergistic effect.

Leukotriene Modifiers:

! Cysteinyl leukotrienes (CysLT) released by mast cells and eosinophils 

during active asthma bind to the CysLT1 receptor resulting in 

bronchoconstriction, vascular permeability and mucus production (47).  

CysLT1 receptor antagonists as well as inhibitors of enzymes involved in 

CysLT biosynthesis have been developed that are safe and available orally, 

however, they are less effective than inhaled corticosteroids.

Methylxanthines:
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! Theophylline is a common and inexpensive xanthine that is chemically 

related to caffeine and which has been used in the treatment of asthma since 

1930.  At least three different biochemical pathways are likely involved in the 

mechanism of action of this class of drugs, however, low efficacy and serious 

side effects limit their therapeutic usefulness.  Mediated by inhibition of cAMP 

phosphodiesterases (PDE), theophylline increases intracellular cAMP 

concentration resulting in bronchodilation in a pathway shared with β2AR 

agonists.  However, side effects related to PDE inhibition include nausea, 

diarrhea and headaches.  Theophylline also functions as an adenosine 

receptor antagonist resulting in reduced release of inflammatory intermediates 

by mast cells (48).  However, side effects from adenosine receptor 

antagonism include cardiac arrhythmias and seizures.  In a different pathway, 

theophylline inhibits phosphoinositide 3-kinase (PI3K) which is activated by 

oxidative stress resulting in degradation of histone deacetylase 2 (HDAC2) 

(37, 49-51).  Inhibition of PI3K by theophylline cooperates with the 

pharmacological role of corticosteroids in recruiting HDAC to co-repressors 

resulting in trans-repression of inflammatory genes.
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Primary Prophylaxis:

! Avoidance of allergens as a means to prevent sensitization early in life 

has provided contrasting results likely due to the development of inflammation 

or tolerance as possible outcomes resulting from allergen exposure (52).  For 

example, studies have demonstrated that  exposure to house dust mites 

correlates with the extent of allergic sensitization while reduced exposure to 

household pets as well as peanuts increases rather than decreases 

sensitization.  In addition, limiting exposure to allergens for previously 

sensitized individuals is likely undermined by non-allergenic factors that 

contribute to ongoing disease.  For example, a large controlled study involving 

asthma patients showed no beneficial effect of using impermeable bed covers 

as means to reduce exposure to house dust mites (53, 54).

Allergen-Specific Immunotherapy (SIT):

! Allergen-specific immunotherapy modifies the immune response by 

repeated subcutaneous or sublingual sensitization to allergens.  In asthma 

patients that are predisposed to generating a Th2 type response to inhaled 

allergens, SIT redirects the immune response towards the generation of 

allergen-specific Th1 cells and/or Tregs.  The generation of allergen-specific 

Th1 cells results in immune deviation mediated by production of non-

pathogenic IgG and/or IgA blocking antibodies rather than the pathogenic IgE 

isotype while the generation of Tregs results in tolerance mediated by 

suppression of Th2 cell effector function (55).  In responsive patients, SIT 
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decreases recruitment of eosinophils and mast cells to the lungs and reduces 

release of inflammatory mediators leading to an improvement of asthma 

symptoms.  However, low efficacy and the possibility of anaphylactic side 

effects limit the usefulness of treatment (56).

Anti-IgE Therapeutic Antibody:

! Allergen-specific IgE plays an important role in asthma pathogenesis 

where it functions to cross-link Fc receptors on the surface of mast cells 

leading to the immediate release of inflammatory mediators.  Omalizumab is a 

humanized IgG1 blocking antibody that targets free IgE thus reducing Fc 

receptor mediated release of inflammatory mediators by mast cells (57).  

While effective at controlling asthma symptoms, up to 16 weeks of 

subcutaneous administration 2-4 times per week is required prior to obtaining 

clinical benefits.  For this reason, omalizumab is used in combination with 

standard corticosteroid treatment.

Mast Cell Inhibitors:

! Mast cells have and continue to be an attractive target in the treatment 

of allergic asthma owing to their role in both the early release of inflammatory 

intermediates as well as in the recruitment of inflammatory cells occurring 

later.  The inhaled drugs sodium cromoglicate (SCG) and nedocromil sodium 

reduce mast cell activation by inhibiting chloride ion flux across the cell 

membrane thus increasing the threshold required for cell activation (58).  

Other therapeutics reduce mast cell activation by inhibiting tyrosine kinases 
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which transduce signaling downstream of the FcεRI and KIT receptors or, 

conversely, by activating phosphatases which negatively regulate receptor-

mediated pathways (59, 60).

Cytokine Immunotherapy:

! Cytokine immunotherapy is a treatment approach that attempts to 

antagonize the inflammatory effects of Th2 cytokines such as IL-4, IL-5 and 

IL-13 which are elevated in asthmatic patients and are involved in generating 

and sustaining lung inflammation (52).  One approach involves directly 

blocking Th2 cytokines by inhalation of exogenously produced anti-cytokine 

monoclonal antibodies or genetically modified soluble cytokine receptors.  

Alternatively, investigators have attempted studies in mice that involve using 

vaccines directed against specific Th2 cytokines in order to generate 

endogenously produced blocking antibodies.  Another approach attempts to 

block cytokine signaling by inhalation of monoclonal antibodies that 

specifically target the cytokine receptor or by administration of genetically 

modified dominant negative Th2 cytokines that bind to their target receptor but 

do not allow downstream signal transduction.  Yet another approach attempts 

to suppress Th2 cytokines by targeting the transcription factors STAT6 and 

GATA3 which are required for cytokine expression by using dominant negative 

peptides or RNA interference.  In order to achieve a response similar to the 

goal of allergen-specific immunotherapy (SIT), other investigators have 

attempted to redirect the immune response by systemic administration of 
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recombinant Th1 cytokines such as IFN-γ and IL-12.  Also, administration of 

IL-10 which is produced by Tregs has been utilized as a means of 

suppressing Th2 cells.  Clinical trials employing multiple cytokine therapeutic 

strategies have demonstrated some success and good safety performance, 

however, low efficacy has limited the usefulness thus far while active research 

is underway aimed at further development.
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1.2. CD4+ Th2 Cells and Experimental Asthma

! Several mouse models of asthma exist that reflect the clinical 

symptoms of human asthma patients including airway hyperresponsiveness 

(AHR), mucus production, recruitment of eosinophils, elevated IgE and the 

secretion of Th2 cytokines by effector cells.  In particular, the abundant 

eosinophilia observed in mouse models also occurs in humans and correlates 

with asthma (61).  An extensively studied mouse model employs the 

immunogenic allergen ovalbumin (OVA) which is a protein derived from 

chicken egg white.  Following adsorption to the adjuvant alum and delivery 

i.p., CD4+ T cells are generated in the context of a primary immune response 

to OVA.  An inflammatory response that is characteristic of asthma then 

results when mice are challenged with OVA that is delivered locally to the 

lungs.  While similar in many respects to human asthma, one difference 

between the murine OVA model commonly used to investigate lung 

inflammation and human disease is in the involvement of mast cells.  Although 

peribronchial mast cells play a well described role in human asthma patients, 

few mast cells are detected in the acute mouse model (62).  Nevertheless, 

accumulation of mast cells can be induced in a chronic model that requires 

repeated exposure to inhaled OVA for several months (62).  As discussed in 

the examples below, many discoveries have been made into the mechanisms 

of asthma pathogenesis employing the OVA-driven model used in 
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combination with methods designed to elucidate the role of specific cell types 

and signaling molecules.

! T lymphocytes play a central role in the asthma pathogenesis as 

demonstrated by the finding that eosinophilia and AHR were prevented upon 

the specific depletion of CD4+ T cells in vivo (63).  In support of this finding, 

OVA-specific Th2 effector cells that were generated in vitro and adoptively 

transferred into unimmunized recipient mice were capable of inducing AHR, 

mucus production and eosinophilia upon challenge with inhaled OVA (64, 65).  

Furthermore, IL-4 secretion is required for the recruitment of lymphocytes and 

eosinophils to the lungs of recipient mice as demonstrated by the adoptive 

transfer of IL4-/- CD4+ T cells (64-66).  However, AHR may occur 

independently of IL-4 secretion (65).  Likewise, mucus production may occur 

independently of both IL-4 and IL-5 secretion and is instead dependent on 

IL-4/IL-13 receptor-mediated signaling (66).  In another study, eosinophil 

recruitment and AHR were abolished when asthma was induced in IL-5-/- mice 

(67).  The subsequent reconstitution of both eosinophilia and AHR upon 

delivery of recombinant IL-5 to the lungs thus establishes this cytokine as an 

important mediator of asthma pathogenesis (67).
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1.2.1. OX40

! OX40 (CD134) is a member of the TNF superfamily of receptors and is 

inducibly expressed 12-48 hours following antigen-dependent activation of 

naive T cells.  Likewise, OX40 ligand (OX40L) is inducibly expressed by 

antigen presenting cells such as dendritic cells, B cells and macrophages 

following toll-like receptor 4 (TLR4) -dependent signaling in response to LPS/

endotoxin.  OX40 expressed by CD4+ Th1/2 effector cells functions as a co-

stimulatory molecule leading to survival, clonal expansion and memory T cell 

development after interaction with an antigen presenting cell expressing OX40 

ligand (OX40L).  The role of OX40 as a co-stimulatory molecule has been 

demonstrated both in OX40 knockout mice as well as by treatment with anti-

OX40L blocking antibody where lung inflammation in response to ovalbumin 

was reduced in the absence or inhibition of OX40 signaling, respectively 

(68-70).  Specifically, OX40 signaling is required for the clonal expansion and 

survival of CD4+ T cells during a primary immune response and results in the 

generation of memory T cells which are activated during a recall response to 

antigen (70).

! In contrast to its co-stimulatory role, OX40 also functions as a 

suppressor of CD25+ CD4+ regulatory T cell (Treg) development in a pathway 

that involves downstream inhibition of the transcription factor Foxp3 (71).  As 

discussed in the pathogenesis of asthma above, one mechanism of 

immunological tolerance involves the generation Tregs that suppress Th2 

25



effector cells mediated by secretion of the inhibitory cytokines IL-10 and TGF-

β.  In a tolerance model of experimental asthma, ovalbumin is delivered 

intransally prior to sensitization i.p. with OVA/alum resulting in enhanced Treg 

development and thus protection from asthma upon i.n. challenge with OVA 

(22).

! However, inhalation of LPS in addition to OVA during the tolerance 

period results in suppressed Treg development combined with enhanced 

development of inflammatory Th2 effector cells and thus susceptibility to 

asthma (72).  One mechanism to account for the observed disruption of 

tolerance is that inhaled LPS is recognized by TLR4 resulting in the inducible 

expression of OX40L by antigen presenting cells.  Next, interaction of OX40L 

and OX40 expressed by Tregs results downstream in inhibition of Foxp3 and 

thus suppression of Treg development.  In support of this model, treatment of 

mice with anti-OX40L blocking antibody during the induction phase of 

tolerance reverses the suppression of Treg development caused by inhalation 

of LPS thus indicating the requirement for OX40 signaling.  To further 

elucidate the mechanism of inhibition, impaired Treg development of mice 

treated with an agonist anti-OX40 antibody and LPS delivered i.p. during the 

induction of tolerance was partially restored by i.p. delivery of anti-IL-6 

receptor blocking antibody and was fully restored when combined with i.p. 

delivery of anti-IL-4 and anti-IFN-γ blocking antibodies.  Therefore, IL-6 

produced by activated APCs and Th1/2 cytokines secreted by activated T cells 
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together with OX40 signaling mediates the inhibitory effect on Treg 

development.  Thus, with regard to its co-stimulatory role in Th2 effector cell 

activation combined with its inhibitory role in Treg development, OX40 is an 

attractive therapeutic target for the treatment of allergic asthma.
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1.2.2. Itk

! The inducible T cell kinase (Itk) is a member of the Tec family of non-

receptor protein tyrosine kinases that is expressed by mast cells, natural killer 

(NK) and T cells.  As demonstrated in studies using knockout mice, protective 

Th2 responses to extracellular parasites are impaired leading to increased 

susceptibility to infection by the protozoa Leishmania major and the nematode 

Nippostrongylus brasiliensis (73, 74).  Likewise, Itk-/- mice displayed reduced 

lung inflammation upon exposure to eggs from the helminth Schistosoma 

mansoni (75).  Upon challenge with OVA in the experimental asthma model, 

Itk-/- mice exhibited reduced lung inflammation as compared to WT control 

mice including reduced AHR, mucus production and recruitment of 

inflammatory eosinophils and T cells to the lungs (11, 76).  Consistent with the 

reduced asthma phenotype, T cells purified from the spleens of Itk-/- mice 

displayed reduced proliferation after restimulation with OVA in vitro (11).  In 

addition, production of Th2 cytokines was reduced upon restimulation of T 

cells purified from spleens and DLN of Itk-/- mice (11).  Furthermore, defective 

airway inflammation of Itk-/- mice as measured by AHR was reconstituted by 

adoptive transfer of purified OVA-specific CD4+ T cells indicating that the 

observed defects were intrinsic to CD4+ T cells (76).  Despite having a 

reduced asthma phenotype, however, serum from Itk-/- mice had elevated and 

unaffected levels of total and OVA-specific IgE, respectively (11).  In a follow 

up study, this phenomenon was linked to a unique role for Itk in the negative 
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regulation γδ NKT cells mediated by the transcription factor PLZF (77).  In the 

absence of Itk, increased numbers of γδ T cells were generated that were 

capable of producing Th2 cytokines and inducing immunoglobulin class 

switching of B cells to IgE upon activation (77).
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1.3. Itk in T Cell Activation and Development

1.3.1. T Cell Activation

! Itk is enzymatically activated downstream of the TCR resulting in 

phosphorylation of PLC-γ1 followed by the generation of second messengers 

that regulate T cell function and development (78-80).  First, a CD4+ T cell 

expressing an antigen-specific T cell receptor (TCR) recognizes an APC 

expressing peptide derived from antigen in the context of major 

histocompatibility class II molecules (MHC).  Upon TCR and CD28 co-

receptor engagement, the CD4-associated Src kinase Lck becomes activated 

and phosphorylates the immunoreceptor tyrosin-based activation motifs 

(ITAMs) located within the intracytoplasmic domains of the TCR/CD3 complex.  

Next, the Syk kinase Zap-70 is recruited to the phosphorylated ITAMs where it 

becomes activated and in turn phosphorylates the adaptor molecules LAT and 

SLP-76 which together form a stable signaling platform as part of the 

immunological synapse.  LAT is constitutively localized within lipid rafts of the 

plasma membrane whereas SLP-76 is located in the cytoplasm and is 

inducibly recruited to LAT upon phosphorylation via the adaptor protein Gads.  

Also occurring following TCR / CD28 receptor engagement, Lck activates the 

kinase PI3K which converts the membrane phospholipid PIP2 to PIP3.  Itk is 

then recruited to the immunological synapse mediated by interaction of its 

pleckstrin homology (PH) domain with membrane PIP3 as well as by 

interaction of its Src homology 2 and 3 (SH2 and SH3) domains with 

30



phosphorylated SLP-76 (81-83).  Specifically, the SH2 and SH3 domains of Itk 

bind to the phosphotyrosine motif and proline rich region (PRR) of SLP-76, 

respectively.  Once localized properly, Itk is phosphorylated in trans by Lck at 

tyrosine reside 511 of its Src homology 1 (SH1) domain followed immediately 

by autophosphorylation in cis at tyrosine reside 180 of its SH3 domain 

(84-86).

! In fulfillment of its enzymatic role, activated Itk phosphorylates 

phospholipase C-γ1 (PLC-γ1) on tyrosine reside 783 (87, 88).  Next, activated 

PLC-γ1 hydrolyzes membrane PIP2 to generate the soluble second 

messengers IP3 and DAG.  In a recently discovered positive feedback loop, 

IP4 which is generated by phosphorylation of soluble IP3 by inositol 

triphosphate 3-kinase B (ItpkB) binds to the PH domain of Itk and enhances 

membrane recruitment (89).  Following second messenger generation, IP3 

binds to IP3 receptors on the membrane of the endoplasmic reticulum (ER) 

leading to intracellular Ca2+ release and activation of the transcription factor 

NFAT while DAG activates protein kinase C (PKC) which leads to activation of 

the transcription factors NF-κB and AP-1.

! In addition to its canonical enzymatic role, Itk also serves as an adaptor 

protein as part of a signal transduction cascade downstream of the TCR that 

supports the nucleation of actin filaments mediated by the Wiskott-Aldrich 

syndrome protein (WASP) (90-94).  Independently of Itk, WASP is incucibly 

recruited to SLP-76 via the adaptor protein Nck (90).  In order to become 

31



activated, WASP binds to GTP-bound Cdc42 via its GTPase binding domain 

(GBD) and undergoes a conformational change that exposes its C-terminal 

VCA domain (95, 96).  Next, the actin nucleating protein Arp2/3 binds to the 

VCA domain of WASP leading to branching and polymerization of filamentous 

actin.  Local activation of WASP is supported by Itk through its constitutive 

association with the guanine nucleotide exchange factor Vav (92).  As Cdc42 

is rapidly inactivated by hydrolysis of GTP, Vav serves to exchange GDP for 

GTP thus activating Cdc42.  WASP- and Itk-dependent rearrangement of the 

actin cytoskeleton is believed to be important functionally for the formation of 

stable T cell-APC conjugates and immunological synapse formation resulting 

in sustained signaling and directed cytokine secretion.
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Figure 3:  Schematic diagram illustrates the early signaling events leading to 
T cell activation.
! A) First, an antigen-specific T cell receptor (TCR) engages foreign 
peptide presented in the context of major histocompatibility (MHC) class II 
molecules expressed by a specialized antigen presenting cell (APC).  Upon 
TCR-mediated activation, the CD4-associated Src kinase Lck phosphorylates 
the intracytoplasmic domains of the TCR/CD3 complex followed by 
recruitment and activation of the Syk kinase Zap-70.  B) Next, Zap-70 
phosphorylates the membrane-associated phospholipid kinase PI3K as well 
as the adaptor molecules SLP-76 and LAT, which are located in the cytoplasm 
and within lipid rafts of the plasma membrane, respectively.  C) Upon 
phosphorylation, SLP-76 is inducibly recruited to LAT via the adaptor molecule 
GADS.  In addition, the non-receptor Tec kinase Itk is inducibly recruited to 
SLP-76 via its SH3 domain.  Once assembled into the LAT-nucleated 
signaling complex, Itk is first phosphorylated in trans by Lck followed by a 
phosphorylation event in cis leading to full kinase activity.  In its separate role 
as an adaptor for Vav, Itk promotes localized activation of the actin nucleating 
protein WASp via activation of the GTPase Cdc42 (not shown).  D) Next, Itk 
phosphorylates tyrosine residue 783 on the phospholipase PLC-γ1, which 
hydrolyzes PIP2 in the plasma membrane to generate the second messengers 
IP3 and DAG.  Further downstream, IP3 activates the calcium-dependent 
transcription factor NFAT while DAG activates NF-κB and AP-1.  After nuclear 
translocation, binding of transcription factors to the cis regulatory regions of 
responsive genes leads to expression of inflammatory genes such as IL-2, 
which leads to proliferation of activated T cell clones.  In addition, activation of 
WASp results in actin polymerization at the immunological synapse.
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1.3.2. T Cell Development

! T cell development occurs in the thymus and, through the stages of 

positive and negative selection, results in the selection of a population of 

thymocytes expressing mature T cell receptors (TCR) that are MHC-restricted 

and self-tolerant (80, 97).  First, CD4- CD8- double negative (DN) thymocytes 

expressing a pre-TCR undergo the process of positive selection that allows 

the survival of immature T cells based on their ability to recognize MHC 

molecules expressed by epithelial cells in the cortical region of the thymus.  T 

cells receiving the necessary signals through their pre-TCR proceed to 

express a mature TCR in addition to the co-receptor molecules CD4 and CD8.  

Next, CD4+ CD8+ double positive (DP) T cells undergo the process of 

negative selection that results in the deletion of T cell clones expressing TCRs 

with high affinity to self-peptides expressed in the context of MHC molecules 

by medullary epithelial cells.  Self-tolerant T cell clones then mature to 

become either single positive (SP) CD4+ or CD8+ T cells before exiting the 

thymus.

! In the periphery, a mature CD4+ T cell is able to recognize foreign 

peptide presented by a professional APC in the context of MHC class II 

molecules (98).  Depending on the surrounding cytokine milieu provided by an 

activated APC, a naive CD4+ helper T cell is capable of differentiating into a T 

helper type 1 (Th1) or type 2 (Th2) effector cell.  Cytokine receptor-mediated 

signaling coupled with activation through the TCR strongly influences the 
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developmental fate of a naive CD4+ T cell.  In response to surrounding IFN-γ 

or IL-12, cytokine receptor-mediated signaling proceeds with the activation of 

STAT1 or STAT4, respectively, leading to induction of the Th1 lineage specific 

transcription factor T-bet.  In contrast, exposure to surrounding IL-4 leads to 

IL-4 receptor-mediated activation of STAT-6 followed by induction of the Th2 

transcription factor GATA3.  After differentiation and clonal expansion, Th1/2 

competent cells secrete effector cytokines upon antigen-specific restimulation 

through the TCR.  Th1 competent cells secrete the signature cytokines IFN-γ 

and IL-12 and are able to instruct CD8+ T cells to differentiate into cytotoxic T 

cells that are capable of lysing infected target cells thus providing immunity to 

intracellular pathogens.  On the other hand, Th2 competent cells secrete the 

cytokines IL-4, IL-5 and IL-13 and instruct B cells to secrete IgE thus providing 

protection against extracellular antigens.  Alternatively, a naive CD4+ T cell 

may differentiate into a regulatory T cell (Treg) mediated by signaling in 

response to TGF-β and induction of the lineage specific transcription factor 

Foxp3.  IL-10 secreted by activated Tregs is important for suppressing Th1 or 

Th2 effector T cells following the initial inflammatory phase of the immune 

response.

! Studies using knockout mice have revealed that several aspects of T 

cell development are altered in the absence of Itk.  In the initial 

characterization of the Itk-/- mice, Liao and Littman discovered a reduced ratio 

of CD4+ to CD8+ thymocytes and a 2-fold decrease in the number of 
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peripheral CD4+ T cells as compared to wild-type mice indicating a 

requirement for Itk-dependent signaling during early thymic development (99).  

In order to investigate the defect further, CD4+ T cells were purified and 

cultured in the presence of conditions designed to mimic the cytokine milieu 

provided in vivo by an activated APC thus effectively skewing naive T cells 

along a Th1 or Th2 developmental pathway in vitro (100-102).  In these 

studies, TCR stimulation was provided in vitro by receptor cross-linking using 

plate-bound anti-TCR antibody coupled with the addition of exogenous IL-2 to 

promote proliferation.  Specifically, skewing towards the Th1 developmental 

pathway was achieved by adding exogenous recombinant IL-12 combined 

with anti-IL-4 blocking antibody while skewing towards the Th2 developmental 

pathway was achieved by adding exogenous recombinant IL-4 combined with 

anti-IFN-γ and/or anti-IL-12 blocking antibodies.  Th1/2 effector function was 

then assessed after harvesting and restimulating differentiated cells using 

plate-bound anti-TCR antibody.  These studies revealed that IL-4 secretion by 

Itk-/- T cells was defective upon restimulation of Th2-skewed cells while IFN-γ 

secretion by Th1-skewed cells was unaffected in the absence of Itk.  In order 

to determine whether the observed Th2 defect was a result of defective 

lineage commitment or effector function, Au-Yeung and Fowell crossed 

knockin mice containing an IL-4-enhanced GFP (eGFP) reporter gene with 

Itk-/- mice and skewed cells along the Th2 differentiation pathway in vitro as 

described above (101, 102).  In summary, these studies identified an essential 
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role for Itk at the effector stage of Th2 cytokine secretion upon TCR-mediated 

restimulation while differentiation of Itk-/- CD4+ T cells into Th2 competent 

cells was not affected as determined by monitoring the expression of the IL-4 

reporter gene.

! In a separate report, expression of the related Tec kinases Itk and Rlk 

was compared in Th1 versus Th2-skewed CD4+ T cells.  At both the mRNA 

and protein level, Itk was upregulated in Th2 as compared to Th1-skewed 

cells (100).  Furthermore, Rlk was not expressed in Th2 cells while its 

expression was selectively induced in Th1-skewed cells.  Taken together, the 

results from the in vitro skewing experiments mentioned above are consistent 

with a model that supports Itk-independent Th2 differentiation driven by 

cytokine receptor mediated signaling in response to exogenous IL-4 resulting 

in STAT6 activation and induction of GATA-3.  At the effector stage, these 

observations are also consistent with a dependence on Itk for the expression 

of Th2 but not Th1 effector function due to the non-redundant expression of 

the Tec family kinase Itk in Th2-differentiated cells.

! Interestingly, studies performed by Miller and Berg using non-skewing 

culture conditions provided additional insight into the role of Itk during Th cell 

differentiation (100).  In these studies, naive CD4+ T cells were allowed to 

differentiate in the absence of exogenous skewing cytokines and were 

directed instead only by the intensity of TCR signaling provided in vitro.  High 

intensity TCR signaling resulted in rapid induction of the Th1 lineage specific 
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transcription factor T-bet and secretion of IFN-γ upon restimulation 

independently of Itk expression while low intensity TCR signaling resulted in 

induction of the Th2 lineage transcription factor GATA-3 in both WT and Itk-/- 

T cells.  However, GATA-3 expression was coupled with low T-bet expression 

in WT T cells resulting in Th2 effector differentiation and secretion of IL-4 upon 

restimulation whereas Itk-/- T cells unexpectedly had increased T-bet 

expression resulting in Th1 effector differentiation and secretion of IFN-γ upon 

restimulation.  Separate from the role of Itk in the release of effector function 

described above, these findings revealed a unique role for Itk in suppressing 

T-bet expression and thus promoting Th2 lineage commitment under 

conditions of low intensity TCR stimulation.  This function could possibly be 

achieved by means of a direct effect on T-bet or by transcriptional repression 

of the T-bet promoter.  Thus, Itk serves to regulate early Th2 commitment in 

terms of its ability to suppress the Th1 transcription factor T-bet as well as to 

regulate Th2 cytokine secretion upon restimulation with antigen downstream 

of the TCR.
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Figure 4:  Schematic diagram illustrates the developmental pathways, 
including Itk-dependent defects, leading to generation of T helper type 1 (Th1) 
and type 2 (Th2) effector cells.
! A) In the cortical region of the thymus, bone marrow-derived T cells are 
double negative (DN) for expression of the surface markers CD4 and CD8.  
During positive selection, signaling through the pre-TCR leads to survival and 
expression of a mature TCR as well as to double positive (DP) expression of 
CD4 and CD8.  Next, self-reactive T cells clone are removed through the 
process of negative selection while self-tolerant clones mature into CD4 or 
CD8 single positive (SP) T cells before exiting the thymus.  In the absence of 
Itk signaling, development of CD4+ T cells is impaired leading to a decreased 
ratio of CD4+ to CD8+ T cells in the periphery.  B) In the periphery, primary 
stimulation in response to antigen results in T cell activation and development 
into Th1 or Th2 effector cell populations depending on additional cytokine and/
or T cell receptor-mediated signaling.  In the presence of exogenous IL-4, 
cytokine receptor-mediated signaling induces expression of the transcription 
factor GATA3, which promotes Th2 differentiation.  In contrast, exogenous 
IFN-γ and/or IL-12 induces expression of the transcription factor T-bet, which 
promotes Th1 differentiation.  In the absence of exogenous cytokines, high 
affinity TCR signaling induces expression of T-bet resulting in Th1 
differentiation while low affinity TCR signaling induces expression of GATA-3 
resulting in Th2 differentiation, which is impaired in the absence of Itk.  Upon 
secondary TCR-mediated stimulation, differentiated Th1 and Th2 cells 
become effector cells, which are capable of  secreting IFN-γ and IL-12 or IL-4, 
IL-5 and IL-13, respectively.  Furthermore, Th2 effector function as measured 
by secretion of IL-4, IL-5 and IL-13 by competent cells is impaired in the 
absence of Itk.
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1.4. Itk Regulation and Association with SLP-76

! Itk is structurally organized into modular domains with shared 

homology to other Tec kinases that contribute to its overall kinase and adaptor 

functions in T cells.  Importantly, negative regulation is a critical feature of all 

kinases in order to prevent uncontrolled phosphorylation of targets within the 

cell.  Negative regulation of Src kinases such as Lck is well known to be 

achieved via an autoinhibitory conformation of the molecule that is mediated 

by the interaction of a phosphotyrosine residue in the kinase domain with the 

adjacent SH2 domain thus allosterically preventing kinase activity (103, 104).  

TCR-mediated release of the autoinhibitory conformation may be achieved 

through multiple mechanisms including dephosphorylation of the inhibitory 

phosphotyrosine by protein tyrosine phosphatases such as CD45, binding of 

exogenous ligand to regulatory domain(s) and/or activating phosphorylation 

events (105, 106).  In contrast to Src kinases, Tec kinases do not have an 

autoinhibitory phosphotyrosine site in their kinase domains and therefore 

negative regulation is achieved by different means.  Using a panel of purified 

Itk domain fragments, Andreotti et al. demonstrated in vitro that binding to 

exogenous substrates was inhibited for a fragment composed of the Itk SH3 

domain and the proline motif KPLPPTP located in the adjacent Tec homology 

(TH) domain (107).  As confirmed by NMR analysis, a model for negative 

regulation of Itk was proposed that is mediated by intramolecular association 

of the SH3 domain and the adjacent proline region within the TH domain.
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! In addition to the intramolecular self-association, Brazin and Andreotti 

discovered an intermolecular self-association with regulatory implications 

mediated by non-classical binding of the SH3 domain to the SH2 domain of 

another Itk molecule (108).  This novel association was dependent on the SH3 

domain binding pocket as demonstrated by disruption of dimer formation by 

mutation of the conserved tryptophan residue at position 208 (W208K) and 

involved binding to a novel surface on the SH2 domain as revealed by NMR 

(108).  Furthermore, binding studies revealed that a proline-rich peptide was 

able to displace the SH3 domain from the SH2 domain while a 

phosphotyrosine-containing peptide had no significant effect on dimer 

formation (108).  These results indicated that Itk dimer formation required 

mutually exclusive binding of the SH3 domain to the novel SH2 ligand while 

the phophotyrosine binding pocket of the SH2 domain was outside of the 

binding surface.  Importantly, the Itk homodimers identified in vitro were 

demonstrated to be functionally significant in a negative regulatory capacity.  

As evidence of this, the Itk SH3 domain was replaced with the SH3 domain 

from the related kinase Btk which does not bind to the SH2 domain thus 

disrupting dimer formation (109).  Upon expressing the ItkBtk SH3 variant in a 

heterologous insect cell line, downstream activation of PLC-γ and ERK was 

enhanced as would be predicted for disruption of an autoinhibitory molecular 

association (109).  However, this effect was not observed using a more 

physiological T cell expression system perhaps as a consequence of impaired 
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binding of the full-length Btk SH3 domain to polyproline ligands present on 

signaling adaptor molecules expressed in T cells such as SLP-76 (110).  In a 

separate report, Severin and Andreotti identified that cis-trans isomerization of 

the imide bond preceding proline 287 of the SH2 domain regulates the SH2/

SH3 mediated dimer formation with the cis isomer favoring association with 

the SH3 domain (111).  Furthermore, the peptidyl-prolyl isomerase cyclophilin 

A catalyzes this cis-trans isomerization and mice lacking the cyclophilin A 

gene are susceptible to a spontaneous Th2 allergic condition characterized by 

swelling of the eyelids (112).  

! The structural studies described above support a model for negative 

regulation of the cis Itk isomer mediated by SH2-SH3 dimer formation that is 

in dynamic equilibrium with an autoinhibitory monomer mediated by SH3-

proline intramolecular interactions.  Upon transition to the trans isoform, the Itk 

SH2 domain favors binding to stimulation-dependent phosphotyrosine ligands 

transiently present on signaling adaptor proteins such as SLP-76 and, 

stabilized by binding of the SH3 domain to exogenous polyproline ligands, 

results in disruption of the autoinhibitory conformation.  Following activation, 

Itk rapidly cycles to return to the cis isomer in this model and is again driven 

towards stable dimer formation.  In the absence of cyclophilin A, the trans 

isomer would be predicted to persist allowing prolonged Itk activation and T 

cell signal transduction resulting in enhanced susceptibility to allergic 

conditions.
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! As revealed by studies using a PH domain deletion mutant (ΔPH-Itk), 

the N-terminal PH domain of Itk is required for the proper recruitment of Itk to 

the plasma membrane in addition to its co-localization with the TCR/CD3 

signaling complex and enzymatic activation (83).  The defects observed in the 

absence of the PH domain are consistent with the role of its inositide-binding 

pocket in associating with the membrane lipid PIP3 which is generated 

following TCR-dependent activation of PI3K (81).  In order to further elucidate 

its role, Hirve et al. generated point mutations in the PH domain of Itk at the 

conserved FYF amino acid motif located within the central β-barrel structure 

(manuscript accepted).  Despite the inability to bind to PIP3, TCR-dependent 

membrane localization of the FYF-Itk mutant was only partially reduced in 

contrast to the complete localization defect previously observed for ΔPH-Itk.  

Furthermore, the inducible association of the FYF-Itk mutant with the adaptor 

proteins SLP-76 and LAT occurred normally.  Taken together, these 

observations are consistent with a possible regulatory role for the Itk PH 

domain in promoting association with a cluster of signaling molecules 

following TCR-dependent stimulation.  However, the FYF-Itk mutant was 

enzymatically inactive suggesting a requirement for stable membrane 

interaction mediated by binding to PIP3 in order to induce a conformational 

change that allows phosphorylation in trans by Lck.  Indeed, fluorescence 

resonance energy transfer (FRET) analysis of the FYF-Itk mutant at the 

immunological synapse reveals that this molecule is conformationally altered 
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in comparison to WT Itk.  In addition to its PIP3-binding and possible adaptor 

roles, the PH domain of Itk has also been identified as a regulator of Itk 

activity.  For example, ΔPH-Itk displayed spontaneous in vitro kinase activity 

suggesting a negative regulatory function in resting T cells.  Furthermore, the 

PH domain has also been implicated in positive regulation of Itk activity 

mediated by binding to soluble IP4 which is generated by ItpkB following T cell 

stimulation (89).  Thus, the PH domain likely provides distinct adaptor and 

regulatory functions in addition to its essential role in binding to membrane 

PIP3.

! As shown by reconstitution of a deficient Jurkat cell line, the SH2 

domain-containing protein and leukocyte protein of 76 kDa (SLP-76) is 

required for TCR-dependent Itk transphosphorylation and activation (113).  

SLP-76 is organized into an N-terminal acidic domain, a large proline rich 

region and a C-terminal SH2 domain.  The N-terminal acidic domain contains 

three tyrosine residues that are phosphorylated upon TCR-dependent 

stimulation with the tyrosine at position 145 being specifically required for Itk-

dependent signaling (114, 115).  However, the TCR-inducible biochemical 

association of Itk and SLP-76 was not affected by mutation of this tyrosine 

residue despite its importance for Itk activation (115, 116).  As previously 

identified in vitro, the purified SH2 domain of Itk specifically binds to phospho-

Tyr145 within the acidic domain of SLP-76 while the Itk SH3 domain binds to 

the central polyproline region of human SLP-76 located at a minimal binding 
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site from amino acid residues 184 to 195 corresponding to the sequence 

QQPPVPPQRPMA (81, 117).

! In order to further investigate the role of the Itk SH3 domain, Grasis et 

al. added a cell-penetrating poly-arginine motif to the SH3 domain polyproline 

ligand identified from the in vitro binding studies and treated Jurkat cells and 

primary T cells with the modified peptide which was referred to as R9-QQP 

(2).  In contrast to the role of the N-terminal Tyr145 in the SLP-76 acidic 

domain, the polyproline region of SLP-76 was necessary for mediating TCR-

dependent Itk–SLP-76 biochemical association as revealed by dose-

dependent competition for binding to the Itk SH3 domain using the R9-QQP 

peptide.  Consistent with the adaptor role of SLP-76, the study by Grasis et al. 

demonstrated that recruitment of Itk to the immunological synapse as well as 

its TCR-mediated transphosphorylation were inhibited upon treatment of T 

cells with R9-QQP.  Furthermore, Itk-dependent catalytic and adaptor function 

were also affected as revealed by decreased Th2 cytokine production and 

reduced actin polymerization at the immunological synapse, respectively.

! Importantly, inhibition of binding to SLP-76 as well as the consequent 

effects on Itk activation and function were specific as determined by treatment 

of T cells with a control peptide containing a scrambled polyproline motif.  For 

example, the adaptor protein GADS constitutively binds to SLP-76 mediated 

by its SH3 domain where it serves to provide a link via its SH2 domain to the 

scaffolding protein LAT which lacks an SH3 domain (118, 119).  At the same 
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time that SH3-mediated binding of Itk at the location of its polyproline ligand 

on SLP-76 was inhibited by R9-QQP, the SH3-mediated association of GADS 

at the location of its distinct polyproline ligand on SLP-76 was not affect by 

R9-QQP thus demonstrating sequence specificity.

! In addition to binding to Itk, an identical location within the proline 

region of SLP-76 is also required for binding to the Src kinase Lck as 

demonstrated by binding to an Lck SH3 domain fragment in vitro (120).  

Furthermore, this association was demonstrated to be functionally significant 

by genetic reconstitution of SLP76-/- mice with a version of SLP-76 lacking the 

specific proline ligand binding region (121).  However, treatment of T cells with 

R9-QQP inhibited SH3-mediated binding of Itk but not Lck to the same 

polyproline ligand of SLP-76 (2).  One explanation for the disparate in vivo 

binding results reported for Lck could involve the strategy used for blocking its 

interaction to SLP-76.  Genetically altering SLP-76 by deletion of a portion of 

its proline region could induce allosteric changes that disrupt physiological 

binding to full length Lck.  In contrast, the use of a competitive inhibitor to 

disrupt binding leaves SLP-76 intact and allows additional stabilizing 

interactions outside of the polyproline ligand binding region to occur 

unperturbed.  In this scenario, association of full length Lck with SLP-76 may 

be preserved by treatment with R9-QQP but not for the SLP-76 deletion 

mutant.
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! While polyproline regions are functionally important in their ability to 

serve as SH3 ligands, they may also play an independent structural role.  For 

example, the P-1 section of the SLP-76 proline region was shown to be 

capable of binding to the PLC-γ1 SH3 domain in vitro (122).  Furthermore, 

binding to PLC-γ1 was abolished upon reconstitution of deficient Jurkat cells 

with SLP-76 mutants containing various partial deletions within the P-1 section 

(123).  However, PLC-γ1 was functionally active despite the lack of binding to 

SLP-76 for all partial deletion mutants.  In contrast, PLC-γ1 function was only 

impaired upon deletion of the entire P-1 section and this defect was partially 

restored by replacement with a P-1 section containing a scrambled sequence.  

Thus, the results of this study are consistent with a structural role for the 

proline region within the P-1 section of SLP-76.  In this context, the ability of 

the P-1 section of SLP-76 to bind to the SH3 domain of PLC-γ1 appears to be 

unrelated to the SLP-76 requirement for PLC-γ1 activation.  While polyproline 

regions may play a structural role in certain contexts, this is not inconsistent 

with the role of polyproline motifs as specific although low affinity ligands for 

SH3 domain containing signaling proteins that provide important functional 

roles as demonstrated for the Itk–SLP-76 association.  Rather than a direct 

association, subsequent work indicated that recruitment of PLC-γ1 to SLP-76 

was dependent on its association with GADS while activation of PLC-γ1 was 

dependent on its SLP-76-mediated association with Itk and Vav as part of a 

LAT-nucleated signaling cluster in proximity to the TCR/CD3 complex (124).
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! Based on studies of Itk domain function, the cumulative data support a 

model for autoinhibition of Itk mediated by dimer and folded monomer 

conformations involving SH2-SH3 domain interaction in trans and SH3-

polyproline interaction in cis, respectively (1, 107).  Upon isomerization of the 

imide bond within the SH2 domain to a trans isoform, Itk is then able to bind 

via its SH3 domain to its polyproline ligand within the proline region of SLP-76 

(108, 112).  Additionally, interaction of the SH2 domain with phospho-Tyr145 

within the acidic domain of SLP-76 is required in order for Itk to become 

activated enzymatically (115, 116).  Combined with the membrane targeting 

and adaptor roles of the PH domain, the cooperative SH2 and SH3 mediated 

binding of Itk to SLP-76 is likely required in order to stabilize a conformation of 

Itk that allows phosphorylation on tyrosine 511 within its SH1 domain by Lck 

(2, 110).  This modification then induces a conformational change that 

activates the kinase domain of Itk.  Furthermore, autophosphorylation of the 

Itk-SH3 domain on tyrosine 181 is likely important for stabilizing Itk in an 

active conformation perhaps by preventing intramolecular folding mediated by 

the inhibitory SH3-proline interaction (86).  Once fully activated, Itk is then 

capable of phosphorylating PLC-γ1 on tyrosine 783 which is required along 

with its association with Vav for its lipase activity followed downstream by 

second messenger generation and transcriptional activation resulting in T cell 

development and effector function (124).
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Figure 5:  Schematic diagram compares and contrasts the domain structure 
composition of Tec and Src family kinases.
! A-B) In contrast to Src kinases, the Tec family of non-receptor tyrosine 
kinases have an N-terminal pleckstrin homology (PH) domain, which binds to 
the membrane phospholipid PIP3.  Furthermore, Tec kinases lack a negative 
regulatory phosphotyrosine residue in their C-terminal kinase domain, which is 
present in Src kinases.  Similarly, both Tec and Src kinases share SH2 and 
SH3 domains with adaptor functions in addition to a conserved kinase 
domains with catalytic function.  Itk is phosphorylated in trans on tyrosine 511 
within its kinase domain, which results in phosphorylation in cis on tyrosine 
181 within its SH3 domain.  In addition, several point mutations have been 
introduced with differential effects on Itk function including R29C and FYF 
(F26S, Y90F and F92S) in the PH domain, which prevent binding to PIP3, 
W208K in the SH3 domain, which prevents binding to polyproline ligands, and 
R265K in the SH2 domain, which prevents binding to phosphotyrosine 
ligands.
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Figure 6:  Schematic diagram illustrates regulatory Itk domain interactions 
including dominant negative inhibition by R9-QQP.
! A) Itk activity is believed to be negatively regulated by stable Itk 
heterodimers mediated by non-canonical SH2-SH3 domain interactions that 
are in dynamic equilibrium with folded Itk monomers mediated by SH3-proline 
interactions.  Catalyzed by cyclophilin A (CypA), proline 287 of the Itk SH2 
domain converts from the cis to the trans isoform resulting in enhanced affinity 
for TCR-dependent phosphotyrosine ligands present in the acidic domain 
(AD) of SLP-76.  In this model, cooperative binding of the Itk SH2 and SH3 
domains to the acid and proline rich domains (PRD) of SLP-76 induces a 
conformation of Itk that allows phosphorylation by Lck followed by stabilization 
of the active conformation by autophosphorylation.  After the initial TCR-
dependent phosphorylation of SLP-76, dynamic cycling of Itk molecules then 
returns Itk to an inactive conformation.  B) Enlargement of Itk and SLP-76 
interaction highlights the domain-specific interactions between that are 
disrupted the QQP peptide, which is derived from the proline rich domain 
(PRD) of SLP-76.  C) The cell permeable R9-QQP peptide inhibits Itk by 
binding to the Itk SH3 domain in a competitive manner thus disrupting the 
association of Itk with SLP-76 which is necessary for its activation.
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1.5. R9-QQP Characterization and Translation to Asthma Model

! As illustrated in the example of the SLP-76 derived R9-QQP peptide, 

cell penetrating peptides (CPP) are useful tools for studying the function of 

physiological protein domain-mediated binding events occurring within live 

cells.  Whether mediated by direct penetration of the plasma membrane or by 

endocytosis, covalent addition of a polyarginine tag to the cargo peptide 

sequence allows delivery of the polyarginine fusion peptide into the 

cytoplasmic compartment of the cell.  Once inside the cell, free peptide is able 

to bind to its target protein thus blocking its functional interaction with another 

endogenously expressed binding partner in a dominant negative manner 

(125-127).  Because the transduction efficiency of polyarginine-conjugated 

peptides may also depend on the amino acid composition of the peptide 

cargo, addition of fluorescent tags combined with confocal microscopy and/or 

detection of fluorescence by flow cytometry are useful methods for monitoring 

peptide uptake.  Particularly at high concentrations, one complication from the 

use of CPP is the possible disruption of the plasma membrane that may occur 

during the cellular uptake process.  As for treatment with any drug in a cell-

based system, determination of cell viability at the effective concentration and 

for the duration of the assay is a routine but important assessment of any 

cytotoxic effects that may affect interpretation of peptide sequence specific 

binding effects.
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! In the study by Grasis et al., cellular uptake of R9-QQP by Jurkat T 

cells and primary murine splenocytes was determined by use of FITC which 

was covalently attached to the N-terminus of the polyarginine cell penetration 

motif.  As determined by FACS analysis, uptake of FITC-R9-QQP by both 

Jurkat cells and splenocytes was dose dependent following a 30 min. in vitro 

incubation with peptide in concentrations ranging from 0-20 µM.  Once taken 

up by T lymphocytes, the TCR-inducible biochemical association of Itk and 

SLP-76 was blocked by R9-QQP in a dose-dependent and peptide sequence 

specific manner as determined by co-immunoprecipitation experiments 

targeting SLP-76 followed by immunoblotting for Itk.  In order to investigate 

the effect of this biochemical association on TCR-inducible recruitment, Jurkat 

cells expressing GFP-Itk were treated with R9-QQP and allowed to form 

conjugates with anti-TCR coated beads which serve as surrogate antigen 

presenting cells.  Consistent with the requirement for interaction with SLP-76, 

analysis of images acquired by confocal microscopy revealed that recruitment 

of GFP-Itk to the cell-bead contact site was impaired in cells that had been 

treated with R9-QQP.

! According to its adaptor role, Itk supports localized actin polymerization 

through its constitutive association with Vav which activates WASp.  In order 

to investigate this Itk-dependent function, Jurkat-bead conjugates were 

stained with TRITC-conjugated phalloidin to visualize filamentous actin after 

treatment of cells with R9-QQP.  In agreement with the Itk localization defect, 
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R9-QQP specifically disrupted accumulation of actin at the cell-bead contact 

site.  Furthermore, Itk is enzymatically activated by phosphorylated on 

tyrosine 511 within its kinase domain by Lck in mechanism that depends on 

SLP-76.  Indeed, Itk activation was also inhibited in R9-QQP treated cells as 

determined using a phospho-specific antibody combined with detection by 

both immunoblotting and phospho-flow cytometric methods.

! Following TCR and Itk-mediated activation of PLC-γ1, second 

messengers such as IP3 and DAG are generated that result in activation of 

downstream signaling pathways which result in transcriptional activation of 

Th2 inflammatory cytokine genes.  In order to assess the effects of R9-QQP 

on expression of cytokine genes, CD4+ T cells were purified from WT C57BL/

6 mice and treated in vitro with R9-QQP or scrambled control peptide.  24 

hours after the primary stimulation with anti-TCR and anti-CD28 antibodies, 

cells were restimulated with anti-TCR antibody and incubated for an additional 

6 hours in the presence or absence of the protein transport inhibitor Brefeldin 

A.  Next, cytokine gene expression of Brefeldin A treated cultures was 

detected by the intracellular cytokine staining method and supernatants from 

independent cultures were harvested and tested for cytokine secretion by 

ELISA.  Similar to the developmental defects observed for Itk-/- T cells, 

inhibition of Itk activation by treatment with R9-QQP specifically reduced 

expression as well as secretion of the Th2 cytokines IL-4, IL-5 and IL-13 while 

the signature Th1 cytokine IFN-γ was not significantly affected.
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! In addition to the R9-QQP specific effects described for the treatment of 

T cells in vitro, Grasis et al. extended the biochemical and functional 

significance of these findings by treating mice with peptide delivered in vivo.  

In these experiments, 20 mg/kg of R9-QQP or control peptide was injected 

intraperitoneally (i.p.) at 24 and 0.5 hrs. prior to harvesting spleens.  After 

processing into a cell suspension, the biochemical defects affecting the Itk–

SLP-76 association as well as Itk enzymatic activation were confirmed using 

this in vivo peptide treatment protocol.  Lastly, the specific functional effects of 

inhibiting the Itk–SLP-76 interaction on Th2 cytokine expression and secretion 

were also demonstrated by administration of R9-QQP in vivo.  While not 

unexpected, the functional effects precipitated by disrupting the Itk–SLP-76 

interaction as detailed in this study elegantly refined the precise binding 

requirements necessary for Itk activation while leaving endogenously 

expressed signaling proteins untouched by mutational approaches.  Namely, 

interaction of the Itk SH3 domain interaction with the SLP-76 polyproline 

ligand was demonstrated to be of paramount importance for physiological 

association of the two full-length molecules.  Furthermore, competitive 

inhibition of this interaction by R9-QQP resulted in a cascading series of 

biochemical and functional defects resulting in decreased Th2 cytokine 

production.

! In addition to being useful tools for studying biochemical signaling 

pathways, CPP have also been used to investigate disease pathogenesis with 
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translational potential for clinical application (128-130).  Treatment of many 

inflammatory skin diseases such as psoriasis and atopic dermatitis is often 

complicated by the poor epidermal penetration of topically applied 

immunosuppressive drugs such as cyclosporin A.  On the other hand, orally 

administered immunosuppressive drugs are effective but often have 

undesirable toxic and carcinogenic side effects.  Using a mouse model of 

contact dermatitis, Rothbard et al. demonstrated that conjugation of a 

polyarginine tag to the calcineurin inhibitor cyclosporin (CsA) facilitated entry 

of R7-CsA into T cells located at the site of inflammation within the dermal 

layer of the skin (130).  In order to determine effectiveness, one ear from each 

mouse in the contact dermatitis model was treated with either R7-CsA or 

unmodified control CsA.  As an indicator of inflammation, ear swelling was 

measured following treatment.  The results of these experiments revealed that 

R7-CsA significantly reduced ear swelling as compared to the unmodified 

control.  Importantly, treatment with R7-CsA did not affect ear swelling on the 

untreated ear and R7-CsA was not detected in serum collected from these 

mice indicating that the effect was occurring locally as opposed to 

systemically.  As demonstrated in this study, polyarginine modification can be 

useful as a strategy to enhance delivery of biologically active compounds to 

sites of inflammation within tissues and inside of cells that are otherwise 

inaccessible to unmodified drugs.

59



! In another study targeting the same pathway, Noguchi et al. used the 

NFAT inhibitor peptide VIVT to successfully prevent rejection of transplanted 

pancreatic islets using a mouse model of transplant rejection (129).  For 

patients with autoimmune-based type 1 diabetes, successful transplant 

therapy requires tolerance to mismatched MHC molecules that can be 

achieved therapeutically by immunosuppressive drugs such as cyclosporine 

A and FK506.  By inhibiting the calcium-dependent phosphatase calcineurin, 

these drugs prevent dephosphorylation and nuclear translocation of NFAT 

which transcriptionally activates many pro-inflammatory genes.  While 

effective immunosuppressors, these drugs also have toxic and carcinogenic 

side effects associated with their long term use.  When modified by the 

addition of 11 arginines and delivered in vivo, 11R-VIVT specifically reduced 

rejection of islet allografts mediated by inhibition of pro-inflammatory 

cytokines.  In addition, 11R-VIVT had reduced toxic effects as demonstrated 

by reduced insulin secretion by a β-pancreatic cell line that was exposed to 

peptide in vitro.  By directly inhibiting NFAT rather its upstream regulator, the 

polyarginine-tagged peptide VIVT is an effective and less toxic 

immunosuppressor as compared to therapeutics that target calcineurin.  

! In an study demonstrating treatment of lung inflammation, McCusker et 

al. used a dominant negative peptide inhibitor of STAT-6 that was delivered 

intranasally to mice during the challenge period of the ovalbumin-induced 

asthma model (128).  During an inflammatory response, OVA-induced IL-4 
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and IL-13 bind to cytokine receptors which share a common IL-4 receptor 

alpha subunit and that are expressed on T cells as well as airway structural 

cells.  Upon binding of IL-4/IL-13, cytoplasmic STAT-6 is recruited to the 

cytokine receptor where it is phosphorylated on tyrosine residue 641 (pY 641).  

Mediated by a subsequent pY 641-SH2 domain interaction, STAT-6 dimerizes 

and translocates to the nucleus where it promotes transcriptional activation of 

pro-inflammatory genes.  In order to block STAT-6 dimerization, a dominant 

negative inhibitor peptide that included pY 641 was tagged with a cell 

penetration motif derived from the HIV-TAT transcription factor protein 

transduction domain.  Upon intranasal delivery, this peptide was demonstrated 

to enter airway structural cells which express STAT-6 and respond to IL-4/

IL-13-dependent cytokine signaling.  Mice treated intranasally with the STAT-6 

inhibitor peptide displayed reduced lung inflammation characterized by 

reduced eosinophil infiltration, mucus production and airway 

hyperresponsiveness.  In addition, lung cells from peptide-treated mice 

showed reduced expression of inflammatory genes such as eotaxin which 

recruits eosinophils as well as genes involved in mucus production.  Together, 

these data establish that a cell permeable peptide can be efficiency delivered 

to structural cells lining the lung mucosa and can be used to treat lung 

inflammation associated with experimental asthma.

! While current treatments for asthma are effective for most individuals, 

the lack of responsiveness in some groups of patients as well as the serious 
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side effects noted in the review above highlight the need to develop additional 

treatment options.  In terms of its requirement for Th2 cell effector function as 

well as the reduced asthma phenotype of knockout mice, Itk is an attractive 

therapeutic target for the treatment of allergic diseases such as asthma (11, 

100, 101).  Previously developed small molecule inhibitors of Itk target its 

conserved kinase domain which shares homology with other kinases and are 

likely to affect many unrelated signaling pathways at therapeutically effective 

concentrations (131, 132).  In contrast, the R9-QQP inhibitor peptide 

characterized in the study by Grasis et al. specifically targets the TCR-

inducible interaction of the Itk-SH3 domain with the polyproline ligand of 

SLP-76 and identifies this association as a necessary condition for the 

enzymatic and adaptor functions of Itk in T cells.  Combined with the feasibility 

of applying CPP to disease models including experimental asthma as 

mentioned above, the current study attempts to translate the biochemical and 

functional characterization of R9-QQP to a mouse model of experimental 

asthma generated in response to OVA.

! Chapter 1, in part, is currently being prepared for submission for 

publication of the material.  Guimond, D.M., Cam, N.R., Hirve, N., Duan, W., 

Lambris, J.D., Croft, M., & Tsoukas, C.D (2012).  Treatment of Experimental 

Asthma Using a Novel Peptide Inhibitor of the Inducible T Cell Kinase.  The 

dissertation author was the primary author of this material.
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2. MATERIALS AND METHODS

2.1. Mice

! Female C57BL/6 or BALB/c mice between 6-8 weeks old were 

purchased from Jackson Laboratories (Bar Harbor, ME).  Itk-/- mice were 

generated as previously described by Dr. D. Littman (New York University 

School of Medicine; New York, NY) (99).  A breeding pair was provided by Dr. 

T. Kawakami (La Jolla Institute for Allergy and Immunology; La Jolla, CA) for 

colony maintenance at the San Diego State University Vivarium Facility and 

genotyping by PCR analysis using tail fragments was performed as described 

below to confirm the presence of the homozygous knockout alleles.  All mice 

were housed in microisolator cages on a 12 hr. light / dark cycle and were 

provided with acidified, autoclaved water and an irradiated rodent diet ad 

libitum.  Euthanasia was performed by first anesthetizing mice inside of a jar 

containing cotton saturated with isoflurane (TW Medical Veterinary Supply, 

Cat. # 21234484; Lago Vista, TX) followed by sacrificing unconscious mice by 

cervical dislocation.  Experiments using mice were approved and conducted 

following the guidelines of the Institutional Animal Care and Use Committees 

(IACUC) at San Diego State University and the La Jolla Institute for Allergy 

and Immunology (for AHR assay), respectively.

63



2.2. Diagnosis of Itk-/- Mice by PCR Analysis

! Itk-/- mice used for characterization of the asthma assay were 

diagnosed by PCR for the homozygous presence of the mutant Itk allele 

containing the neomycin cassette followed by a stop codon in place of Itk 

exon 3, intron 3 and exon 4 as described previously (99).  First, 1 cm tail 

fragments were removed and solubilized overnight at 55°C in the presence of 

20 mg/mL proteinase K (Invitrogen / Life Technologies, Cat. # 25530-015; 

Carlsbad, CA) in tail solubilization buffer (100 mM NaCl, 1% SDS, 5 mM 

EDTA and 10 mM Tris-HCl, pH 8.0).  Next, SDS and proteins were 

precipitated by the addition of 0.4 volume of tail salts buffer (4.21 M NaCl, 

0.63 M KCl and 10 mM Tris-HCl, pH 8.0) and incubation for 4 hrs. on ice 

followed by centrifugation for 10 min. at 14,000 rpm (4°C).  80 µL of 

supernatant was then transferred to a microcentrifuge tube and DNA was 

precipitated by the addition of 2 volumes of ice-cold 100% ethanol and 

incubation for 4 hrs. at -20°C followed by centrifugation for 10 min. at 14,000 

rpm (4°C).  After ethanol precipitation, the supernatant was discarded and 

DNA contained in the pellet was washed with 500 µL ice-cold 80% ethanol 

followed again by centrifugation as before.  Lastly, the supernatant was 

discarded and purified DNA contained in the pellet was allowed to dry before 

being dissolved in 50µL of TE buffer (1 mM Tris-HCl, 0.1 mM EDTA, pH 8.0) 

and stored at -20°C.
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! For each PCR reaction, 3 µL of purified template DNA obtained 

following mouse tail biopsy as described above was added to a PCR tube in 

addition to the following components which were purchased from Invitrogen / 

Life Technologies and adjusted to a final volume of 50 µL using PCR grade 

water:  0.2 mM dNTP mixture, 2 mM MgSO4, 0.2 µM of each primer, 1x High 

Fidelity PCR buffer and 1 unit of Platinum Taq DNA Polymerase High Fidelity 

(Cat. # 11304-011).  The following primers were added together to each PCR 

tube:  neomycin forward primer (5' CTT, GAC, GAG, TTC, TTC, TGA, GGG, 

GA 3'), Itk exon 2 forward primer (5' GGC, TCC, ATT, GAA, CTC, TCC, AG 3') 

and Itk intron 4 reverse primer (5' GGG, ATG, CCA, GAA, TCA, ACT, TTG, 

GTA, G 3').  PCR was performed using an Eppendorf Mastercycler thermal 

cycler that was programmed to repeat 40 cycles of template denaturation for 1 

min. at 93°C and primer annealing for 1 min. at 58°C followed by strand 

extension for 8 min. at 65°C.  5 µL of PCR product was added to each well of 

a 0.8% agarose gel and bands were resolved by gel electrophoresis.  A single 

1.9 kb band was predicted to result following PCR amplification of template 

DNA purified from a homozygous Itk-/- mouse as compared to a single 7.5 kb 

band from a WT (C57BL/6) mouse and a dual 1.9 kb and 7.5 kb band from a 

heterozygous Itk+/- mouse, respectively.
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2.3. Confirmation of Itk-/- Mice by Immunoblotting

! The lack of Itk expression by Itk-/- mice was confirmed by 

immunoblotting of lysates prepared from spleens of WT (C57BL/6) or Itk-/- 

mice using anti-Itk antibody.  First, spleens were harvested and cell 

suspensions were prepared as described below for cell culture.  Next, 60x106 

splenocytes from each mouse were resuspended in 0.5 mL of ice-cold NP-40 

lysis buffer (20 mM Tris-HCl, 0.4 mM EDTA and 1% NP-40) supplemented 

with 5 µg/mL of leupeptin (Sigma; St. Louis, MO), 5 µg/mL of pepstatin A (MP 

Biomedicals; Solon, OH) and 1 mM of PMSF (Calbiochem / EMD Millipore; 

Billerica, MA).  After lysis for 1 hr. on a tube rotator at 4°C, cellular debris was 

pelleted by centrifugation for 20 min. at 14,000 rpm using a refrigerated 

microcentrifuge.  A 10 µL aliquot of supernatant was then combined with an 

equal volume of 2x laemmli sample buffer (125 mM Tris-HCl, 20% glycerol, 

4% SDS, 0.2 M DTT and 0.02% bromophenol blue) and proteins in lysate 

samples were denatured by placing tubes in boiling water for 5 min. followed 

by centrifugation for 30 sec. at maximum speed.  Next, 20 µL of lysate sample 

was added to each well of a 7.5% acrylamide gel (Sigma) and proteins were 

resolved by SDS-PAGE followed by transfer to a PVDF membrane (Pall Life 

Sciences, Cat. # 66543; Port Washington, NY).  After blocking for 1 hr. with 

5% BSA, faction V (Calbiochem / EMD Millipore, Cat. # 2930) in TBST (10 

mM Tris, 150 mM NaCl and 0.1% Tween 20, pH 7.4), the membrane was 

probed with anti-Itk antibody (clone 2F12; Upstate / EMD Millipore, Cat. # 
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05-476; Waltham, MA) diluted 1:1,000 in 2.5% BSA / TBST for 1 hr. followed 

by incubation with 0.2 µg/mL of HRP-conjugated goat anti-mouse antibody 

(Jackson ImmunoResearch, Cat. # 115-035-146; West Grove, PA) for 30 min. 

while washing 3x with TBST between each step.  Lastly, enhanced 

chemiluminescent substrate (ECL; Pierce / Thermo Fisher Scientific, Inc., Cat. 

# 34077; Rockford, IL) was added and bands representing Itk were visualized 

and confirmed by size in reference to the protein standard (Bio-Rad, Cat. # 

161-0374; Hercules, CA).
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2.4. Cell Culture

! Jurkat clone E6.1 was obtained from the American Type Culture 

Collection (ATCC; Manassas, VA) and cells were maintained in RPMI-1640 

medium supplemented with 10 mM HEPES, 2 mM L-glutamine, 100 I.U./mL 

penicillin, 100 µg/mL streptomycin (Mediatech Cellgro / Corning, Inc.; 

Manassas, VA) plus 10% heat-inactivated fetal bovine serum (FBS) (SAFC 

Biosciences; Lenexa, KS).  Jurkat cells were seeded into vented flasks at an 

initial density of 0.1x106 cells/mL and split prior reaching a density of 106 cells/

mL.  Cell concentration and viability was routinely monitored by removing an 

aliquot of cells from culture, diluting 1:2 in 0.15% erythrosine B and counting 

live / dead cells using a hemacytometer.

! Primary mouse lymphocytes used for in vitro cytokine production were 

obtained from draining lymph nodes (DLN) or spleens.  First, lymphoid tissue 

was mechanically dissociated using the blunt end of a 1 mL syringe plunger 

against a 70 µm nylon cell strainer.  After rinsing each strainer with RPMI, 

cells were collected in a 50 mL tube and centrifuged for 5 min. at 1,500 rpm 

(4°C).  Next, red blood cells (RBCs) were lysed by resuspending cells in ACK 

lysis buffer (0.15 M NH4Cl, 10 mM KHCO3 and 0.1 mM Na2EDTA) and 

incubating for 5-10 min. at room temperature.  Cells were then washed and 

resuspended in RPMI-1640 medium supplemented as described above in 

addition to 0.05 mM 2-mercaptoethanol (2-ME; Sigma) plus 10% heat-

inactivated FBS.  After counting cells using a hemacytometer, cell 
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concentrations were adjusted and 105-106 cells in 0.1 mL were seeded to 

each of 3-5 replicate wells of round-bottom 96-well tissue culture treated 

plates (Sarstedt, Cat. # 83.1837; Nümbrecht, Germany).  Next, cells  were 

stimulated by addition of an equal volume (0.1 mL) of culture medium 

containing 0.1-0.2 mg/mL of OVA for a final concentration of 50-100 µg/mL of 

OVA.  After incubation for 4 days, cell culture supernatants were harvested 

and cytokine secretion was analyzed by ELISA as described below.

! In order to reduce the potential for contamination, all cell culture work 

was performed in a laminar flow biological safety cabinet (Baker Company, 

Inc.; Sanford, ME) using aseptic technique and sterile, pyrogen-free 

instruments / consumable reagents.  After counting cells using a 

hemacytometer, tissue culture vessels were seeded at the appropriate 

densities and placed inside of a humidified, 5% CO2, 37°C incubator.
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2.5. Cell Penetrating Peptides

! RRRRRRRRRQQPPVPPQRPMA (R9-QQP), 

RRRRRRRRRPQMPAPQRPQPV (R9-PQM) and 

RRRRRRRRRQQAAVAAQRAMA (R9-QQA) peptides were custom 

synthesized by GL Biochem, Ltd. (Shanghai, China) using L-enantiomer 

amino acids.  Peptides were amidated at the carboxy (C)-terminus and FITC 

was conjugated at the amino (N)-terminus for uptake studies.  All peptides 

were delivered > 95% pure by reverse-phase high-performance liquid 

chromatography (HPLC) and were analyzed by mass spectroscopy.  

Lyophilized peptide stocks were stored inside desiccators at -20°C.  Prior to 

use, peptides were reconstituted at 20 mg/mL by nominal mass in cell culture 

grade PBS (Mediatech) for in vivo experiments or in cell culture grade water 

(HyClone / Thermo Fisher Scientific, Inc.; South Logan, UT) for in vitro 

experiments.  In order to avoid repeated freeze-thaw cycles, aliquots of 

peptide stock solutions were prepared in microcentrifuge tubes and were 

stored at -20°C for ≤ 4 weeks.
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2.6. Peptide Uptake Studies

! For in vitro uptake studies, Jurkat cells were resuspended in 

supplemented RPMI-1640 without FBS and aliquots of 5x106 cells per mL 

were dispensed to FACS tubes for each peptide treatment condition.  Next, 

FITC-conjugated R9-peptides were added and tubes were placed inside of a 

humidified, 5% CO2, 37°C incubator for 30 min.  Following peptide treatment, 

cells used for uptake studies were washed with ice-cold PBS and 

resuspended in 0.05% trypsin - 0.53 mM EDTA in HBSS (Mediatech, Cat. # 

25-051-CI).  In a separate control experiment, Jurkat cells were treated with 

trypsin and enzyme kinetics were determined by staining cells for surface 

expression of the trypsin-sensitive transferrin receptor (CD71) with anti-CD71 

antibody (clone OKT9, purified from ascites) followed by detection with FITC-

conjugated goat anti-mouse antibody (FITC-GαM; Upstate / EMD Millipore, 

Cat. # 12-506).  After incubation for 10 min. at 37°C, trypsin was quenched by 

addition of FACS buffer (0.5% BSA/PBS + 0.2% NaN3) and cells were washed 

for an additional 3 times while being kept on ice throughout.  Next, cells were 

fixed with 2% paraformaldehyde (Fisher Scientific; Waltham, MA) / PBS for 10 

min. on ice, washed, and resuspended in 300 µL of FACS buffer prior to 

acquiring FACS data for FSC, SSC and FITC channels.  Jurkat cells were 

gated based on FSC and SSC and the mean FITC fluorescence intensity 

(MFI) was recorded for each peptide treatment condition.
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! For investigation of systemic uptake in mice, 1 mg of FITC-conjugated 

R9-QQP was delivered i.p. at -24 and/or -0.5 hrs. prior to harvesting spleens 

and processing splenocytes as described above.  In addition, mice were 

sensitized with OVA/alum on day 0 and local uptake at the lung mucosa was 

investigated by i.n. delivery of 200 µg of FITC-conjugated R9-QQP 2 hrs. prior 

to each challenge with OVA on days 7-9 as described below for induction of 

allergic asthma.  On day 10, bronchoalveolar lavage was performed and BAL 

cells were processed as described below.  Next, mouse cells were treated 

with trypsin and washed as described above for Jurkat uptake studies.

! For identification of CD4+ T cells,  ~106 primary cells (100 µL) in FACS 

buffer were transferred to labeled FACS tubes and 1 µg of Fc blocking 

antibody (BD Biosciences, Cat. # 553141; San Jose, CA) was added to each 

tube followed 5 min. later by the addition of 1 µg each of Pacific Blue-

conjugated anti-mouse CD4 (clone MR4-5; BioLegend; San Diego, CA) and 

APC-conjugated anti-TCRβ (clone H57-597; BioLegend) antibodies.  After a 

45 min. incubation on ice, cells were fixed with 2% paraformaldehyde in PBS 

and resuspended in 300 µL of FACS buffer prior to acquiring FACS data for 

FSC, SSC, APC, PB and FITC channels.  FACS analysis was performed by 

gating lymphocytes based on FSC and SSC followed by gating TCR+ cells as 

defined by APC fluorescence.  Next, TCR+ lymphocytes were further 

characterized by CD4 expression as defined by Pacific Blue fluorescence 

versus FITC fluorescence representing internalized peptide.  Peptide uptake 

72



was quantified by determining the MFI of gated CD4+ T cell in addition to 

determining the percentage of CD4+ FITC+ T cells based on the background 

FITC fluorescence of mice treated with vehicle.
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2.7. In Vitro Peptide Treatment and Restimulation of Splenocytes with 
OVA

! C57BL/6 or BALB/c mice were sensitized i.p. with 20 µg OVA, grade V 

(Sigma, Cat. # A-5503) / 2 mg alum (Pierce / Thermo Scientific, Inc., Cat. # 

77161) and mice were sacrificed 7 days later.  Spleens from each mouse 

were then harvested and dissociated into separate cell suspensions as 

described above.  After RBC lysis, splenocytes were resuspended at 10x106 

cells/mL in supplemented RPMI without FBS.  Next, splenocytes were 

dispensed to labeled FACS tubes, peptides were added at the indicated µM 

concentrations and tubes were placed inside of a humidified, 5% CO2, 37°C 

incubator for 30 min.

! For analysis of cytokine secretion by ELISA, 106 splenocytes in 0.1 mL 

were added to round-bottom 96-well plates and cultured as described above.  

For quantification of the number of cytokine producing cells, splenocytes were 

added in a similar manner to 96-well filter plates that were previously coated 

with anti-cytokine specific capture antibody and blocked as described below 

for the ELISpot assay.  After seeding plates, peptide-treated splenocytes were 

stimulated by addition of an equal volume (0.1 mL) of supplemented RPMI 

containing 0.1-0.2 mg/mL OVA and 20% FBS for a final concentration of 

50-100 µg/mL OVA and 10% FBS.  After incubation for 4 days, cell culture 

supernatants were harvested and analyzed by ELISA or filter plates were 

developed as described below for the ELISpot assay.
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2.8. In Vivo Peptide Treatment and Induction of Allergic Asthma in 
Response to OVA

! For characterization of the Itk KO asthma phenotype, mice were 

sensitized and challenged similar to the protocol described by Mueller and 

August (11).  First, mice were sensitized with 20 µg OVA, grade V / 2 mg alum 

delivered i.p. in 150 µL on days 0 and 5.  On days 12-15, mice were 

anesthetized in the presence of 4.5% isoflurane mixed with oxygen (Airgas 

West; Long Beach, CA) at a flow rate of 1 L/min. and challenged daily with 

various amounts of OVA in 20 µL of PBS delivered intranasally (i.n.).

! For peptide studies, C57BL/6 mice were injected i.p. with 25 mg/kg 

(~0.5 mg) of R9-QQP or R9-QQA (control) peptide at -24 and -0.5 hr. prior to 

sensitization with 20 µg of OVA / 2 mg alum delivered i.p. as described above 

on day 0.  Next, peptide was again delivered i.p. 24 hours prior to the first 

challenge with OVA on day 7.  In addition, mice were treated with peptide i.p. 

as before and 200 µg of peptide was delivered intranasally (i.n.) to 

anesthetized mice 2 hours prior to each challenge with 10 µg of OVA in 20 µL 

of PBS delivered i.n. on days 7-9 for a total exposure of 30 µg of OVA.  Total 

peptide delivery was ~3.0 mg i.p. and ~0.6 mg i.n. for a total in vivo exposure 

of ~3.6 mg per mouse.

! For each asthma experiment, groups of 2-4 mice were sensitized on 

the same date using commonly prepared OVA/alum and challenged using a 

common OVA/PBS solution except for OVA titration studies.  Similarly, a 
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common peptide stock solution was prepared prior to each experiment and 

aliquots were used throughout the experiment for in vivo delivery to each 

mouse belonging to the same group.  In addition, each experiment 

investigating the effect of peptides delivered in vivo also included a positive 

control group that received vehicle for comparison.
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2.9. Airway Hyperresponsiveness (AHR)

! Asthma was induced as described above and invasive airway 

hyperresponsiveness (AHR) was measured 24 hours after the final challenge 

with OVA using the FlexiVent small rodent ventilator system (Scireq, Inc.; 

Montreal, QC, Canada).  Calibration of the FlexiVent system was performed 

prior to acquiring data for each subject according to the manufacturer's 

instructions.

! First, mice were anesthetized by i.p. injection of a cocktail containing 

80 mg/kg of ketamine (~2 mg; Fort Dodge Animal Health; Overland Park, KS) 

and 8 mg/kg of xylazine (~0.2 mg; Lloyd, Inc.; Shenandoah, IA).  Next, 

tracheotomy was performed on anesthetized mice and an 18 gauge cannula 

(BD Medical, Cat. # 408208; Franklin Lakes, NJ) was inserted into the trachea 

and secured using surgical suture as described above.  Then, the 

endotracheal cannula was connected via the adaptor end to the FlexiVent 

system and ventilation was initiated.  Once mice were passively breathing, 

airway resistance was measured in response to increasing doses of 

aerosolized methacholine (0, 3, 6, 12 and 24 mg/mL; Sigma, Cat. # A2251) 

that were delivered to the lungs through the endotracheal cannula.  The 

maximal airway resistance values for each dose of methacholine were 

recorded for each mouse and averaged (+/- SEM) for all mice belonging to the 

same treatment group.
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2.10. Lung Histological Analysis

! Following asthma induction and collection of BALF as described above, 

a single lung lobe from each mouse was extracted, rinsed with PBS and 

stored in a vial containing 10% zinc formalin (Protocol / Fisher HealthCare, 

Cat. # 313-095; Houston, TX).  Preserved lung tissue was submitted to Pacific 

Pathology (San Diego, CA) for further processing.  First, tissue was 

embedded in paraffin, cut into 5 µm sections around the middle of the 

specimen and at least four sections were mounted onto each microscopy 

slide.  Next, separate slides from each specimen were stained as described 

below for detection of mucus-producing goblet cells or inflammatory cells.  All 

slides were coded with randomly assigned numbers prior to visualization by 

light microscopy using a 40x objective.

! Mucus was detected by staining slides with periodic acid schiff (PAS) 

reagent for 5 min. and rinsing with cold water followed by counter-staining with 

hematoxylin.  Goblet cell hyperplasia and mucus production were evaluated 

by assigning a mucus severity score according to the percentage of each 

bronchiole cross section staining fuchsia as follows:  a value of 0 indicates no 

detectable mucus, a value of 1 indicates ≤ 10% staining positive for mucus, a 

value of 2 indicates > 10% and ≤ 25% staining positive, a value of 3 indicates 

> 25% and ≤ 50% staining positive, a value of 4 indicates > 50% and ≤ 75% 

staining positive and a value of 5 indicates > 75% and ≤ 100% staining 

positive.

78



! Recruitment of inflammatory cells to the lungs was visualized by 

staining slides with hematoxylin and eosin (H&E).  The degree of inflammation 

was evaluated by assigning a score according to the depth of infiltrating cells 

surrounding each blood vessel or bronchiole as follows:  a value of 0 indicates 

no infiltrating cells, a value of 1 indicates a single layer of cells, a value of 2 

indicates a layer of 2-4 cells, a value of 3 indicates a layer of 5-7 cells and a 

value of 4 indicates a layer of ≥ 7 cells.
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2.11. IgE Assay

! Prior to performing bronchoalveolar lavage, mice were anesthetized 

using isoflurane and 0.3-0.5 mL of retroorbital blood was collected in separate 

microcentrifuge tubes for each mouse.  After allowing blood to clot for ≥ 2 hrs. 

at room temperature, tubes were centrifuged for 15 min. at 3,000 rpm (4°).  

Sera were then transferred to a new set of tubes and stored at -20°C prior to 

analysis.  Total serum IgE was detected by the sandwich ELISA method 

described below.  Antibodies used for the IgE-specific ELISA were purchased 

from Southern Biotech (Birmingham, AL).  First, 5 µg/mL of goat anti-mouse 

IgE (Cat. # 1110-01) in PBS and was added to individual wells of 96-well 

ELISA plates.  After overnight incubation at 4°C, plates were blocked and 

either serum samples or dilutions of purified mouse IgE standard (clone 15.3; 

Cat. # 0114-01) ranging from 200 to 3.1 ng/mL were added in duplicate to 

designated wells while washing plates between each step.  Next, 0.1 µg/mL of 

biotin-conjugated anti-mouse IgE (clone 23G3; Cat. # 1130-08) followed by 1x 

streptavidin-HRP diluted in 0.1 µg/mL BSA/PBS were serially added to wells 

and plates were processed from addition of substrate to measurement of 

absorbance as described below.
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2.12. Bronchoalveolar Lavage and Lung Tissue Dissociation

! 24 hours after the final challenge with OVA, mice were sacrificed and 

dissected to reveal the chest cavity and trachea.  Tracheotomy was performed 

by creating a small incision in the trachea at the location of the cartilage ring.  

Next, an endotracheal cannula consisting of polyethylene tubing connected to 

the end of an 18 gauge needle was inserted via the tubing into the trachea to 

a depth of 1 cm posterior to the incision.  After securing the tubing using 

surgical suture, 1 mL of ice-cold PBS was slowly dispensed to the lungs using 

a syringe attached to the adaptor end of the 18 gauge needle.  Next, 

bronchoalveolar lavage fluid (BALF) was aspirated and dispensed to a labeled 

FACS tube and kept on ice throughout.  After repeating for a total of 5 times 

for each mouse, BALF was centrifuged for 5 min. at 1,500 rpm (4°C).  RBCs 

were then lysed by resuspending the pellet in ACK lysis buffer and incubating 

for 5 min. at room temperature.  Next, BALF cells were washed, resuspended 

in 300 µL of FACS buffer and counted using a hemacytometer to determine 

total cell number.

! Following bronchoalveolar lavage, individual lung lobes were excised, 

rinsed in a petri dish filled with PBS and minced using forceps into 1-2 mm 

pieces.  Next, tissue was transferred to a FACS tube containing 1 mL of 

culture medium supplemented with 3 mg/mL of collagenase (Worthington 

Biochemical Corp., Cat. # LS004186; Lakewood, NJ) and 100 µg/mL of 

DNAse I (Sigma, Cat. # DN25).  After enzymatic digestion for 1 hr. at 37°C, 
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tissue was transferred onto 70 µm cell stainers and mechanically dissociated 

followed by rinsing with FACS buffer and recovery of cells.  Next, lung cells 

were centrifuged for 5 min. at 1,500 rpm (4°C), resuspended in 4 mL of FACS 

buffer and counted using a hemacytometer.
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2.13. Cytospin Preparation and Staining for Quantification of 
Inflammatory Cells by FACS

! For preparation of cytospin slides, ~105 BAL cells in 400 µL of FACS 

buffer were added to cytology funnel / filter card / slide assemblies 

(Biomedical Polymers, Inc., Cat. # BMP-CYTO-S50; Gardner, MA) and were 

attached to glass slides after centrifugation for 5 min. at 600 rpm using a 

Shandon Cytospin 2 centrifuge (Thermo Scientific, Inc.; Waltham, MA).  Next, 

slides were stained using a modified Wright-Giemsa dye according to the 

manufacturer's instructions (Protocol / Fisher HealthCare, Cat., # 122-911) 

and coverslips were adhered following application of 10 µL of Permount 

mounting medium (Fisher Scientific, Cat. # SP15-100).  Alevolar macrophages 

were identified by light microscopy as large cells with atopic nuclei and 

cytoplasm staining purple while eosinophils were identified as small cells with 

bilobed nuclei and cytoplasmic granules staining pink.

! Quantification of inflammatory cells by FACS was performed using ~105 

BAL cells or ~106 lung cells in 100 µL of FACS buffer obtained as described 

above.  Staining was performed in FACS tubes using 0.5 µg of all antibodies 

which were purchased from BD Biosciences.  5 min. prior to the addition of 

fluorophore-conjugated antibodies, Fc receptors expressed on cells were 

blocked by the addition of rat anti-mouse CD16/CD32 (BD Biosciences, Cat. # 

553141).
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! Staining for eosinophils and macrophages was performed according to 

the method described by Stevens and Braciale (133).  First, a cocktail 

containing 0.5 µg each of PE-conjugated rat anti-Siglec-F (BD Biosciences, 

Cat. # 552126), PerCP-Cy5.5 rat anti-CD45 (BD Biosciences, Cat. # 550994) 

and FITC-conjugated hamster anti-mouse Cd11c (BD Biosciences, Cat. # 

557400) was directly added to tubes containing BALF or lung cells.  After 

incubation for 45 min. at 4°C, cells were washed with FACS buffer and fixed 

for 10 min. with 2% paraformaldehyde on ice.  Next, cells were washed again 

and resuspended in 300 µL of FACS buffer prior to acquisition of FACS data 

for FSC, SSC, PE, PerCP-Cy5.5 and FITC channels.  A minimum of 10,000 or 

20,000 events were collected for BAL or lung cell samples, respectively.  

FACS analysis was performed by first generating a histogram displaying 

PerCP-Cy5.5 fluorescence and gating total leukocytes as defined by CD45 

expression.  Next, CD45+ events were further analyzed by generating a two-

color plot displaying PE fluorescence on the y-axis versus FITC fluorescence 

on the x-axis.  Eosinophils and macrophages were both positively defined by 

expression of Siglec-F and were differentially gated based on low versus high 

expression of Cd11c, respectively.  Eosinophil and macrophage percentages 

of CD45+ cells were recorded for each sample.

! For quantification of T cells, a cocktail containing 0.5 µg each of 

PerCP-Cy5.5 rat anti-CD45 and PE-Cy7 hamster anti-CD3ε antibodies (BD 

Biosciences, Cat. # 552774) was added to a separate aliquot of BAL cells.  
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After incubation on ice, stained cells were fixed and resuspended in 300 µL of 

FACS buffer while washing between each step as described above.  Next, a 

minimum of 20,000 events were acquired for FSC, SSC, PerCP-Cy5.5 and 

PE-Cy7 channels.  FACS analysis was then performed by gating CD45+ 

leukocytes as described above followed by further defining lymphocytes 

based on FSC versus SSC.  Lastly, CD45+ lymphocytes were further 

analyzed by generating a plot displaying FSC on the y-axis versus PE-Cy7 

fluorescence on the x-axis and gating TCR+ lymphocytes based on the 

background PE-Cy7 fluorescence of BAL cells from negative control mice.  T 

cell percentages of CD45+ cells (grandparent population) were recorded for 

each sample.
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2.14. Flow Cytometry

! Cells used for flow cytometry were stained with fluorophore-conjugated 

antibodies, fixed with 2% paraformaldehyde / PBS and resuspended in FACS 

buffer inside 5 mL round-bottom FACS tubes (BD Biosciences, Cat. # 352054) 

while being protected from light and on ice throughout.  FACS data was 

acquired within 72 hours after fixing cells and 10,000 - 50,000 events were 

acquired for each sample.  Prior to acquiring FACS data, voltages for all 

channels were calibrated using CST beads (BD Biosciences) and 

compensation was performed based on single-color control samples to correct 

for spectral overlap among fluorophores as needed.  FACS analysis and 

graphs created for figures were created using FlowJo software (Tree Star, 

Inc., Ashland, OR).  Tick marks displayed on FACS plots represent a linear 

scale for FSC and SSC channels and a logarithmic scale for fluorescence 

channels.

! Acquisition of FACS data for peptide uptake studies using mouse 

primary cells was performed using a BD FACSAria flow cytometer.  Each 

fluorophore was excited using a different laser as follows:  Pacific Blue (PB) 

was excited using a 405 nm laser and was detected using a 450/40 emission 

filter; FITC was excited using a 488 nm laser and was detected using a 

530/30 nm emission filter; and, APC was excited using a 633 nm laser and 

detected using a 660/20 emission filter.  For peptide uptake studies using 
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Jurkat cells, FACS data was acquired using the 488 nm excitation laser in 

combination with the 530/30 nm emission filter.

! Acquisition of FACS data for quantification of inflammatory cells from 

BALF and lung cell samples was performed using a BD FACSCanto flow 

cytometer using the 488 nm laser.  Samples stained for quantification of 

eosinophils and macrophages were excited using the 488 nm laser with 

detection of PE using the 585/42 nm filter, of PerCP-Cy5.5 using the 670 nm 

LP filter and of FITC using the 530/30 nm filter.  Independent samples were 

stained for quantification of T cells and were excited using the 488 nm laser 

with detection of PerCP-Cy5.5 using the 670 nm LP filter and of PE-Cy7 using 

the 780/60 nm filter.
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2.15. DLN Cell Restimulation with OVA

! For identification of DLN, the chest cavity was expanded by pinning the 

left and right sides of the rib cage to the dissection board.  Assisted by a 

dissection microscope and light source, individual DLN were excised using 

fine point forceps and transferred to a 15 mL tube containing culture medium 

on ice.  In order to increase cell yield, DLN from groups of 2-3 mice were 

pooled prior to dissociation into a cell suspension.  Next, RBCs were lysed, 

cells were counted and 105 or 106 cells in 0.1 mL were seeded to round-

bottom 96-well tissue culture treated plates.  Next, cells  were stimulated by 

addition of an equal volume (0.1 mL) of culture medium containing 0.1 mg/mL 

OVA for a final concentration of 50 µg/mL of OVA.  After incubation for 4 days, 

cell culture supernatants were harvested and cytokine secretion was analyzed 

by ELISA as described below.
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2.16. ELISA

! Cytokines were quantitated from cell-free samples by sandwich ELISA 

for IL-4, IL-5, IL-13 and IFN-γ.  The detection limit was 4 pg/mL for IL-4, IL-5 

and IL-13 and 31.3 pg/mL for IFN-γ.  Anti-mouse IL-4 capture antibody (clone 

11B11), recombinant standard and biotin-conjugated detection antibody (clone 

BVD6-24G2) were purchased from eBioscience, Inc. (San Diego, CA).  Anti-

mouse IL-5 capture antibody (clone TRFK5), recombinant standard and biotin-

conjugated detection antibody (clone TRFK4) were purchased from 

eBioscience, Inc.  Anti-mouse IL-13 capture antibody (clone eBio13A), 

recombinant standard and biotin-conjugated detection antibody (clone 

eBio1316H) were purchased from eBioscience, Inc.  Anti-mouse IFN-γ 

capture antibody (clone R4-6A2) and biotin-conjugated detection antibody 

(clone XMG1.2) were purchased from BD Biosciences and recombinant 

standard was purchased from eBioscience, Inc.

! Capture antibodies were diluted in coating buffer (0.1 M sodium 

carbonate, pH 9.5) at 2 µg/mL for IL-4, IL-5 and IL-13 or at 4 µg/mL for IFN- γ 

and were added to individual wells of designated 96-well ELISA plates (BD 

Biosciences, Cat. # 353279).  After overnight incubation at 4°C, plates were 

washed (0.05% Tween-20 / PBS), blocked for 1.5 hrs. with 1% BSA (Fisher 

Scientific, Inc., Cat. # BP1600-100) in PBS and washed again prior to addition 

of 50 µL volume per well in duplicate of samples or recombinant standards 

diluted in 0.1% BSA/PBS.  After incubation with samples for 1.5 hrs., plates 
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were washed between each step and serially incubated with biotin-conjugated 

detection antibodies at 2 µg/mL and with 1x streptavidin-HRP (BD 

Biosciences, Cat. # 51-9002812) both diluted in 0.1% BSA/PBS for 1.5 hrs. 

and 45 mins., respectively.  Next, 1x TMB substrate (eBioscience, Inc., Cat. # 

00-4201-56) was added to each well followed directly by  addition of stop 

solution (1 M H3PO4) within 30 min.  Finally, absorbance was measured at 450 

nm with subtraction at 650 nm using a filter-based Emax Endpoint ELISA 

Microplate Reader (Molecular Devices, Sunnyvale, CA).  Based on cytokine-

specific standard curves generated independently for each plate, absorbance 

values for each sample were reported as cytokine concentrations in pg/mL or 

ng/mL as determined using SoftMax Pro software (Molecular Devices).
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2.17. ELISpot Assay

! For quantification of the number of cytokine producing cells, anti-mouse 

IL-4 capture antibody (eBioscience, Inc., clone 11B11) was diluted to 4 µg/mL 

in PBS and added to 96-well filter plates (EMD Millipore, Cat. # MSIPS4510; 

Billerica, MA).  After overnight incubation at 4°C, plates were washed (0.05% 

Tween-20 / PBS) and blocked with 1% BSA/PBS + 0.05% Tween-20 for 2 hrs. 

at 37°C.  Next, plates were seeded and peptide-treated splenocytes were 

restimulated with OVA as described above.  After incubation for 4 days, filter 

plates were washed between each step and serially incubated with biotin-

conjugated anti-IL-4 (clone BVD6-24G2) detection antibody at 0.5 µg/mL and 

with 1x streptavidin-HRP (BD Biosciences) both diluted in 1% BSA/PBS + 

0.05% Tween-20 for 2 hrs. and 45 min., respectively.  Next, AEC (3-amino-9-

ethyl-carbazole; Sigma, Cat. # A6926-50TAB) substrate solution was added to 

each well and plates were washed with tap water within 30 min.  Plates were 

then allowed to dry completely and individual spots representing cytokine-

producing cells were quantitated using an automated Zeiss ELISpot reader 

and KS ELISpot software (Carl Zeiss AG; Oberkochen, Germany).
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2.18. Statistical Analysis

! Graphs were created using Prism software (GraphPad Software; La 

Jolla, CA) and display the average and SEM of cumulative data that were 

obtained from individual mice or groups of mice as stated in the figure 

legends.  Statistical significance for OVA-dependent cytokine production 

following in vitro peptide treatment of splenocytes was calculated using a 

paired student's t test comparing cytokine amounts from peptide treated 

culture supernatants to untreated, positive control (PC) samples that were 

obtained from the same mouse.  An unpaired student's t test was used for all 

other statistical comparisons and each peptide treatment group was 

compared to vehicle for calculation of statistical significance.  For all p values 

reported, * = p < 0.05, ** = p < 0.01, *** = p < 0.001 and **** = p < 0.0001.

! Chapter 2, in part, is currently being prepared for submission for 

publication of the material.  Guimond, D.M., Cam, N.R., Hirve, N., Duan, W., 

Lambris, J.D., Croft, M., & Tsoukas, C.D (2012).  Treatment of Experimental 

Asthma Using a Novel Peptide Inhibitor of the Inducible T Cell Kinase.  The 

dissertation author was the primary author of this material.
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3. RESULTS

3.1. R9-QQP and control peptides delivered in vitro efficiently enter 
Jurkat T cells

! In order to determine the ability of R9-QQP to enter cells, FITC was 

covalently tagged at the N-terminus and FITC fluorescence was measured as 

a reporter of cellular uptake following treatment of Jurkat T cells with FITC-R9-

QQP in vitro.  For assessment of specificity, the SLP-76 polyproline ligand 

represented by the R9-QQP peptide sequence was scrambled to generate the 

control peptide named R9-PQM.  As an additional control for specificity used 

in this study, each proline in the sequence of the R9-QQP peptide was 

substituted with an alanine to generate the peptide named R9-QQA.  For 

evaluation of peptide uptake, aliquots of Jurkat cells were incubated with 1 

µM, 5 µM and 10 µM of FITC-R9 peptides for 30 min. and cells were washed 

with ice-cold PBS to remove free peptide immediately following the incubation 

period as described in Materials and Methods.  In order to enhance detection 

of internalized peptide, peptide-treated cells were then incubated with trypsin 

prior to acquisition of FITC fluorescence by FACS.

! In a separate control experiment, the efficacy and kinetics of the trypsin 

treatment protocol were first established by incubating aliquots of Jurkat cells 

with trypsin for various time intervals followed by staining for endogenous 

expression of the trypsin-sensitive transferrin receptor (CD71).  After 
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treatment with trypsin, Jurkat cells were stained with anti-CD71 (clone OTK9) 

antibody followed by secondary detection using FITC-conjugated goat anti-

mouse antibody.  Next, stained cells were fixed with paraformaldehyde and 

FITC fluorescence was measured by FACS.  As displayed in Figure 7A, mean 

FITC fluorescence for each sample was inversely correlated with trypsin 

incubation time suggesting that trypsin was effective in enzymatically 

digesting the transferrin receptor that was accessible at the cell surface.  

Specifically, incubation with trypsin for 10 min. resulted in a 80.4% reduction in 

the ability to detect surface expression of CD71 (i.e., from 20,915 relative 

fluorescence units for untreated cells as compared to 4,092 units) and this 

incubation time was used for subsequent peptide uptake studies.

! In continuation, peptide-treated cells were incubated with trypsin for 10 

min. as established above to enhance detection of internalized rather than 

membrane-associated peptide.  Next, trypsin was quenched by addition of 

medium containing 10% FBS and cells were again washed for three additional 

times with ice-cold PBS.  Lastly, cells were fixed with paraformaldehyde and 

FITC fluorescence was acquired by FACS.  As displayed in overlaid 

histograms (Figure 7B) and in bar graphs (Figure 7C), incubation of Jurkat 

cells with increasing concentrations of FITC-R9 peptides correlated with 

increasing FITC fluorescence indicating that all peptides efficiently enter cells.  

Furthermore, comparison of fluorescence of cells treated with different 

peptides at the same nominal concentration suggests that the R9-PQM and 
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R9-QQA control peptides are no less efficiently taken up by cells as compared 

to the R9-QQP inhibitor peptide.
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Figure 7:  FITC-conjugated R9-peptides are efficiently taken up by Jurkat T 
cells.
! A) Schematic diagram of in vitro peptide treatment protocol.  B) In order 
to determine the effectiveness and kinetics of trypsin used for peptide uptake 
studies, Jurkat cells were treated with 0.05% trypsin for various amounts of 
time as described in Materials and Methods.  Next, trypsin-treated Jurkat cells 
were stained with anti-CD71 (OKT9) antibody followed by FITC-conjugated 
goat anti-mouse (GαM) secondary antibody and surface expression of the 
trypsin-sensitive transferrin receptor was evaluated by FACS.  C) Jurkat cells 
were treated with various µM concentrations of FITC-conjugated R9-peptides 
for 30 min. followed by treatment with trypsin for 10 min.  Overlaid histograms 
display FITC fluorescence of Jurkat cells after incubation with various 
concentrations of each peptide.  D) Bar graph compares mean FITC 
fluorescence intensity (MFI) of FACS data in panel B.
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3.2. R9-QQP added to splenocytes in vitro inhibits OVA-dependent 
cytokine secretion in a dose-dependent and peptide-specific 
manner

! In order to assess the ability of the R9-QQP peptide to inhibit OVA-

dependent Th2 cytokine secretion in vitro, mice were sensitized with OVA/

alum on day 0 and spleens were harvested and processed into splenocyte 

suspensions after 7 days as described in Materials and Methods.  As 

illustrated in Figure 8A, separate aliquots of splenocytes were then treated 

with peptides in vitro and 106 cells were subsequently added to designated 

wells of round-bottom 96-well plates.  Next, splenocytes were restimulated by 

the addition of OVA in culture medium and 96-well plates were incubated for 4 

days to allow production and secretion of cytokines into the culture medium.  

As displayed in Figures 8 and 9, cytokine secretion from independent cultures 

representing different peptide treatments was measured by testing tissue 

culture supernatant samples for the concentration of IL-4, IL-5, IL-13 and IFN-

γ by ELISA which was performed as described in Materials and Methods.

! As shown in panels B, D and E of Figure 8, treatment of splenocytes in 

vitro with R9-QQP ranging from 5-100 µM resulted in a dose-dependent 

reduction of the Th2 cytokines IL-4, IL-5 and IL-13 upon restimulation with 

OVA.  Specifically, IL-4 was reduced from 34.2 pg/mL to 13.0 pg/mL over this 

range of R9-QQP concentrations representing a 62% decrease in cytokine 

secretion.  Similarly, the level of IL-5 was reduced from 594.3 pg/mL to 318.2 
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pg/mL and IL-13 was reduced from 2,704 pg/mL to 938.6 pg/mL representing 

46.5% and 65.3% decreases in Th2 cytokine secretion, respectively.

! In addition to analyzing cytokine secretion, the effect of R9-QQP on 

cytokine production was assessed using the ELISpot assay which was 

performed as described in Materials and Methods.  Sensitization of mice with 

OVA/alum, processing of spleens into splenocytes and in vitro peptide 

treatment were performed identically to the experiments described for 

analyzing cytokine secretion above.  For the ELISpot assay, 106 splenocytes 

per well were seeded onto filter plates that were pre-coated with anti-IL-4 

capture antibody.  After incubation for 4 days, filter plates were developed and 

spots on the bottom of each well representing individual cytokine producing 

cells were counted and averaged for replicate wells.  As displayed in Figure 

8C, treatment of splenocytes in vitro with concentrations of R9-QQP ranging 

from 5-50 µM did not affect the number of cytokine producing cells which 

varied from 59.5 - 81 spots/well upon restimulation with OVA versus 21.5 

spots/well for non-stimulation control as determined by the ELISpot method.  

In contrast, treatment of splenocytes with R9-QQP across this same range of 

concentrations resulted in a dose-dependent decrease in cytokine secretion 

as measured by ELISA (Fig. 8B).

! Furthermore, inhibition by R9-QQP was specific for the peptide cargo 

sequence as determined by treatment of splenocytes at the effective 

concentration of 20 µM with R9-PQM or R9-QQA control peptides followed by 
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analysis of cytokine secretion by ELISA.  In order to determine statistical 

significance, a paired comparison was performed between splenocytes 

treated with 20 µM of R9-QQP or R9-PQM / R9-QQA peptides to splenocytes 

derived from the same mouse that were treated with vehicle and restimulated 

with OVA.  For these experiments, independent replicates for statistical 

analysis were generated from splenocytes cultures that were obtained from 

5-6 separate mice.  Overall, these experiments revealed that treatment with 

R9-QQP at 20 µM significantly and specifically inhibited Th2 cytokines while 

the signature Th1 cytokine IFN-γ was elevated independently of restimulation 

with OVA and was not affected by treatment with either peptide.  Specifically, 

treatment of splenocytes with 20 µM of R9-QQP significantly inhibited IL-4 

secretion from an average concentration of 145.9 pg/mL for treatment with 

vehicle to 95.4 pg/mL representing a decrease of 34.6% (p < 0.01) while 

treatment with 20 µM of R9-PQM control peptide resulted in an average IL-4 

concentration of 152.7 pg/mL (Fig. 9A).  Similarly, treatment with 20 µM of R9-

QQP significantly inhibited IL-5 secretion from 700.5 pg/mL to 486.7 pg/mL 

representing a 30.5% decrease (p < 0.05) while treatment with 20 µM of R9-

QQA resulted in an average IL-5 concentration of 742.1 pg/mL (Fig. 9B).  In 

addition, treatment with 20 µM of R9-QQP significantly inhibited IL-13 

secretion from 5,670 pg/mL to 3,616 pg/mL representing a 36.2% decrease 

while treatment with 20 µM of R9-QQA resulted in an average IL-13 

concentration of 5,672 pg/mL (Fig. 9C).  Lastly, IFN-γ secretion was not 
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affected by either restimulation with OVA or by treatment with either R9-QQP 

inhibitor or R9-PQM control peptide and ranged from 3,661 - 4,559 pg/mL 

(Fig. 9D).
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Figure 8:  R9-QQP added in vitro inhibits OVA-dependent Th2 cytokine 
production by splenocytes in a dose-dependent manner.
! As described in Materials and Methods, BL/6 mice were sensitized i.p. 
with OVA/alum and spleens were harvested after 7 days.  Splenocytes were 
then treated with 5-100 µM of R9-QQP and dispensed to designated wells of 
96-well plates.  Next, OVA in culture medium was added to designated wells 
for restimulation at a final concentration of 50 µg/mL.  After 4 days of culture in 
vitro, supernatants were harvested and tested for cytokines by ELISA or filter 
plates were processed to detect cytokine producing cells by ELISpot as 
described in Materials and Methods.  B, D & E) Bar graphs display pg/mL of 
IL-4, IL-5 and IL-13 measured from culture supernatants by ELISA.  C) Bar 
graph displays number of IL-4 producing cells as determined by ELISpot.  B-
E) Bar graphs display average values and standard deviation from replicate 
wells.
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Figure 9:  R9-QQP added in vitro specifically inhibits OVA-dependent Th2 
cytokine production by splenocytes.
! Similar to the experiment described in figure 1, BALB/c mice were 
sensitized i.p. with OVA/alum and spleens were harvested after 7 days.  
Splenocytes were then treated with 20 µM of R9-QQP or R9-PQM / R9-QQA 
(control peptides) and dispensed to designated wells of 96-well plates.  Next, 
OVA in culture medium was added to designated wells for restimulation at  a 
final concentration of 100 µg/mL.  After 4 days of culture in vitro, supernatants 
were harvested and tested for cytokines by ELISA.  A-D) Bar graphs display 
the average and SEM of 5-6 mice analyzed per group for IL-4, IL-5, IL-13 and 
IFN-γ ELISA, respectively.  Statistical significance was calculated using a 
paired student's t test comparing cytokine amounts of peptide-treated to 
untreated (positive control) culture supernatants for each mouse (* = p < .05; 
** = p < 0.01).
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3.3. Itk-/- mice have reduced eosinophilic inflammation as compared to 
WT mice upon challenge with low but not high doses of OVA

! Prior to investigating the effects of the R9-QQP inhibitor peptide, the 

previously reported defective inflammatory responses of Itk-/- mice upon 

challenge in the OVA-induced asthma model were verified by evaluation of 

inflammatory cells collected from bronchoalveolar lavage fluid (BALF) (11, 76).  

First, WT and Itk-/- mice were sensitized with 20 µg OVA / 2 mg alum delivered 

intraperitoneally (i.p.) on days 0 and 5.  During the challenge period from days 

12-15, WT and Itk-/- mice were briefly anesthetized using isoflurane and 

challenged with 10 µg of OVA delivered intranasally (i.n.) for a total exposure 

of 40 µg of OVA (Figure 10A).  On day 16, mice were sacrificed and BALF 

was collected and processed for each mouse as described in Materials and 

Methods.  Next, BAL cells were attached to separate cytospin slides and 

stained using a modified Wright-Giemsa dye to qualitatively evaluate the 

presence of inflammatory cells.  In contradiction to previously published 

reports, a large infiltrate of granulocytes characteristic in appearance to 

eosinophils was observed on cytospin slides prepared from both WT and Itk-/- 

mice that were challenged with a total of 40 µg of OVA (Figure 10B).

! In order to confirm the genotype of the Itk-/- mice used in these 

experiments, tail fragments were obtained from both WT and Itk-/- mice and 

genomic DNA was purified as described in Materials and Methods.  Next, 

genomic DNA was amplified by PCR using primers for Itk Exon 2 and Intron 4 
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as well as for the neomycin cassette that was used to replace Exon 3 to 

generate the Itk-/- mice.  Lastly, PCR products were resolved by agarose gel 

electrophoresis prior to the genomic diagnosis of each mouse.  Analysis of gel 

images obtained using this method confirmed the presence of the predicted 

7.5 and 1.9 kb band fragments corresponding to the WT and Itk-/- alleles for 

each mouse strain, respectively (data not shown).  Furthermore, the lack of Itk 

protein expression by Itk-/- mice was confirmed by immunoblotting.  For this 

analysis, spleens were obtained from WT and Itk-/- mice followed by 

processing to generate splenocyte lysate samples.  Next, lysates were 

resolved by SDS-PAGE and transferred to a PVDF membrane followed by 

incubation with anti-Itk (clone 2F12) antibody.  After secondary incubation with 

HRP-conjugated goat anti-mouse antibody, protein expression was detected 

by the addition of enhanced chemiluminescent (ECL) substrate.  As displayed 

in Figure 10C, analysis of gel images revealed a 72 kDa band corresponding 

to the predicted size of Itk from lysate samples prepared from WT but not Itk-/- 

mice.  Thus, the unexpected Itk knockout phenotype observed in the OVA-

induced asthma model could not be attributed to mis-identification of the Itk-/- 

mice used in these studies.

! In pursuit of the previously reported defect, the total amount of OVA 

provided during the challenge period was reduced by a factor of 10.  For these 

experiments, WT and Itk-/- mice were sensitized on days 0 and 5 as described 

above and challenged with 1 µg of OVA delivered intranasally on days 12-15 
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for a total exposure of 4 µg (Figure 10A).  While BALF samples obtained from 

both WT and Itk-/- mice indicated a high degree of inflammation upon 

challenge with 40 µg of OVA, examination of cytospin slides prepared from 

mice challenged with a total exposure of 4 µg of OVA revealed a greatly 

reduced eosinophilic infiltrate obtained from both WT and Itk-/- mice as 

expected.  Furthermore, detailed examination of cytospin slides at 400x 

magnification revealed an almost complete lack of eosinophils obtained from 

Itk-/- mice challenged with 4 µg of OVA as compared to WT mice which 

displayed moderate eosinophilic inflammation (Figure 10B).

! In order to quantify the inflammatory phenotype described above, 

fluorophore-conjugated antibodies were used to stain eosinophils followed by 

FACS analysis performed according to the method described by Stevens and 

Braciale (133).  Briefly, cells obtained from BALF samples were stained using 

an antibody cocktail containing PE-conjugated anti-Siglec-F, PerCP-Cy5.5-

conjugated anti-CD45 and FITC-conjugated anti-Cd11c as described in 

Materials and Methods.  Fluorescence of stained cells was then acquired by 

FACS followed by multi-color analysis to identify eosinophils.  First, total 

leukocytes contained in BALF samples were gated as defined by expression 

of the surface marker CD45.  Next, gated CD45+ cells were further analyzed 

using two-color density plots to display expression of Siglec-F versus Cd11c.  

As identified by a Siglec-F+ Cd11c- expression profile, eosinophils were gated 

and quantified as a percentage of the parent CD45+ population.  Furthermore, 
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alveolar macrophages were quantified based on a Siglec-F+ Cd11c+ 

expression profile that inversely correlates with the percentage of eosinophils 

with respect to the parent CD45+ population.

! As displayed in Figure 11A, the representative density plots generated 

as described above indicate that eosinophils represent ~70% of total 

leukocytes obtained from both WT and Itk-/- mice that are challenged with 40 

µg of OVA.  Consistent with the qualitative evaluation of the cytospin slides, 

eosinophilia was less robust for WT mice challenge with 4 µg of OVA (i.e., 

~30% versus ~70% of total leukocytes) while Itk-/- mice displayed an almost 

complete reduction in eosinophilia at this dose of OVA.  Significantly, the 

cumulative data displayed in Figure 11B reveal that eosinophilic inflammation 

as measured by the percentage of total leukocytes is reduced in BALF 

samples obtained from Itk-/- versus WT mice that are challenged with a total of 

4 µg of OVA (average of 31.7% eosinophilia for WT mice versus 2.2% for Itk-/- 

mice; p < 0.01).  Conversely, the cumulative data displayed in Figure 11C 

reveal that the percentage of alveolar macrophages from Itk-/- mice is 

significantly increased as compared to WT mice (average of 52.4% alveolar 

macrophages for WT mice versus 78.8% for Itk-/- mice; p < 0.05).  Thus, Itk-/- 

mice display defective eosinophilic inflammation from BALF upon challenge 

with low but not high doses of OVA.

! Consistent with the analysis of BALF samples, eosinophilia is also 

reduced in the lung tissue of Itk-/- mice upon challenge with low but not high 
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doses of OVA (Figure 12).  After collecting BALF samples, individual lung 

lobes were extracted from mice and lung tissue was dissociated into a cell 

suspension as described in Materials and Methods.  Next, lung cells were 

stained with fluorophore-conjugated antibodies for quantification of 

eosinophils and macrophages as described above.  Overall, eosinophilia as a 

percentage of total leukocytes was reduced in lung tissue as compared to 

BALF samples.  For example, eosinophils accounted for ~70% of BALF 

leukocytes versus ~15% of lung cell leukocytes obtained from both WT and 

Itk-/- mice that were challenged with 40 µg of OVA (Figures 11B and 12B).  

Despite the smaller detection range in lung tissue, the cumulative data 

displayed in Figure 12B indicate that eosinophilia is significantly reduced in 

Itk-/- versus WT mice that are challenged with 4 µg of OVA (average of 7.6% 

eosinophilia for WT mice versus 3.7% for Itk-/- mice; p < 0.05).  However, no 

differences were detected in terms of macrophage percentages in the lung 

tissue (Figure 12C).

! In order to determine the half maximal effective dose of OVA (EC50), 

WT and Itk-/- mice were challenged with total doses of OVA ranging from 0.4 

µg to 160 µg.  Next, eosinophil percentages obtained from BALF and lung 

tissue were plotted as a function of total OVA exposure and a sigmoidal cure 

fit was applied to the recorded data points (Figures 11D and 12D).  In 

summary, the EC50 response to OVA as determined from BALF eosinophilia 

was 4.1µg and 10.2 µg for WT and Itk-/- mice, respectively (Figure 11D).  
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Furthermore, the EC50 response to OVA as determined from lung tissue 

eosinophilia was 4.2 µg and 25.3 µg for WT and Itk-/- mice, respectively 

(Figure 12D).  Taken together, the qualitative and quantitative approaches 

described above indicate that Itk-/- mice have reduced but not completely 

defective inflammatory responses to OVA as determined by BALF and lung 

tissue eosinophilia.  Informed by these studies, an OVA dose within the Itk-

sensitive range was established for investigation of the inhibitory effects of 

R9-QQP applied to the asthma model.
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Figure 10:  BALF inflammation is reduced in Itk KO mice when challenged 
with a low amount of OVA.
! C57BL/6 (WT) and Itk KO mice were sensitized and challenged 
intranasally with either a total of 40 µg or 4 µg of OVA.  B) Micrographs 
display representative fields acquired at 400x magnification from BALF 
cytospin slides that were stained using a modified Wright-Giemsa dye to 
identify infiltrating leukocytes.  Inset box in upper right corner of each 
micrograph shows additional digital magnification of corresponding region 
outlined in original image.  C) Next, splenocytes from WT an Itk KO mice were 
lysed and samples were resolved by SDS-PAGE gel electrophoresis followed 
by immunoblotting for detection of Itk expression as described in Materials 
and Methods.
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Figure 11:  BALF eosinophilia is reduced in Itk KO mice challenged with a low 
amount of OVA.
! FACS plots display eosinophils (eos) and macrophages (Mac) of 
representative wild type (WT) and Itk KO mice challenged with a total of 40 or 
4 µg of OVA.  Numbers above each gate indicate the percentage of CD45+ 
cells for each population and tick marks indicate fluorescence intensity on a 
log scale.  B & C) Bar graphs display the average and SEM of eosinophil and 
macrophage percentages of CD45+ cells for the indicated numbers (N) of WT 
and Itk KO mice challenged with either a total of 40 or 4 µg of OVA.  Statistical 
significance was determined using an unpaired student's t test comparing WT 
and Itk KO mice for each amount of OVA (* = p < 0.05; ** = p < 0.01).  D) XY 
graph displays the eosinophil percentage of CD45+ cells as a function of the 
total amount of OVA (µg) delivered i.n. during the challenge period on a log 
scale for WT and Itk KO mice.  A sigmoidal dose response cure was applied in 
order to determine a half maximal effective dose (EC50) of OVA for WT as 
compared to Itk KO mice.
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Figure 12:  Lung tissue eosinophilia is reduced in Itk KO mice when 
challenged with a low amount of OVA.
! FACS plots display eosinophils (eos) and macrophages (Mac) of 
representative wild type (WT) and Itk KO mice challenged with a total of 40 or 
4 µg of OVA.  Numbers above each gate indicate the percentage of CD45+ 
cells for each population and tick marks indicate fluorescence intensity on a 
log scale.  B & C) Bar graphs display the average and SEM of eosinophil and 
macrophage percentages of CD45+ cells for the indicated numbers (N) of WT 
and Itk KO mice challenged with either a total of 40 or 4 µg of OVA.  Statistical 
significance was determined using an unpaired student's t test comparing WT 
and Itk KO mice for each amount of OVA (* = p < 0.05).  D) XY graph displays 
the eosinophil percentage of CD45+ cells as a function of the total amount of 
OVA (µg) delivered i.n. during the challenge period on a log scale for WT and 
Itk KO mice.  A sigmoidal dose response curve was applied in order to 
determine a half maximal effective dose (EC50) of OVA for WT as compared to 
Itk KO mice.
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3.4. FITC-R9-QQP delivered i.p. and i.n. is taken up by CD4+ T cells

! After optimizing the amount of OVA provided at challenge, translation of 

R9-QQP to the OVA-induced asthma model was next developed by 

investigation of the pharmacokinetics of peptide delivered in vivo using FITC-

conjugated R9-QQP.  While previous in vitro experiments established that R9-

QQP and control peptides were efficiently taken up by Jurkat cells (Figure 7), 

the ability of R9-QQP delivered intraperitoneally to enter primary CD4+ T cells 

was determined using a similar method that was modified to include staining 

for additional surface markers.  As displayed in Figure 13A, 1 mg of FITC-R9-

QQP was delivered i.p. at 24 hr. and/or 0.5 hr. prior to harvesting spleens.  

After processing into splenocytes, cells were washed with ice-cold PBS and 

treated with trypsin to enhance detection of internalized peptide as described 

for uptake studies performed in Jurkat cells.  Next, splenocytes were washed 

an additional three times in ice-cold PBS and cells were then resuspended in 

FACS buffer containing PB-conjugated anti-CD4 and APC-conjugated anti-

TCR antibodies as described in Materials and Methods.  After surface 

staining, splenocytes were fixed with 2% paraformaldehyde and resuspended 

in FACS buffer prior to acquisition of cellular fluorescence by FACS.

! FACS analysis for quantification of peptide uptake was performed by 

gating lymphocytes based on their signature forward and side scatter profile 

followed by gating based on expression of the TCR.  Subsequently, TCR+ 

lymphocytes were analyzed using two-color density plots to display CD4 
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expression versus FITC fluorescence.  For quantification of peptide uptake as 

a percentage of total T cells, density plots were gated into quadrants based on 

background fluorescence of mice receiving vehicle control (Figure 13B) and 

the percentage of CD4+ FITC+ T cells was recorded for mice treated with 

peptide at various time points (Figure 13C-E).  As displayed in the cumulative 

graph (Figure 13F), 1 mg of FITC-R9-QQP delivered i.p. at both time points 

was taken up by 37% of T cells in the spleen and this percentage was 

reduced to 26% and 5% when delivered only at the -24 hr. or -0.5 hr time 

points, respectively.  In addition, the FITC mean fluorescence intensity (MFI) 

of CD4+ T cells was quantified by gating CD4+ cells as displayed in the 

accompanying histograms for visual comparison (Figure 13B-F).  Consistent 

with the analysis of peptide uptake as a percentage of total T cells, 1 mg of 

FITC-R9-QQP delivered at both time points resulted in a FITC MFI of 208 

relative fluorescence units that was reduced to 266 units and 127 units when 

peptide was delivered at only the -24 hr. or -0.5 hr. time points, respectively 

(Figure 13G).

! In addition to demonstrating systemic delivery by i.p. injection, the 

ability of FITC-R9-QQP to enter CD4+ T cells in the lungs was quantified 

following intranasal (i.n.) delivery of peptide to OVA-sensitized and challenged 

mice.  For these studies, robust lung inflammation was induced by challenging 

OVA-sensitized mice with 40 µg of OVA on each day of the challenge period 

from days 7-9 for a total exposure of 120 µg.  Furthermore, mice were 
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anesthetized 2 hrs. prior to each challenge with OVA and treated with 200 µg 

of FITC-R9-QQP delivered i.n. for a total exposure of 0.6 mg (Figure 14A).  24 

hours after the final challenge, mice were sacrificed and lungs were lavaged 

as described in Materials and Methods.  Next, cells contained in BALF 

samples were washed, treated with trypsin and stained for TCR and CD4 

surface expression as described above for splenocytes.  After fixation with 2% 

paraformaldehyde, acquisition of cellular fluorescence and FACS analysis 

were performed as described above.  As displayed in Figure 14B-E, gated 

density plots indicate that FITC-R9-QQP was taken up by 7% of total T cells 

obtained from BALF as compared to a background of 1% for mice treated with 

vehicle.  Furthermore, i.n. treatment with FITC-R9-QQP resulted in a FITC 

MFI of 112 relative fluorescence units for gated CD4+ T cells as compared to 

a background of 45 units.  Based on the detection of FITC reporter 

fluorescence, R9-QQP delivered in vivo either by i.p. injection or by i.n. 

administration results in uptake by CD4+ T cells, which are the relevant 

cellular target for Itk-dependent inhibition of asthma pathogenesis.
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Figure 13:  FITC-conjugated R9-QQP injected intraperitoneally is efficiently 
taken up by CD4+ T cells in the spleen.
! BL/6 mice were injected with 1 mg of FITC-R9-QQP at -24 and/or -0.5 
hrs. prior to harvesting spleens.  Next, spleens were processed into 
splenocytes, treated with trypsin and washed to enhance detection of 
internalized peptide.  Splenocytes were then stained with APC-conjugated 
anti-TCR and Pacific Blue (PB)-conjugated anti-CD4 antibodies and fixed prior 
to analysis by FACS.  Pseudo-colored density plots display TCR+ splenocytes 
analyzed for CD4 expression versus FITC fluorescence and are gated to 
measure the percentage of CD4+ FITC+ T cells.  Histograms display the FITC 
fluorescence intensity of the gated CD4+ T cells.  B-E) Density plots display 
fluorescence data from mice receiving B) vehicle at -24 and -0.5 hr. time 
points, C) FITC-R9-QQP at both time points, D) vehicle at -24 hrs. followed by 
FITC-R9-QQP at -0.5 hr. time point or E) FITC-R9-QQP followed by vehicle at 
-0.5 hr. time point.  Numbers above gates in density plots indicate the 
percentage of T cells and tick marks indicate fluorescence intensity on a log 
scale for all fluorescence channels.  Open histogram in panel B represents 
vehicle treatment and is overlaid with shaded histograms representing 
treatment with FITC-R9-QQP in panels C-E for comparison of fluorescence 
intensity.  F-G) Bar graphs display the F) percentage of CD4+ FITC+ T cells or 
G) the FITC MFI of CD4+ T cells.
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Figure 14:  FITC-conjugated R9-QQP delivered intranasally (i.n.) is efficiently 
taken up by CD4+ T cells in the lungs.
! BL/6 mice were sensitized with OVA/alum on day 0.  On days 7-9, mice 
were first treated i.n. with 200 µg of FITC-R9-QQP (or vehicle control) and 
challenged ~2 hrs. later with 40 µg of OVA delivered i.n.  On day 10, mice 
were lavaged and BAL cells were treated with trypsin and washed to enhance 
detection of internalized peptide.  BAL cells were then stained with APC-
conjugated anti-TCR and Pacific Blue anti-CD4 antibodies and fixed prior to 
analysis by FACS.  Pseudo-colored density plots display TCR+ BAL cells 
analyzed for CD4 expression and FITC fluorescence and are gated to 
measure the percentage of CD4+ FITC+ T cells.  Histograms display the FITC 
fluorescence intensity of the gated CD4+ T cells.  B-C) Density plots display 
fluorescence data from mice receiving B) vehicle or C) FITC-R9-QQP i.n.  
Numbers above gates in density plot indicate the percentage of T cells and 
tick marks indicate fluorescence intensity on a log scale for all fluorescence 
channels.  Open histogram in panel B represents vehicle treatment and is 
overlaid with shaded histogram representing treatment with FITC-R9-QQP in 
panel C for comparison of fluorescence intensity.  D-E) Bar graphs display the 
D) percentage of CD4+ FITC+ T cells or E) the FITC MFI of CD4+ T cells.
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3.5. Mice treated with R9-QQP display reduced AHR, mucus 
production and inflammation upon challenge in the OVA-induced 
asthma model

! Informed by the previous studies, R9-QQP was next translated to the 

OVA-induced asthma model for investigation of inhibitory effects in vivo.  For 

each independent asthma experiment, separate groups of 3-4 mice per group 

were treated with either vehicle (positive control; PC), R9-QQP inhibitor 

peptide or R9-QQA control peptide and experimental asthma was induced as 

described in Materials and Methods.  In these studies, C57BL/6 mice were 

sensitized i.p. with OVA/alum on day 0 and challenged i.n. with 10 µg of OVA 

on days 7-9 for a total exposure of 30 µg of OVA.  In order to maximize 

bioavailability and thus effectiveness, R9-QQP or control peptide was 

delivered to each mouse throughout the entire sensitization and challenge 

periods as illustrated in Figure 15 and described in Materials and Methods.  

First, 0.5 mg (~25 mg/kg) of R9-QQP or R9-QQA peptide was delivered i.p. at 

24 hrs. and 0.5 hr. prior to sensitization with OVA/alum on day 0.  Next, 

peptide was delivered i.p. as described previously at 24 hrs. prior to the first 

challenge with OVA on day 7.  In addition, peptide was delivered both i.p. as 

described before as well as by i.n. administration at 2 hrs. prior to each 

challenge with OVA on days 7-9.  For the i.n. peptide treatment, mice were 

briefly anesthetized using isoflurane and 200 µg of peptide was delivered by 

inhalation of a 20 µL bolus provided drop-wise to alternating nares.  As 

diagrammed in Figure 16, parameters of lung inflammation were assayed 24 
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hours after the final challenge with OVA on day 10 of the experimental 

protocol.

! For assessment of airway hyperresponsiveness (AHR), mice were 

deeply anesthetized using a cocktail composed of ketamine and xylazine 

delivered i.p. and the trachea was surgically exposed as described in 

Materials and Methods.  After creating a small opening, an 18 gauge cannula 

was inserted into the trachea that was secured using surgical suture.  Next, 

mice were connected to a small rodent ventilator and AHR of passively 

breathing mice was measured in response to increasing doses of aerosolized 

methacholine.  As displayed in Figure 17A, AHR of mice treated with R9-QQP 

for 4-7 independent experiments representing an average of 2 mice per group 

was significantly reduced at the 12 mg/mL dose of methacholine as compared 

to mice in the positive control (PC) group that received vehicle (average 

airway resistance of 4.2 cmH20.s/mL for PC group versus 2.8 cmH20.s/mL for 

R9-QQP group; p < 0.05).  Furthermore, the effect was specific as indicated 

by a representative experiment comparing mice treated with R9-QQA control 

peptide versus vehicle control (average airway resistance of 4.1cmH20.s/mL 

for both PC and R9-QQA groups; Fig. 17B).  Taken together, these data 

indicate that R9-QQP specifically inhibits a physiological measurement of 

airway obstruction that is indicative of asthma.

! In order to examine the histological basis for the observed reduction in 

AHR, lung tissue was harvested from mice that were treated as described 
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above followed by processing for evaluation of mucus production and lung 

inflammation.  For these experiments, mice were sacrificed 24 hours after the 

final challenge with OVA and lungs were lavaged as described in Materials 

and Methods.  Next, a single lung lobe was removed from each mouse that 

was rinsed in PBS and fixed in formalin.  Lung tissue was then sectioned, 

mounted onto microscopy slides and stained with periodic acid schiff (PAS) 

reagent for detection of mucus production or with hematoxylin and eosin 

(H&E) reagent for detection of lung inflammation.  For evaluation of 

histological staining, slides prepared from each lung specimen were labeled 

with randomly assigned numbers, examined using a light microscope and 

blindly scored using criteria described in Materials and Methods.

! As displayed in Figure 18A, representative images of bronchioles 

acquired at 200x magnification indicate that mucus production by goblet cells 

as revealed by cytoplasm staining fuchsia is reduced in mice treated with R9-

QQP as compared to bronchioles of mice from both vehicle (PC) and R9-

QQA peptide control groups.  For quantification of mucus production, 

individual bronchioles were assigned a mucus severity score ranging from 0-5 

according to the percentage of the bronchiole circumference staining positive 

for mucus.  Due to the low overall mucus production induced upon challenge 

with low doses of OVA, the raw mucus severity score for each mouse was 

normalized to the average score of the PC group which was defined as 100%.  

As displayed in Figure 18B, the cumulative scores acquired from 3-5 mice 
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with an average of 32 bronchioles examined per specimen reveal that 

treatment with R9-QQP significantly inhibits mucus production as compared to 

treatment of mice with vehicle (PC) while the R9-QQA control peptide has no 

significant effect (average normalized score of 100% for PC group versus 

12.1% for R9-QQP group and 81.5% for R9-QQA group; p < 0.01).

! Similarly, representative images of bronchioles acquired at 200x 

magnification show a reduced accumulation of nuclei staining dark purple in 

the lung tissue of mice treated with R9-QQP as compared to mice from both 

vehicle (PC) and R9-QQA control groups (Figure 19A).  For quantification of 

inflammation, the degree of peribronchiole as well as perivascular cuffing was 

assigned a score ranging from 0-4 according to the depth cells infiltrating the 

lung tissue directly surrounding each bronchiole or blood vessel.  Again, raw 

scores obtained for each mouse were normalized to the average score of the 

PC group due to the purposefully low overall level of inflammation induced 

with OVA at challenge.  As displayed in Figure 19B, the cumulative 

inflammation scores representing 3-4 mice with an average of 45 combined 

bronchioles and blood vessels examined per mouse indicate that R9-QQP 

significantly inhibits lung tissue inflammation while the R9-QQA control 

peptide has no significant effect as compared to the PC group (average 

normalized score of 100% for PC group versus 28.7% for R9-QQP group and 

143.5% for R9-QQA group; p < 0.05).  Thus, inhibition of AHR by R9-QQP 
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correlates with a peptide-specific reduction in mucus production and 

inflammation occurring in the lung tissue.
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Figure 15:  Schematic diagram summarizes the in vivo peptide delivery 
protocol used for treatment of experimental asthma as described in Materials 
& Methods.
! BL/6 mice were treated with 25 mg/kg of peptide by intraperitoneal (i.p.) 
injection at -24 and -0.5 hr. prior to sensitization with 20 µg OVA/ 2 mg alum 
on day 0.  Next, peptide was again delivered i.p. 24 hours prior to the first 
challenge with OVA on day 7.  In addition, mice were treated with peptide i.p. 
as before and 200 µg of peptide was delivered intranasally (i.n.) to 
anesthetized mice 2 hours prior to each challenge with 10 µg of OVA on days 
7-9.
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Figure 16:  Schematic diagram summarizes parameters analyzed following 
induction of experimental asthma.
! 24 hours after the final challenge with OVA, mice were assayed for 
various parameters of lung inflammation as described in detail Materials and 
Methods.  Briefly, in vivo measurement of airway hyperresponsiveness (AHR) 
was performed using mice anesthetized with a cocktail of ketamine / xylazine 
administered i.p.  In separate experiments, mice were anesthetized with 
isoflurane and retroorbital blood was collected for measurement of serum IgE.  
After sacrificing anesthetized mice, lungs were lavaged and bronchoalveolar 
lavage fluid (BALF) was collected for identification of infiltrating cells.  In 
addition, separate lung lobes were excised and fixed for tissue processing and 
histological staining or dissociated and analyzed for the identification of 
infiltrating cells.  Lastly, lung draining lymph nodes (DLN) were harvested and 
processed to prepare a cell suspension.  DLN cells were then restimulated for 
4 days and in vitro culture supernatants were analyzed for Th2 cytokines. 

128



Figure 17:  Mice treated with R9-QQP have reduced airway 
hyperresponsiveness (AHR) as compared to mice treated with control peptide.
! BL/6 mice were treated with peptides and experimental asthma was 
induced as described in figure 7.  24 hours after the final challenge with OVA, 
mice were anesthetized and AHR was measured in response to increasing 
doses of aerosolized methacholine as described in Materials and Methods.  A 
& B) XY graphs display average airway resistance (+/- SEM) versus dose of 
methacholine.  A) Graph compares mice treated with R9-QQP to positive and 
negative control (PC, NC) groups for indicated number (N) of independent 
experiments representing an average of 2 mice per group.  B) Graph displays 
results of a representative control experiment including R9-QQA group for 
indicated number (N) of individual mice.  Statistical significance was 
determined using an unpaired student's t test comparing each peptide treated 
group to the positive control (PC) group at the 12 mg/mL dose of 
methacholine (* = p < 0.05).
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Figure 18:  R9-QQP specifically inhibits mucus production.
! BL/6 mice were treated with peptides and experimental asthma was 
induced as described in figure 7.  After sacrificing mice and performing 
bronchoalveolar lavage, lung tissue from each mouse was sectioned, stained 
with PAS and analyzed as described in Materials and Methods.  A) 
Micrographs display representative bronchiole cross sections acquired at 
200x magnification from slides stained with PAS for each group.  Inset box in 
upper right corner of each micrograph shows additional digital magnification of 
corresponding region outlined in original image.  Cytoplasm staining fuchsia 
indicates mucus producing goblet cells.  B) Bars display average and SEM of 
normalized mucus severity score for cumulative number (N) of mice per group  
(** p < 0.01).
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Figure 19:  R9-QQP specifically inhibits lung tissue inflammation.
! BL/6 mice were treated with peptides and experimental asthma was 
induced as described in figure 7.  After sacrificing mice and performing 
bronchoalveolar lavage, lung tissue from each mouse was sectioned, stained 
with H&E and analyzed as described in Materials and Methods.  A) 
Micrographs display representative bronchiole cross sections acquired at 
200x magnification from slides stained with H&E for each group.  Inset box in 
upper right corner of each micrograph shows additional digital magnification of 
corresponding region outlined in original image.  Nuclei staining dark purple 
surrounding bronchioles indicate the presence of inflammatory cells.  B) Bars 
display average and SEM of normalized mucus severity score for cumulative 
number (N) of mice per group (* = p < 0.05).
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3.6. R9-QQP specifically inhibits BAL and lung cell eosinophilia in the 
OVA-induced asthma model

! In order to characterize the inflammatory cells affected by treatment 

with R9-QQP, cells obtained from BALF samples were counted using a 

hemacytometer, attached to cytospin slides and stained using a modified 

Wright-Giemsa dye for hematological identification as described previously.  

As displayed in Figure 20A, the total number of cells obtained from mice 

treated with R9-QQP in the OVA-induced asthma model was significantly 

reduced as compared to mice treated with vehicle  while treatment with R9-

QQA had no effect on total BAL cell counts (i.e., from an average of 374,000 

cells for PC group to 173,000 cells for R9-QQP group representing a 53.7% 

decrease and 344,000 cells for R9-QQA group; p < 0.0001).  Furthermore, 

microscopic evaluation of cytospin slides prepared from mice treated with 

vehicle and R9-QQA control peptide revealed a high frequency of 

granulocytes consistent in appearance to eosinophils while BAL cells on 

slides prepared from mice treated with R9-QQP consistently mostly of alveolar 

macrophages with few granulocytes (Fig. 20B).

! For quantification of the inflammatory phenotype, separate aliquots of 

BAL cells obtained from each mouse were stained with fluorophore-

conjugated antibodies according to the previously described method for 

evaluation of eosinophils and macrophages as a percentage of total 

leukocytes by FACS.  Consistent with the representative cytospin images (Fig. 
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20A), the representative density plots displayed in Figure 21A revealed that a 

high relative frequency of eosinophils as defined by a CD45+ Siglec-F+ FITC- 

staining profile were obtained from mice treated with vehicle (PC) and R9-

QQA control peptide while the majority of BAL cells obtained from mice 

treated with R9-QQP were characterized as alveolar macrophages as defined 

by a CD45+ Siglec-F+ FITC+ staining profile.  As substantiated by the 

cumulative analysis displayed in Figure 21B, treatment of mice with R9-QQP 

resulted in a highly significant reduction in the percentage of BAL eosinophils 

as compared to treatment with vehicle while the R9-QQA control peptide had 

no significant effect on eosinophilia (i.e., from an average of 53.2% 

eosinophils for PC group to 28.1% for R9-QQP group representing a 47.2% 

decrease and 49.9% for R9-QQA group; p < 0.0001).  Conversely, the 

percentage of alveolar macrophages was significantly higher for mice treated 

with R9-QQP as compared to treatment with vehicle as displayed in Figure 

21C (i.e., 26.1% macrophages for PC group versus 55.1% for R9-QQP group 

and 33.9% for R9-QQA group; p < 0.0001).

! Using a similar method, separate aliquots of BAL cells were stained for 

quantification of T cells.  For this assay, PerCP-Cy5.5-conjugated anti-CD45 

and PE-Cy7-conjugated anti-CD3ε antibodies were added to Fc receptor-

blocked cells followed by FACS analysis as described in Materials and 

Methods.  After gating CD45+ lymphocytes, T cells as defined by positive 

staining for CD3ε were expressed as a percentage of total leukocytes.  
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Although the detection range was narrow (i.e., from 1.6% T cells for NC group 

to 7.1% for PC group), no difference in the percentage of T cells was 

observed for mice treated with either R9-QQP or R9-QQA peptides as 

compared to vehicle control (Figure 21D-E).

! To further validate the effects of R9-QQP, lung tissue was dissociated 

as described in Materials and Methods and lung cells were stained and 

analyzed by FACS as described for quantification of BAL cell eosinophilia (Fig. 

22A-C).  Although the detection range was much more narrow for lung tissue 

(i.e., 12.4 percentage point difference in eosinophils between NC and PC 

groups as compared to a 50.9 difference for BAL eosinophilia), the percentage 

of eosinophils obtained from lung tissue was significantly reduced for mice 

treated with R9-QQP as compared to treatment with vehicle in a manner that 

was consistent with the reduction in BAL eosinophilia while treatment with the 

R9-QQA control peptide had no significant effect  (i.e., from 15.8% eosinophils 

for PC group to 8.2% for R9-QQP group representing a 48.1% decrease and 

13.0% for R9-QQA group; p < 0.001).  Furthermore, the contribution of 

macrophages was significantly increased for mice treated with R9-QQP as 

compared to treatment with vehicle as observed for BAL cells (i.e., 6.3% 

macrophages for PC group versus 9.5% for R9-QQP group; p < 0.01).  

Together, the characterization of BAL and lung cells indicates that R9-QQP 

specifically reduces eosinophilic inflammation upon challenge with OVA in the 

mouse asthma model.

134



Figure 20:  R9-QQP specifically inhibits BALF infiltration.
! BL/6 mice were treated with peptides and experimental asthma was 
induced as described in figure 7.  A) After sacrificing mice, bronchoalveolar 
lavage fluid (BALF) was collected and total infiltrating cells were counted as 
described in Materials and Methods.  Bars display average total cell number 
and SEM for cumulative number (N) of mice per group.  Statistical significance 
was determined using an unpaired student's t test comparing each peptide 
treated group to the positive control group (**** = p < 0.0001).  B) Micrographs 
display representative fields acquired at 400x magnification from cytospin 
slides that were stained using a modified Wright-Giemsa dye to identify 
infiltrating leukocytes.  Inset box in upper right corner of each micrograph 
shows additional digital magnification of corresponding region outlined in 
original image.
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Figure 21:  R9-QQP specifically inhibits BALF eosinophilia.
! BL/6 mice were treated with peptides and experimental asthma was 
induced as described in figure 7.  A) After performing bronchoalveolar lavage, 
BALF cells were stained for eosinophils / macrophages and analyzed by 
FACS as described in Materials and Methods.  FACS plots display eosinophils 
(eos) and macrophages (Mac) of representative mice from each group.  B & 
C) Bar graphs display cumulative eosinophil and macrophage percentages of 
CD45+ cells for each group.  D) In addition, BALF cells were stained for T 
cells as described in Materials and Methods.  FACS plots display T cells (TCR
+) of representative mice from each group.  E) Bar graph displays cumulative 
T cell percentages of CD45+ cells for each group.  A & D) Numbers above 
each gate indicate the percentage of CD45+ cells for each population and tick 
marks indicate fluorescence intensity on a log scale for all fluorescence 
channels and on a linear scale for FSC-A.  B, C & E) Bar graphs display 
average and SEM of cumulative number (N) of mice per group and statistical 
significance was determined using an unpaired student's t test comparing 
each peptide treated group to the positive control for each parameter (**** = p 
< 0.0001).
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Figure 22:  R9-QQP specifically inhibits lung tissue eosinophilia.
! BL/6 mice were treated with peptides and experimental asthma was 
induced as described in figure 7.  After sacrificing mice and performing 
bronchoalveolar lavage, lung tissue from each mouse was harvested, rinsed 
in PBS and stained for eosinophils / macrophages as described in Materials 
and Methods.  A) FACS plots display eosinophils (eos) and macrophages 
(Mac) of representative mice from each group.  Numbers above each gate 
indicate the percentage of CD45+ cells for each population and tick marks 
represent fluorescence intensity on a log scale for fluorescence channels.  B 
& C) Bar graphs display average and SEM of eosinophil and macrophage 
percentages of CD45+ cells for cumulative number (N) of mice per group.  
Statistical significance was determined using an unpaired student's t test 
comparing each peptide treated group to the positive control for each 
parameter (** = p < 0.01; *** = p < 0.001).
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3.7. OVA-dependent serum IgE is not affected by treatment with R9-
QQP

! As a known mediator of asthma pathogenesis, serum IgE levels were 

investigated for mice treated with R9-QQP in the OVA-inducible asthma 

model.  For this assay, mice were anesthetized and retroorbital blood was 

collected 24 hours after the final challenge with OVA as illustrated in the 

protocol and assay diagrams (Fig. 15-16).  After clot formation, serum was 

separated by centrifugation and aliquots obtained from each mouse were 

tested in duplicate for total IgE by ELISA as described in Materials and 

Methods.  As displayed in Figure 23, total serum IgE levels were highly 

induced for OVA-sensitized and challenged mice as compared to non-

immunized negative control mice (i.e., from an average of 61 pg/mL for NC 

group to an average of 671 pg/mL for PC group).  However, OVA-inducible 

IgE was not affected for mice treated with R9-QQP as compared to treatment 

with vehicle (i.e., average total IgE of 659 pg/mL for R9-QQP group versus 

671 for PC group).  Thus, the inhibitory effects of R9-QQP on parameters of 

lung inflammation as described in this report were apparently independent of 

IgE.
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Figure 23:  R9-QQP does not affect total serum IgE.
! BL/6 mice were treated with R9-QQP and experimental asthma was 
induced as described in figure 7.  24 hours after the final challenge with OVA, 
serum was obtained from indicated number (N) of mice for each group.  Bars 
display average and SEM of total serum IgE as determined by ELISA.
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3.8. R9-QQP specifically inhibits Th2 cytokine production by lung DLN 
cells upon restimulation with OVA in vitro

! In order to identify the inflammatory mediators affected by treatment of 

mice with R9-QQP, Th2 cytokine production by lung draining lymph node cells 

was investigated following restimulation with OVA in vitro.  For these 

experiments, mice were treated with peptides and asthma was induced in 

response to OVA as described previously.  Twenty-four hours after the final 

challenge with OVA, mice were sacrificed and lung draining lymph nodes 

(DLN) were harvested following dissection of the chest cavity.  Next, DLN from 

2-3 mice for each treatment group were combined and lymphoid tissue was 

dissociated into separate cell suspensions.  For restimulation in vitro, 105 or 

106 DLN cells were seeded to replicate wells of round-bottom 96-well plates 

followed by addition of OVA at a final concentration of 50 µg/mL as described 

in Materials and Methods.  After incubation of DLN cells for 4 days, tissue 

culture supernatants corresponding to separate treatment groups were 

harvested and tested in duplicate for quantification of IL-4, IL-5 and IL-13 by 

ELISA., respectively.  Importantly, no additional peptides were added during 

the in vitro incubation as this assay was designed to reflect the effects of R9-

QQP in vivo.

! As represented for 6-7 independent experiments (Fig. 24A-B), OVA-

dependent restimulation resulted in robust secretion of IL-13 by DLN cells 

isolated from mice treated with vehicle (PC) that were seeded at 105 cells per 
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well while IL-13 was significantly reduced for independent cultures derived 

from mice treated with R9-QQP (i.e., average IL-13 concentration of 428.7 pg/

mL for PC group as compared to 64.5 pg/mL for R9-QQP group; p < 0.01).  

Importantly, the inhibitory effect of R9-QQP was specific as restimulation of 

DLN cells from mice treated with R9-QQA  was not significantly different as 

compared to treatment with vehicle (average IL-13 concentration of 378.6 pg/

mL for R9-QQA group).  Similarly, analysis of the same supernatant samples 

for quantification of IL-5 revealed a more narrow detection range that 

nevertheless revealed a significant reduction in IL-5 secretion by DLN cells of 

mice treated with R9-QQP as compared to vehicle while treatment with R9-

QQA had no effect (i.e., average IL-5 concentration of 17.1 pg/mL for PC 

group as compared to 4.7 pg/mL for R9-QQP group and 18.5 pg/mL for R9-

QQA group; p < 0.05).  However, levels of the Th2 signature cytokine IL-4 

were beyond the detection limit for the IL-4 ELISA assay using the culture 

conditions described above (data not shown).

! In order to maximize the ability to detect low levels of IL-4, parallel 

cultures were established that were seeded at 106 DLN cells per well and 

restimulated with OVA as described above.  As represented for 4-7 

independent experiments (Fig. 24C-D), restimulation with OVA resulted in 

significantly reduced secretion of IL-4 by DLN cells from mice that were 

treated with R9-QQP as compared to treatment with vehicle while treated with 

the R9-QQA control peptide had no significant effect (i.e., average IL-4 
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concentration of 73.4 pg/mL for PC group as compared to 20.0 pg/mL for R9-

QQP group and 54.1 pg/mL for R9-QQA group; p < 0.05).  Likewise, analysis 

of the same culture supernatants for IL-5 revealed a significant and peptide 

specific effect while increasing the overall levels of IL-5 as compared to 

cultures seeded at 105 cells per well (i.e., average IL-5 concentration of 

1,186.5 pg/mL for PC group as compared to 657.7 pg/mL for R9-QQP group 

and 1,217.0 pg/mL for R9-QQA group; p < 0.05).  In summary, these results 

indicate that R9-QQP specifically inhibits secretion of the Th2 cytokines IL-4, 

IL-5 and IL-13 by lung DLN cells, which are critical mediators involved in 

asthma pathogenesis.

! Chapter 3, in part, is currently being prepared for submission for 

publication of the material.  Guimond, D.M., Cam, N.R., Hirve, N., Duan, W., 

Lambris, J.D., Croft, M., & Tsoukas, C.D (2012).  Treatment of Experimental 

Asthma Using a Novel Peptide Inhibitor of the Inducible T Cell Kinase.  The 

dissertation author was the primary author of this material.
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Figure 24:  R9-QQP specifically inhibits Th2 cytokine production by lung 
draining lymph node (DLN) cells upon in vitro restimulation with OVA.
! BL/6 mice were treated with peptides and experimental asthma was 
induced as described in figure 7.  24 hours after the final challenge with OVA, 
mice were sacrificed and lung DLN were harvested and pooled from 2-4 mice 
per group as described in Materials & Methods.  After preparing a cell 
suspension, pooled DLN cells for each group were seeded at 105 or 106 DLN 
cells per well to designated wells of a round-bottom 96-well plate and 
restimulated with OVA.  After culture for 4 days in vitro, supernatants were 
harvested and tested for Th2 cytokines by ELISA as described in Materials 
and Methods.  A-D) Bar graphs display the average and SEM of Th2 cytokine 
amounts from supernatants of cell cultures seeded at (A-B) 105 or (C-D) 106 
DLN cells per well.  Statistical significance was calculated using an unpaired 
student's t test comparing cytokine amounts of peptide-treated to untreated 
(positive control) DLN cell culture supernatants for each group (* = p < .05; ** 
= p < 0.01).
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4. DISCUSSION

! As required for its enzymatic and adaptor functions, the inducible T cell 

kinase (Itk) interacts with the adaptor protein SLP-76 downstream of signals 

received via the T cell receptor (TCR).  Upon stimulation, the Itk–SLP-76 

association is mediated by binding of the SH2 and SH3 domains of Itk to 

specific phosphotyrosine (pY 145) and polyproline ligands present on SLP-76, 

respectively (81, 117).  Furthermore, previous in vitro binding studies using 

purified Itk domain fragments identified the QQPPVPPQRPMA peptide 

sequence derived from the SLP-76 proline rich domain as the minimal 

polyproline ligand for the Itk SH3 domain with a reported affinity of 0.77 mM 

(1, 81).

! In order to study the biological effects of the Itk–SLP-76 interaction, 

Grasis et al. modified the SLP-76 polyproline ligand peptide sequence by the 

addition of a cell penetration motif at the N-terminus consisting of nine 

arginines to generate the synthetic peptide named R9-QQP in addition to a 

control peptide with a scrambled cargo sequence named R9-PQM (2).  

Previously, studies had demonstrated that peptides as well as protein 

domains could be rendered capable of penetrating the plasma membrane by 

the addition of cationic residues including polyarginine motifs (125-130).  As a 

reporter of cellular uptake, FITC-tagged R9-QQP was added to Jurkat T cells 

and primary splenocytes followed by analysis of fluorescence by confocal 
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microscopy and FACS.  As revealed in the previous and current studies, FITC-

tagged versions of R9-QQP, R9-PQM and R9-QQA (proline to alanine 

substitution control peptide) were all efficiently taken up by cells (2).  

Furthermore, R9-QQP was non-toxic for the duration of the in vitro 

experiments performed using splenocytes as demonstrated by analysis of cell 

viability using 7-AAD (2).

! Beyond the combined requirement for the Itk SH2 and SH3 domains, 

the individual contribution of each adaptor domain for binding to SLP-76 had 

not been previously addressed.  As revealed by treatment of T cells with R9-

QQP, disruption of the inducible Itk–SLP-76 association indicated that binding 

of the Itk SH3 domain to its polyproline ligand on SLP-76 is necessary for the 

biochemical association of the full length molecules occurring in live cells.  

Thus, these results demonstrated that internalized R9-QQP is capable of 

competing with full length SLP-76 for binding to the Itk SH3 domain.

! After establishing the biochemical importance of the Itk SH3 domain for 

the association with SLP-76, a series of downstream signaling events 

resulting in Itk activation and effector function were investigated that were 

predicted to be disrupted upon treatment of cells with the R9-QQP inhibitor 

peptide.  Upon TCR-mediated stimulation, Itk and SLP-76 are inducibly 

recruited to the immunological synapse nucleated by the signaling molecule 

LAT which is constitutively associated within lipid rafts within the plasma 

membrane (83, 134).  Furthermore, recruitment of Itk to the immunological 
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synapse is defective in Jurkat cells with a disrupted SLP-76 gene (2, 113, 

115).  Taken together, the requirement of the Itk SH3 domain for association 

with SLP-76 implied that the recruitment of Itk to the immunological synapse 

would be impaired upon treatment of cells with R9-QQP.  In order to 

investigate the TCR-mediated recruitment of Itk to the immunological 

synapse, Jurkat cells were transfected with GFP-tagged Itk and transfectants 

were conjugated to polystyrene beads coated with anti-TCR antibody which 

served as surrogate antigen presenting cells (APCs).  Consistent with the 

prediction based on the disrupted biochemical association, analysis of images 

acquired by confocal microscopy revealed that recruitment of GFP-Itk to the 

surrogate immunological synapse was defective for Jurkat cells treated with 

R9-QQP (2).

! Once recruited to the immunological synapse, Itk promotes TCR-

dependent activation of WASp mediated by its constitutive association with 

Vav (90-96, 135).  In its adaptor role, Itk serves to recruit Vav to the 

immunological synapse, which activates Cdc42.  In this model, Cdc42 then 

activates WASp, which is inducibly recruited to SLP-76 independently of Itk.  

As a consequence of its impaired recruitment, the adaptor function of Itk in 

supporting actin polymerization at the surrogate immunological synapse was 

investigated for cells treated with R9-QQP.  Consistent with the Itk recruitment 

defect, TCR-dependent actin polymerization was impaired for Jurkat cells 

treated with R9-QQP as determined by staining of Jurkat-bead conjugates for 
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filamentous actin followed by analysis of images acquired by confocal 

microscopy (2).

! In its canonical enzymatic role, Itk is activated by phosphorylation in 

trans on tyrosine 511 of its kinase domain by Lck  followed by 

autophosphorylation in cis on tyrosine 180 of its SH3 domain.  While the SH3 

domain is necessary for the initial recruitment of Itk to SLP-76 as 

demonstrated using the R9-QQP inhibitor peptide, additional domains are 

required that are hypothesized to cooperatively stabilize Itk in a conformation 

that allows access of the kinase domain for release of catalytic activity.  In 

particular, the PH domain binds to the membrane phospholipid PIP3 as well as 

serving as a possible adaptor to enhance recruitment and activation.  In 

addition, the SH2 domain binds to pY 145 in the acidic domain of SLP-76 and 

is necessary for Itk activation (114, 115).  After autophosphorylation in cis, pY 

180 in the Itk SH3 domain is hypothesized to allosterically modify the SH3 

domain to destabilize a previously described autoinhibitory intramolecular 

conformation of Itk mediated by interaction with the adjacent proline rich 

region (107).  Taken together, the net effect of the TCR-dependent Itk domain 

interactions mentioned above leads to sustained Itk kinase activity resulting in 

phosphorylation the the phospholipase PLC-γ1 on tyrosine residue 783.  As 

demonstrated for both Jurkat T cells and splenocytes, incubation with R9-

QQP inhibits Itk activation as measured by  phosphorylation of tyrosine 511 
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located in the kinase domain, which is a substrate targeted by Lck that is 

necessary for the enzymatic activation of Itk (2).

! Once activated, PLC-γ1 hydrolyzes PIP3 resulting in generation of the 

second messengers IP3 and DAG which activate pathways leading to 

transcriptional activation of inflammatory genes including cytokine genes.  As 

reported for Itk-/- T cells, TCR-mediated secretion of the Th2 cytokines IL-4, 

IL-5 and IL-13 is defective in the absence of Itk (100-102).  In order to 

characterize the effect of R9-QQP on cytokine secretion, splenocytes from 

WT C57BL/6 mice were treated in vitro with R9-QQP followed by primary 

stimulation and secondary stimulation using ant-TCR and anti-CD28 

antibodies.  Consistent with the previously described defect for Itk-/- T cells, 

analysis of tissue culture supernatants by ELISA as well as analysis of 

cytokine expression by ICCS revealed that R9-QQP significantly inhibited 

secretion of the Th2 cytokines IL-4, IL-5 and IL-13 while the signature Th1 

cytokine IFN-γ was not affected (2).

! In addition to the previously described effects of R9-QQP added to cells 

in vitro, Grasis et al. extended these findings by delivery of R9-QQP to mice in 

vivo followed by functional characterization in the context of Itk activation as 

described above.  For these experiments, 20 mg/kg of R9-QQP was delivered 

by intraperitoneal (i.p.) injection at 24 and 0.5 hours prior to harvesting 

spleens.  After processing into splenocytes, the TCR-mediated association of 

Itk with SLP-76, activation of Itk by phosphorylation at tyrosine 511 and 
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production of Th2 cytokines were analyzed as described previously.  Despite 

concerns about peptide stability in vivo, delivery of R9-QQP by i.p. injection 

resulted in significant inhibitory and peptide specific effects that were 

consistent with the results of adding R9-QQP to cells in vitro.  Thus, this study 

demonstrated the feasibility of using R9-QQP as a competitive inhibitor of the 

inducible T cell kinase upon delivery to mice in vivo.

! In the current study, the in vivo significance of the Itk–SLP-76 

interaction was investigated by application of the R9-QQP inhibitor peptide to 

the OVA-inducible asthma model.  In this model, naive mice are first 

sensitized with the model allergen OVA which is purified from chicken egg 

white and adsorbed to the adjuvant aluminum hydroxide followed by delivery 

by i.p. injection.  After 7 days, OVA-specific T cell clones are generated in vivo 

mediated by cells of the innate immune system such as dendritic cells and 

macrophages which present OVA-derived peptides to CD4+ T cells in the 

context of MHC class II molecules.  Unlike the use of anti-TCR antibodies 

employed in the initial characterization of R9-QQP, the OVA-inducible system 

results in a more physiological mode of T cell stimulation.

! Prior to the investigation of its effects on asthma pathogenesis, R9-

QQP was first characterized in an in vitro model of OVA-dependent T cell 

function as assessed by Th2 cytokine secretion.  For these experiments, mice 

were sensitized i.p. with OVA/alum and spleens were harvested 7 days later.  

After processing into splenocyte suspensions, separate aliquots of cells were 
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treated in vitro with vehicle, R9-QQP inhibitor or R9-PQM / R9-QQA control 

peptides according to the in vitro peptide treatment protocol established in the 

initial characterization of R9-QQP.  Next, soluble OVA was added to the 

culture medium for restimulation followed by incubation for 4 days to allow 

cytokine secretion by OVA-specific T cells.

! In agreement with the previously published results, analysis of tissue 

culture supernatant samples by ELISA revealed that R9-QQP inhibited Th2 

cytokine secretion in a dose-dependent and specific manner while the 

signature Th1 cytokine was not affected.  The differential effect of R9-QQP on 

Th2 but not Th1 cytokine production correlates with the Itk-specific 

requirement for Th2 effector function while Th1 effector function has been 

demonstrated to occur independently of Itk expression.  Presumably, the Itk-

specific requirement for Th2 effector function is due to its selective expression 

by Th2 effector cells while the related Tec family kinase Rlk is upregulated in 

Th1 effector cells where it is presumably able to compensate for the lack of Itk 

expression in Itk-/- T cells.

! While analogous to the previous characterization of cytokine 

production, differences in terms of the timing of inhibition provided by R9-

QQP in the two protocols allows additional distinctions to be made with 

respect to the specific requirement for Itk in the OVA-dependent system.  In 

the previous characterization, splenocytes from naive mice were treated with 

R9-QQP in vitro followed by primary and secondary stimulation separated by 
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24 hours mediated by anti-TCR and anti-CD28 antibodies.  In this protocol, 

R9-QQP was presumably internalized and effective as a dominant negative 

inhibitor of Itk activation prior to the primary stimulation as well as being 

possibly effective 24 hours later at the secondary stimulation time point.  In 

the current work, Itk activation was allowed to occur unperturbed throughout 

the duration of the primary OVA-dependent stimulation occurring in vivo with 

inhibition mediated by R9-QQP only applied during the secondary stimulation 

occurring in vitro.

! As introduced earlier, Itk is required for TCR-mediated Th2 commitment 

in the absence of additional cytokine-mediated signaling (100).  In addition, Itk 

is required for the TCR-mediated release of effector function by Th2 

competent cells upon secondary stimulation (101, 102).  In the previous 

characterization, the inhibitory effect of R9-QQP could be interpreted as 

affecting either Th2 commitment, Th2 effector function or both due to its likely 

effectiveness throughout the entire protocol including at the time points of 

primary and secondary TCR-mediated stimulation.  In the current study, R9-

QQP is demonstrated to be required at the effector stage of Th2 cytokine 

release due to the timing of its addition 7 days after the initial sensitization 

occurring in vivo.  In reference to the previous characterization of the role of 

Itk in T cell development, the results reported in the current study are 

consistent with a model requiring Itk at the effector stage of cytokine secretion 

upon OVA-mediated restimulation of allergen-specific T cell clones.
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! In order to further characterize the mode of inhibition provided by 

treatment of cells with R9-QQP, cytokine expression was compared using the 

ELISA and ELISpot assays.  As determined by the ELISA assay, Th2 cytokine 

secretion into the culture medium is inhibited by R9-QQP in a dose-dependent 

manner.  However, analysis of the number of cytokine producing cells as 

determined by the ELISpot assay reveals no effect upon treatment of parallel 

cultures with R9-QQP.  Together, these apparently contradictory results can be 

resolved by interpretation of the inhibitory effect as suppressing cytokine 

secretion by previously differentiated Th2 effector cells rather than by affecting 

the frequency of OVA-specific CD4+ T cells.  According to this model, 

treatment with R9-QQP would be expected to inhibit the amount of Th2 

cytokines secreted by a constant population of Th2 effector cells that 

cumulatively results in a reduction of the total amount of cytokine present in 

the tissue culture supernatant as measured by the ELISA assay.  Thus, these 

results are consistent with the differentiation of OVA-specific CD4+ T cells that 

occurs prior to treatment with R9-QQP in this assay and provides additional 

evidence that R9-QQP is specifically capable of inhibiting Th2 effector 

function.

! In transition to the OVA-inducible asthma model, the previously 

characterized defective lung inflammation reported for Itk-/- mice was validated 

prior to application of the R9-QQP inhibitor peptide to the asthma protocol.  

According to this model, mice are first sensitized i.p. with OVA/alum followed 
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by a challenge period in which anesthetized mice are treated with OVA 

provided intranasally.  After the final challenge with OVA, parameters of lung 

inflammation are assessed including airway hyperresponsiveness, mucus 

production, cellular infiltration into lung tissue and cytokine production by lung 

draining lymph node cells.  As previously described for Itk-/- mice, these 

parameters of asthma are significantly reduced as compared to WT mice in 

the OVA-inducible asthma model (11, 76).  Indeed, the asthma phenotype for 

Itk-/- mice described in these reports is nearly identical to non-immunized 

control mice.  Surprisingly, the initial validation of the Itk-/- phenotype in the 

current study performed according to the previously described protocol 

resulted in robust lung inflammation that was equivalent to WT mice as 

indicated by quantification of eosinophils present in bronchoalveolar lavage 

fluid (BALF) and in lung tissue.  Cumulatively, analysis of WT and Itk-/- mice 

treated according to this protocol revealed a nearly identical ~70% 

eosinophilia as a percentage of total leukocytes in BALF and ~15% 

eosinophilia in lung tissue for both groups of mice.  Due to the unexpected 

inflammatory phenotype, the Itk-/- mice used in these studies were evaluated 

for possible mis-expression of Itk.  However, genotyping using Itk-specific 

PCR primers and immunoblotting for evaluation of protein expression using an 

anti-Itk monoclonal antibody confirmed the knockout status of the Itk-/- mice.  

Thus, the lung inflammation observed for the Itk-/- mice treated according to 

the OVA-inducible asthma protocol was apparently independent of Itk.
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! Based on the previous characterization of the role of Itk in Th2 

development and effector function, Itk is known to be an important regulator of 

low affinity TCR interactions with high affinity TCR interactions occurring 

independently of Itk (100).  In the context of the paradoxical results described 

above for Itk-/- mice treated according to the OVA-inducible asthma protocol, 

the amount of OVA provided intranasally during the challenge period was 

suspected to be beyond the sensitive range for regulation by Itk.  That is, high 

amounts of OVA provided i.n. during the challenge period were suspected to 

result in high affinity / avidity TCR interactions that would bypass the role of Itk 

resulting in Itk-independent inflammatory responses.  In order to test this 

hypothesis, the total amount of OVA provided at challenge was reduced 10-

fold from a total of 40 µg to 4 µg of OVA.  While differences were not observed 

after exposure with 40 µg of OVA delivered i.n. according to previous reports, 

comparison of WT and Itk-/- challenged with a total exposure of 4 µg of OVA 

resulted in a significant reduction in eosinophilia in BALF and lung tissue for 

Itk-/- mice as compared to WT mice.  Cumulatively, BALF eosinophilia of WT 

mice challenged with a total exposure of 4 µg of OVA was 32% as compared 

to 2% for Itk-/- mice while lung eosinophilia was 8% for WT mice versus 4% for 

Itk-/- mice.  Thus, the Itk-dependent defect was reproduced in the OVA-

inducible asthma model but only upon intranasal exposure of mice with 

relatively low amounts of OVA.
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! While satisfying, these results did not explain the discrepancy with the 

previous report that described defective lung inflammation upon a total 

exposure of 40 µg of OVA.  In this regard, technical differences in the 

intranasal delivery of nominally equivalent amounts of OVA to anesthetized 

mice may explain the disparate results observed in the previous and current 

reports.  For example, previous studies have tracked tissue distribution of 

equivalent amounts of a dye provided intranasally that was provided in 

different volumes.  Overall, delivery of equivalent amounts of dye in larger 

volumes resulted in a greater proportion of dye that was detected in the lower 

respiratory tract (136, 137).  In addition, the degree and type of anesthesia 

impacts the delivery of material to the lower respiratory tract that is provided 

intranasally.  Taken together, these technical differences may individually and 

in combination result in the delivery of different amounts of OVA to the lower 

respiratory tract while nominally providing equivalent amounts delivered 

intranasally according to the same protocol.  In summary, validation of the 

previously described Itk-/- phenotype was invaluable for the development of an 

OVA-inducible asthma protocol to test the effectiveness of the Itk inhibitor 

peptide R9-QQP on parameters of asthma.

! In the final stage of translation to the OVA-inducible asthma model, 

FITC-tagged R9-QQP was demonstrated to enter CD4+ T cells upon in vivo 

delivery both by i.p. injection as well as by i.n. treatment.  For investigation of 

uptake by systemic delivery, naive C57BL/6 mice were injected i.p. with FITC-
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R9-QQP at 24 hrs. and/or 0.5 hr. prior to harvesting spleens.  After extensive 

washes and treatment with trypsin to reduce detection of membrane-

associated peptide, splenocytes were stained using anti-CD4 and anti-TCR 

fluorophore-conjugated antibodies followed by fixation and analysis by FACS.

! As compared to mice treated with vehicle, CD4+ T cells obtained from 

the spleens of mice treated with FITC-R9-QQP at both time points were 

positive for FITC fluorescence as determined by the mean fluorescence 

intensity (MFI) of CD4+ T cells as well as by the percentage of FITC+ CD4+ 

double positive T cells.  According to the MFI analysis of CD4+ T cells, 

injection of mice with FITC-R9-QQP resulted in a 2.8-fold increase in FITC 

fluorescence as compared to mice treated with vehicle.  Furthermore, analysis 

of the percentage of FITC+ CD4+ double positive T cells revealed that the 

2.8-fold increase in MFI was attributed to 37% of the CD4+ T cell population.  

Together, these separate analyses suggest that FITC-R9-QQP is not uniformly 

taken up by all CD4+ T cells obtained from the spleens of mice treated with 

peptide by i.p. injection.  Rather, these results imply that FITC-R9-QQP is 

disproportionally taken up by a subset of these cells that are perhaps more 

accessible to peptide at the time of injection.

! In further analysis of the pharmacokinetics of peptide uptake, injection 

of FITC-R9-QQP at either 24 hours or 0.5 hour prior to harvesting spleens 

resulted in reduced detection of FITC fluorescence as compared to mice 

treated with peptide at both time points.  As likely accounted for by proteolytic 

157



degradation within the peritoneal cavity, the single i.p. injection of FITC-R9-

QQP at the 24 hours time point resulted in the least detection of FITC 

fluorescence as measured by both the MFI of CD4+ T cells as well as by the 

percentage of FITC+ CD4+ T cells followed in magnitude by the single 

injection at the 0.5 hour time point with the delivery at both time points 

resulting the greatest FITC fluorescence.

! For investigation of uptake at the lung mucosa, separate OVA-

sensitized mice were briefly anesthetized and treated intranasally (i.n.) with 

FITC-R9-QQP prior to each challenge with OVA.  24 hours after the final 

challenge, mice were sacrificed and lungs were lavaged.  Next, BALF cells 

were processed as described above for detection of internalized FITC-R9-

QQP by CD4+ T cells obtained from spleens.  Similar to the analysis of uptake 

by systemic delivery, FACS analysis of BAL cells revealed a 2.5-fold increase 

in the FITC MFI of CD4+ T cells as compared to mice treated with vehicle.  

Furthermore, analysis of the percentage of FITC+ CD4+ T cells revealed that 

this 2.5-fold increase in FITC MFI was attributed to 7.3% of the CD4+ T cell 

population.  Consistent with the investigation of uptake by systemic delivery, 

these results suggest that FITC-R9-QQP is disproportionally taken up by a 

subset of CD4+ T cells at the lung mucosa.  According to the same 

interpretation as before, this phenomenon is likely due to the accessibility of 

peptide to CD4+ T cells present at the lung mucosa at the time of i.n. delivery.  

Importantly for inhibition of Itk in the asthma model, investigation of peptide 
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uptake by i.p. injection as well as by i.n. treatment provides proof of principle 

that R9-QQP is taken up by CD4+ T cells both systemically and at the lung 

mucosa, respectively.  However, the minor percentage of FITC+ CD4+ T 

detected upon separate treatment of mice with FITC-R9-QQP by i.p. injection 

or i.n. administration illustrates the potential issues of peptide stability and 

availability that may impact effectiveness in the asthma disease model.

! Informed by the OVA titration analysis as well as by the peptide uptake 

studies described above, an experimental protocol was designed for 

investigation of the role of the Itk–SLP-76 interaction in the OVA-inducible 

asthma model.  In order to maximize the effectiveness of the peptide 

treatment, R9-QQP inhibitor or R9-QQA control peptides were delivered to 

designated groups of mice throughout the entire sensitization and challenge 

periods.  To this end, mice were injected i.p. with 25 mg/kg of R9-QQP or R9-

QQA control peptides at 24 hrs. and 0.5 hr. prior to sensitization with OVA/

alum.  In this context, the peptide treatment protocol prior to sensitization with 

OVA/alum was consistent with the previously described characterization in 

which 20 mg/kg of R9-QQP was delivered at the these time points resulting in 

specific inhibition of Itk activation and function upon restimulation of 

splenocytes ex vivo (2).  Furthermore, i.p. delivery of FITC-R9-QQP at both 24 

hrs. and 0.5 hr. time points prior to harvesting spleens resulted in the greatest 

FITC fluorescence observed for CD4+ T cells thus indicating its bio-availability 

upon delivery using this protocol.  Thus, this peptide treatment strategy was 
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adopted for inhibition of asthma pathogenesis upon sensitization with OVA/

alum.

! Seven days after sensitization with OVA/alum, R9-QQP or R9-QQA 

peptides were delivered both systemically as well as locally to the lung 

mucosa during the challenge period.  Similar to the delivery of peptide prior to 

sensitization, mice were treated with R9-QQP or R9-QQA by i.p. injection at 

24 hours prior to the first i.n. challenge with OVA.  In addition, mice were 

treated with peptides by i.p. injection as well as by i.n. delivery of 0.2 mg of 

peptides at 2 hrs. prior to each of 3 daily i.n. challenges with OVA.  As 

demonstrated previously, i.n. delivery of 0.2 mg of FITC-R9-QQP according to 

this protocol resulted in detection of FITC fluorescence as a reporter of uptake 

by CD4+ T cells obtained from BALF samples.  Cumulatively, each mouse 

treated according to the protocol described above received a total of ~3.6 mg 

of peptide with 3 mg delivered systemically by 6 i.p. injections of 0.5 mg each 

and 0.6 mg delivered locally by i.n. administration of 0.2 mg each.  Although 

expensive in terms of peptide consumption (and not to mention intensive in 

terms of labor), this treatment protocol was designed to maximize 

effectiveness of R9-QQP by inhibiting Itk-dependent development of Th2 

competent cells following sensitization with OVA/alum as well as by inhibiting 

Th2 effector function upon challenge in the OVA-inducible asthma model.

! Separately, the OVA treatment protocol used for the following asthma 

studies was adopted from the previous characterization of WT versus Itk-/- 
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mice.  As discussed above, Itk was demonstrated to be sensitive to the 

amount of OVA provided i.n. upon challenge in the asthma model.  That is, Itk 

was shown to regulate lung inflammation as measured by BAL and lung 

eosinophilia at low but not high doses of OVA in this model.  In order to 

measure Itk-dependent inhibition upon treatment with R9-QQP, mice used for 

the characterization of R9-QQP in the asthma model were challenged with a 

sub-optimal amount of OVA as determined from the OVA dose response that 

was performed in these previous studies.  As predicted from a sigmoidal curve 

that was applied to these data, mice treated with peptides were challenged 

with 10 µg of OVA that was delivered i.n. for 3 daily challenges resulting in a 

total exposure of 30 µg of OVA.  24 hours after the final challenge with OVA, 

mice were evaluated for various parameters of asthma as described below.

! For evaluation of a composite indicator of asthma, separate groups of 

mice were treated with peptides or vehicle control as described above 

followed by assessment of airway hyperresponsiveness (AHR).  For 

measurement of AHR, an 18 gauge cannula was inserted into the trachea of 

anesthetized mice and external ventilation was initiated upon connection to 

the Scireq FlexiVent system.  Next, airway resistance was recorded in 

response to increasing doses of aerosolized methacholine ranging from 3 - 24 

mg/mL which was aerosolized and delivered directly to the lungs of mice via 

the intratracheal cannula.  As compared to the non-immunized negative 

control group, airway resistance was significantly increased for OVA-
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sensitized and challenged mice at the 12 mg/mL dose of methacholine (from 

an average of 2.2 to 4.2 cmH2O.s/mL, respectively).  Significantly, AHR was 

reduced at the 12 mg/mL dose of methacholine for mice treated with R9-QQP 

as compared to vehicle control (average of 2.8 cmH2O.s/mL; p < 0.05 as 

compared to vehicle control).  Furthermore, the inhibitory effect of R9-QQP 

was specific as determined by treatment of mice with the R9-QQA control 

peptide versus vehicle control.  Thus, the in vivo assessment of AHR indicated 

that the R9-QQP peptide was effective as an inhibitor of a physiological 

parameter of asthma.

! In order to examine the histological basis of the inhibitory effect of R9-

QQP, intact lungs were extracted and fixed in formalin after treatment of mice 

with peptides and induction of asthma as described above.  Next, 5 µm thick 

sections were prepared and mounted onto microscopy slides followed by 

staining for mucus production and for the presence of inflammation, 

respectively.  For analysis of mucus production, lung sections were stained 

with PAS followed by evaluation of individual bronchioles by light microscopy.  

For each bronchiole examined, a semi-quantitative score was recorded 

corresponding to the percentage of the total circumference that was positive 

for mucus as indicated by fuchsia staining.  As revealed by this analysis which 

was performed blindly, mucus severity was significantly inhibited from the 

lungs of mice treated with R9-QQP versus vehicle while treatment with the 

R9-QQA control peptide had no effect (average mucus severity score of 
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12.1% for mice treated with R9-QQP normalized to vehicle control versus 

81.5% for R9-QQA control peptide; p < 0.01)

! For evaluation of inflammation, lung histology slides were stained with 

H&E for detection of nuclei followed by semi-quantitative analysis according to 

the depth of inflammatory cells surrounding bronchioles as well as blood 

vessels.  Similar to the pattern observed for mucus production, inflammation 

was significantly reduced from the lungs of mice treated with R9-QQP versus 

vehicle while treatment with the R9-QQA control peptide had no effect 

(average inflammation score of 28.7% for mice treated with R9-QQP 

normalized to vehicle control versus 143.5% for R9-QQA; p < 0.05).  Taken 

together, the reduced asthma phenotype indicated by the analysis of AHR 

correlates with the inhibition of mucus production and inflammation detected 

from the lung histological analyses described above.

! In order to characterize the inflammatory cells inhibited by R9-QQP, 

mice were treated with peptides as described above followed by collection 

and analysis of bronchoalveolar lavage (BAL) cells.  As determined by 

performing total cell counts, treatment of mice with R9-QQP resulted in a 

significant 53.7% decrease in the number of BAL cells collected as compared 

to treatment with vehicle (p < 0.0001) while treatment with R9-QQA had no 

significant effect on total BAL cell number.  For morphological analysis, BAL 

cells obtained from separate mice were attached to cytospin slides followed 

by staining using a modified Wright-Giemsa dye.  Qualitative evaluation of 
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cytospin slides revealed a robust infiltrate of inflammatory cells containing pink 

cytoplasmic granules consistent in appearance to eosinophils for slides 

prepared from mice treated with vehicle while slides from mice treated with 

R9-QQP had a reduced frequency of granulocytes relative to lung resident 

alveolar macrophages.

! For objective evaluation of inflammatory cells by flow cytometry, 

aliquots of BAL cells obtained from separate mice were stained with a cocktail 

of fluorophore-conjugated antibodies followed by FACS analysis for 

identification and quantification of eosinophils as a percentage of total 

leukocytes.  As revealed by this method, robust eosinophilia was induced 

upon treatment of mice with vehicle that were sensitized and challenged 

according to the asthma induction protocol in response to OVA as described 

above.  Significantly, the percentage of eosinophils obtained from BALF 

samples of mice treated with R9-QQP was reduced by 47.2% (p < 0.0001) as 

compared to treatment with vehicle while the R9-QQA control peptide had no 

effect.  For further investigation of the inhibitory effect of R9-QQP on 

eosinophilia, lung tissue was harvested from mice after performing 

bronchoalveolar lavage followed by dissociation into a lung cell suspension 

and staining for quantification of eosinophilia by flow cytometry.  Although less 

robust overall as compared to BALF samples, eosinophilia in lung tissue was 

significantly reduced by 48.1% (p < 0.001) for mice treated with R9-QQP as 

compared to treatment with vehicle while R9-QQA had no effect.  Thus, 
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quantitative analysis of BALF samples and lung tissue reveals that treatment 

of mice with R9-QQP significantly and specifically inhibits eosinophilia.  

Although their exact role in asthma pathogenesis is not completely 

understood, eosinophils are inducibly recruited to the lung mucosa in 

response to inhaled allergens and release inflammatory intermediates which 

are associated with disease severity (15-17).

! As central regulators of the inflammatory response, T helper type 2 

(Th2) lymphocytes are recruited to the lung mucosa by chemokines which are 

secreted by epithelial cells in response to inhaled allergen.  Once recruited, 

activated Th2 effector cells secrete sustained levels of the Th2 cytokines IL-4, 

IL-5 and IL-13 that together mediate the allergic asthmatic response (63-67).  

Specifically, IL-4 is involved in the maintenance and differentiation of the Th2 

effector population.  In addition, IL-4 secreted by Th2 effectors induces 

cognate B lymphocytes to undergo immunoglobulin class switching to 

generate and secrete IgE which is involved in the pathogenesis of clinical 

asthma.  Furthermore, IL-5 secreted by Th2 effectors at the lung mucosa 

recruits and activates eosinophils while IL-13 mediates mucus production and 

airway hyperresponsiveness of smooth muscle cells surrounding bronchioles 

during an active inflammatory response.

! In order to evaluate the effect of R9-QQP on T lymphocytes, separate 

aliquots of BAL cells obtained from individual mice that were treated according 

to the asthma protocol as described above were stained with anti-TCR 
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antibodies for quantification of T cells as a percentage of total leukocytes by 

flow cytometry.  In contrast to the effect on eosinophilia, analysis of BAL cells 

revealed that the percentage of T cells was not significantly affected upon 

treatment of mice with either R9-QQP inhibitor or R9-QQA peptide as 

compared to treatment with vehicle.  In terms of the model of asthma 

pathogenesis, these results apparently preclude the possibility that the 

inhibitory effects of R9-QQP on the parameters of asthma discussed above 

are due to the impaired recruitment of T cells to the lung mucosa as a result of 

defective chemokine signaling.  Instead, these results are consistent with a 

model of inhibition of Th2 effector function in terms of OVA-inducible cytokine 

secretion upon treatment with R9-QQP that results in impaired pathogenesis 

of asthma.

! Interestingly, these results seemingly disagree with the previously 

described defective recruitment of T cells to the lungs of Itk-/- as compared to 

WT mice that were sensitized and challenged with OVA (11).  However, 

differences in terms of the strategies employed for the inhibition of Itk activity 

in the two studies may account for the contrasting outcomes in terms of T cell 

recruitment.  For example, targeted inhibition of the Itk–SLP-76 interaction 

employed in the current study may allow Itk to function in a pathway 

downstream of chemokine receptor-mediated signaling as opposed to the 

completely impaired signaling in Itk-/- T cells.  In addition, analysis of T cells 

obtained from BALF samples in the current study versus from the lungs of 
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mice in the characterization of the Itk-/- mice may account for the different 

results reported in the two studies (11).  That is, the lung tissue may represent 

an intermediate step in the eventual migration of T cells to the lung mucosa as 

represented by cells collected following bronchoalveolar lavage.  According to 

this model, the small differences observed in the OVA-inducible recruitment of 

T cells in the lungs of WT versus Itk-/- mice may not be reflected in BALF 

samples which represent the final step in the migration of T cells following 

several challenges with OVA.

! In further pursuit of the inhibitory effect of R9-QQP, B cell function was 

examined as reflected by the levels of OVA-inducible IgE measured from the 

serum of mice treated according to the protocol described above.  As 

mentioned in the context of asthma pathogenesis, IL-4 secreted by Th2 

effector cells induces cognate B cells to secrete IgE which enters systemic 

blood circulation.  At the lung mucosa, IgE binds to high affinity Fc receptors 

expressed by resident mast cells and, upon IgE-mediated binding to inhaled 

allergen, results in the immediate release of pre-formed inflammatory 

intermediates which precipitate an asthma attack.  As revealed by ELISA, total 

serum IgE was highly induced in response to OVA for mice that were 

sensitized and challenged with OVA as compared to non-immunized control 

mice.  However, levels of serum IgE for mice treated with vehicle versus R9-

QQP were similarly induced in response to OVA.  One possibility implied by 

these results is that the Th2-dependent activation of B cells was not affected 
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by the in vivo treatment with R9-QQP.  According to this possibility, partial 

inhibition of Th2 effector function by R9-QQP may allow for the secretion of 

sufficient levels of IL-4 as required for B cell activation in the B cell germinal 

center of the lymph node while at the same time inhibiting the pathogenesis of 

asthma occurring in the lungs.  Alternatively, B cell activation may occur 

independently of Th2 effector function which may explain the lack of an effect 

of treatment with R9-QQP on the levels of serum IgE.  Independently of either 

interpretation pertaining to the effect of R9-QQP, the previous characterization 

of Itk-/- mice revealed that OVA-specific IgE was unexpectedly increased as 

compared to WT mice (11).  Later, an aberrant developmental pathway in Itk-/- 

mice leading to the increased generation of γδ T cells was demonstrated to 

underlie the dysregulated IgE secretion previously observed for these mice 

(77).

! In order to assess the effect of R9-QQP on Th2 cytokine production in 

the asthma model, lung draining lymph nodes were harvested and pooled for 

separate groups of mice that were treated with peptides according to the 

protocol described above.  For each experiment, lymphoid tissue was 

processed into a single cell suspension and DLN cells were seeded to 

replicate wells of round-bottom 96-well plates.  After incubation for 4 days, 

tissue culture supernatants were harvested and separate aliquots were tested 

for IL-4, IL-5 and IL-13 by ELISA.  In summary, OVA-inducible secretion of 

IL-4, IL-5 and IL-13 by DLN cells obtained from mice that were treated with 
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R9-QQP was significantly reduced as compared to similar cultures 

established from mice that were treated with vehicle while cytokine secretion 

was unaffected by DLN cells from mice teated with the R9-QQA control 

peptide.  Consistent with the defect reported for Itk-/- mice, the results obtained 

for treatment of mice with R9-QQP delivered in vivo support a model of 

inhibition of asthma pathogenesis resulting from impaired Th2 cytokine 

secretion.  Furthermore, the specific effect achieved by the dominant negative 

R9-QQP peptide in this model implicates the inducible Itk–SLP-76 association 

as an essential interaction which is intrinsic to T lymphocytes.

! As noted in the review of CD4+ Th2 effector development, Itk is 

differentially required for the generation of Th2 competent and effector cells 

upon primary and secondary TCR-mediated stimulation, respectively 

(100-102).  As the peptide treatment protocol employed in the current study 

encompasses both aspects of Th2 effector development, the question of when 

Itk activation is required in the context of the asthma model cannot be inferred 

from these data.  By analogy, the results of the in vitro addition of R9-QQP to 

splenocytes obtained from OVA-sensitized mice followed by restimulation with 

OVA suggest that R9-QQP may inhibit Th2 effector function when 

administered in vivo only during the challenge phase.  In order directly to 

address this issue, ongoing studies are aimed at modifying the 

comprehensive peptide treatment protocol to provide R9-QQP only at the 
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initial sensitization with OVA or during the challenge period followed by 

analysis of the asthma phenotype.

! In contrast to the previous studies using Itk knockout mice, the use of 

the cell permeable peptide R9-QQP as a tractable research tool allows for 

investigation into the Itk-dependent requirements during Th2 development in 

otherwise intact mice.  In terms of a therapeutic strategy, either use of R9-

QQP as a prophylactic provided prior to sensitization or as a treatment for 

ongoing asthma would be possible means of intervention aimed at disrupting 

asthma pathogenesis by blocking Itk activation.  More broadly, allergic and 

autoimmune disease progression for many other pathological conditions 

involving Th2 cells may be similarly affected by inhibition of Itk.

! Chapter 4, in part, is currently being prepared for submission for 

publication of the material.  Guimond, D.M., Cam, N.R., Hirve, N., Duan, W., 

Lambris, J.D., Croft, M., & Tsoukas, C.D (2012).  Treatment of Experimental 

Asthma Using a Novel Peptide Inhibitor of the Inducible T Cell Kinase.  The 

dissertation author was the primary author of this material.

170



Figure 25:  Model of inhibitory mechanism of R9-QQP in the OVA-inducible 
asthma model.
! A) Diagram of in vivo peptide treatment protocol.  B) CD4+ Th2 
development affected by R9-QQP competitive inhibitory peptide.  C-D) 
Diagram of lung tissue inflammation affected by treatment with R9-QQP or 
R9-QQA control peptides, respectively.
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Figure 26:  Schematic diagram compares and contrasts peptide treatment 
protocols.
! A) Peptide treatment throughout sensitization and challenge as 
performed in current study.  B-C) Future directions of treating mice with R9-
QQP at sensitization or challenge, respectively.
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5. APPENDIX
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5.1. Buffers and Solutions
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5.1.1. General

70% (v/v) Ethanol / dI H2O
for sterilizing surfaces

! -!for 2 L, combine:
! -!1.4 L 95% ethanol
! -!0.6 L dI H2O
! -!transfer to carboy

10 N NaOH
! -!work inside chemical fume hood
! -!for 50 mL, combine:
! -!30 mL ultrapure water
! -!20 g NaOH

add to water to reduce risk from exothermic reaction
! -!stir to dissolve
! -!adjust to final volume with ultrapure water
! -!transfer to 50 mL tube
! -!store at room temp.

1 N NaOH
! -!work inside chemical fume hood
! -!for 50 mL, combine in 50 mL tube:
! -!45 mL ultrapure water
! -!5 mL 10 N NaOH
! -!invert to mix
! -!store at room temp.

0.5 M Tris-HCl, pH 6.8 - 8.0
! -!for 100 mL, combine:
! -!80 mL ultrapure water
! -!6.1 g Tris base
! -!for 500 mL, combine:
! -!400 mL ultrapure water
! -!30.5 g Tris base
! -!stir to dissolve
! -!adjust pH to 6.8-8.0

add 10 N HCl drop-wise
! -!adjust to final volume with ultrapure water
! -!filter sterilize (0.22 µm PES)
! -!store at 4°C
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0.5 M EDTA, pH 8.0
372.24 g/mol

! -!for 100 mL, combine:
! -!80 mL ultrapure water
! -!18.6 g EDTA
! -!stir to dissolve overnight
! -!adjust pH to 8.0
! -!adjust to final volume with ultrapure water
! -!filter sterilize (0.22 µm PES)
! -!store at 4°C

0.5 M EGTA, pH 8.0
380.4 g/mol

! -!for 100 mL, combine:
! -!80 mL ultrapure water
! -!19 g EGTA
! -!stir to dissolve overnight
! -!adjust pH to 8.0
! -!adjust to final volume with ultrapure water
! -!filter sterilize (0.22 µm PES)
! -!store at 4°C

0.5 M Calcium Chloride
110.99 g/mol

! -!for 100 mL, combine:
! -!80 mL ultrapure water
! -!5.6 g CaCl2
! -!stir to dissolve
! -!adjust to final volume with ultrapure water
! -!filter sterilize (0.22 µm PES)
! -!store at 4°C

1 mM CaCl2 / PBS
! -!for 100 mL, combine:
! -!80 mL PBS
! -!0.2 mL 0.5 M CaCl2
! -!adjust to final volume with PBS
! -!filter sterilize (0.22 µm PES)
! -!store at 4°C
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Indo-1 Stock, 1,000x
Molecular Probes, Cat. # I-1223

! -!reconstitute at 2 mg/mL in DMSO
e.g., dissolve 50 µg aliquot in 25 µL of DMSO

! -!store at -20°C for ≤ 1 month

30 mM EGTA / 300 mM Tris-HCl, pH 7.4
! -!for 100 mL, combine:
! -!60 mL Tris-HCl, pH 7.4
! -!6 mL 0.5 M EGTA, pH 8.0
! -!stir to mix
! -!adjust final pH to 7.4
! -!filter sterilize (0.22 µm PES)
! -!store at 4°C

10x PBS, pH 7.4
! -!for 1 L, combine:
! -!80 g NaCl
! -!2 g KCl
! -!14.4 g Na2HPO4
! -!2.4 g KH2PO4
! -!800 mL ultrapure water
! -!stir to dissolve while heating at 30°C
! -!adjust to final volume with ultrapure water
! -!store at 4°C
! -!pre-heat to 37°C prior to use

to dissolve precipitated salts

1x PBS, pH 7.4
137 mM NaCl, 2.7 mM KCl, 10.1 mM Na2HPO4, 1.8 mM KH2PO4

! -!for 1 L, combine:
! -!100 mL 10x PBS
! -!800 mL ultrapure water
! -!stir to mix
! -!adjust pH to 7.4
! -!adjust to final volume with ultrapure water
! -!filter sterilize (0.22 µm PES)
! -!store at 4°C
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Texas Red Phalloidin Staining Buffer
- 5 U/mL Texas Red Phalloidin in Blocking Buffer
- 1 unit = amount required to stain 1 microscope slide

! -!for each slide, combine:
adjust volumes proportionally according to # of slides

! -!5 µL 200 U/mL Texas Red Phalloidin stock
- Invitrogen / Molecular Probes, Cat. # T7471
- 200 U/mL stock in methanol

! -!200 µL Blocking Buffer (1% BSA/PBS)

0.01 M Tris Base, pH 10.0
! -!for 1 L, combine:
! -!1.21 g Tris Base
! -!800 mL ultrapure water
! -!stir to dissolve
! -!adjust pH to 10.0
! -!adjust to final volume with ultrapure water
! -!transfer to glass bottle
! -!store at 4°C

1 mM Fluorescein Stock Solution
! -!for 100 mL, combine:
! -!33.2 mg fluorescein

MW:  332 g/mol
! -!80 mL 0.01 M Tris Base, pH 10.0
! -!stir to dissolve
! -!adjust to final volume with 0.01 M Tris Base, pH 10.0
! -!transfer to glass bottle
! -!cover bottle with foil to protect from light
! -!store at 4°C
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Kinase Reaction Buffer
! -!prepare fresh
! -!for 10 mL, combine:
! -!6 mL ultrapure water
! -!500 µL 1 M HEPES, pH 7.4

50 mM final
! -!100 µL 200 mM MnCl2

2 mM final
! -!20 µL 100 mM dATP

0.2 mM final
! -!1 mL 100 mM MgCl2

10 mM final
! -!500 µL 200 mM DTT

10 mM final
! -!adjust to final volume with ultrapure water
! -!filter sterilize (0.22 µm PES)
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5.1.2. DNA

1x LB
! -!for 1 L, combine in 2 L flask:
! -!10 g bacto-tryptone
! -!5 g bacto-yeast
! -!10 g NaCl
! -!1 L ultrapure water
! -!cover opening with foil

adhere using autoclave tape
! -!place flask inside autoclave-safe container

add tap water to base
! -!autoclave for 30 min. on wet cycle; slow exhaust

takes 1 hr. total time
! -!cool to room temp.
! -!store at 4°C

2x YT
! -!for 1 L, combine in 2 L flask:
! -!16 g bacto-tryptone
! -!10 g bacto-yeast
! -!5 g NaCl
! -!1 L ultrapure water
! -!cover opening with foil

adhere using autoclave tape
! -!place flask inside autoclave-safe container

add tap water to base
! -!autoclave for 30 min. on wet cycle; slow exhaust

takes 1 hr. total time
! -!cool to room temp.
! -!store at 4°C

1,000x Ampicillin
50 mg/mL ampicillin in ultrapure water

! -!solid stored at -20°C
! -!prepare aliquots and store at -20°C
! -!use at 50 µg/mL final
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500x Kanamycin
10 mg/mL kanamycin in ultrapure water

! -!solid stored at -20°C
! -!prepare aliquots and store at -20°C
! -!use at 20 µg/mL final

Resuspension Buffer (#1), pH 7.5
! -!for 500 mL, combine:
! -!3.9 g Tris base
! -!1.9 g EDTA
! -!50 mg RNase A
! -!400 mL ultrapure water
! -!stir to dissolve
! -!adjust pH to 7.5
! -!adjust to final volume with ultrapure water
! -!filter sterilize (0.22 µm PES)
! -!store at 4°C

Lysis Buffer (#2)
! -!for 500 mL, combine:
! -!25 g SDS
! -!4 g NaOH
! -!400 mL ultrapure water
! -!stir to dissolve
! -!adjust to final volume with ultrapure water
! -!store at room temp.

Neutralization Buffer (#3), pH 4.8
! -!for 500 mL, combine:
! -!64.8 g KAc
! -!400 mL ultrapure water
! -!stir to dissolve
! -!adjust pH to 4.8

add 10 N HCl drop-wise
! -!adjust to final volume with ultrapure water
! -!store at 4°C
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Column Wash
! -!for 1 L, combine:
! -!7.9 g KAc
! -!400 mL ultrapure water
! -!stir to dissolve
! -!continue to add:
! -!16.6 mL 0.5M Tris-HCl, pH 7.4
! -!80 µL 0.5M EDTA, pH 8.0
! -!579 mL ethanol (molecular biology grade)
! -!adjust pH to 7.5
! -!adjust to final volume with ultrapure water
! -!store at 4°C

3.0 M Sodium Acetate, pH 5.2
! -!for 100 mL, combine:
! -!40.8 g sodium acetate

136.1 g/mol
! -!80 mL ultrapure water
! -!adjust pH to 5.2
! -!adjust to final volume with ultrapure water
! -!store at 4°C

50x TAE Buffer
! -!for 500 mL, combine:
! -!121 g Tris base
! -!250 mL ultrapure water
! -!stir to dissolve
! -!continue to add:
! -!28.6 mL glacial acetic acid
! -!50 mL 0.5 M EDTA, pH 8.0
! -!adjust to final volume with ultrapure water
! -!store at room temp.

1x TAE Buffer
! -!for 500 mL, combine:
! -!10 mL 50x TAE Buffer
! -!490 mL ultrapure water
! -!store at room temp.
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1x TE Buffer, pH 7.5 / 8.0
! -!for 100 mL, combine:
! -!80 mL ultrapure water
! -!2 mL 0.5 M Tris-HCl, pH 7.5 / 8.0

10 mM final
! -!200 µL 0.5 M EDTA, pH 8.0

1 mM final
! -!stir to mix
! -!adjust pH to 7.5 / 8.0
! -!adjust to final volume with ultrapure water
! -!filter sterilize (0.22 µm PES)
! -!store at 4°C

0.1x TE Buffer, pH 7.5 / 8.0
! -!for 100 mL, combine:
! -!80 mL ultrapure water
! -!10 mL 1x TE Buffer, pH 7.5 / 8.0

1 mM Tris-HCl, 0.1 mM EDTA final
! -!stir to mix
! -!adjust pH to 7.5 / 8.0
! -!adjust to final volume with ultrapure water
! -!filter sterilize (0.22 µm PES)
! -!store at 4°C
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5.1.3. Mouse Tail Digestion

Tail Solubilization Buffer (TSB)
! -!1 mL TSB per 1 cm tail fragment
! -!prepare fresh
! -!for 10 mL, combine in 15 mL tube:
! -!7 mL ultrapure water
! -!1 mL 10x SET

1% SDS, 5 mM EDTA, 10 mM Tris-HCl, pH 8.0 final
! -!2 mL 0.5 M NaCl

100 mM final
! -!invert to mix

Proteinase K Reconstitution Buffer
! -!for 100 mL, combine:
! -!40 mL ultrapure water
! -!2 mL 0.5 M Tris-HCl, pH 7.4

10 mM final
! -!4 mL 0.5 M CaCl2

20 mM final
! -!50 mL glycerol

50% final
! -!stir to mix
! -!adjust pH to 7.4
! -!adjust to final volume with ultrapure water
! -!prepare aliquots in 50 mL tubes
! -!store at -20°C

20 mg/mL Proteinase K
! -!reconstitute at 20 mg/mL in Proteinase K Reconstitution Buffer
! -!allow to hydrate for ~10 mins. at room temp.
! -!store at -20°C
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Tail Salts
! -!for 100 mL:
! -!pre-heat 90 mL of ultrapure water to 30°C with stirring
! -!gradually add the following salts until completely dissolved:
! -!24.6 g NaCl

4.21 M final
! -!4.7 g KCl

0.63 M final
! -!continue to add:
! -!2 mL 0.5 M Tris-HCl, pH 8.0

10 mM final
! -!cool to room temp.
! -!adjust pH to 8.0
! -!adjust to final volume with ultrapure water
! -!store at room temp.

10x SDS, EDTA, Tris (SET), pH 8.0
! -!for 100 mL, combine:
! -!60 mL ultrapure water
! -!10 g SDS

10% final
! -!stir to dissolve for ~1 hr at 30°C
! -!continue to add:
! -!10 mL 0.5 M EDTA, pH 8.0

50 mM final
! -!20 mL 0.5 M Tris-HCl, pH 8.0

100 mM final
! -!stir to mix
! -!adjust final pH to 8.0
! -!adjust to final volume with ultrapure water
! -!filter sterilize (0.22 µm PES)
! -!store at room temp.
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5.1.4. Cell Culture / In Vitro

Freezing Medium
10% DMSO + 90% FBS

! -!prepare fresh
! -!for 10 mL, combine:
! -!1 mL DMSO, cell culture grade
! -!9 mL FBS
! -!heat-inactivated
! -!invert to mix

10x Erythrosine B
! -!for 100 mL, combine:
! -!80 mL PBS
! -!1.5 g erythrosine B

1.5% final
! -!stir to dissolve
! -!adjust to final volume with PBS
! -!prepare aliquots in 50 mL tubes
! -!store at 4°C

1x Erythrosine B
! -!for 100 mL, combine:
! -!80 mL PBS
! -!10 mL 10x Erythrosine B

0.15% final
! -!stir to mix
! -!adjust to final volume with PBS
! -!aliquot 10 mL per 15 mL tube
! -!store at 4°C

1% Sodium Deoxycholate
for endotoxin removal

! -!for 25 mL, combine:
! -!25 mL water, cell culture grade
! -!250 mg sodium deoxycholate
! -!vortex to dissolve
! -!filter (0.22 µm PES)
! -!store at 4°C

Jurkat / Raji Wash Medium (WM)
RPMI-1640 without supplements
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293 Wash Medium (WM)
DMEM without supplements

complete RPMI (cRPMI)
RPMI-1640 + 10 mM HEPES, 2 mM L-glutamine, 100 I.U./mL penicillin and 
100 µg/mL streptomycin

! -!for 515 mL, combine:
! -!500 mL bottle RPMI-1640
! -!5 mL 1 M HEPES
! -!stored at 4°C
! -!5 mL 200 mM L-glutamine
! -!stored at -20°C
! -!5 mL 10,000 I.U./mL penicillin - 10,000 µg/mL streptomycin
! -!stored at -20°C
! -!invert to mix
! -!store at 4°C for ≤ 2 months

complete DMEM (cDMEM)
DMEM + 10 mM HEPES, 2 mM L-glutamine, 100 I.U./mL penicillin and 100 

µg/mL streptomycin
! -!for 515 mL, combine:
! -!500 mL bottle DMEM
! -!5 mL 1 M HEPES
! -!stored at 4°C
! -!5 mL 200 mM L-glutamine
! -!stored at -20°C
! -!5 mL 10,000 I.U./mL penicillin - 10,000 µg/mL streptomycin
! -!stored at -20°C
! -!invert to mix
! -!store at 4°C for ≤ 2 months

Jurkat / Raji Growth Medium (GM)
cRPMI + 10% FBS

! -!for 565 mL, combine:
! -!515 mL bottle cRPMI
! -!50 mL FBS
! -!heat-inactivated
! -!invert to mix
! -!store at 4°C for ≤ 2 months
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293 Growth Medium (GM)
cDMEM + 10% FBS

! -!for 565 mL, combine:
! -!515 mL bottle cDMEM
! -!50 mL FBS
! -!heat-inactivated
! -!invert to mix
! -!store at 4°C for ≤ 2 months

Transfection Medium (TM)
RPMI-1640 / DMEM + 10 mM HEPES, 2 mM L-glutamine and 10% FBS 
(without penicillin-streptomycin)

! -!for 560 mL, combine:
! -!500 mL bottle RPMI-1640 / DMEM
! -!5 mL 1 M HEPES
! -!stored at 4°C
! -!5 mL 200 mM L-glutamine
! -!stored at -20°C
! -!50 mL FBS
! -!heat-inactivated
! -!invert to mix
! -!store at 4°C for ≤ 2 months

Starvation Medium
cRPMI / cDMEM + 0.2% FBS

! -!for 516 mL, combine:
! -!515 mL bottle cRPMI / cDMEM
! -!1 mL FBS
! -!heat-inactivated
! -!invert to mix
! -!store at 4°C for ≤ 2 months

Cell Line Nucleofector Solution V
for use with Jurkat Amaxa Nucleofection Protocol

! -!for 2.75 mL, combine:
! -!2.25 mL Cell Line Nucleofector Solution V
! -!0.5 mL Supplement 1
! -!mix gently
! -!store at 4°C for ≤ 3 months

188



T Cell Medium (TCM)
cRPMI + 10% FBS + 0.05 mM 2-ME

! -!for 565.5 mL, combine:
! -!515 mL bottle cRPMI
! -!50 mL FBS
! -!heat-inactivated
! -!500 µL 1,000x 2-ME
! -!invert to mix
! -!store at 4°C for ≤ 2 months

Buffer 1
for CD4+ purification kit

! -!for ~250 mL, combine:
! -!200 mL PBS
! -!250 µL FBS

0.1% final
! -!heat-inactivated 
! -!1 mL 0.5 M EDTA, pH 8.0

2 mM final
! -!stir to mix
! -!adjust final pH to 7.4
! -!adjust to final volume with PBS
! -!filter (0.22 µm PES)
! -!store at 4°C

1,000x 2-Mercaptoethanol (2-ME)
50 mM

! -!for ~10 mL, combine:
! -!10 mL RPMI-1640
! -!35 µL 14.3 M 2-ME, cell culture grade
! -!invert to mix
! -!aliquot 600 µL per microcentrifuge tube
! -!store at -20°C

189



ACK Lysis Buffer
! -!for 1 L, combine:
! -!8.29 g NH4Cl

0.15 M final
! -!1 g KHCO3

10 mM final
! -!37.2 mg Na2EDTA

0.1 mM final
! -!800 mL ultrapure water
! -!stir to dissolve
! -!adjust pH to 7.4
! -!adjust to final volume with ultrapure water
! -!filter sterilize (0.22 µm PES)
! -!store at room temp.

Mouse T Cell Nucleofector Solution
for use with Mouse T Cell Amaxa Nucleofection Protocol

! -!for 2.75 mL, combine:
! -!2.25 mL Mouse T Cell Nucleofector Solution
! -!0.5 mL Mouse T Cell Solution Supplement
! -!mix gently
! -!store at 4°C for ≤ 3 months

Mouse T Cell Nucleofector Medium
for use with Mouse T Cell Amaxa Nucleofection Protocol

! -!for 107 mL, combine:
! -!100 mL Mouse T Cell Nucleofector Medium

supplied with kit
! -!1 mL 200 mM L-glutamine

2 mM final
! -!stored at -20°C
! -!5 mL FBS, heat-inactivated

5% final
! -!1 mL Medium Component A

supplied with kit
! -!mix gently
! -!store at 4°C
! -!prior to use, supplement with Medium Component B as follows:
! -!remove aliquot from medium above supplemented with L-

glutamine, FBS and Component A
! -!add 10 µL Medium Component B per 1 mL
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200 µg/mL PMA
! -!reconstitute in DMSO
! -!store at -20°C

10 mM Ionomycin (IM)
! -!reconstitute at 7.5 mg/mL in DMSO
! -!store at -20°C

100x PMA/IM
! -!prepare fresh in microcentrifuge tube
! -!for 50 µL, combine:
! -!40 µL RPMI-1640
! -!5 µL 200 µg/mL PMA

1/10 dilution of stock
! -!5 µL 10 mM Ionomycin

1/10 dilution of stock
! -!pipet up and down to mix

murine rIL-2
500 ng/mL in TCM

! -!quick-spin vial
! -!reconstitute at 100 µg/mL in water (cell culture grade)
! -!dilute 1:200 in TCM to prepare 500 ng/mL working solution

5 ng/mL final
! -!store at -20°C

murine rIL-4
1 µg/mL in TCM

! -!quick-spin vial
! -!reconstitute at 100 µg/mL in water (cell culture grade)
! -!dilute 1:100 in TCM to prepare 1 µg/mL working solution

10 ng/mL final
! -!store at -20°C

murine rIL-12
100 ng/mL in TCM

! -!quick-spin vial
! -!reconstitute at 200 µg/mL in PBS (cell culture grade)
! -!dilute 1:2,000 in TCM to prepare 100 ng/mL working solution

1 ng/mL final
! -!store at -20°C
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5.1.5. Protein Biochemistry

10% Ammonium Persulfate (APS)
! -!prepare fresh in microcentrifuge tube
! -!for 500 µL, combine:
! -!50 mg APS
! -!500 µL ultrapure water
! -!vortex to dissolve
! -!keep on ice

TEMED
! -!aliquot 500 µL per microcentrifuge tube
! -!store at 4°C

5 mg/mL Leupeptin
! -!reconstitute in ultrapure water
! -!aliquot 50 µL per microcentrifuge tube
! -!store at 4°C

1 mg/mL Pepstatin A
! -!reconstitute in ethanol (molecular biology grade)
! -!aliquot 500 µL per microcentrifuge tube
! -!store at -20°C

100 mM PMSF
! -!reconstitute at 17.4 mg/mL in isopropanol (molecular biology grade)
! -!aliquot 500 µL per microcentrifuge tube
! -!store at -20°C

100 mM NaO
! -!prepare fresh in microcentrifuge tube
! -!for 1 mL, combine:
! -!18 mg NaO
! -!1 mL ultrapure water
! -!vortex to dissolve
! -!keep on ice
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NP-40 Lysis Buffer
! -!for 100 mL, combine:
! -!80 mL ultrapure water
! -!0.9 g NaCl

150 mM final
! -!stir to dissolve
! -!continue to add:
! -!4 mL 0.5 M Tris-HCl, pH 7.4

20 mM final
! -!80 µL 0.5 M EDTA, pH 8.0

0.4 mM final
! -!1 mL NP-40

1% final
! -!stir to mix
! -!adjust pH to 7.4
! -!adjust to final volume with ultrapure water
! -!filter sterilize (0.22 µm PES)
! -!store at 4°C

Complete Lysis Buffer (CLB)
! -!prepare fresh in microcentrifuge tube
! -!for ~1 mL, combine:
! -!1 mL NP-40 Lysis Buffer
! -!1 µL 5 mg/mL Leupeptin

5 µg/mL final
! -!5 µL 1 mg/mL Pepstatin A

5 µg/mL final
! -!10 µL 100 mM PMSF

1 mM final
! -!10 µL 100 mM NaO

1 mM final
! -!vortex to mix
! -!keep on ice
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2x Laemmli Sample Buffer (LB)
! -!for 10 mL, combine in small beaker:
! -!2.5 mL 0.5 M Tris-HCl, pH 6.8

125 mM final
! -!2 mL glycerol

20% v/v final
! -!0.4 g SDS

4% final
! -!0.3 g DTT

0.2 M final
! -!stir to dissolve at room temp.
! -!continue to add while mixing:
! -!2 µL Bromophenol Blue

0.02% final
! -!adjust to final volume with ultrapure water (in 15 mL tube)
! -!invert to mix
! -!aliquot 500 µL per microcentrifuge tube
! -!store at -20°C

30% Acrylamide
! -!prepare inside chemical fume hood; wear gloves and face mask
! -!for 100 mL, combine:
! -!60 mL ultrapure water
! -!pre-heat to 30°C
! -!29 g acrylamide
! -!1 g N,N'-methylenebisacrylamide
! -!stir to dissolve
! -!cool to room temp.
! -!adjust pH to ≤ 7.0
! -!adjust to final volume with ultrapure water
! -!filter (0.4 µm PES)
! -!wrap bottle in aluminum foil, protect from light
! -!store at 4°C

4x (1.5 M) Running Gel Buffer, pH 8.8
! -!for 100 mL, combine:
! -!80 mL ultrapure water
! -!18.7 g Tris base
! -!0.4 g SDS
! -!stir to dissolve
! -!adjust pH to 8.8
! -!adjust to final volume with ultrapure water
! -!filter sterilize (0.22 µm PES)
! -!store at 4°C
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4x (0.5 M) Stacking Gel Buffer, pH 6.8
! -!for 100 mL, combine:
! -!80 mL ultrapure water
! -!6.1 g Tris base
! -!0.4 g SDS
! -!stir to dissolve
! -!adjust pH to 6.8
! -!adjust to final volume with ultrapure water
! -!filter sterilize (0.22 µm PES)
! -!store at 4°C

6% Acrylamide Gel Buffer
for running gel and plug

! -!prepare fresh
! -!for 10 mL, combine in 15 mL tube:
! -!5.5 mL ultrapure water
! -!2.5 mL 4x Running Buffer

1x final
! -!2 mL 30% Acrylamide

6% final
! -!vortex to mix

7.5 % Acrylamide Gel Buffer
for running gel and plug

! -!prepare fresh
! -!for 10 mL, combine in 15 mL tube:
! -!5.0 mL ultrapure water
! -!2.5 mL 4x Running Buffer

1x final
! -!2.5 mL 30% Acrylamide

7.5% final
! -!vortex to mix

9% Acrylamide Gel Buffer
for running gel and plug

! -!prepare fresh
! -!for 10 mL, combine in 15 mL tube:
! -!4.5 mL ultrapure water
! -!2.5 mL 4x Running Buffer

1x final
! -!3.0 mL 30% Acrylamide

9% final
! -!vortex to mix
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Stacking Gel Buffer
! -!prepare fresh
! -!for 5 mL, combine in 15 mL tube:
! -!3 mL ultrapure water
! -!1.25 mL 4x Stacking Buffer

1x final
! -!670 µL 30% Acrylamide

4% final
! -!vortex to mix

5x Running Buffer
! -!for 1 L, combine:
! -!800 mL ultrapure water
! -!15.1 g Tris base
! -!72 g glycine
! -!5 g SDS
! -!stir to dissolve
! -!do not adjust pH

will be ~8.3 when diluted to 1x
! -!adjust to final volume with ultrapure water
! -!transfer to glass bottle
! -!store at 4°C

1x Running Buffer
! -!prepare in graduated cylinder
! -!for 1 L, combine:
! -!800 mL ultrapure water
! -!200 mL 5x Running Buffer
! -!transfer to glass bottle
! -!store at 4°C
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Western Transfer Buffer (WTB), pH 8.0
! -!for 1 L, combine:
! -!800 mL ultrapure water
! -!3 g Tris base

25 mM final
! -!14.4 g glycine

192 mM final
! -!stir to dissolve
! -!continue to add:
! -!50 mL methanol, ACS grade

5% final
! -!stir to mix
! -!adjust pH to 8.0 using 10 N NaOH
! -!adjust to final volume with ultrapure water
! -!filter sterilize (0.22 µm PES)
! -!store at 4°C

Coomassie Stain
50% methanol, 10% acetic acid + 0.05% Brilliant Blue R-250

! -!for 200 mL, combine:
! -!100 mL methanol
! -!0.1 g Brilliant Blue R-250
! -!mix until completely dissolved
! -!continue to add:
! -!20 mL acetic acid
! -!adjust to final volume with ultrapure water
! -!prepare aliquots in 50 mL tubes

reuse each aliquot several times

Ponceau Dye
! -!for 100 mL, combine:
! -!80 mL glacial acetic acid
! -!2 g Ponceau dye

2% final
! -!stir to dissolve
! -!adjust to final volume with glacial acetic acid
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TBST, pH 7.4
! -!for 2 L, combine:
! -!1.8 L ultrapure water
! -!2.5 g Tris base

10 mM final
! -!17.5 g NaCl

150 mM final
! -!stir to dissolve
! -!continue to add:
! -!2 mL Tween 20

0.1% final
! -!stir to mix
! -!adjust pH to 7.4 with 10 N HCl
! -!adjust to final volume with ultrapure water
! -!filter sterilize (0.22 µm PES)
! -!aliquot to 1 L bottles
! -!store at 4°C

Blocking Buffer
! -!for 100 mL, combine:
! -!80 mL TBST
! -!pre-heat to 30°C
! -!5 g BSA

5% final
! -!stir to dissolve
! -!adjust to final volume with TBST
! -!aliquot to 50 mL tubes
! -!store at -20°C

Blotting Solution
! -!prepare fresh
! -!for 15 mL, combine in 15 mL tube:
! -!7.5 mL Blocking Buffer

2.5% BSA final
! -!7.5 mL TBST
! -!invert to mix
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Stripping Buffer, pH 6.8
! -!for 100 mL, combine:
! -!60 mL TBST
! -!7.9 g Tris base
! -!20 g SDS
! -!stir to dissolve
! -!continue to add:
! -!7 mL β-mercaptoethanol
! -!adjust pH to 6.8
! -!adjust to final volume with TBST
! -!store at room temp.
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5.1.6. Microscopy / FACS

10% (w/v) Sodium Azide (NaN3)
! -!for 50 mL, combine:
! -!5 g NaN3
! -!40 mL ultrapure water
! -!stir to dissolve
! -!adjust to final volume with ultrapure water
! -!store at 4°C

FACS Buffer
0.5% BSA/PBS + 0.02% (w/v) NaN3

! -!for 1 L, combine:
! -!800 mL ultrapure water
! -!100 mL 10x PBS
! -!pre-heat to 37°C
! -!heat to 30°C
! -!continue to add:
! -!5 g BSA
! -!stir to dissolve
! -!continue to add:
! -!2 mL 10% (w/v) NaN3
! -!cool to room temp.
! -!adjust pH to 7.4
! -!adjust to final volume with ultrapure water
! -!store at 4°C

4% Paraformaldehyde (PFA) / PBS
! -!work inside chemical fume hood
! -!for 100 mL, combine:
! -!90 mL PBS
! -!heat to 60°C
! -!4 g paraformaldehyde
! -!for 500 mL:
! -!450 mL PBS
! -!heat to 60°C
! -!20 g paraformaldehyde
! -!stir to dissolve completely
! -!cool to room temp.
! -!adjust pH to 7.0 by adding 1 M NaOH
! -!adjust to final volume with ultrapure water
! -!aliquot to 15 mL tubes / microcentrifuge tubes
! -!store at -20°C for ≤ 1 year
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2% Paraformaldehyde (PFA) / PBS
! -!prepare by diluting 4% paraformaldehyde 1:2 (v/v) in PBS
! -!aliquot to 15 mL tubes / microcentrifuge tubes
! -!store at -20°C for ≤ 1 year

0.01% (w/v) Poly-L-Lysine (pLL) / H2O
! -!for 10 mL, combine in 50 mL tube:
! -!1 mL 0.1% (w/v) poly-L-lysine

Sigma, Cat. # P8920; 100 mL
! -!9 mL ultrapure water
! -!invert tube to mix
! -!store at room temp.

Microsphere Storage Buffer
0.05% BSA/PBS (0.5 mg/mL)

Microsphere Blocking Buffer
0.1% BSA/PBS (1 mg/mL)

Permeabilization Buffer
0.1% (v/v) Triton X-100 / PBS

! -!for 100 mL, combine:
! -!100 mL PBS
! -!100 µL Triton X-100

Sigma, Cat. # X-100
! -!stir to dissolve
! -!store at 4°C

Blocking Buffer
1% BSA/PBS

! -!for 100 mL, combine:
! -!90 mL PBS
! -!1 g BSA

1% final
! -!stir to dissolve
! -!adjust to final volume with PBS
! -!store at 4°C
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5.1.7. ELISA

Coating Buffer
0.1 M sodium carbonate, pH 9.5

! -!for 250 mL, combine:
! -!1.8 g NaHCO3

84.8 mM final
! -!398 mg Na2CO3

150 mM final
! -!200 mL ultrapure water
! -!stir to dissolve
! -!adjust pH to 9.5
! -!adjust to final volume with ultrapure water
! -!filter (0.22 µm PES)
! -!store at 4°C for ≤ 4 weeks

Blocking Buffer
1% BSA / PBS, pH 7.4

! -!for 250 mL, combine:
! -!200 mL PBS
! -!pre-heat to 30°C with stirring
! -!2.5 g BSA, Fraction V
! -!stir until completely dissolved
! -!adjust to final volume with PBS
! -!filter (0.22 µm PES)
! -!store at 4°C for ≤ 4 weeks

Reaction Buffer
0.1% BSA / PBS, pH 7.4

! -!for 250 mL, combine:
! -!200 mL PBS
! -!pre-heat to 30°C with stirring
! -!250 mg BSA, Fraction V
! -!stir until completely dissolved
! -!adjust to final volume with PBS
! -!filter (0.22 µm PES)
! -!store at 4°C for ≤ 4 weeks
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Wash Buffer
0.05% Tween-20 / PBS, pH 7.4

! -!prepare in large beaker
! -!for 2 L, combine:
! -!200 mL 10x PBS
! -!~1.6 L ultrapure water
! -!1 mL Tween-20
! -!stir to mix
! -!adjust pH to 7.4
! -!adjust to final volume with ultrapure water
! -!filter (0.22 µm PES)
! -!transfer to 1 L bottles
! -!store at 4°C for ≤ 4 weeks

Stop Solution
1 M H3PO4 / H2O

! -!for 100 mL, combine in graduated cylinder:
! -!6.8 mL 14.7 M H3PO4

1 M final
! -!ultrapure water to final volume
! -!transfer to glass bottle
! -!store at room temp.
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5.1.8. ICCS

FACS Buffer
see 'General' section

PBS
see 'General' section

2% Paraformaldehyde / PBS
see 'General' section

Saponin, 10% (w/v)
! -!for 10 mL, combine in 15 mL tube:
! -!1 g saponin

Sigma, Cat. # S-7900
! -!8 mL PBS, pH 7.4
! -!place tube in 37°C water bath to dissolve
! -!adjust to final volume with PBS
! -!filter (0.22 µm)
! -!aliquot 1 mL per microcentrifuge tube
! -!store at -20°C

once thawed, the 10% solution is stable for several months at 4°C

Permeabilization Buffer
0.5% BSA + 0.1% saponin + 0.02% NaN3 in PBS

! -!for 100 mL, combine:
! -!80 mL FACS Buffer
! -!1 mL 10% (w/v) saponin
! -!stir to mix
! -!adjust to final volume with FACS Buffer
! -!store at 4°C for ≤ 6 months

Blocking Buffer
5% BSA + 0.1% saponin in PBS

! -!for 10 mL, combine in 15 mL tube:
! -!500 mg BSA
! -!8 mL Permeabilization Buffer
! -!place tube in 37°C water bath to dissolve
! -!adjust to final volume with Permeabilization Buffer
! -!centrifuge for 30 min. at 15,000 g

to sediment solids
! -!transfer supernatant to new tube
! -!store at 4°C for ≤ 6 months
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5.1.9. ELISPOT

1x PBS, pH 7.4
! -!see 'General' section for instructions

Wash Buffer
! -!see 'ELISA' section for instructions

Blocking Buffer
1% BSA / PBS + 0.05% Tween-20, pH 7.4

! -!for 250 mL, combine:
! -!225 mL Wash Buffer (see above)
! -!pre-heat to 30°C with stirring
! -!2.5 g BSA, Fraction V
! -!stir until completely dissolved
! -!adjust to final volume with Wash Buffer
! -!filter sterilize, 0.22 µm PES
! -!store at 4°C

1.5 M Sodium Acetate, pH 5.2
! -!for 100 mL, combine:
! -!20.4 g sodium acetate

CH3COONa
! -!80 mL ultrapure water
! -!stir until completely dissolved
! -!adjust pH to 5.2 using acetic acid (not HCl)
! -!adjust to final volume with ultrapure water
! -!filter sterilize (0.22 µm PES)
! -!store at room temp.

AEC / DMF Solution
! -!prepare fresh
! -!combine in glass scintillation vial:
! -!1 tablet AEC (3-amino-9-ethyl-carbazole)

Sigma, Cat. # A6926-50TAB
! -!1 mL DMF (N, N, -dimethylformamide)

Sigma, Cat. # D4551
! -!agitate to dissolve completely
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Substrate Solution
! -!prepare fresh
! -!combine in 50 mL tube:
! -!3.33 mL 1.5 M sodium acetate, pH 5.2 (see above)
! -!ultrapure water to 50 mL
! -!825 µL AEC / DMF (see above)
! -!25 µL 30% H2O2
! -!invert tube to mix
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5.1.10. OVA System / Asthma

0.2 mg/mL OVA/PBS
for i.p. sensitization

! -!prepare fresh in 15 mL Falcon tube
! -!remove OVA powder from refrigerator

equilibrate to room temp. before opening
! -!cut 3"x3" sheet of weigh paper into 1/4 size and tare on analytical 

balance
! -!weigh 2-3 mg OVA, grade V

Sigma, Cat. # A-5503
! -!reconstitute in sterile PBS at 0.2 mg/mL

nominal concentration by gross mass
! -!invert tube to dissolve; do not vortex

OVA/Alum, 2:1 (v/v)
! ⁃! for i.p. sensitization
! ⁃! 20 µg OVA / 2 mg alum / 150 µL i.p. per mouse

! -!prepare fresh in 50 mL Falcon tube
! -!for 20 mice (3 mL), combine:
! -!2 mL 0.2 mg/mL OVA/PBS

- 0.133 mg/mL final
- prepared fresh (see above)

! -!1 mL 40 mg/mL Imject alum
- 13.33 mg/mL final
- Pierce / Thermo Scientific, Cat. # 77161

! -!incubate on tube rotator for ≥ 2 hours at room temp. to adsorb OVA to 
alum

0.5 mg/mL OVA/PBS
- for i.n. challenge
- 10 µg OVA / 20 µL i.n. per mouse

! -!prepare fresh in 15 mL tube
! -!remove OVA powder for refrigerator

equilibrate to room temp. before opening
! -!cut 3"x3" sheet of weigh paper into 1/4 size and tare on analytical 

balance
! -!weigh 2-3 mg OVA, grade V

Sigma, Cat. # A-5503
! -!reconstitute in sterile PBS at 0.5 mg/mL

nominal concentration by gross mass
! -!invert tube to dissolve -- do not vortex
! -!aliquot to microcentrifuge tubes for each challenge day
! -!store single-use aliquots at -20°C for ≤ 1 week
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1% OVA/PBS
- for aerosol challenge
- 10 mg/mL OVA/PBS

! -!prepare fresh for each challenge day in 50 mL tube
! -!remove OVA powder from refrigerator

equilibrate to room temp. before opening
! -!weigh ~200 mg OVA, grade V

Sigma, Cat. # A-5503
! -!reconstitute at 10 mg/mL in sterile PBS

nominal concentration by gross mass

100 mg/mL Collagenase D
for lung tissue dissociation

! -!equilibrate lyophilizate to room temp.
! -!reconstitute in PBS
! -!allow to hydrate for ~10 min.
! -!aliquot 250 µL per microcentrifuge tube
! -!store at -20°C

10 mg/mL DNase I
for lung tissue dissociation

! -!reconstitute in PBS
! -!aliquot to microcentrifuge tubes
! -!store at -20°C

10 mg/mL OVA
for re-stimulation in vitro

! -!prepare in 15 mL tube
! -!remove OVA powder from refrigerator

equilibrate to room temp. before opening
! -!cut 3"x3" sheet of weigh paper into 1/4 size and tare on analytical 

balance
! -!weigh ~20 mg OVA, grade V

Sigma, Cat. # A-5503
! -!reconstitute at 10 mg/mL in sterile PBS

nominal concentration by gross mass
! -!invert tube to dissolve completely -- do not vortex
! -!prepare 120 µL aliquots in microcentrifuge tubes
! -!store single-use aliquots at -80°C
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100 mg/mL Ketamine HCl
! -!Ketaset III

Fort Dodge Animal Health, NDC 0856-4403-01
! -!supplied at 100 mg/mL (10x stock)
! -!store at room temp. in locked cabinet

20 mg/mL Xylazine HCl
! -!AnaSed

Lloyd Laboratories, Cat. # 4811
! -!supplied at 20 mg/mL (20x stock)
! -!store at room temp. in locked cabinet

Ketamine / Xylazine Cocktail
for 25 mg mouse,
- 80 mg/kg ketamine and 8 mg/kg xylazine
- 2 mg ketamine / 0.2 mg xylazine / 200 µL i.p. per mouse

! -!prepare fresh
! -!for 15 mice (3 mL), combine in 50 mL tube:
! -!300 µL 100 mg/mL ketamine

see above; 10 mg/mL final
! -!150 µL 20 mg/mL xylazine

see above; 1 mg/mL final
! -!2.55 mL sterile PBS
! -!keep at room temp.

5% Methacholine (MCh)
- 50 mg/mL methacholine in PBS (Sigma, Cat. # A2251)
- for AHR assay:  0, 3, 6, 12 and 24 mg/mL methacholine doses

! -!for ≥ 5 mL:
! -!prepare in 15 mL tube
! -!remove powder from -20°C and equilibrate to room temp. 

before opening
! -!weigh ≥ 250 mg
! -!dissolve in PBS at 50 mg/mL
! -!prepare 10 mL of each dose in 15 mL tubes
! -!dilute to 24 mg/mL in PBS
! -!add 4.8 mL of 50 mg/mL stock
! -!add 5.2 mL of PBS
! -!invert to mix
! -!prepare 1:2 serial dilutions at 12, 6 and 3 mg/mL in PBS
! -!dilute serially 1:2 in PBS
! -!store at room temp.

209



5.2. Protocols
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5.2.1. General
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Pipet Tip Sterilization
for routine bench work – do not use for tissue culture work (requires filter tips)

Equipment:
! -!autoclave
! -!lab oven

Materials:
! -!pipet tips, bulk packaging
! -!10 µL

VWR, Cat. # 82028-528
! -!200 µL

Fisher, Cat. # 02-681-134
! -!200 µL gel-loading

Fisher, Cat. # 02-707-181
! -!1 mL

VWR, Cat. # 82028-564
! -!empty tip boxes
! -!autoclave tape
! -!gloves

Protocol:
! 1)!fill empty pipet tip boxes with tips from bulk package as needed
! 2)!adhere autoclave tape across opening of box

to indicate whether or not box has been autoclaved
! 3)!autoclave for 30 min. on dry cycle
! 4)!dry tips overnight in lab oven
! 5)!transfer to shelf for storage
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Absorbance Measurement Using Spectrophotometer
for routine absorbance measurement

Equipment:
! -!UV-VIs spectrophotometer

- Beckman
- instrument is most sensitive for detecting absorbance readings in 
range from 0.1 - 1.0

! -!quartz cuvette
keep clean with Kimwipes

! -!dI water squirt bottle
! -!waste container
! -!P1000 micropipettor and tips
! -!microcentrifuge rack

Materials:
! -!microcentrifuge tubes

for preparing dilutions
! -!gloves

to protect samples from DNases and proteases
! -!ultrapure water
! -!solution for blank

matched to sample buffer
! -!sample
! -!DNA
! -!plasmid DNA, purified
! -!primer stock solution
! -!protein
! -!peptide
! -!Kimwipes
! -!paper and pen

for recording readings

Protocol:
- DNA absorbs optimally at 260 nm
! - depending on purity of DNA preparation, contaminating bacterial proteins 

may also be present in solution which can be detected optimally by 
absorbance at 280 nm

! - a 260 / 280 ratio of 1.8 or greater indicates a pure DNA preparation
- protein / antibody absorbs optimally at 280 nm
! - calculate antibody concentration in mg/mL from A280 according to Beer's 

Law as follows:  (A280 / ε) x 10 = mg/mL
- peptide bond absorbs optimally at 214 nm
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! 1)!prepare dilutions of stock solution in microcentrifuge tubes
! 1.1)!for 1:100 dilution, combine 10 µL of stock + 990 µL of 

ultrapure water
! 1.2)!for 1:200 dilution, combine 5 µL of DNA stock + 995 µL of 

ultrapure water
! 2)!initialize spectrophotometer
! 2.1)!turn on UV lamp
! 2.2)!allow ~5 min. for lamp to warm-up / stabilize
! 3)!for plasmid DNA:
! 3.1)!select 'DNA/Oligo Quant' > dsDNA program
! 3.2)!enter sample ID and dilution factor for each sample
! 4)!for DNA primers:
! 4.1)!select 'DNA/Oligo Quant' > 'Oligo DNA Short' program
! 4.2)!enter sample ID, nucleotide sequence and dilution factor for 

each sample
! 5)!for protein:
! 5.1)!select 'Protein' program
! 6)!for peptide:
! 6.1)!select fixed wavelength program
! 7)!blank instrument
! 7.1)!add 1 mL of blank solution to cuvette
! 7.2)!place cuvette inside compartment
! 7.3)!close lid
! 7.4)!select 'blank'
! 7.5)!remove cuvette and discard contents
! 7.6)! dry by inverting on top of Kimwipes
! 8)!read samples
! 8.1)!add 1 mL of sample to cuvette
! 8.2)!place cuvette inside compartment
! 8.3)!close lid
! 8.4)!read sample
! 8.5)!record concentration

- correct for dilution factor
- for DNA samples, record 260/280 ratio

! 8.6)!remove cuvette and discard contents
! 9)!wash cuvette
! 9.1)!fill cuvette with dI water from squirt bottle (wash)
! 9.2)!discard contents
! 9.3)!repeat for a total of 3 washes
! 9.4)!dry by inverting on top of Kimwipes
! 9.5)!repeat blank (see above) after each sample
! 10)!exit spectrophotometer
! 10.1)!print report of results (if printer is available)
! 10.2)!exit program
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! 10.3)!turn off UV lamp
! 11)!for accuracy, use reading(s) for dilutions within sensitive detection 

range
average readings if possible
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Absorbance Measurement Using NanoDrop
for measurement of valuable and/or low concentration stock solutions – 
consumes only 2 µL of sample volume measured neat (without prior dilution 
required)

Equipment:
! -!NanoDrop spectrophotometer

- ND-1000
- instrument is most sensitive for detecting absorbance readings in 
range from 0.1 - 1.0

! -!PC with NanoDrop application software installed
! -!waste container
! -!P2 micropipettor and tips
! -!microcentrifuge rack

Materials:
! -!gloves 

to protect samples from DNases and proteases
! -!ultrapure water
! -!solution for blank

matched to sample buffer
! -!sample
! -!DNA
! -!protein
! -!Kimwipes
! -!paper and pen

for recording readings

Protocol:
- DNA absorbs optimally at 260 nm
! - depending on purity of DNA preparation, contaminating bacterial proteins 

may also be present in solution which can be detected optimally by 
absorbance at 280 nm

! - a 260 / 280 ratio of 1.8 or greater indicates a pure DNA preparation
- protein / antibody absorbs optimally at 280 nm
! - calculate antibody concentration in mg/mL from A280 according to Beer's 

Law as follows:  (A280 / ε) x 10 = mg/mL

! 1)!initialize NanoDrop
! 1.1)!launch NanoDrop application on connected PC
! 1.2)!follow software prompts 
! 1.3)!open sampling arm
! 1.4)!dry / clean sample pedestal using Kimwipe
! 1.5)!add 1.5 µL of ultrapure water to sample pedestal
! 1.6)!close sampling arm
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! 1.7)!select 'OK'
! 1.8)!dry / clean sample pedestal using Kimwipe
! 2)!choose DNA / protein program
! 3)!blank instrument
! 3.1)!follow software prompts 
! 3.2)!open sampling arm
! 3.3)!add 2 µL of blank solution to pedestal
! 3.4)!close sampling arm
! 3.5)!select 'blank'
! 3.6)!dry / clean sample pedestal using Kimwipe
! 4)!read DNA / protein sample
! 4.1)!follow software prompts
! 4.2)!open sampling arm
! 4.3)!add 2 µL of sample to pedestal
! 4.4)!close sampling arm
! 4.5)!select 'measure'
! 4.6)!record concentration

for DNA samples, record 260/280 ratio
! 4.7)!dry / clean sample pedestal using Kimwipe
! 4.8)!close sampling arm
! 5)!exit NanoDrop

217



Antibody Purification from Ascites Fluid

Equipment:
! -!fingertight stop plug 1/16”, black

- to seal top of column
- GE Healthcare Life Sciences, Cat. # 11-0003-55

! -!stop plug female, 1/16”, black
- to seal bottom of column
- GE Healthcare Life Sciences, Cat. # 11-0004-64

! -!1/16” male / luer female, red
- to connect syringe to top of column
- GE Healthcare Life Sciences, Cat. # 18-1112-51

! -!union 1/16” female / M6 male, red
- connect directly to bottom of column
- GE Healthcare Life Sciences, Cat. # 18-1112-57

! -!union M6 female / 1/16” male, red
- connect to union M6 male at bottom of column
- GE Healthcare Life Sciences, Cat. # 18-3858-01

Materials:
! -!5 mL syringe
! -!HiTrap Protein G HP column, 1 mL

GE Healthcare Life Sciences, Cat. # 17-0404-03
! -!stored at 4°C
! -!equilibrate to room temp. prior to use
! -!binding buffer, 10x

GE Healthcare Life Sciences, Cat. # 17-1128-01
! -!stored at 4°C
! -!equilibrate to room temp prior to use
! -!elution buffer, 10x

GE Healthcare Life Sciences, Cat. # 17-1128-01
! -!stored at 4°C
! -!equilibrate  to room temp. prior to use
! -!neutralizing buffer, 1x

GE Healthcare Life Sciences, Cat. # 17-1128-01
! -! stored at 4°C
! -! equilibrate to room temp. prior to use
! -!15 mL tube

for collection of sample flow through
! -!microcentrifuge tubes

for collection of fractions numbered from 1-20
! -!ascites fluid
! -!stored at -20°C
! -!0.45 µm filter
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! -!20% ethanol (molecular biology grade) in ultrapure water, 10 mL
! -!parafilm

Protocol:

Figure 27:  Purification of OKT3 antibody from mouse ascites fluid.
! Red arrows indicate fractions containing purified antibody.

! 1)!buffer preparation
! 1.1)!dilute 10x binding buffer as follows:  2.5 mL 10x binding 

buffer + 22.5 mL ultrapure water (25 mL total volume)
! 1.2)!dilute 10x elution buffer as follows:  0.5 mL 10x elution 

buffer + 4.5 mL ultrapure water (5 mL total volume)
! 1.3)!aliquot 75 µL of neutralization buffer per microcentrifuge 

tube numbered from 1-20
! 2)!prepare ascites for antibody (IgG) purification
! 2.1)!filter fluid through 0.45 µm filter to remove particulates
! 2.2)!dilute ascites fluid 1:1 in 1x binding buffer
! 3)!assemble column apparatus; listed from top to bottom:
! 3.1)!5 mL syringe
! 3.2)!1/16” male / luer female, red
! 3.3)!HiTrap Protein G HP column, 1 mL
! 3.4)!union 1/16” female / M6 male, red
! 3.5)!union M6 female / 1/16” male, red
! 4)!wash column with 5 mL of ultrapure water (to waste) at a flow rate of 

1 drop / sec
! 5)!equilibrate column with 3 mL of binding buffer (to waste)
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! 6)!apply 1-5 mL of ascites (filtered through 0.45 µm filter and diluted 1:1 
in binding buffer) to column 

! 6.1)!collect sample flow through in 15 mL tube
! 7)!wash column with 7 mL binding buffer
! 7.1)!collect 1 mL fractions in numbered microcentrifuge tubes 

containing 75 µL neutralization buffer per tube
! 8)!elute with 5 mL elution buffer
! 8.1)!collect 1 mL fractions in numbered microcentrifuge tubes 

containing 75 µL neutralization buffer per tube
! 9)!after use, clean column with 10 mL of 20% ethanol
! 9.1)!pass ~ 8 mL through column to waste
! 9.2)!while fully saturated with ethanol solution, close both ends 

of column with stoppers
! 9.3)!seal stoppers with parafilm and store column at 4°C after 

use
! 9.4)!column can be used repeatedly for designated antibody 

purification
! 9.4.1)!do not use same column for purification of different 

antibodies
! 10)!determine antibody concentration of each fraction

see supporting protocol
! 11)!identify and combine fraction(s) containing highest concentration of 

antibody (≥ 0.5 mg/mL)
! 12)!proceed with dialysis protocol
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Dialysis of Purified Antibody

Equipment:
! -!autoclave
! -!2 L capacity glass flask
! -!deli fridge
! -!stir plate
! -!stir bar
! -!weight attached to string
! -!rubber stopper attached to string

Materials:
! -!10x PBS, 1 L
! -!dialysis tubing, molecular weight cutoff 12-14,000 daltons

Fisher, Cat. # 08-667B
! -!stored at 4°C
! -!antibody
! -!purified from ascites
! -!clips for dialysis tubing
! -!parafilm
! -!syringe
! -!needle
! -!50 mL tube
! -!glycerol, molecular biology grade
! -!microcentrifuge tubes

Supporting Protocols:
! -!Antibody Purification from Ascites Fluid
! -!Absorbance Measurement using NanoDrop

Protocol:
! 1)!sterilize 2 L capacity glass flask
! 1.1)!cover opening with foil and secure using autoclave tape
! 1.2)!autoclave for 30 min. on dry cycle
! 2)!sterilize PBS
! 2.1)!dilute 10x PBS to 1x with ultrapure water
! 2.2)!adjust pH to 7.4
! 2.3)!sterilize PBS by passing through 0.22 µm filter

reuse filter for additional rounds
! 3)!fill flask to top with sterile PBS
! 4)!prepare dialysis tubing
! 4.1)!cut ample length of dialysis tubing
! 4.2)!rinse with distilled water prior to use
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! 4.3)!tie knot to secure bottom end of tubing
! 5)!add purified antibody to tubing at top end
! 6)!tie knot to secure top end of tubing 

avoid trapping air below knot
! 7)!trim excess tubing as needed
! 8)!attach bottom end of tubing to weight using clip

to keep tubing completely submerged in PBS
! 9)!attach top end of tubing to rubber stopper
! 10)!add tubing with attached weight to flask filled with PBS
! 11)!secure tubing with rubber stopper at top of flask
! 12)!allow buffer exchange overnight (~16 hrs.) at 4°C with gently 

stirring
1st exchange

! 13)!discard buffer
! 14)!replace PBS and allow buffer exchange for ~8 hrs. at 4°C with 

gently stirring
2nd exchange

! 15)!discard buffer
! 16)!replace PBS and allow buffer exchange for ~16 hrs. at 4°C with 

gently stirring
3rd / final exchange

! 17)!discard buffer
! 18)!remove weight and rubber stopper from tubing
! 19)!carefully remove antibody solution from interior of tubing using 

needle attached to syringe
keep inside 50 mL tube for recovery if spilled

! 20)!dispense antibody solution to sterile tube
! 21)!dilute antibody solution 1:1 (v/v) in glycerol
! 22)!mix well
! 23)!determine antibody concentration according to Beer's Law as 

follows:
see supporting protocol
(A280 / ε) x 10 = mg/mL
where ε = 14

! 24)!aliquot antibody solution to labeled microcentrifuge tubes
! 25)!store at -20°C
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5.2.2. DNA
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Agar Plate Preparation
- agar is added to 2xYT medium and dissolves in the autoclave
- antibiotic is then added and liquid medium is poured into petri dishes before 
agar solidifies

Equipment:
! -!2 L capacity flask
! -!autoclave
! -!thermometer
! -!bunsen burner
! -!refrigerator
! -!insulated gloves
! -!ultrafine Sharpie marker

Materials:
! -!2x YT, 1 L

- see 'Buffers and Solutions'
- prepare in 2 L flask

! -!agar
! -!ultrapure water
! -!autoclave tape
! -!foil
! -!1,000x penicillin
! -!stored at -20°C
! -!500x kanamycin
! -!stored at -20°C
! -!petri dishes
! -!lab tape

Protocol:
! 1)!add 15 g of agar to 1 L of 2x YT
! 2)!shake flask to mix
! 3)!cover opening with foil

adhere using autoclave tape
! 4)!place flask inside autoclave-safe container

add tap water to base
! 5)!autoclave for 30 min. on wet cycle with slow exhaust

takes 1 hr. total time
! 6)!remove from autoclave
! 7)!place thermometer in water at base of container to monitor 

temperature of medium
! 8)!add antibiotic to medium when temperature cools to 55°C

antibiotic is unstable when added at higher temperatures
! 9)!swirl flask to mix antibiotic
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use insulated gloves to handle flask
! 10)!arrange petri dishes on lab bench

keep plastic sleeve for later storage
! 11)!remove lids from dishes – set aside
! 12)!swirl flask and pour ~30 mL to each open petri dish while medium is 

still liquid / hot
use insulated gloves to handle flask

! 13)!briefly flame surface of medium using bunsen burner
! 14)!replace lids on dishes
! 15)!leave dishes on lab bench overnight

to allow agar to solidify
! 16)!label bottom of each plate with type of antibiotic
! 17)!stack plates inside plastic sleeve for storage

add plates upside down to prevent contamination
! 18)!secure opening of plastic sleeve with tape
! 19)!label sleeve with type of antibiotic and date of preparation
! 20)!store in refrigerator
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Preparation of DH5α Aliquots

Equipment:
! -!styrofoam container
! -!tube rack

for holding microcentrifuge tubes
! -!-80°C freezer
! -!bucket with ice

for thawing DH5α stock

Materials:
! -!dry ice
! -!95% ethanol
! -!microcentrifuge tubes
! -!DH5α E.coli

- sub-cloning efficiency
- chemically-competent

! -!stored at -80°C

Protocol:
! 1)!prepare dry ice ethanol bath

for quick-freezing aliquots
! 1.1)!add pieces of dry ice to styrofoam container
! 1.2)!slowly add 95% ethanol to container
! 1.3)!add tube rack

partially immerse in ethanol
! 2)!thaw DH5α stock on ice
! 3)!label microcentrifuge tubes
! 4)!aliquot 50 µL to each tube

immediately place in tube rack to quick-freeze
! 5)!transfer directly from dry ice ethanol bath to -80°C freezer
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Transformation of DH5α

Equipment:
! -!37°C warm room
! -!42°C water bath
! -!thermometer
! -!-80°C freezer
! -!refrigerator
! -!bunsen burner
! -!glass / metal rod

for spreading on agar plates
! -!glass container with 70% ethanol

for sterilizing rod
! -!37°C shaker
! -!lab timer
! -!microcentrifuge
! -!bucket with ice

Materials:
! -!plasmid DNA, purified
! -!ligation reaction
! -!microcentrifuge tubes (1 per reaction)

for DNA
! -!DH5α aliquots, chemically competent (1 per reaction)
! -! stored at -80°C
! -!LB / 2xYT growth medium
! -!stored at 4°C
! -!glass culture tubes with caps (1 per reaction)

for culture medium
! -!1,000x ampicillin stock aliquots
! -!stored at -20°C
! -!500x kanamycin stock aliquots
! -!stored at -20°C
! -!agar plates (1 per reaction)

see supporting protocol
! -!stored at 4°C
! -!microcentrifuge tubes (1 per reaction)

for concentrating DH5α
! -!parafilm

Supporting Protocols:
! -!Ligation Reaction
! -!Preparation of DH5α Aliquots
! -!Agar Plate Preparation
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Protocol:
! 1)!aliquot 1-2 µL of plasmid DNA or 15-20 µL of ligation reaction into 

separate microcentrifuge tubes for each transformation reaction
! 2)!remove DH5α aliquot from -80°C freezer and thaw on wet ice
! 3)!transfer thawed DH5α cells to each tube containing DNA
! 4)!chill the cell/DNA mixture on wet ice for 30 min.

continue with preparations below while waiting
! 5)!transfer 1 mL of growth medium to each culture tube
! 6)!label each tube
! 7)!prepare agar plates
! 7.1)!remove from refrigerator

to equilibrate to room temp.
! 7.2)!thaw antibiotic stock aliquot
! 7.3)!add 1x ampicillin / kanamycin to each plate

- estimate 30 mL volume agar per plate
- e.g., add 30 µL of 1,000x ampicillin stock per plate

! 7.4)!spread evenly on surface of each plate using rod
! 7.5)!equilibrate plates to 37°C inside warm room
! 7.6)!place plates upside down on shelf

to prevent condensation from accumulating on agar 
surface

! 8)!heat shock cell/DNA mixture for 20 seconds at 42°C
perform serially for each reaction

! 9)!immediately return to ice for 2 min.
! 10)!transfer heat-shocked cells to labeled culture tubes containing 1 mL 

of growth medium
! 11)!incubate / shake culture tubes for 1 hr at 255 rpm (37°C)
! 12)!concentrate DH5α
! 12.1)!transfer 1 mL of culture to each microcentrifuge tube
! 12.2)!centrifuge for 5 min. at 5,000 rpm
! 12.3)!remove 50 µL of supernatant using P200 micropipettor and 

tip
retain for resuspending cells

! 12.4)!discard remaining supernatant
! 12.5)!resuspend cell pellet in 50 µL of retained supernatant
! 13)!transfer 50 µL of concentrated cell suspension to each agar plate
! 14)!spread cells evenly on agar surface using rod

flame / decontaminate before each plate
! 15)!incubate plates overnight in 37° warm room

keep plates upside down
! 16)!inspect plates for colonies

incubate longer if needed
! 17)!seal plates with parafilm
! 18)!store in bacterial refrigerator for ≤ 2 weeks

228



! 19)!proceed with Mini / Mega Prep protocol
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Mini Prep
small scale (50 µg yield) DNA purification

Equipment:
! -!37°C shaker
! -!37°C water bath
! -!microcentrifuge
! -!vacuum pump
! -!vacuum manifold
! -!-20°C freezer

Materials:
! -!agar plate with transformed colonies
! -!freshly prepared or stored for ≤ 2 weeks at 4°C
! -!toothpicks / pipet tips

for inoculating starter culture
! -!LB medium
! -!glass culture tubes w/ caps (1 per MiniPrep)
! -!1,000x ampicillin stock
! -!stored at -20°C
! -!500x kanamycin stock
! -!stored at -20°C
! -!microcentrifuge tubes (1 per MiniPrep)

for pelleting cells
! -!Resuspension Buffer (Buffer #1)
! -!stored at 4°C
! -!Lysis Buffer (Buffer #2)
! -!stored at room temp.
! -!Neutralization Buffer (Buffer #3)
! -!stored at 4°C
! -!Wizard MiniColumns (1 per MiniPrep)
! -!syringe barrels (1 per MiniPrep)

for attachment to MiniColumns
! -!Promega MaxiPrep resin
! -!warm in 37°C water bath if precipitate visible
! -!Column Wash
! -!stored at 4°C
! -!microcentrifuge tubes (1 per MiniPrep)

for drying resin
! -!caps removed
! -!microcentrifuge tubes(1 per MiniPrep)

for eluting DNA
! -!caps removed
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! -!microcentrifuge tubes (1 per MiniPrep)
for storage of purified DNA

Supporting Protocols:
! -!Transformation of DH5α
! -!Absorbance Measurement using NanoDrop

Protocol:
proceed independently for each MiniPrep

! 1)!prepare starter culture
! 1.1)!add 5 mL of LB medium to each culture tube
! 1.2)!add 1x antibiotic 
! 1.3)!pick a colony and transfer to culture tube

to inoculate
! 1.4)!incubate / shake overnight at 255 rpm (37°C)
! 2)!pellet transformed DH5α

proceed depending on optical density (growth) of starter culture
! 2.1)!transfer 1 mL from starter culture to microcentrifuge tube
! 2.2)!centrifuge for 5 min. at 5,000 rpm
! 2.3)!discard supernatant
! 2.4)!repeat 3x in same tube
! 2.5)!optional:  retain 1 mL of starter culture to use for Mega Prep 

culture (keep at 4°C)
! 3)!prepare lysate
! 3.1)!resuspend pellet in 500 µL of Resuspension Buffer (#1)
! 3.2)!add 500 µL of Lysis Buffer (#2)
! 3.3)!invert tube 5x to mix
! 3.4)!wait for solution to become clear (5 min.)
! 3.5)!add 500 µL of Neutralization Buffer (#3)
! 3.6)!invert 5x to mix
! 3.7)!wait for 5 min.
! 3.8)!centrifuge bacterial lysate for 5 min. at 14,000 rpm
! 3.9)!retain supernatant
! 4)!prepare MiniColumn
! 4.1)!label MiniColumn on lip
! 4.2)!attach MiniColumn to syringe barrel
! 4.3)!attach column-barrel to port on vacuum manifold
! 4.4)!add 500 µL of MaxiPrep resin to each barrel
! 4.5)!fill designated barrel with lysate supernatant
! 5)!filter liquid through MiniColumn
! 5.1)!with one port open on vacuum manifold, turn on vacuum 

pump and increase pressure to '30' mark on gauge
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! 5.2)!open vacuum port for each column-barrel until liquid has 
completely passed through resin

! 5.3)!close vacuum port
! 5.4)!add 2 mL of column wash to each column-barrel
! 5.5)!open vacuum port to allow column wash to completely pass 

through resin
! 5.6)!apply vacuum for an additional 30 seconds
! 6)!dry MiniColumn
! 6.1)!detach syringe barrel from MiniColumn
! 6.2)!secure MiniColumn inside microcentrifuge tube with lid 

removed
! 6.3)!centrifuge for 1 min. at 14,000 rpm
! 6.4)!remove MiniColumn from microcentrifuge tube
! 6.5)!discard tube and residual column wash
! 7)!elute DNA
! 7.1)!secure MiniColumn inside new microcentrifuge tube with lid 

removed
! 7.2)!add 50 µL of cell culture grade water to each MiniColumn
! 7.3)!centrifuge for 1 min. at 14,000 rpm
! 7.4)!remove MiniColumn from microcentrifuge tube
! 7.5)!discard column and save tube containing eluted DNA
! 7.6)!transfer purified DNA to new microcentrifuge tube
! 7.7)!label tube for storage
! 8)!measure DNA concentration and purity (260 / 280 ratio) using 

NanoDrop
see supporting protocol – use NanoDrop to conserve limited DNA 
yield from MiniPrep

! 9)!store DNA at -20°C
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Mega Prep
large scale DNA purification

Equipment:
! -!37°C shaker
! -!autoclave
! -!ultra-centrifuge
! -!rotor for large centrifuge tubes
! -!equilibrate to 4°C
! -!rotor for small centrifuge tubes
! -!equilibrate to 4°C
! -!large centrifuge tubes (3 per MegaPrep)

for pelleting cells following expansion
! -!autoclave before use
! -!small centrifuge tubes (4 per MegaPrep)

for preparing lysate
! -!autoclave before use
! -!funnels

for filtering lysate supernatant
! -!graduated cylinders

for filtering lysate supernatant
! -!small centrifuge tubes (4 per MegaPrep)

for precipitating DNA
! -!autoclave before use
! -!37°C water bath
! -!vacuum pump
! -!vacuum manifold
! -!centrifuge
! -!-20°C freezer

Materials:
! -!option 1:  fresh starter culture
! -!agar plate with transformed colonies
! -!freshly prepared or stored for ≤ 2 weeks at 4°C
! -!toothpicks / pipet tips

for inoculating starter culture
! -!LB medium
! -!glass culture tubes w/ caps (1 per MegaPrep)
! -!option 2:  starter culture from MiniPrep
! -!1 mL culture reserved from MiniPrep
! -!stored at 4°C
! -!2xYT medium
! -!1,000x ampicillin stock
! -!stored at -20°C
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! -!500x kanamycin stock
! -!stored at -20°C
! -!2 L flask containing 1 L of LB medium (1 per MegaPrep)

for expanding starter cultures
! -!bleach

for decontamination
! -!buffers for DNA isolation
! -!Resuspension Buffer (Buffer #1)
! -!stored at 4°C
! -!Lysis Buffer (#2)
! -!stored at room temp.
! -!Neutralization Buffer (#3)
! -!stored at 4°C
! -!Column Wash
! -!stored at 4°C
! -!Whatman #1 filter paper

for filtering lysate supernatant
! -!100% isopropanol, molecular biology grade
! -!keep on ice
! -!TE buffer
! -!Wizard MegaColumns (1 per MegaPrep)
! -!MaxiPrep resin

Promega, Cat. # A7401
! -!warm in 37°C water bath if precipitate visible
! -!70% ethanol (molecular biology grade) in ultrapure water (10 mL per 

MegaPrep)
! -!50 mL centrifuge tubes

for drying resin (1 per MegaColumn)
! -!50 mL centrifuge tubes

for collecting eluted DNA (1 per MegaColumn)
! -!ultrapure water

for elution
! -!5 mL syringe

for filtering DNA solution
! -!0.22 µm filter

for filtering DNA solution
! -!microcentrifuge tubes

for storage of DNA aliquots

Supporting Protocols:
! -!Transformation of DH5α
! -!Absorbance Measurement Using NanoDrop
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Protocol:
proceed independently for each MegaPrep

! 1)!option 1:  fresh starter culture
! 1.1)!add 2 mL of LB medium to culture tube
! 1.2)!add 1x antibiotic 
! 1.3)!pick a colony and transfer to culture tube

to inoculate
! 1.4)!incubate / shake for 6-8 hrs. at 255 rpm (37°C)
! 2)!option 2:  starter culture from MiniPrep
! 2.1)!add 1 mL of 2xYT to 1 mL of reserved MiniPrep culture
! 2.2)!incubate / shake for 1-2 hrs. at 255 rpm (37°C)
! 3)!expand starter culture
! 3.1)!add 1x antibiotic to 1 L of 2xYT
! 3.2)!add starter culture (from either option 1 or 2 above) to 2 L 

flask
! 3.3)!incubate / shake overnight at 255 rpm (37°C)
! 4)!pellet transformed DH5α

proceed depending on optical density / growth of culture
! 4.1)!distribute culture to 3 large centrifuge tubes

do not overfill to prevent leakage while inside ultra-
centrifuge

! 4.2)!centrifuge for 20 min. at 5,000 g (4°C)
! 4.3)!discard supernatant to bleach container

for decontamination
! 4.4)!optional:  keep pellet at 4°C overnight
! 5)!prepare lysate
! 5.1)!resuspend pellet from each large tube in 10 mL of 

Resuspension Buffer (#1)
! 5.2)!combine cell suspension from each tube
! 5.3)!distribute cell suspension to 4 small centrifuge tubes (10 

mL / tube)
! 5.4)!add 10 mL of Lysis Buffer (#2)
! 5.5)!invert tube 5x to mix
! 5.6)!wait for solution to become clear (5 min.)
! 5.7)!add 10 mL of Neutralization Buffer (#3)
! 5.8)!invert 5x to mix
! 5.9)!wait for 5 min.
! 5.9.1)!keep on ice
! 5.9.2)!mix once per minute
! 5.10)!centrifuge bacterial lysate for 20 min. at 14,000 g (4°C)
! 5.11)!retain supernatant
! 6)!filter lysate supernatant
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! 6.1)!prepare Whatman filter paper / funnels / cylinders apparatus 
to filter lysate supernatant

rate limiting step – setup a few filter apparatuses to 
operate in parallel

! 6.2)!filter lysate supernatant through Whatman paper and collect 
in graduated cylinders

! 6.3)!combine filtered lysate supernatant into large graduated 
cylinder and determine total volume

! 7)!precipitate DNA
! 7.1)!add 0.7x volume of ice-cold isopropanol

final isopropanol will be 41% (v/v)
! 7.2)!distribute to 4 small centrifuge tubes

40 mL maximum volume per tube
! 7.3)!centrifuge for 20 min at 14,000 g (4°)
! 7.4)!discard supernatant from each tube while taking care to 

avoid disturbing DNA pellet
! 7.5)!optional:  store DNA pellet at 4°C overnight
! 8)!resuspend / combine DNA pellet from each tube
! 8.1)!add 4 mL of TE buffer to tube #1
! 8.2)!resuspend DNA pellet from tube #1

pellet may not be visible
! 8.3)!transfer DNA solution to tube #2
! 8.4)!repeat resuspend / transfer steps for tube #3 and #4
! 9)!prepare MegaColumn
! 9.1)!add 5 mL of MaxiPrep DNA purification resin to DNA 

solution
! 9.2)!swirl tube to mix
! 9.3)!label MegaColumn on rim
! 9.4)!attach to port on vacuum manifold
! 9.5)!transfer DNA-resin slurry to MegaColumn
! 9.6)!add 25 mL of column wash above slurry
! 10)!filter liquid through MegaColumn
! 10.1)!with one port open on vacuum manifold, turn on vacuum 

pump and increase pressure to '30' mark on gauge
! 10.2)!open vacuum port for MegaColumn until liquid has 

completely passed through resin
! 10.3)!add an additional 25 mL of column wash to MegaColumn 

and filter as before
! 11)!wash MegaColumn with ethanol
! 11.1)!add 5 mL of 70% ethanol (molecular biology grade) to 

MegaColumn
! 11.2)!filter through MegaColumn as before
! 11.3)!repeat for a total of 2 washes (10 mL total volume)
! 12)!dry MegaColumn
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! 12.1)!remove MegaColumn from vacuum manifold and place 
inside 50 mL centrifuge tube

! 12.2)!centrifuge for 5 min. at 2,500 rpm
! 12.3)!return MegaColumn to vacuum manifold and apply 

vacuum for an additional 5 min
to completely dry resin

! 13)!elute DNA
! 13.1)!add ultrapure water to small beaker (need > 3 mL)
! 13.2)!heat in microwave oven for ~ 3 min
! 13.2.1)!adjust temperature to 65-70°C
! 13.3)!place MegaColumn inside new 50 mL centrifuge tube
! 13.4)!add 2 mL of heated water to MegaColumn
! 13.5)!wait for 1 min.
! 13.6)!centrifuge for 5 min. at 2,500 rpm

eluted DNA contained in water at bottom of tube
! 13.7)!add an additional 1 mL of heated water to each 

MegaColumn
! 13.8)!wait for 1 min.
! 13.9)!centrifuge for 5 min. at 2,500 rpm
! 14)!filter DNA solution

to sterilize
! 14.1)!label microcentrifuge tubes for storage of DNA aliquots
! 14.2)!attach syringe barrel to 0.22 µm filter
! 14.3)!add DNA solution to syringe barrel
! 14.4)!using plunger, pass DNA solution through filter

collect in labeled tubes
! 15)!measure DNA concentration and purity (260 / 280 ratio) using 

NanoDrop or spectrophotometer
! 16)!store DNA at -20°C
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Ethanol Precipitation
small-scale purification and/or concentration of DNA preparations

Equipment:
! -!bucket with ice
! -!vortex
! -!refrigerated microcentrifuge
! -!biosafety cabinet / TC hood

Materials:
! -!DNA solution for precipitation
! -!3.0 M sodium acetate, pH 5.2
! -!microcentrifuge tubes
! -!cell culture grade water
! -!100% ethanol, molecular biology grade
! -!keep on ice
! -!70% ethanol, molecular biology grade
! -!prepared fresh using cell culture grade water
! -!keep on ice

Protocol:
perform all steps using microcentrifuge tubes

! 1)!estimate volume of DNA solution to be purified
! 2)!add 3.0 M sodium acetate to DNA solution for final concentration of 

0.3 M
- Na+ neutralizes phosphate backbone of DNA and favors 
precipitation
- e.g., add 40 µL of 3.0 M sodium acetate to 360 µL of DNA solution 
(total volume should not exceed 400 µL)

! 3)!mix well
! 4)!add 2 volumes of ice-cold 100% ethanol

- precipitates DNA from solution
- e.g., to 400 µL volume above, add 800 µL

! 5)!mix well
! 6)!keep on ice for 1 hour

to precipitate DNA
! 7)!centrifuge for 15 min. at 12,000 g (4°C)

to recover precipitated DNA
! 8)!carefully aspirate supernatant

do not disturb DNA pellet
! 8.1)!retain supernatant as precaution
! 9)!gently resuspend DNA pellet in 1 mL of ice-cold 70% ethanol

to dissolve precipitated salts
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! 10)!centrifuge for 15 min. at 12,000 g (4°C)
to recover precipitated DNA

! 11)!carefully aspirate supernatant
do not disturb DNA pellet

! 11.1)!retain supernatant as precaution
! 12)!lay tube flat inside tissue culture hood

- to allow ethanol to evaporate
- do not proceed until tube is completely dry

! 13)!dissolve DNA pellet in small volume of cell culture grade water (or 
buffer of choice)

! 13.1)!rinse walls of tube to dissolve precipitated DNA
! 14)!proceed to determine DNA concentration and purity using 

spectrophotometer or NanoDrop
see supporting protocols
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Restriction Enzyme Digestion Reaction
for small-scale analytical DNA gel

Materials:
! -!cell culture grade water
! -!plasmid DNA
! -!stored at -20°C
! -!10x (1 mg/mL) BSA

diluted from supplied 100x (10 mg/mL) stock in cell culture grade 
water

! -!10x reaction buffer
- enzyme specific
- for double-digestion, check for most compatible buffer

! -!restriction enzyme(s)
! -!stored at -20°C
! -!6x DNA loading dye

Supporting Protocol:
! -!Agarose Gel Electrophoresis

Protocol:
! 1)!create table for each reaction and calculate amounts / volumes of all 

reagents below
- prepare non-cut (negative control) reaction for each plasmid
- for double-digest reaction, prepare single-cut control reaction for 
each restriction enzyme alone

! 2)!set up each reaction in separate microcentrifuge tube (10 µL total 
volume per reaction)

use DNAse-free tubes and pipet tips
! 2.1)!add ultrapure water
! 2.2)!add 1µg plasmid DNA
! 2.3)!add 1µL of 10x BSA (1x final)
! 2.4)!add 1µL of 10x buffer to each tube (1x final)
! 2.5)!add 1µL of restriction enzyme(s) to each tube (1 unit final)

for double-digestion, add 1 unit of each restriction enzyme
! 2.6)!mix each tube using pipettor and tip

change tips for each tube
! 3)!incubate in 37°C water bath for 1 hr.
! 4)!remove from water bath and keep on ice
! 5)!add 2µL of 6x DNA loading dye to each tube
! 6)!mix each tube using pipettor and tip
! 7)!prepare agarose gel for analysis
! 8)!resolve fragments by DNA gel electrophoresis
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Agarose Gel Electrophoresis

Equipment:
! -!microwave oven
! -!gel caster
! -!gel comb
! -!horizontal gel electrophoresis apparatus
! -!power supply
! -!black and red wires

for connection to power supply
! -!UV light source

to monitor separation progress during electrophoresis
! -!gel imaging apparatus
! -!memory card, compatible with gel imaging apparatus
! -!solid waste container for ethidium bromide

to discard contaminated pipet tips, gloves, etc.
! -!liquid waste container for ethidium bromide

to discard contaminated TAE buffer

Materials:
! -!agarose, electrophoresis grade
! -!ethidium bromide
! -!protect from light
! -!DNA sample
! -!microcentrifuge tubes
! -!0.1-10 kb DNA ladder, 1 µg/mL

NEB, Cat. # N3200L
! -!stored at 4°C
! -!6x loading dye
! -!stored at 4°C
! -!TAE buffer

Protocol:
! 1)!prepare 0.8% agarose gel in flask
! 1.1)!for small / analytical gel:  0.4 g agarose + 50 mL TAE

14 wells total
! 1.2)!for large gel:  1.2 g agarose + 150 mL TAE
! 1.3)!microwave for 3 min. at 50% power
! 1.3.1)!if needed, increase time to dissolve completely
! 1.4)!allow to cool slightly
! 1.5)!add 1 µL of ethidium bromide to gel
! 1.6)!mix well
! 2)!cast gel
! 2.1)!assemble caster components
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! 2.2)!pour gel
! 2.3)!insert gel comb
! 2.4)!allow to gel to cool / solidify completely
! 3)!prepare DNA ladder for loading
! 3.1)!aliquot 5 µL of DNA ladder to microcentrifuge tube
! 3.2)!add 1 µL of 6x loading dye (1x final)
! 4)!prepare DNA samples for loading
! 4.1)!aliquot DNA for electrophoresis to microcentrifuge tube
! 4.2)!add 6x loading dye to 1x final

e.g., add 2 µL of 6x loading dye to 10 µL DNA sample
! 5)!load gel
! 5.1)!remove solidified gel from caster

keep gel on top of plastic base
! 5.2)!place gel and base in electrophoresis apparatus
! 5.3)!add TAE buffer

wells should be completely submerged
! 5.4)!carefully remove comb from gel
! 5.5)!slowly load ladder / DNA samples to designated wells

- take care not to damage wells
- 12 µL maximum sample volume per well of small gel

! 5.5.1)!add 6 µL of ladder to designated wells
! 6)!run gel
! 6.1)!connect electrophoresis apparatus to power supply using 

wires
! 6.2)!set limits for power supply as follows:

500 V, 200 mA, 100 W
constant voltage:  100 V

! 6.3)!press 'run'
! 6.4)!allow DNA to separate 30 min - 1 hr
! 6.5)!monitor separation progress using UV light source
! 7)!acquire gel image
! 7.1)!turn on UV light
! 7.2)!capture digital image
! 7.3)!save image to memory card
! 7.4)!analyze using Image J software
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DNA Sequencing Reaction Preparation

Equipment:
! -!-20°C freezer

Materials:
! -!template DNA
! -!plasmid DNA, purified
! -!PCR product
! -!primer stock solution
! -!cell culture grade water
! -!microcentrifuge tube

Supporting Protocols:
! -!Mini / Mega Prep
! -!Absorbance Measurement using Spectrophotometer
! -!Agarose Gel Electrophoresis

Protocol:
! 1)!empirically determine concentration of template DNA using 

spectrophotometer
see supporting protocol

! 2)!characterize DNA for sequencing on gel prior to submitting for 
sequencing

! 3)!empirically determine concentration of primer stock solution using 
spectrophotometer

see supporting protocol
! 4)!dilute primer for sequencing reaction to 6.4 µM (= 6.4 pmol/µL) in cell 

culture grade water
! 5)!prepare sequencing reaction in microcentrifuge tube (12 µL final 

volume) as follows:
! 5.1)!add 1 µL of 6.4 µM primer (6.4 pmol)
! 5.2)!add 0.5-1 µg of purified plasmid or PCR product
! 5.3)!adjust to final volume with cell culture grade water
! 6)!keep at -20°C prior to submitting for sequencing

request chromatograms to be including with sequencing results
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PCR Reaction

Equipment:
! -!thermal cycler

Materials:
! -!1.1x (22 units/mL) Platinum Blue PCR Supermix

- Invitrogen, Cat. # 12580-015
- contains Taq DNA polymerase, anti-Taq DNA polymerase antibody, 
Mg2+, dNTPs, glycerol and blue tracking dye

! -!stored at -20°C
! -!template DNA
! -!forward primer
! -!reverse primer
! -!cell culture grade water
! -!PCR tubes with caps

Supporting Protocols:
! -!Absorbance Measurement Using Spectrophotometer

Protocol:
modify as needed

! 1)!empirically determine concentration of template DNA
see supporting protocol

! 2)!prepare PCR reaction in PCR tube (50 µL final volume)
for multiple reactions, prepare master mix of common components 
and aliquot to each tube

! 2.1)!add 1 unit (45 µL) of Platinum Blue PCR SuperMix
! 2.2)!add 10 pmols of forward primer (0.2 µM final concentration)
! 2.3)!add 10 pmols of reverse primer (0.2 µM final concentration)
! 2.4)!add 1 ng of plasmid DNA
! 2.5)!adjust to final volume with cell culture grade water
! 3)!cap tubes
! 4)!load in thermal cycler
! 5)!incubate for 2 min. at 94°C

to denature template DNA and active polymerase
! 6)!amplify for 25-30 cycles as follows:
! 6.1)!denature for 30 sec. at 94°C
! 6.2)!anneal for 30 sec. at 55°C
! 6.3)!extend for 1 min. per kb of template at 72°C
! 6.4)!hold at 4°C
! 7)!analyze PCR product on gel
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Gel Band Purification
for purification of DNA fragment for sub-cloning / ligation

Equipment:
! -!UV light source
! -!dark room
! -!55°C water bath
! -!tube rotator
! -!microcentrifuge

Materials:
! -!plasmid DNA
! -!straight-edge razors
! -!1.5 mL microcentrifuge tubes, DNAse-free
! -!UltraClean 15 UltraSalt

Mo Bio Laboratories, Cat. # 121003002
! -!stored at room temp.
! -!UltraClean 15 UltraBind

Mo Bio Laboratories, Cat. # 121003001
! -!stored at room temp.
! -!UltraClean 15 UltraWash

Mo Bio Laboratories, Cat. # 121003003
! -!stored at 4°C

Supporting Protocols:
! -!Restriction Enzyme Digestion Reaction
! -!Agarose Gel Electrophoresis

Protocol:
! 1)!digest plasmid DNA with restriction enzyme pair to yield fragment of 

interest (see supporting protocol for details)
! 2)!resolve DNA fragment on 0.8% agarose gel
! 3)!excise fragment using straight-edge razor (make perpendicular cuts 

around band)
use UV light source in dark room to visualize

! 4)!transfer gel slice to microcentrifuge tube
! 5)!fill tube with Ultra Salt solution
! 6)!melt gel slice in 55°C water bath
! 7)!add 10 µL of Ultra Bind slurry
! 8)!rotate / mix for 5 min.
! 9)!centrifuge for 10 seconds at 12,000 rpm in microcentrifuge
! 10)!aspirate / discard supernatant
! 11)!resuspend pellet in 1 mL of Ultra Wash solution
! 12)!soak for 1 min.
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! 13)!centrifuge for 10 seconds at 12,000 rpm in microcentrifuge
! 14)!aspirate / discard supernatant
! 15)!centrifuge for 10 seconds at 12,000 rpm in microcentrifuge
! 16)!aspirate / discard remaining supernatant
! 17)!resuspend pellet in 20 µL of ultrapure water

to elute DNA
! 18)!centrifuge for 10 seconds at 12,000 rpm in microcentrifuge
! 19)!transfer supernatant (contains eluted DNA) to new microcentrifuge 

tube
take care to avoid transferring pellet / slurry

! 20)!remove 5 µL aliquot of eluted DNA and analyze on gel to confirm 
purification of desired fragment

! 21)!estimate DNA amount / concentration using semi-quantitative 
ladder

presence of carryover salts from purification affects 260 nm 
absorbance – do not determine concentration using NanoDrop

! 22)!store remaining DNA from purification at 4°C
! 23)!proceed immediately with PCR amplification and/or ligation reaction
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5' Phosphate Removal
incubation with antarctic phosphatase removes 5' phosphates from vector 
DNA fragment and prevents self-ligation during ligation reaction with insert 
DNA

Equipment:
! -!37°C water bath

for enzyme reaction
! -!65°C water bath

for heat-inactivation of phosphatase
! -!lab timer

Materials:
! -!vector / backbone fragments
! -!purified from gel

see supporting protocol
! -!Antarctic Phosphatase, 5 units/µL

New England BioLabs, Cat. # M0289S
! -!stored at -20°C
! -!10x Antarctic Phosphatase Reaction Buffer

supplied with enzyme
! -!stored at -20°C
! -!cell culture grade water
! -!microcentrifuge tube

Supporting Protocol:
! -!Gel Band Purification

Protocol:
! 1)!prepare phosphatase reaction in microcentrifuge tube (50 µL final 

reaction volume) as follows:
! 1.1)!add up to 1 µg of vector DNA fragment
! 1.2)!add 10x Antarctic Phosphatase Reaction Buffer to 1x final
! 1.3)!add 1 unit of antarctic phosphatase enzyme
! 1.4)!adjust to final volume with cell culture grade water
! 2)!incubate for 30 min. at 37°C
! 3)!heat-inactivate for 5 min. at 65°C
! 4)!proceed immediately with ligation reaction

no need for additional purification

247



Ligation Reaction
for sub-cloning insert DNA to vector backbone

Equipment:
! -!16°C water bath
! -!65°C water bath
! -!lab timer

Materials:
! -!vector backbone fragment
! -!purified from gel

see supporting protocol
! -!prepared fresh
! -!insert fragment
! -!purified from gel

see supporting protocol
! -!prepared fresh
! -!T4 DNA ligase
! -!stored at -20°C
! -!10x T4 DNA ligase buffer
! -!stored at -20°C
! -!cell culture grade water

Supporting Protocols:
! -!Gel Band Purification
! -!5' Phosphate Removal

Protocol:
! 1)!determine length (# of base pars) of vector and insert fragments from 

map / analytical gel
! 2)!determine approximate DNA concentration of vector and insert 

fragments in reference to semi-quantitative DNA ladder from 
analytical gel (see supporting protocol)

! 3)!remove 5' phosphates from vector backbone fragment (see 
supporting protocol)

! 4)!calculate amount (ng) of insert DNA fragment needed for 2:1 molar 
ratio of insert to vector

! 4.1)!solve for X in the following ratio:
100 ng vector fragment / # bp = X ng of insert fragment / # 
bp

! 4.2)!multiply X by 2
! 5)!prepare ligation reaction in microcentrifuge tube (20 µL final volume) 

as follows:
! 5.1)!add 1 unit of T4 DNA ligase
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! 5.2)!add 2 µL of 10x T4 DNA ligase buffer (1x final)
! 5.3)!add 100 ng of vector fragment
! 5.4)!add calculated amount of insert fragment (2:1 molar ratio of 

insert to vector)
! 5.5)!adjust to final volume with cell culture grade water
! 6)!incubate overnight at 16°C
! 7)!heat inactivate enzyme for 10 min. at 65°C
! 8)!analyze 5 µL of ligation reaction on analytical gel to determine 

efficiency of ligation
! 9)!transform 15 µL of DNA ligation reaction to DH5α cells and select 

clones for further expansion
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Preparation of Mouse Tail DNA
purification of mouse tail DNA for amplification by PCR

Equipment:
! -!vortex
! -!refrigerated microcentrifuge
! -!55°C water bath
! -!-20°C freezer

Materials:
! -!ruler
! -!razor blades
! -!microcentrifuge tubes, 2.0 mL

Fisher, Cat. # 05-408-146
! -!tail solubilization buffers

see 'Buffers & Solutions > Mouse Tail Digestion'
! -!TSB
! -!Proteinase K, 20 mg/mL
! -!Tail Salts
! -!ethanol, 100%, molecular biology grade
! -!keep ice-cold
! -!water, cell culture grade
! -!ethanol, 80%
! -!diluted in cell culture grade water
! -!keep ice-cold
! -!TE Buffer (10:1), pH 8.0

1 mM Tris-HCl, 0.1 mM EDTA

Protocol:
process in parallel for each mouse

! 1)!solubilize tail fragment
! 1.1)!remove 1 cm from tip of tail using razor blade

use new razor blade for each mouse
! 1.2)!transfer tail fragment to pre-labeled microcentrifuge tube
! 1.3)!add 2 mL of TSB + 0.2 mg/mL Proteinase K (added fresh) to 

each tube
i.e., add 20 µL of 20 mg/mL Proteinase K to 2 mL of TSB

! 1.4)!incubate tubes overnight at 55°C
! 1.5)!allow tubes to cool to room temp.
! 1.6)!optional:  store at 4°C indefinitely
! 2)!precipitate protein and SDS
! 2.1)!transfer solubilized tail fragment to 15 mL tube
! 2.2)!add 0.4 volume of Tail Salts to each tube
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i.e., add 0.8 mL to 2 mL of TSB
! 2.3)!vortex well
! 2.4)!incubate for 1-4 hours at 4°C

salts precipitate protein, potassium precipitates SDS
! 2.5)!centrifuge for 10 minutes at maximum speed using 

microcentrifuge (4°C)
DNA contained in supernatant

! 3)!precipitate DNA
! 3.1)!remove 80 µL of supernatant and transfer to new 

microcentrifuge tube
! 3.2)!optional:  store at 4°C indefinitely
! 3.3)!add 2 volumes of ice-cold 100% ethanol

i.e., add 160µL
! 3.4)!transfer to -20°C freezer for ≥ 4 hours to precipitate DNA
! 3.5)!centrifuge for 10 minutes at 14,000 rpm in a refrigerated 

microcentrifuge
DNA contained in pellet

! 3.6)!carefully discard supernatant
! 4)!wash DNA pellet

to remove precipitated salts
! 4.1)!gently resuspend DNA pellet in 500 µL of ice-cold 80% 

ethanol
! 4.2)!centrifuge for 10 minutes at maximum speed in refrigerated 

microcentrifuge
! 4.3)!remove supernatant completely
! 4.4)!allow to air dry
! 5)!resuspend DNA in 50µL of TE Buffer
! 6)!store at -20°C indefinitely
! 7)!proceed with PCR amplification
! 7.1)!use 4µL of template DNA for each PCR reaction
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Itk KO Diagnosis by PCR
for identification of Itk-/- versus WT C57BL/6 

Equipment:
! -!thermal cycler

Materials:
! -!PCR tubes (1 per mouse / reaction)
! -!water, cell culture grade
! -!10x High Fidelity PCR buffer
! -!10 mM dNTP mixture
! -!50 mM MgSO4
! -!10 µM Itk exon 2 forward primer

5' GGC, TCC, ATT, GAA, CTC, TCC, AG 3'
! -!10 µM neomycin forward primer

5' CTT, GAC, GAG, TTC, TTC, TGA, GGG, GA 3'
! -!10 µM Itk intron 4 reverse primer

5' GGG, ATG, CCA, GAA, TCA, ACT, TTG, GTA, G 3'
! -!template DNA from WT and Itk KO mice
! -!purified from tail biopsy
! -!Platinum Taq High Fidelity DNA polymerase

Supporting Protocols:
! -!Preparation of Mouse Tail DNA
! -!Agarose Gel Electrophoresis
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Protocol:

Figure 28:  Diagram of Itk introns and exons for C57BL/6 WT and Itk KO mice.
! The numbered boxes in diagram indicate Itk exons.  Itk KO mice 
contain the neomycin cassette in place of exon 3, intron 3 and exon 4.  In a 
multiplex PCR reaction containing exon 2 forward, neomycin forward and 
intron 4 reverse primers, the majority products of ~7.5 kb or 1.9 kb are 
indicative of WT or Itk KO genomic DNA, respectively.  A similar PCR reaction 
from a heterozygote would be predicted to have both PCR products present.

Figure 29:  Image of DNA gel for characterization of WT and Itk-/- mice by 
PCR analysis.
! Representative data of expected band sizes corresponding to PCR 
products from WT and Itk KO mice, respectively.

! 1)!setup one multiplex PCR reaction as follows for each mouse tail 
biopsy sample to be diagnosed
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! ! ! ! ! ! ! 50 µL final volume / rxn
component! ! ! ! [stock]! vol / rxn! [final]
PCR water! ! ! ! n/a! ! 35.8 µL! n/a
High Fidelity PCR buffer! ! ! 10x! ! 5 µL! ! 1x
dNTP mixture! ! ! ! 10 mM! 1 µL! ! 0.2 mM
MgSO4! ! ! ! 50 mM! 2 µL! ! 2 mM
Itk exon 2 forward primer! ! ! 10 µM! 1 µL! ! 0.2 µM
neomycin forward primer! ! ! 10 µM! 1 µL! ! 0.2 µM
Itk intron 4 reverse primer! ! ! 10 µM! 1 µL! ! 0.2 µM
template DNA! ! ! ! n/a! ! 3 µL! ! n/a
Platinum Taq High Fidelity
DNA polymerase! ! ! ! 5 U/µL! 0.2 µL! 0.02 U/µL (1 unit)

! 2)!mix samples well and attach caps
! 3)!run on thermal cycler with the following conditions:

1) lid 104°C; wait > auto
2) 93°C for 2 min.
3) 93°C for 1 min. (for template denaturation)
4) 58°C for 1 min. (for primer annealing)
5) 65°C for 8 min. (for strand extension)
6) GOTO 2; REP 40 (for amplification)
7) HOLD 4°C
8) END

! 4)!prepare analytical agarose gel
see supporting protocol

! 5)!resolve samples from WT (C57BL/6) and Itk KO by electrophoresis
! 6)!analyze bands according to diagram above
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5.2.3. Cell Culture
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Serological Pipet Decontamination
treatment for reusable glass serological pipets

Equipment:
! -!dI water supply
! -!pipet washer / rinser

Nalgene
! -!pipet plugger

cotton stuffing machine
! -!pipet canisters
! -!autoclave
! -!lab oven with high temperature thermometer
! -!forceps
! -!reusable glass serological pipets
! -!stored in 10% bleach solution

for decontamination

Materials:
! -!autoclave tape

Procedure:
! 1)!remove excess autoclave tape from pipet canisters

to prevent fumes while inside lab oven
! 2)!remove cotton plug from serological pipets using forceps
! 3)!segregate 5, 10 and 25 mL pipets
! 4)!rinse at least 3x using dI water using pipet washer / rinser

removes debris and bleach from pipets
! 5)!place inside labeled canisters according to size
! 6)!stuff cotton in top of pipets using cotton plugging machine
! 7)!return to respective canisters
! 8)!apply autoclave tape across cap of canister
! 9)!autoclave for 30 min. on dry cycle
! 10)!bake in lab oven at 180°C for 4 hrs

to dry and destroy endotoxin
! 11)!allow to cool
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FBS Heat Inactivation
for complement inactivation

Equipment:
! -!37°C water bath and thermometer
! -!biosafety cabinet (TC hood)

for preparing sterile aliquots
! -!55°C water bath and thermometer
! -!lab timer
! -!-20°C freezer

for storage of aliquots

Materials:
! -!fetal bovine serum (FBS), 0.5 - 1 L bottle
! -!thawed at room temp. overnight or in 37°C water bath
! -!50 mL tubes, sterile and endotoxin free

Protocol:
! 1)!add dI water to water bath if needed
! 2)!equilibrate water bath to 55°C
! 3)!place bottle of FBS in water bath

do not submerge cap below water
! 4)!incubate for a total of 30 min. at 55°C
! 4.1)!after every 10 min., remove bottle
! 4.2)!invert to mix
! 4.3)!return to water bath
! 5)!place inside biosafety cabinet
! 6)!allow bottle to rest for 2-3 hr.

to allow particulate matter to settle to bottom of bottle by gravity
! 7)!aliquot 40 mL of heat-inactivated FBS to each 50 mL tube

allows space in tube for expansion upon freezing
! 8)!label each tube with 'FBS' and date
! 9)!keep aliquots at -20°C until use
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Thawing Cell Lines

Equipment:
! -!liquid nitrogen log book
! -!liquid nitrogen vessel
! -!protective eyewear

for removing cryovial from liquid nitrogen
! -!biosafety cabinet (TC hood)
! -!squirt bottle with 70% ethanol
! -!37°C water bath
! -!refrigerated centrifuge
! -!humidified, 37°C, 5% CO2 incubator

Materials:
! -!cryovial containing cell line

select low passage number clone with good viability prior to thawing
! -!preserved in liquid nitrogen
! -!15 mL centrifuge tubes
! -!wash medium, cell line specific

- see 'Buffers & Solutions'
- designate separate bottle for each cell line to prevent cross-
contamination

Supporting Protocol:
! -!Freezing Cell Lines

Protocol:
use aseptic technique throughout

! 1)!consult log book for location, history and characteristics of vial prior 
to removal from liquid nitrogen vessel

! 2)!add 10 mL of wash medium to 15 mL centrifuge tube
! 3)!remove cryovial from liquid nitrogen vessel
! 3.1)!wear protective eyewear to prevent injury caused by 

projectile caps
! 3.2)!confirm identification written on vial with that indicated in the 

log book
! 4)!immediately thaw vial in 37°C water bath with gentle agitation
! 5)!wipe surface of vial with ethanol prior to bringing inside TC hood
! 6)!wash cells
! 6.1)!transfer cell suspension to 15 mL tube containing wash 

medium
! 6.2)!invert tube to mix / wash
! 6.3)!centrifuge at 1,000 rpm for 5 min. (4°C)
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! 6.4)!discard supernatant
! 7)!notate log book to reflect removal of vial
! 8)!proceed immediately with cell maintenance protocol for specific cell 

line
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Freezing Cell Lines

Equipment:
! -!liquid nitrogen log book
! -!-80°C freezer
! -!refrigerated centrifuge
! -!liquid nitrogen vessel

Materials:
! -!cell culture
! -!expanded

- low passage number
- logarithmic growth phase

! -!wash medium
! -!freezing medium

90% FBS + 10% DMSO
! -!cryovials
! -!colored caps for cryovials
! -!freezer box with cotton lining
! -!bucket with crushed dry ice

Supporting Protocols:
! -!Cell Line Maintenance
! -!Cell Counting

Protocol:
! 1)!wash cells
! 1.1)!remove culture from incubator
! 1.2)!transfer to centrifuge tube(s)
! 1.3)!centrifuge for 5 min. at 1,000 - 1,500 rpm (4°C)
! 1.4)!aspirate supernatant completely
! 1.5)!resuspend in wash medium
! 2)!perform cell count
! 2.1)!centrifuge for 5 min. at 1,000 - 1,500 rpm (4°C)
! 2.2)!aspirate supernatant completely
! 2.3)!resuspend in volume suitable for counting
! 3)!resuspend in freezing medium
! 3.1)!add wash medium to tube
! 3.2)!centrifuge for 5 min. at 1,000 - 1,500 rpm (4°C)
! 3.3)!aspirate supernatant completely
! 3.4)!resuspend pellet in freezing medium at 5-10x106 cells/mL
! 4)!transfer to cryovials
! 4.1)!label cryovials
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! 4.2)!apply colored cap to each vial
choose unique color / color combination for future 
identification in liquid nitrogen storage box

! 4.3)!aliquot 0.5-1 mL of cell suspension to labeled cryovials
! 4.4)!seal caps tightly
! 4.5)!place vials in center of cotton-lined freezer box
! 4.6)!place box in -80°C freezer overnight
! 5)!transfer to liquid nitrogen
! 5.1)!remove vials and place in bucket with crushed dry ice
! 5.2)!transfer vials to liquid nitrogen vessel storage box
! 5.2.1)!choose location in advance
! 6)!record entry of vials in log book
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Cell Counting

Equipment:
! -!light microscope, upright

with 40x objective
! -!P-200 pipettor
! -!P-20 pipettor
! -!lab timer
! -!hemacytometer

- 9 large squares (arranged in 3x3 grid)
- large central square sub-divided into 5x5 grid (used for counting 
cells)
- chamber depth:  0.1 mm
- surface area:  1 mm2 per large square
- volume:  0.1 mm3 = 10-4 cm3 = 10-4 mL per large square

! -!store in petri dish with cover when not in use
for protection from breakage

! -!manual tally counter
! -!calculator

Materials:
! -!cell suspension for counting
! -!petri dish with cover
! -!coverslip
! -!erythrosine

for viability determination
! -!PBS

for diluting sample before counting, if needed
! -!Kimwipes
! -!96-well plate
! -!70% ethanol squirt bottle

Protocol:
! 1)!resuspend cells well to disrupt clumps
! 2)!remove 30 µL aliquot from cell suspension
! 3)!add to 96-well plate designated for cell counting
! 4)!count live / dead cells
! 4.1)!count in 5x5 grid in center of hemacytometer
! 4.2)!mix cell suspension with 30 µL (equal volume) of erythrosine

dye is actively excluded from healthy / live cells and is 
taken up by unhealthy / dead cells

! 4.3)!slowly add 10 µL of cell suspension to each side of 
hemacytometer with coverslip in place

avoid air bubbles
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! 4.4)!allow 1 min. for cells to settle
! 4.5)!for accuracy, aim to count 100 - 500 total cells in large 

central square (sub-divided into grid)
use 40x objective

! 5)!if too many cells to count:
! 5.1)!remove another aliquot
! 5.2)!dilute in PBS

note dilution factor used
! 5.3)!repeat count as described above
! 6)!if too few cells:
! 6.1)!allow cells to proliferate further before repeating count (if 

possible)
! 6.2)!alternatively, concentrate sample prior to repeating count
! 6.2.1)!remove volume from cell suspension
! 6.2.2)!centrifuge
! 6.2.3)!discard supernatant
! 6.2.4)!resuspend in smaller volume

note concentration factor used
! 6.3)!repeat count as described above
! 7)!for precision, count on both sides of hemacytometer

repeat count if numbers differ by > 10%
! 8)!calculate concentration of cell suspension in cells/mL
! 8.1)!calculate number of live / dead cells per large (counting) 

square
! 8.1.1)!average independent counts on either side of 

hemacytometer
! 8.2)!multiply average number of live / dead cells by 10,000

# cells / 0.1 mm3 x 10,000 = # cells / mL
! 8.3)!multiply each value by 2

correction factor for 1:2 dilution in erythrosine
! 8.4)!multiply / divide each value by additional dilution / 

concentration factor, respectively
to correct for additional dilution or concentration of original 
cell suspension prior to counting, if applicable
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Doubling Time Calculation

Equipment:
! -!calculator

Materials:
! -!lab notebook

Supporting Protocol:
! -!Cell Counting

Protocol:
Doubling time is a unique property of each cell line and should be monitored 
along with viability as an indication of culture health.

Doubling time calculation assumes that cells have been seeded in an 
appropriate culture vessel at a known concentration and incubated for a 
known amount of time until subsequently resuspended and counted to 
determine the final concentration.

Formula for doubling time (T) is as follows:  T = t / n
where n = ln (T/T0) / ln (2)
and ln = natural logarithm where eln(x) = x

! 1)!record N0
initial concentration
ex:  0.3x106 cells/mL

! 2)!record N
final concentration
ex:  1.5x106 cells/mL

! 3)!record t
time between N0 and N
ex:  72 hours

! 4)!calculate 'n' where n = ln (T/T0) / ln (2)
ex:
n = ln (1.5x106 / 0.3x106) / ln (2)
n = ln (5) / ln (2)
n = 1.609 / 0.693
n = 2.322

! 5)!calculate 'T' where T = t / n
ex:
T = 72 / 2.322
T = 31 hours
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Jurkat / Raji Cell Line Maintenance
- for non-adherent cell lines (e.g., Jurkat, Raji, etc.)
- all work related to culturing cells should be performed using proper aseptic 
technique in a certified biosafety cabinet

Equipment:
! -!refrigerated centrifuge
! -!humidified, 37°C, 5% CO2 incubator
! -!biosafety cabinet (TC hood)

certified for BSL 2 designation
! -!inverted light microscope
! -!waste container

for decontamination of discarded culture
! -!containing 10% bleach when full

Materials:
! -!Jurkat cell line

- human leukemic T cell line
- various sub-lines available (e.g., Jurkat E6.1 available from ATCC)

! -!freshly thawed from liquid nitrogen
! -!Raji cell line

- human Burkitt's lymphoma B cell line
- available from ATCC

! -!freshly thawed from liquid nitrogen
! -!Wash Medium (WM)

see 'Buffers & Solutions'
! -!Growth Medium (GM)

see 'Buffers & Solutions'
! -!T-25 flasks

25 cm2 surface area / 10 mL culture volume
! -!T-75 flasks

75 cm2 surface area / 50 mL culture volume
! -!T-150 flasks

150 cm2 surface area / 100 mL culture volume
! -!1, 5, 10 and 25 mL serological pipets

sterile and endotoxin-free

Supporting Protocols:
! -!Thawing Cell Lines
! -!Cell Counting
! -!Freezing Cell Lines
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Protocol:
- progressive color change of phenol red in medium from red to orange to 
yellow indicates active cell metabolism and thus cell survival and proliferation
- periodically examine cells using inverted light microscope for presence of 
grape-like clusters formed due to homotypic adhesions among dividing cells
- in addition, periodically examine cells visually and using microscope for 
presence of fungal or bacterial contamination, respectively
- healthy culture conditions are intended to maintain cells in logarithmic phase 
of growth curve (typically in the range between 105-106 cells/mL with a 
doubling time of approximately 24 hours)
- If working with more than one cel line, reduce the risk of cross-contamination 
by:
! - maintaining each cell line independently,
! - sterilizing surfaces with 70% ethanol before and after work and,
! - designating separate bottles of medium for each cell line

! 1)!establish starter culture
- passage 0
- growth in small clusters is important for survival and further growth
- maintain starter culture in small volume and do not resuspend 
cells until needed

! 1.1)!immediately after removal from liquid nitrogen, resuspend 
pellet in 5 mL of JGM

! 1.2)!label 25 cm2 flask with initials, cell line, clone, date and 
passage number

! 1.3)!transfer cell suspension to flask
! 1.4)!place inside incubator overnight in vertical position
! 1.4.1)!loosen cap to allow gas exchange if not using flask 

with vented cap
! 1.5)!monitor color of growth medium for signs of growth
! 1.6)!continue to incubate in vertical position until medium 

becomes red-orange
! 1.7)!once cell growth has been noted, add 5 mL of JGM to flask 

and place flask in horizontal position
do not resuspend cells

! 1.8)!continue to incubate in horizontal position until medium 
becomes orange-yellow is consistent with expected cell 
density as judged visually using inverted light microscope

! 2)!perform cell count
! 2.1)!resuspend cells to form single-cell suspension
! 2.2)!remove small aliquot of culture for cell counting and viability 

determination
see 'Cell Counting' protocol for details

! 2.3)!once density of culture reaches ~106 cells/mL, proceed by 
maintaining cells

266



if cell density remains well below 106 cells/mL, return flask 
to incubator and continue to culture until target density is 
achieved

! 3)!maintain original culture
- as cells continue to proliferate, healthy culture conditions are 
maintained by re-seeding flask while replacing nutrients by adding 
fresh medium
- continue to re-use original 25 cm2 flask for multiple passages
- use original culture as source to seed additional flasks (see below)

! 3.1)!re-seed 25 cm2 flask with 106 cells in 10 mL of final culture 
volume

e.g., add 1 mL of culture at 106 cells/mL to 9 mL of fresh 
JGM

! 3.1.1)!retain remaining culture volume to seed additional 
flasks

or discard if not required
! 3.2)!label flask with consecutive passage number 
! 3.3)!continue to maintain culture in same manner for 10-20 

passages
! 3.4)!calculate and record doubling time between successive 

passages
see 'Cell Counting' protocol for details

! 4)!expanding cells
- in addition to maintaining the culture, one must also expand cells 
by seeding into larger flask sizes to generate sufficient cell numbers 
for re-freezing and for use in experiments
- to maintain genetic characteristics of original culture, seed flasks 
to generate cells for re-freezing at first passage

! 4.1)!seed flask(s) of various sizes with cell number needed for 
density of 105 cells/mL upon addition of JGM to final culture 
volume

proceed by expanding to progressively larger sized flask
! 4.1.1)!for 75 cm2 flask, add 5x106 cells in 50 mL of final 

culture volume
! 4.1.2)!for 150 cm2 flask, add 107 cells in 100 mL of final 

culture volume
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Jurkat Serum Starvation
to reduce basal activation of signaling proteins prior to use in experiments

Equipment:
! -!biosafety cabinet (TC hood)

certified for BSL 2 designation
! -!humidified, 37°C, 5% CO2 incubator
! -!waste container

for decontamination of discarded culture
! -!containing 10% bleach when full

Materials:
! -!Jurkat cells

logarithmic growth phase
! -!cultured to ~106 cells/mL
! -!Raji cells

logarithmic growth phase
! -!cultured to ~106 cells/mL
! -!50 mL centrifuge tubes
! -!Starvation Medium

cRPMI + 0.2% FBS

Protocol:
! 1)!remove cells from culture to use for experiment when concentration 

reaches ≤ 106 cells/mL
logarithmic growth phase

! 2)!resuspend cells
! 3)!centrifuge for 5 min. at 1,000 rpm (4°C)
! 4)!discard supernatant
! 5)!resuspend pellet in Starvation Medium
! 6)!return cells to flask
! 7)!place flask in incubator overnight (16-18 hrs.)
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HEK293 Cell Line Maintenance
for adherent cell lines (e.g., HEK293, Cos, etc.)

Equipment:
! -!refrigerated centrifuge
! -!humidified, 37°C, 5% CO2 incubator
! -!inverted light microscope
! -!waste container

for decontamination of discarded culture
! -!containing 10% bleach when full

Materials:
! -!10 cm2 plate

for adherent cell lines (e.g., HEK293)
! -!293 Growth Medium

cDMEM + 10% FBS
! -!PBS, cell culture grade
! -!trypsin-EDTA
! -!transfer pipets
! -!15 mL centrifuge tube

Supporting Protocol:
! -!Thawing Cell Lines

Protocol:
- protocol assumes 10 cm diameter (60 cm2) cell culture plate
- scale volumes proportionally for various-size culture vessels
- seed number of plates required for experiment in advance

! 1)!trypsin treatment
- proceed when cells achieve ≤ 90% confluency
- discard plate after trypsin treatment (do not reuse plate)

! 1.1)!gently wash cells with 5 mL PBS
to remove calcium and magnesium prior to incubation with 
trypsin

! 1.2)!decant
! 1.3)!repeat wash with PBS
! 1.4)!decant
! 1.5)!add 500 µL tryspin

tilt plate to cover entire surface area
! 1.6)!incubate with trypsin for 5 min. inside 37°C incubator

to detach cells
! 2)!quench trypsin
! 2.1)!add 10 mL of 293 Growth Medium
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! 2.2)!transfer cell suspension to 15 mL centrifuge tube
! 2.3)!centrifuge for 5 min. at 1,500 rpm (4°C)
! 2.4)!decant supernatant
! 3)!wash cells
! 3.1)!resuspend in 10 mL of PBS
! 3.2)!centrifuge for 5 min. at 1,500 rpm (4°C)
! 3.3)!decant supernatant
! 4)!seed new culture plate

set up multiple plates at different starting densities in order to have 
continuous supply of plates available for transfection

! 4.1)!resuspend pellet in 293 Growth Medium to yield 
concentrated cell suspension

- adjust volume based on size of cell pellet
- pipet up and down numerous times to break apart cell 
clumps
- start by resuspending in small volume and increase 
volume if needed

! 4.2)!add 15 mL of 293 Growth Medium to plate
! 4.3)!add concentrated HEK293 cell suspension drop-wise
! 4.4)!adjust cell number in order to achieve ≤ 10% confluency

determine optimal starting density using inverted light 
microscope

! 4.5)!place inside TC incubator overnight
! 5)!examine under microscope for proper cell attachment, morphology, 

and growth
- viable cells extent projections for attachment to plate surface
- actively dividing cells retract from plate
- dead / unhealthy cells remain unattached and can be removed by 
replacing medium if needed

270



HEK293 Serum Starvation
for adherent cell lines (e.g., HEK293, Cos, etc.)

Equipment:
! -!biosafety cabinet (TC hood)

certified for BSL 2 designation
! -!humidified, 37°C, 5% CO2 incubator
! -!waste container

for decontamination of discarded culture
! -!containing 10% bleach when full

Materials:
! -!plate of adherent cells
! -!Starvation Medium

cDMEM + 0.2% FBS

Protocol:
! 1)!discard / decant 293 Growth Medium
! 2)!wash 2x with PBS

to remove remaining growth medium
! 3)!replace with equal volume of Starvation Medium
! 4)!place plate in incubator overnight (16-18 hrs.)
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HEK293 Transfection with Lipofectamine

Equipment:
! -!refrigerated centrifuge
! -!humidified, 37°C, 5% CO2 incubator
! -!inverted light microscope

Materials:
! -!plasmid DNA
! -!Lipofectamine 2000 reagent or equivalent

Invitrogen / Life Technologies
- Cat. # 11668-027; 0.75 mL
- Cat. # 11668-019; 1.5 mL

! -!HEK293
! -!seeded in 10 cm diameter plate
! -!cultured to ~90% confluency
! -!293 Growth Medium

cDMEM + 10% FBS
! -!293 Transfection Medium

DMEM supplemented with HEPES, L-Glutamine + 10% FBS (without 
antibiotics)

! -!293 Wash Medium
- without supplements and serum-free
- for formation of DNA-lipid complexes prior to transfection

! -!PBS, cell culture grade
! -!trypsin-EDTA

Supporting Protocol:
! -!HEK293 Cell Line Maintenance

Protocol:
- protocol assumes 10 cm diameter (60 cm2) cell culture plate
- scale volumes proportionally for various-size culture vessels based on 
surface area
- during transfection with Lipofectamine, internalized penicillin-streptomycin 
may be toxic to cells; thus it is important to seed HEK293 in medium without 
antibiotics at least 1 day prior to transfection

! 1)!process cells as follows
refer to 'HEK293 Cell Line Maintenance' protocol

! 1.1)!treat with trypsin
! 1.2)!quench trypsin
! 1.3)!wash cells
! 2)!seed new plate(s) for transfection 
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! 2.1)!resuspend pellet in 293 Transfection Medium to yield 
concentrated cell suspension

- adjust volume based on size of cell pellet
- start by resuspending in small volume and increase 
volume if needed

! 2.1.1)!pipet up and down numerous times
to break apart cell clumps

! 2.2)!add 15 mL of 293 Transfection Medium to plate
! 2.3)!add concentrated HEK293 cell suspension drop-wise
! 2.4)!adjust cell number in order to achieve ~90% confluency 

within ~24 hours
- determine optimal starting density using inverted light 
microscope
- may incubate longer until ≤ 90% confluency is achieved

! 2.5)!place inside TC incubator overnight
! 3)!prepare DNA-lipid complexes

prepare using DMEM without supplements or FBS
! 3.1)!dilute Lipofectamine
! 3.1.1)!mix Lipofectamine stock well prior to use
! 3.1.2)!add 60 µL of Lipofectamine to 1.5 mL of DMEM 

basal medium
! 3.1.3)!incubate for ≥ 5 min. and < 25 min. at room temp. 

prior to combining with diluted DNA
! 3.2)!dilute 24 µg of plasmid DNA in 1.5 mL of DMEM basal 

medium
! 3.3)!combine diluted Lipofectamine and diluted DNA solutions 

(total volume 3 mL)
! 3.4)!mix gently and incubate for > 20 min. and < 6 hrs. at room 

temp.
for formation of DNA-lipid complexes

! 4)!add 3 mL of DNA-lipid complexes to cells
in addition to 15 mL of 293 Transfection Medium

! 5)!optional:  replace medium after 4-6 hours
! 6)!place inside incubator for 18-48 hrs. prior to assessing for 

expression
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Jurkat Bio-Rad Electroporation
low transfection efficiency / high cell yield – for biochemical analyses

Equipment:
! -!Bio-Rad electroporator
! -!refrigerated centrifuge
! -!biosafety cabinet (TC hood)
! -!37°C, 5% CO2 humidified incubator

Materials:
! -!plasmid DNA
! -!purified and endotoxin-free (preferred)
! -!splenocytes (80x106 cells per transfection)
! -!Jurkat cells (20x106 cells per transfection)
! -!cultured to ≤ 106 cells/mL
! -!seed sufficient number of flasks in advance according to 

experimental design
! -!retain culture supernatant for preparation of conditioned 

medium
! -!Sharpie marker, ultrafine point
! -!Kimwipes
! -!electroporation cuvettes, 4 mm gap
! -!50 mL centrifuge tubes
! -!Jurkat Wash Medium

RPMI-1640
! -!Jurkat Transfection Medium (JTM)

RPMI-1640 + 10 mM HEPES, 2 mM L-glutamine + 10% FBS
! -!bucket with ice
! -!microcentrifuge tubes
! -!25 cm2 flasks (1 per transfection)
! -!transfer pipets

Supporting Protocols:
! -!Jurkat Cell Line Maintenance
! -!Cell Counting

Protocol:
! 1)!perform cell count
! 2)!prepare post-transfection culture medium
! 2.1)!add 10 mL of growth medium to 25 cm2 flask

for Jurkat cells:
- 10% conditioned medium
- 10% FBS
- 80% complete RPMI
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! 2.2)!label each flask
! 2.3)!equilibrate in incubator
! 3)!aliquot plasmid DNA
! 3.1)!thaw plasmid DNA stock solution to room temperature
! 3.2)!label microcentrifuge tube
! 3.3)!aliquot 20 µg of plasmid DNA per tube

perform in TC hood
! 3.4)!keep on ice
! 4)!label cuvettes on caps
! 4.1)!equilibrate on ice
! 5)!wash cells 2x
! 5.1)!transfer cell culture to centrifuge tube(s)
! 5.2)!centrifuge cells at 1,000-1,500 rpm for 5 min. (4°C)
! 5.3)!discard supernatant
! 5.4)!wash pellet in 10 mL of RPMI-1640
! 5.5)!repeat
! 6)!resuspend cells for transfection
! 6.1)!centrifuge cells at 1,000-1,500 rpm for 5 min. (4°C)
! 6.2)!aspirate supernatant

remove completely
! 6.3)!for each transfection reaction, resuspend 20x106 cells in 0.5 

mL of ice-cold Wash Medium
! 7)!mix DNA and cells
! 7.1)!transfer 500 µL of cell suspension to each microcentrifuge 

tube containing DNA
! 7.2)!pipet gently up and down to mix cells and DNA
! 7.3)!transfer 500 µL of DNA / cell suspension to ice-cold cuvette

avoid air bubbles
! 7.3.1)!keep on ice
! 7.4)!gently tap cuvette to bring DNA / cell suspension to bottom
! 8)!electroporate
! 8.1)!perform serially for each transfection
! 8.2)!set to deliver 250 mV

display reads '0.250'
! 8.3)!remove cuvette from ice and dry electrodes using Kimwipe
! 8.4)!place cuvette in electroporator
! 8.5)!press both buttons simultaneously to deliver charge
! 8.6)!immediately return cuvette to ice following electroporation
! 9)!culture cells post-transfection
! 9.1)!remove T-25 flask(s) from incubator in advance
! 9.2)!transfer transfected cells to flask containing culture medium
! 9.3)!return to incubator for 48 hours

for gene expression
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Jurkat Amaxa Nucleofection
high transfection efficiency / low cell yield – for analysis by microscopy and/or 
FACS

Equipment:
! -!Nucleofector II

Amaxa
! -!refrigerated centrifuge
! -!37°C, 5% CO2 humidified incubator

Materials:
! -!Jurkat clone E6.1 (ATCC)

- 1-5x106 cells per nucleofection reaction
- seed sufficient number of flasks in advance according to 
experimental design

! -!cultured to ≤ 106 cells/mL
! -!plasmid DNA, purified and endotoxin-free (preferred)
! -!Jurkat Wash Medium

RPMI-1640
! -!Jurkat Transfection Medium (JTM)

RPMI-1640 + 10 mM HEPES, 2 mM L-glutamine + 10% FBS
! -!Cell Line Nucleofector Kit V
! -!Amaxa, Cat. # VCA-1003
! -!cuvettes
! -!Cell Line Nucleofector Solution V

see 'Buffers & Solutions' for details
! -!transfer pipets
! -!12-well culture plates (Corning, Cat. # 3513)
! -!15 mL / 50 mL centrifuge tubes
! -!microcentrifuge tubes

Supporting Protocols:
! -!Jurkat Maintenance
! -!Cell Counting

Protocol:
! 1)!perform cell count
! 2)!pre-warm supplemented Nucleofection Solution V to room 

temperature
supplied with kit

! 3)!prepare post-nucleofection culture medium
! 3.1)!for each nucleofection, add 1.5 mL of Jurkat Transfection 

Medium per well of 12-well plate
! 3.2)!label each well on top of plate
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! 3.3)!equilibrate plate for ≥ 30 min. inside incubator
! 4)!aliquot plasmid DNA
! 4.1)!thaw plasmid DNA stock solution to room temperature
! 4.2)!label each microcentrifuge tube
! 4.3)!for each nucleofection, aliquot 2-5 µg of DNA per tube
! 5)!label caps of Amaxa cuvettes for each nucleofection

supplied with kit
! 6)!wash cells 2x

transfer cell culture to centrifuge tube(s)
! 6.1)!centrifuge cells at 1,000 rpm for 5 min. (4°C)
! 6.2)!discard supernatant
! 6.3)!wash pellet in 10 mL of RPMI-1640
! 7)!resuspend cells for nucleofection
! 7.1)!centrifuge cells at 1,000 rpm for 5 min. (4°C)
! 7.2)!aspirate supernatant – remove completely
! 7.3)!for each nucleofection reaction, resuspend 1-5x106 cells in 

100 µL of supplemented Nucleofector Solution V
! 7.4)!complete nucleofection protocol within 15 min.
! 8)!mix DNA and cells
! 8.1)!transfer 100 µL of cell suspension to each microcentrifuge 

tube containing DNA
! 8.2)!pipet gently up and down to mix cells and DNA
! 8.3)!transfer 100 µL of DNA / cell suspension to labeled cuvette 

-- avoid air bubbles
! 8.4)!gently tap cuvette to bring DNA / cell suspension to bottom
! 9)!nucleofection

perform serially for each reaction
! 9.1)!plug Nucleofector II into power supply and turn device on
! 9.2)!select program 'X-001'

- additional programs include 'X-005' and 'S-018'
- assess each for optimal combination of transfection 
efficiency and viability

! 9.3)!place cuvette in device
! 9.4)!press 'X' button to deliver charge
! 9.5)!verify that device displays 'OK' following successful 

nucleofection
! 10)!culture cells post-nucleofection
! 10.1)!remove 12-well plate from incubator in advance
! 10.2)!for each nucleofection, remove 0.5 mL of growth medium 

from designated well of plate
! 10.3)!gently add 0.5 mL of growth medium to cuvette
! 10.4)!using supplied transfer pipet, gently resuspend cells in 

cuvette
! 10.5)!transfer cell suspension to designated well of plate
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! 10.6)!label plate with time of final nucleofection
! 10.7)!return plate to incubator for 24-48 hours

for gene expression
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Mouse T Cell Amaxa Nucleofection
high transfection efficiency / low cell yield – for analysis by microscopy and/or 
FACS

Equipment:
! -!Nucleofector II
! -!refrigerated centrifuge
! -!37°C, 5% CO2 humidified incubator

Materials:
! -!5-10x106 murine lymphocytes

do not perform RBC lysis
! -!0.5-1x106 purified T cells

do not perform RBC lysis
! -!plasmid DNA
! -!purified and endotoxin-free (preferred)
! -!Mouse T Cell Nucleofector Kit

Amaxa, Cat. # VPA-1006
! -!cuvettes
! -!Mouse T Cell Nucleofector Solution

see 'Buffers & Solutions' for details
! -!Mouse T Cell Nucleofector Medium

see 'Buffers & Solutions' for details
! -!transfer pipets
! -!12-well culture plates

Corning, Cat. # 3513
! -!microcentrifuge tubes

Supporting Protocols:
! -!In Vivo / Ex Vivo > Splenocyte Preparation
! -!Cell Counting

Protocol:
! 1)!isolate murine lymphocytes from spleen and/or thymus

do not perform RBC lysis
! 2)!perform cell count
! 3)!pre-warm supplemented Mouse T Cell Nucleofector Solution to room 

temperature
supplied with kit

! 4)!prepare post-nucleofection culture medium
! 4.1)!for each nucleofection, add 1 mL of Mouse T Cell 

Nucleofector Medium per well of 12-well plate
! 4.2)!label each well on top of plate
! 4.3)!equilibrate plate for ≥ 30 min. inside incubator
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! 5)!aliquot plasmid DNA
! 5.1)!thaw plasmid DNA stock solution to room temperature
! 5.2)!label each microcentrifuge tube
! 5.3)!for each nucleofection, aliquot 4 µg of DNA per tube
! 6)!label caps of Amaxa cuvettes for each nucleofection

supplied with kit
! 7)!resuspend cells for nucleofection

complete nucleofection protocol within 15 min.
! 7.1)!centrifuge cells at 1,500 rpm for 5 min. (4°C)
! 7.2)!aspirate supernatant

remove completely
! 7.3)!for each nucleofection reaction, resuspend recommended 

cell number in 100 µL of supplemented Mouse T Cell 
Nucleofector Solution

! 8)!mix DNA and cells
! 8.1)!transfer 100 µL of cell suspension to each microcentrifuge 

tube containing DNA
! 8.2)!pipet gently up and down to mix cells and DNA
! 8.3)!transfer 100 µL of DNA / cell suspension to labeled cuvette

avoid air bubbles
! 8.4)!gently tap cuvette to bring DNA / cell suspension to bottom
! 9)!nucleofection

perform serially for each reaction
! 9.1)!plug Nucleofector II into power supply and turn device on
! 9.2)!select program 'X-001'
! 9.3)!place cuvette in device
! 9.4)!press 'X' button to deliver charge
! 9.5)!verify that device displays 'OK' following successful 

nucleofection
! 10)!culture cells post-nucleofection
! 10.1)!remove 12-well plate from incubator in advance
! 10.2)!for each nucleofection, remove 0.5 mL of growth medium 

from designated well of plate
! 10.3)!gently add 0.5 mL of growth medium to cuvette
! 10.4)!using supplied transfer pipet, gently resuspend cells in 

cuvette
! 10.5)!transfer cell suspension to designated well of plate
! 10.6)!label plate with time of final nucleofection
! 10.7)!return plate to incubator for 24-48 hours

for gene expression
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5.2.4. In Vivo / Ex Vivo
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Mouse Euthanasia Using CO2
CO2 displaces O2 and results in death by affixation

Equipment:
! -!mouse cage with wire rack
! -!-20°C freezer

for storage of mouse carcasses

Materials:
! -!mice to be euthanized
! -!dry ice
! -!insulated blanket, disposable

to wrap cage
! -!paper towels
! -!plastic bag

for mouse carcasses

Protocol:
! 1)!remove food and water from cage containing mice to be euthanized
! 2)!place piece of dry ice on top of folded paper towel above wire rack
! 3)!wrap cage inside insulated blanket
! 4)!allow 5-10 mins. or until mice are unconscious / dead
! 5)!remove each mouse from cage and perform cervical dislocation

in case CO2 was not effective
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Anesthesia Using Isoflurane
short term anesthesia delivery in glass jar

Equipment:
! -!fume hood
! -!glass jar with lid

for delivery of anesthetic prior to cervical dislocation

Materials:
! -!mice to be anesthetized
! -!isoflurane
! -!cotton / surgical gauze

to absorb isoflurane

Protocol:
- proceed for each mouse individually
- work with isoflurane inside chemical fume hood

! 1)!absorb isoflurane onto cotton / surgical gauze
! 2)!place inside jar with lid
! 3)!place mouse inside anesthesia chamber
! 4)!observe until just unconscious

for survival, monitor carefully to prevent overdose
! 5)!optional:  sacrifice anesthetized mouse by cervical dislocation
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Mouse Tail Biopsy
used for DNA purification and characterization by PCR

Equipment:
! -!fume hood
! -!bunsen burner
! -!beaker with 70% ethanol

for sterilizing surgical instruments
! -!scalpel, with sharpened blade
! -!forceps
! -!ruler

Materials:
! -!microcentrifuge tubes (1 per mouse / specimen)
! -!labeled with mouse ID
! -!ultrafine point Sharpie marker
! -!paper towels
! -!Kimwipes

Supporting Protocol:
! -!Anesthesia Using Isoflurane

Protocol:
proceed serially for each mouse

! 1)!sterilize blade of scalpel
! 1.1)!soak in 70% ethanol
! 1.2)!flame using bunsen burner
! 1.3)!allow to cool
! 2)!place mouse inside isoflurane jar until just motionless

see supporting protocol
! 3)!remove mouse from jar

proceed quickly
! 4)!cut 1 cm length segment from tip of tail
! 5)!transfer tail segment to labeled tube
! 6)!seal wound site
! 6.1)!soak blade of scalpel in 70% ethanol
! 6.2)!heat in flame for 10 seconds
! 6.3)!expose heated scalpel blade to wound site for 1-2 seconds

to stop bleeding
! 7)!return mouse to cage
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Retroorbital Blood Collection
can be survival for repeated sampling

Equipment:
! -!microcentrifuge
! -!-20°C / -80°C freezer

Materials:
! -!mice
! -!paper towels
! -!Natelson blood collecting tubes

VWR, Cat. # 14705-020
Fisher, Cat. # 02-668-15

! -!surgical gauze
! -!microcentrifuge tubes
! -!lab timer
! -!mouse cage with wire top

Supporting Protocol:
! -!Anesthesia Using Isoflurane

Protocol:
work with one mouse at a time

! 1)!place mouse inside isoflurane jar until just motionless
see supporting protocol

! 2)!remove mouse from jar and lay face down on top of paper towels
! 3)!using first finger and thumb, pull skin away form eyeball until 

protruding from socket
! 4)!insert tip of Natelson blood collecting tube at 45° angle into anterior 

corner of socket behind eyeball
! 5)!rotate blood collecting tube clockwise and counterclockwise until 

blood begins to enter tube
! 6)!once blood enters tube, adjust angle downward to facilitate flow by 

capillary action
! 7)!after collecting sufficient amount of blood, dispense into 

microcentrifuge tube by blowing into top of tube
! 8)!continue to collect blood as before for a total of 300-500 µL per 

mouse
use new tubes as needed

! 9)!after blood draw is complete, apply slight pressure to eyeball with 
surgical gauze

! 10)!return mouse to new cage and allow to recover
! 11)!proceed with additional mice
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! 12)!to collect serum, allow blood to clot for ≥ 2 hr. at room temp.
! 13)!centrifuge for 3,000 rpm for 15 min. at 4°C
! 14)!transfer serum (top phase) to new microcentrifuge tube
! 15)!store serum samples at -20°C or -80°C

References:
! (138)

286



Anesthesia Machine Set Up
isoflurane mixed with oxygen for consistent and safe anesthesia

Equipment:
! -!chemical fume hood

place isoflurane vaporizer and induction chamber inside chemical 
fume hood to protect from isoflurane vapors

! -!anesthesia machine
! -!tubing
! -!oxygen E-tank
! -!pressure regulator / flowmeter
! -!isoflurane vaporizer
! -!induction chamber

Materials:
! -!isoflurane
! -!transfer pipet

Protocol:
! 1)!connect anesthesia machine according to diagram below

Figure 30:  Isoflurane vaporizer placed inside chemical fume hood.

! 2)!fill reservoir of isoflurane vaporizer with isoflurane as needed
! 3)!check hoses for any obstructions
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! 4)!adjust O2 flow rate to 1 liter/minute
! 5)!adjust level of isoflurane to 3.5%
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RBC Lysis
erythrocyte lysis

Equipment:
! -!refrigerated centrifuge
! -!vortex
! -!lab timer

Materials:
! -!primary lymphocyte
! -!freshly isolated
! -!ACK lysis buffer
! -!keep at room temp.
! -!Wash Medium / RPMI-1640
! -!keep at 4°C
! -!FACS Buffer
! -!keep at 4°C

Supporting Protocol:
! -!Splenocyte Preparation

Protocol:
! 1)!for each tube, resuspend cells in 0.2-1 mL of ACK lysis buffer
! 2)!incubate for 5 min. at room temp.
! 3)!vortex occasionally
! 4)!fill tube with Wash Medium / FACS Buffer

to quench / wash
! 5)!centrifuge for 5 min. at 1,500 rpm (4°C)
! 6)!discard supernatant
! 7)!visually inspect pellet for efficient lysis of RBCs

removal of red layer
! 8)!if needed, repeat for removal of red layer

References:
! (139)
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Splenocyte Preparation

Equipment:
! -!bucket with ice
! -!refrigerated centrifuge
! -!forceps (2)
! -!surgical scissors (2)
! -!beaker with 70% ethanol

for sterilizing surgical instruments
! -!70% ethanol squirt bottle

Materials:
! -!mice
! -!15 mL tubes
! -!T Cell Medium (TCM)

RPMI-1640 + 10% FBS + HEPES + L-Glutamine, + 2-ME + Pen/
Strep

! -!paper towels

Supporting Protocols:
! -!Anesthesia Using Isoflurane
! -!Tissue Dissociation
! -!RBC Lysis
! -!Cell Culture > Cell Counting

Protocol:

Figure 31:  Splenectomy.
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! 1)!add 10 mL of ice-cold TCM to 15 mL tube
- prepare inside TC hood
- prepare separately for each mouse

! 1.1)!keep on ice
! 2)!sacrifice mouse using isoflurane followed by cervical dislocation

see supporting protocol
! 3)!place mouse on stack of paper towels with left side facing up
! 4)!soak fur on left side with 70% ethanol solution
! 5)!lift loose skin and make single incision through skin on left side 

above spleen
! 6)!firmly pull apart skin on either side of incision to expand opening

spleen should be visible below peritoneal membrane
! 7)!lift peritoneal membrane and make single incision through 

membrane
! 8)!excise spleen using sterile surgical scissors and forceps to separate 

from connective tissue and blood vessels
! 9)!place spleen in 15 mL tube containing ice-cold medium
! 10)!proceed with Tissue Dissociation protocol

see supporting protocol
! 11)!perform RBC lysis

see supporting protocol
! 11.1)!resuspend cells from single spleen in 0.5 mL of ACK lysis 

buffer
! 12)!resuspend splenocytes in 5 mL of TCM
! 13)!perform cell count

see supporting protocol
! 14)!optional:  keep cells on ice overnight

References:
! (139)
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Mouse Dissection
opening of chest cavity to harvest thymus, mediastinal lymph nodes, and/or 
lungs

Equipment:
! -!light source for dissection
! -!surgical scissors (2)

- sharp end (1)
- blunt end (1)

! -!forceps (1)
! -!squirt bottle containing 70% ethanol
! -!bucket with ice

Materials:
! -!dissection board
! -!needles

for securing mouse to dissection board
! -!paper towels

Supporting Protocol:
! -!Anesthesia Using Isoflurane

Protocol:

Figure 32:  Mouse dissection.
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! 1)!sacrifice mouse using isoflurane followed by cervical dislocation
see supporting protocol

! 2)!place mouse supine on top of dissection board
! 3)!extend front and rear paws and secure using needles
! 4)!soak fur with 70% ethanol solution
! 5)!using forceps, lift loose skin just below sternum
! 6)!make single longitudinal incision through skin at midline
! 7)!separate skin above chest cavity by extending flat edge of blunt 

scissors towards lower jaw
! 8)!separate skin below rib cage by extending flat edge of blunt scissors 

laterally on both sides
! 9)!make longitudinal incision through skin above chest cavity
! 10)!make two lateral incisions through skin below rib cage on both 

sides
! 11)!make single incision through peritoneal membrane just below 

sternum
! 12)!make two lateral incisions through peritoneal membrane below rib 

cage on both sides
! 13)!make single longitudinal incision through sternum to penetrate 

chest cavity
! 14)!make two lateral incisions through membrane surrounding chest 

cavity below rib cage on both sides
! 15)!continue longitudinal incision through rib cage towards anterior
! 16)!separate rib cage using pins to open chest cavity (optional)
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Tissue Dissociation
to prepare single-cell suspension from primary tissue

Equipment:
! -!bucket with ice
! -!refrigerated centrifuge

Materials:
! -!T Cell Medium (TCM)

RPMI-1640 + 10% FBS + HEPES + L-Glutamine, + 2-ME + Pen/
Strep

! -!tissue specimen in medium
! -!keep on ice
! -!70 µm nylon cell strainers (1 per specimen)
! -!50 mL centrifuge tubes (1 per specimen)
! -!transfer pipets (1 per specimen)
! -!syringes (1 per specimen)

Protocol:
! 1)!place 70 µm cell strainer on top of 50 mL tube
! 2)!using transfer pipet, wet surface of cell strainer with medium
! 3)!collect tissue on top of strainer
! 4)!using blunt end of syringe plunger, manually dissociate tissue 

against top of strainer
! 5)!pass 10 mL of TCM through strainer to collect cells in 50 mL tube
! 5.1)!rinse blunt end of syringe plunger to recover additional cells
! 6)!centrifuge splenocytes for 5 min. at 1,500 rpm (4°C)
! 7)!discard supernatant

References:
! (139)
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CD4+ Negative Enrichment
for CD4 negative isolation from splenocytes or DLN cells

Equipment:
! -!bucket with ice
! -!refrigerated centrifuge
! -!tube rotator
! -!magnetic particle concentrator

- Invitrogen/Dynal, MPC-S
- for use with microcentrifuge tubes

Materials:
! -!splenocytes or DLN cells

see supporting protocol
! -!do not lyse RBCs
! -!count WBCs

see supporting protocol
! -!keep on ice
! -!reserve aliquot of ~106 cells

for CD4 staining prior to purification
! -!Buffer 1

see 'Buffers & Solutions'
! -!keep on ice
! -!15 mL centrifuge tube (1 per reaction)

for cells
! -!FBS
! -!heat-inactivated
! -!mouse CD4 negative isolation kit

Invitrogen/Dynal, 114.16D
! -!antibody mix

0.4 mL total volume
! -!mouse depletion Dynabeads

400x106 beads/mL stock
4 mL total volume

! -!microcentrifuge tubes (2 per reaction)
- for beads (1)
- for purified cells (1)

! -!T Cell Medium (TCM)
cRPMI + 10% FBS

Supporting Protocols:
! -!Splenocyte Preparation
! -!Lung Inflammation / Asthma > DLN Preparation
! -!Cell Culture > Cell Counting
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Protocol:
- for purification of 50x106 WBCs
- scale volumes proportionally (with some noted exceptions) from 10-100x106 
cells depending on cell number

Figure 33:  Purification of CD4+ cells.
! Splenocytes were purified for CD4+ cells using manufacturer's kit and 
aliquots of cells obtained before and after purification were stained for surface 
expression of CD4.

! 1)!prepare cells
! 1.1)!centrifuge for 5 min. at 1,500 rpm (4°C)
! 1.2)!discard supernatant
! 1.3)!resuspend cells in 0.5 mL of Buffer 1

100x106 cells/mL
! 1.4)!transfer cell suspension to 15 mL Falcon tube
! 2)!incubate with antibody mix
! 2.1)!add 100 µL of FBS

20% FBS final
! 2.2)!add 20 µL of antibody mix

- increase up to 5x for greater purity
- do not use less than 20 µL

! 2.3)!mix well
! 2.4)!incubate for 20 min. on ice
! 3)!wash magnetic beads
! 3.1)!resuspend beads using P1000 and tip
! 3.2)!transfer 200 µL of bead suspension to microcentrifuge tube

- increase up to 2.5x for greater purity
- do not use less than 200 µL or more than 500 µL

! 3.3)!add 1 mL Buffer 1
! 3.4)!resuspend with P1000 and tip to wash
! 3.5)!place tube in magnet for 1min
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! 3.6)!remove/discard supernatant
! 3.7)!remove tube from magnet
! 3.8)!resuspend beads in equal volume (200 µL) of Buffer 1
! 4)!wash cells
! 4.1)!add 10 mL of Buffer 1 (wash)
! 4.2)!centrifuge for 5 min. at 1,500 rpm (4°C)
! 4.3)!aspirate / discard supernatant using pipet tip
! 4.4)!resuspend cells in 800 µL of Buffer 1
! 5)!incubation with magnetic beads
! 5.1)!transfer 800 µL of cell suspension to microcentrifuge tube 

containing 200 µL of pre-washed beads
1 mL final volume

! 5.2)!tumble on rotator for 15 min at room temp.
! 5.3)!remove tube from rotating wheel

do NOT resuspend cells
! 6)!CD4+ negative isolation
! 6.1)!place microcentrifuge tube containing beads/cells in magnet 

for 2 min.
! 6.2)!transfer supernatant containing negatively-isolated CD4+ 

cells to new microcentrifuge tube
! 7)!replace medium
! 7.1)!centrifuge for 5 min. at 1,500 rpm (4°C)
! 7.2)!aspirate supernatant
! 7.3)!resuspend pellet in volume of TCM for counting
! 7.4)!count cells

reserve aliquot of ~106 cells for CD4 staining post-
purification

! 7.5)!adjust to desired cell concentration in TCM
! 8)!proceed with downstream application
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Mononuclear Cell Isolation Using Density Gradient
for isolating / improving viability of lymphocytes and other mononuclear cells 
above histopaque layer – RBCs, granulocytes and dead cells contained in 
pellet

Equipment:
! -!centrifuge

Materials:
! -!source of lymphocytes for mononuclear cell isolation

Jurkat cell culture, whole blood (anti-coagulated), splenocytes, DLN 
cells, lung cells, etc.

! -!15 / 50 mL centrifuge tubes
! -!Histopaque-1077

- density of 1.077 g/mL
- Sigma, Cat. # 10771; 100 mL

! -!stored at 4°C
! -!transfer pipets
! -!PBS, cell culture grade
! -!T Cell Medium (TCM)

cRPMI + 10% FBS

Supporting Protocol:
! -!Cell Culture > Cell Counting

Protocol:
! 1)!add 3 mL of Histopaque to 15 mL tube
! 2)!equilibrate to room temp.
! 3)!slowly layer equal volume (3 mL) of cell source for isolation above 

histopaque
use transfer pipet to add cells drop-wise against wall of tube held at 
an angle

! 4)!centrifuge for 30 min. at 400 g / ~1,500 rpm (room temp.)
- do not centrifuge at 4°C during isolation step to avoid clumping / 
poor recovery
- do not leave cells on histopaque for > 30 min. to avoid toxicity

! 5)!add 10 mL of PBS to new 15 mL tube
for washing isolated mononuclear cells

! 6)!using transfer pipet, remove (opaque) layer of isolated mononuclear 
cells above histopaque

! 7)!transfer isolated mononuclear cells to new tube containing PBS 
(wash)

! 8)!centrifuge for 5 min. at 1,500 rpm (4°C)
! 9)!discard supernatant
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! 10)!resuspend pellet in volume of TCM for counting
! 11)!count live / dead cells and determine viability
! 12)!adjust to desired cell concentration in TCM
! 13)!proceed with downstream application
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Intraperitoneal (i.p.) Injection
for delivery of reagents to abdominal cavity

Equipment:
! -!empty cage with wire top
! -!biohazardous sharps container

Materials:
! -!mice
! -!solution for injection
! -!equilibrate to room temp. prior to injection
! -!1 mL syringes

BD, Cat. # 309602
! -!27G 1/2" needles

BD, Cat. # 305109
! -!Kimwipes
! -!Sharpie marker, ultra-fine point

Protocol:

Figure 34:  Demonstration of i.p. injection into upper right quadrant of 
abdomen.

! 1)!prepare needle / syringe for injection(s):
proceed in parallel for mice receiving same treatment

! 1.1)!attach needle to syringe
align tapered end of needle with number/calibrations on 
syringe barrel

! 1.2)!mark calibrations on syringe barrel for desired number of 
injections

injection volume = 150 µL per mouse
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! 1.3)!remove protective cap from needle
! 1.4)!submerge needle in solution and withdrawal plunger to fill 

syringe beyond desired total volume
! 1.5)!position syringe with needle upright and flick barrel to collect 

air bubbles at top
! 1.6)!depress plunger to remove air and adjust to desired final 

volume
! 2)!restrain mouse

- proceed serially for each mouse
- reverse left / right hand for left-handed individual

! 2.1)!scruff mouse from behind with left hand
! 2.2)!grasp tail with right hand
! 2.3)!flip left hand so that abdomen of mouse is facing up
! 2.4)!secure tail using small finger of left hand against palm
! 3)!perform injection
! 3.1)!using right hand, insert needle into upper-right quadrant of 

abdomen (see above)
- tapered end of needle facing up
- 45° angle to abdomen
- insert needle just below skin

! 3.2)!steadily depress plunger to deliver 150 µL into peritoneal 
cavity

! 3.3)!slowly remove needle in reserve path
! 4)!following injection, place mouse in separate cage and repeat for 

additional mice receiving similar treatment as needed
! 5)!discard used needle / syringe in biohazardous sharps container
! 6)!observe injected mice for acute signs of complication from injection

References:
! (140, 141)
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Intranasal (i.n.) Treatment
- for delivery of cost-limiting reagents to respiratory tract
- allows for controlled dosing

Equipment:
! -!20 µL pipettor
! -!bucket with ice
! -!dI water squirt bottle
! -!lab timer

Materials:
! -!mice
! -!solution for inhalation
! -!Kimwipes
! -!gel-loading pipet tips
! -!paper towels

Supporting Protocol:
! -!Anesthesia Machine Set Up

Protocol:

Figure 35:  Demonstration of i.n. administration of liquid droplet.

! 1)!set up anesthesia machine
see supporting protocol

! 2)!anesthetize small cohort of 3-5 mice (1 cage of mice) in parallel
! 2.1)!place mice inside chamber for ≥ 3 minutes
! 2.2)!observe until mice remain unconscious and motionless

increase exposure time and/or % isoflurane to effect
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! 3)!position mouse for intranasal treatment
perform serially for each mouse in cohort

! 3.1)!remove mouse from chamber
proceed quickly between subsequent steps until 
completion of intranasal treatment

! 3.2)!place supine on top of paper towel on lab bench
! 3.3)!using forefinger and thumb of left hand, apply slight 

opposing pressure to upper and lower jaw
⁃ to close mouth and to promote inhalation versus 
ingestion of bolus
- reverse left / right hand for left-handed individual

! 4)!perform intranasal treatment
! 4.1)!deliver 20 µL bolus of solution for inhalation applied 

externally as droplets to alternating nares
observe inhalation of each droplet prior to applying 
subsequent droplets

! 4.2)!continue to apply slight opposing pressure to upper and 
lower jaw until complete inhalation of bolus

! 4.3)!to stimulate breathing, tap chest cavity and/or squeeze hind 
paw

! 5)!following complete inhalation, place mouse on top of folded paper 
towel inside cage with abdomen facing down

! 6)!challenge each additional mouse of cohort inside anesthesia 
chamber

limit isoflurane exposure to ≤ 15 min. for any given mouse in cohort
! 7)!observe mice for recovery following treatment
! 8)!remove paper towel from cage
! 9)!clean interior of induction chamber with water

do not use ethanol

References:
! (136, 137)
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Aerosol Treatment
- for delivery of non-cost-limiting reagents to respiratory tract
- provides consistent delivery from mouse to mouse

Equipment:
! -!ultrasonic nebulizer

Ultra-NEB99; Devilbiss / Sunrise Medical, Model # 099HD
! -!induction chamber
! -!tubing (2)
! -!medicine cup

Materials:
! -!mice
! -!solution for inhalation
! -!paper towels

Protocol:
combine cohort of ~8 mice inside induction chamber

! 1)!fill transducer compartment of nebulizer with tap water between 'min' 
and 'max' calibrations 

! 2)!dispense solution for inhalation inside medicine cup
! 3)!connect components for nebulizer according to diagram below

Figure 36:  Nebulizer setup for delivery of aerosolized material to mice.

! 4)!place mice inside induction chamber
! 5)!connect tubing (2) as indicated in diagram below
! 5.1)!connect tubing on nebulizer from fan to medicine cup
! 5.2)!connect tubing from nebulizer to induction chamber
! 6)!turn on power for nebulizer
! 7)!adjust airflow control knob on front of nebulizer to generate dense 

aerosol fog
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between 12 to 3 o'clock position
! 8)!set timer for desired exposure to aerosol
! 9)!return mice to respective cage(s)
! 10)!carefully invert nebulizer to discard water from transducer 

compartment
do not detach from unit

! 11)!use folded paper towels to wick excess water from compartment
! 12)!clean induction chamber, medicine cup and hoses with tap water
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5.2.5. Peptide
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Lyophilized Stocks

Equipment:
! -!-20°C freezer
! -!desiccator jar w/ lid

Materials:
! -!drierite
! -!parafilm

Protocol:
- peptides are most stable as lyophilized powder and can be stored for 
extended periods (> 1 year) at -20°C inside desiccator jar containing drierite
- do not reconstitute until needed for series of experiments
- peptides can be shipped as lyophilized powder at ambient temperature or 
with refrigerant pack for 2nd day delivery
- unless stated otherwise, mass indicated on label represents total mass 
including salts
- where indicated, linear peptides have been modified at the N-terminus with 
FITC or biotin
- all linear peptides contain an amide group at the C-terminus (amidiation)

for reference, the composition and molecular weight of selected peptides are 
as follows:

abbreviation:! sequence:! ! ! ! ! ! ! ! g/mol
R9-QQP! ! RRRRRRRRRQQPPVPPQRPMA-NH2! ! ! 2,750.27
FITC-R9-QQA! FITC-RRRRRRRRRQQAAVAAQRAMA-NH2! ! 3,122.62
FITC-R9-PQM! FITC-RRRRRRRRRPQMPAPQRPQPV-NH2! ! 3,252.81
Biotin-QQP!! Biotin-QQPPVPPQRPMA-NH2! ! ! ! 1,570.89
QQP! ! ! QQPPVPPQRPMA-NH2! ! ! ! ! 1,344.59
QQA! ! ! QQAAVAAQRAMA-NH2! ! ! ! ! 1,214.40

! 1)!remove peptide vial(s) from packaging
- do not sign for package if external evidence of water damage
- inner packaging should be free of moisture
- vial should be enclosed in secondary plastic bag containing 
desiccant

! 2)!seal vial cap with parafilm if not done so already
! 3)!for each peptide, verify that label on tube matches accompanying 

packing slip / documentation
! 4)!review HPLC data sheet and confirm that purity is ≥ 95%
! 5)!review LCMS data sheet and confirm that all major peaks are 

consistent with predicted molecular weight of peptide
! 6)!store peptide vial inside desiccator jar containing drierite
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! 6.1)!close lid securely
! 7)!store at -20°C
! 8)!record information for each peptide including description, mass, and 

desiccator location in lab notebook and/or electronic database
- physical description
- mass
- freezer location
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Reconstitution / Stock Solutions

Equipment:
! -!analytical balance
! -!-80°C freezer
! -!refrigerated centrifuge

Materials:
! -!lyophilized peptide stock
! -!stored inside desiccator jar at -20°C
! -!screw cap aliquot tubes or microcentrifuge tubes, sterile
! -!50 mL centrifuge tube(s)
! -!weighing paper, 3" x 3"
! -!cell culture grade water
! -!metal spatula
! -!parafilm

Supporting Protocol:
! -!Lyophilized Stocks

Protocol:
- many peptides are very hygroscopic
! - to reduce exposure with moisture due to condensation, allow ample time 

for peptide to equilibrate to ambient temperature before opening cap of 
vial and exposure to air

- lyophilized peptide should be dissolved in cell culture grade water unless 
factors such as solubility and/or pH require a different solvent (e.g., DMSO) to 
be used
! - do *not* reconstitute in any solution containing carrier protein (e.g. BSA)

- nominal stock concentration should be ≥ 0.5 mg/mL
! - lower stock concentrations are not recommended due to the loss of free 

peptide caused by binding to the plastic tube

- stock solutions can be stored for ≤ 2 months at -80°C

! 1)!calculate approximate amount of peptide needed for series of 
experiments

! 2)!when needed for experiment, remove desiccator jar from -20°C
! 3)!equilibrate to room temp. for ≥ 30 min. before opening lid of 

desiccator jar
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! 4)!remove peptide vial from desiccator and allow to equilibrate to 
ambient temperature for an additional ≥ 30 min. before opening cap 
of vial

! 5)!spin vial to collect lyophilize at bottom (if needed)
! 5.1)!place peptide vial inside secondary 50 mL centrifuge tube
! 5.2)!spin for 5 min. at 2,000 rpm (4°C)
! 6)!depending on amount of peptide in tube as well as requirements for 

experiment, weigh aliquot of lyophilizate and transfer to new tube
for accuracy, do not weigh less than 1.0 mg using analytical 
balance

! 6.1)!trim piece of weighing paper to 1/4 size, fold and tare on 
analytical balance

! 6.2)!use clean metal spatula to remove small piece of 
lyophilizate

! 6.3)!carefully place on weighing paper
! 6.4)!transfer to designated aliquot tube and label with peptide 

name, date, and nominal mass
! 7)!re-seal stock vial containing remaining lyophilized peptide with 

parafilm and return to desiccator
! 7.1)!store at -20°C
! 8)!dissolve peptide in cell culture grade water at ≥ 0.5 mg/mL
! 8.1)!add calculated volume of water to vial using micropipettor 

and tip
! 8.2)!pipet up and down to dissolve

do not vortex
! 8.3)!allow to dissolve / hydrate for 15 min. at ambient 

temperature
! 9)!store stock solution for ≤ 2 months at -80°C
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Relative Concentration Determination

Materials:
! -!reference peptide stock solution
! -!previously characterized and biologically active
! -!reconstituted at ≥ 0.5 mg/mL (nominal concentration) in water 

*without* carrier (e.g., BSA)
! -!stored at -20°C
! -!'concentration unknown' peptide stock solution
! -!reconstituted at ≥ 0.5 mg/mL in water without carrier (e.g., BSA)
! -!cell culture grade water

for preparing dilutions and blank
! -!microcentrifuge tubes

Supporting Protocols:
! -!Reconstitution / Stock Solution
! -!General > Absorbance Measurement Using Spectrophotometer

Protocol:
based on peptide bond absorbance maximum at 214 nm (190 nm - 230 nm), 
one can generate a standard curve of absorbance versus nominal 
concentration (mg/mL)

one can use absorbance 214 nm values of peptide stock solutions in the 
following specific scenarios:
! - to compare / standardize the concentration of independently 

reconstituted stock solutions
! - to monitor / standardize the concentration of the same peptide stock 

solution over time
! - to compare / standardize the concentration of different peptides of 

identical length and composition of amino acids (e.g., sequence specific 
peptide versus scrambled control peptide)

! - to compare / standardize the concentration of different peptides of 
identical length and similar composition of amino acids – provided 
differences among amino acids are similar in terms of side group 
absorbance properties

limitations:
! - only peptide stocks dissolved in water and *without* carrier (e.g., BSA) 

can be analyzed for absorbance at 214 nm
! - one cannot compare tagged (fluorescently or otherwise) and non-tagged 

versions of the same peptide
! - one cannot compare peptides of different length (i.e., number of amino 

acids)
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! 1)!prepare standard curve of reference peptide stock solution that has 
been previously characterized in a biological assay

Figure 37:  R9-QQP standard curve of absorbance at 214 nm versus nominal 
concentration of reference peptide stock solution.

! 1.1)!prepare range of dilutions (e.g., 1:25, 1:50, 1:100, 1:200, 
1:400) in water

need ≥ 0.5 mL per sample
! 1.2)!measure absorbance for each prepared dilution

see supporting protocol
! 1.3)!plot absorbance at 214 nm versus nominal concentration 

(mg/mL)
! 1.4)!determine slope and y-intercept from linear regression 

analysis according to linear equation (y = mx + b)
once determined, can be used for future reference

! 2)!measure concentration of 'unknown' peptide stock solution
! 2.1)!prepare dilutions of stock solution (e.g., 1:50 and 1:100) in 

water
need ≥ 0.5 mL per sample

! 2.2)!measure absorbance for each prepared dilution
see supporting protocol

! 3)!calculate concentration of 'unknown' stock solution using linear 
equation determined from standard curve above
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! 4)!as needed, label concentration of 'unknown' stock solution using 
calculated concentration

to prevent variations in concentration that may result from relying on 
nominal concentration
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Dilutions / Working Solutions

Equipment:
! -!-20°C freezer

Materials:
! -!buffer for dilutions (e.g., PBS, RPMI)

with or without carrier protein
! -!peptide stock solution
! -!stored at -20°C
! -!tube(s) for preparing dilution, sterile

optional:  can be coated with carrier protein
! -!aliquot tubes, sterile

optional:  can be coated with carrier protein

Supporting Protocol:
! -!Reconstitution / Stock Solutions

Protocol:
- peptide stock solution can be diluted in buffer of choice (e.g., PBS, RPMI) 
with or without carrier protein as required
- prepare dilutions at needed concentration
! - do not dilute beyond needed working concentration in order to reduce 

loss of free peptide caused by binding to plastic tube
! - optional:  prepare dilutions / aliquots in tubes pre-coated with carrier 

protein
- working solutions should preferably be used immediately or stored for ≤ 2 
weeks at -20°C
! - limit freeze-thaw cycles

! 1)!thaw peptide stock solution
! 1.1)!keep on ice
! 2)!prepare dilution in selected buffer for experiment
! 3)!prepare aliquots as needed
! 4)!use immediately or store for ≤ 2 weeks at -20°C
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In Vitro Peptide Transduction

Equipment:
! -!refrigerated centrifuge
! -!humidified, 5% CO2, 37°C incubator
! -!bucket with ice

Materials:
! -!R9-peptide stock solution
! -!stored at -20 / -80°C
! -!Jurkat cells (required # according to experimental design)

e.g., 20x106 cells per condition for biochemistry
! -!splenocytes (required # according to experimental design)

e.g., 60-80x106 cells per condition for biochemistry
! -!lyse RBCs

to minimize uptake of peptide by platelets
! -!Wash Medium (RPMI-1640)

serum-free
! -!12-well plate

2 mL volume per well
! -!24-well plate

1 mL volume per well
! -!Jurkat Growth Medium (JGM)
! -!T Cell Medium (TCM)

Supporting Protocols:
! -!Reconstitution / Stock Solutions
! -!Dilutions / Working Solutions
! -!Cell Culture > Jurkat Cell LIne Maintenance
! -!In Vivo / Ex Vivo > Splenocyte Preparation
! -!RBC Lysis

Protocol:
! 1)!prepare peptide
! 1.1)!thaw peptide stock solution on ice just prior to use
! 1.2)!dilute stock solution in PBS to desired working 

concentration (e.g., 0.1-10 mM)
prepare working solution to allow for accurate pipetting 
without significantly affecting final volume

! 1.3)!keep on ice
! 2)!wash cells

remove serum prior to incubation with peptide:
- to reduce protease-mediated degradation of peptide
- to minimize binding of peptide to serum proteins
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! 2.1)!centrifuge for 5 min. at 1,000 - 1,500 rpm (4°C)
! 2.2)!aspirate / discard supernatant
! 2.3)!resuspend cells in serum-free RPMI at required 

concentration according to experimental design
! 3)!incubate with peptide
! 3.1)!transfer required number of cells to designated well(s) of 12 

or 24-well plate
! 3.2)!add peptide stock / working solution to designated well(s)
! 3.3)!pipet up and down to mix
! 3.4)!cover plate with lid

to prevent contamination during incubation
! 3.5)!place inside TC incubator for ≥ 30 min.
! 4)!optional:  wash cells

to remove excess peptide from medium
! 4.1)!centrifuge for 5 min. at 1,000 - 1,500 rpm (4°C)
! 4.2)!aspirate / discard supernatant
! 4.3)!resuspend cells in complete medium (containing 10% FBS) 

at required concentration according to experimental design
! 5)!proceed with experiment
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Trypsin Treatment for Uptake Studies
to reduce membrane-associated peptide

Equipment:
! -!refrigerated centrifuge with adaptors for microcentrifuge tubes
! -!37°C water bath
! -!vortex
! -!bucket with ice

Materials:
! -!Jurkat cells / primary lymphocytes
! -!treated with FITC-R9 peptide
! -!protect from light
! -!0.05% trypsin - 0.53 mM EDTA in HBSS

- with sodium bicarbonate, without calcium and magnesium
- Mediatech, Cat. # 25-051-CI

! -!keep on ice
! -!PBS (without Ca2+ and Mg2+)
! -!keep on ice
! -!FACS buffer

Supporting Protocol:
! -!In Vitro Peptide Transduction

Protocol:
! 1)!remove free peptide
! 1.1)!immediately following peptide treatment, centrifuge for 5 

min. at 1,000 - 1,500 rpm (4°C)
! 1.2)!aspirate to discard supernatant completely
! 1.3)!resuspend in 1 mL of ice-cold PBS (wash)
! 1.4)!centrifuge for 5 min. (4°C)
! 1.5)!aspirate / discard supernatant completely
! 2)!reduce membrane-associated peptide
! 2.1)!resuspend pellet in 200 µL of trypsin
! 2.2)!incubate at 37°C for 10 min.
! 2.3)!add 1 mL of FACS buffer to quench
! 2.4)!centrifuge for 5 min. (4°C)
! 2.5)!aspirate / discard supernatant completely
! 3)!additional washes
! 3.1)!resuspend in 1 mL of ice-cold PBS (wash #1)
! 3.2)!centrifuge for 5 min. (4°C)
! 3.3)!aspirate / discard supernatant completely
! 3.4)!resuspend in 1 mL of ice-cold PBS (wash #2)
! 3.5)!centrifuge for 5 min. (4°C)
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! 3.6)!aspirate / discard supernatant completely
! 3.7)!resuspend in 1 mL of ice-cold PBS (wash #3)
! 3.8)!aspirate / discard supernatant completely
! 4)!for primary cells, proceed with staining for CD4+ T Cells
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FACS Staining for Uptake Studies
for uptake analysis of FITC-conjugated peptide by CD4+ TCR+ lymphocytes

Equipment:
! -!refrigerated centrifuge
! -!vortex
! -!bucket with ice
! -!lab timer

Materials:
! -!FACS buffer
! -!keep on ice
! -!FACS tubes
! -!primary lymphocytes
! -!treated with FITC-R9 peptide
! -!treated with trypsin

to reduce membrane-associated peptide
! -!rat anti-mouse CD16/CD32

BD, Cat. # 553141
Mouse BD Fc Block

! -!Pacific Blue anti-mouse CD4, clone MR4-5
BioLegend, Cat. # 100531
ex:  405 nm laser
em:  450/40 filter

! -!APC anti-TCRβ, clone H57-597
BioLegend, Cat. # 109211
ex:  633 nm laser
em:  660/20 filter

! -!70 µm cell strainers
! -!2% paraformaldehyde (PFA) / PBS
! -!keep on ice

Supporting Protocol:
! Trypsin Treatment for Uptake Studies

Protocol:
- in order to minimize spectral overlap with FITC, lymphocytes are stained 
with Pacific Blue anti-CD4 and APC anti-TCRβ
! - thus, each fluorophore is excited with a different laser as follows 

(analyze using FACSAria not FACSCanto):
! ! - 405 nm laser for Pacific Blue
! ! - 488 nm laser for FITC
! ! - 633 nm laser for APC
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- single-color control samples should be prepared in order to establish optimal 
voltages for each channel and to compensate for any residual spectral 
overlap if required

- keep cells on ice throughout

! 1)!prepare samples for FACS staining
! 1.1)!resuspend peptide and trypsin-treated lymphocytes in 

required volume of FACS buffer for staining
calculate volume based on number of FACS staining 
tubes required for each cell preparation

! 1.2)!transfer 100 µL to each staining tube
plan in advance

! 2)!block Fc receptors
! 2.1)!add 0.5-1 µg of Fc blocking antibody to each tube
! 2.2)!incubate for 5 min.

do not wash
! 3)!stain for CD4 and TCRβ
! 3.1)!add 0.5-1 µg of Pacific Blue anti-mouse CD4 to each tube
! 3.2)!add 0.5-1 µg of APC anti-mouse TCRβ to each tube
! 3.3)!incubate for ~45 min. at 4°C
! 4)!wash cells
! 4.1)!add 2 mL of ice-cold FACS buffer to each tube
! 4.2)!centrifuge for 5 min. at 1,500 rpm (4°C)
! 4.3)!discard supernatant
! 5)!fix cells
! 5.1)!add 200 µL of 2% PFA to each tube
! 5.2)!vortex to resuspend
! 5.3)!incubate for 10 min. at 4°C

protect from light
! 5.4)!add 2 mL of ice-cold FACS buffer (quench)
! 5.5)!centrifuge for 5 min. at 1,500 rpm (4°C)
! 5.6)!discard supernatant
! 6)!to remove debris / cell clumps
! 6.1)!resuspend in 2 mL of ice-cold FACS buffer
! 6.2)!pass each sample through 70 µm cell strainer
! 6.2.1)!collect in separate FACS tubes
! 6.3)!centrifuge for 5 min. at 1,500 rpm (4°C)
! 6.4)!discard supernatant
! 7)!resuspend in 300 µL of FACS buffer
! 8)!store in dark at 4°C until FACS analysis
! 9)!analyze FACS data
! 9.1)!create SSC vs. FSC dot plot
! 9.1.1)!display all events
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! 9.1.2)!create lymphocyte gate
! 9.2)!create SSC vs. APC dot plot
! 9.2.1)!display lymphocyte population
! 9.2.2)!create T cell gate

child of lymphocyte gate
! 9.3)!create Pacific Blue vs. FITC gate
! 9.3.1)!display T cell population
! 9.3.2)!create quadrants to determine % CD4+ FITC+ cells
! 9.3.3)!create CD4+ gate to determine FITC MFI of CD4+ 

T cells
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5.2.6. T Cell Stimulation / Itk Activation
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Jurkat α-TCR Antibody Stimulation
for investigating TCR-dependent signaling events in human T cells

Equipment:
! -!humidified, 5% CO2, 37°C incubator
! -!refrigerated centrifuge with tube adaptors
! -!37°C water bath
! -!vortex
! -!lab timer
! -!bucket with ice

Materials:
! -!Jurkat cells, ≤ 20x106 cells

seed sufficient number of flasks in advance according to 
experimental design

! -!cultured to ≤ 106 cells/mL
! -!serum starved overnight
! -!Wash Medium / RPMI-1640
! -!prepare aliquot in 50 mL Falcon tube
! -!keep on ice
! -!microcentrifuge tubes
! -!OKT3, mouse IgG2a anti-human TCR CD3ε
! -!UPC10, mouse IgG2a isotype control

used for non-stimulation control
! -!rabbit α-mouse IgG (RαM), unconjugated

cross-linking antibody

Supporting Protocols:
! -!Cell Culture > Jurkat Maintenance
! -!Cell Culture > Jurkat Serum Starvation
! -!Cell Culture > Cell Counting
! -!Peptide > In Vitro Peptide Transduction

Protocol:
! 1)!count cells
! 2)!pre-treatment with peptide (if included in experimental design)

see supporting protocol for details
! 3)!prepare cells
! 3.1)!centrifuge required number of cells for 5 min. at 1,000 rpm 

(4°C)
! 3.2)!aspirate supernatant
! 3.3)!resuspend cells in ice-cold RPMI at required concentration

0.5 mL volume per reaction
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! 3.4)!transfer 0.5 mL per reaction to designated microcentrifuge 
tube(s)

! 3.5)!incubate on ice for ≥ 10 min.
! 4)!incubation with OKT3 (for stimulation) / UPC10 (for non-stim. control)

keep on ice throughout
! 4.1)!add 2.5 µg of OKT3 / UPC10 (5 µg/mL final)
! 4.2)!vortex to mix
! 4.3)!incubate for 30 min. on ice to allow binding
! 5)!wash cells
! 5.1)!centrifuge for 5 min. at 1,000 rpm (4°C)
! 5.2)!aspirate supernatant using pipet tip
! 5.3)!resuspend pellet in 0.5 mL of ice-cold RPMI
! 6)!incubate with rabbit anti-mouse (RαM) cross-linking antibody

keep on ice throughout
! 6.1)!add 2.5 µg of RαM antibody (5 µg/mL final)
! 6.2)!vortex to mix
! 6.3)!incubate for 15 min. on ice to allow binding
! 7)!stimulate cells

optimal kinetics should be determined empirically for each 
investigator

! 7.1)!for non-stim. control, keep tube on ice
! 7.2)!place tubes in 37°C water bath for designated time points 

(e.g., 0.5, 1, 3, 5 min.)
! 7.3)!return tube(s) to ice immediately following incubation at 

37°C
! 7.4)!continue with downstream assay (e.g., phosphoflow, lysis)
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Primary Lymphocyte α-TCR Antibody Stimulation
for investigating TCR-dependent signaling events in primary mouse T cells

Equipment:
! -!humidified, 5% CO2, 37°C incubator
! -!refrigerated centrifuge with tube adaptors
! -!37°C water bath
! -!vortex
! -!lab timer
! -!bucket with ice

Materials:
! -!primary lymphocytes, ≤ 80x106 cells

harvest sufficient number of cells according to experimental design
! -!freshly isolated
! -!rested inside incubator for ≤ 4 hours prior to stimulation

keep in 50 mL polypropylene tube (rather than polystyrene) to 
prevent loss of cell yield due to adherence

! -!Wash Medium / RPMI-1640
! -!prepare aliquot in 50 mL Falcon tube
! -!keep on ice
! -!microcentrifuge tubes
! -!2C11, armenian hamster α-mouse TCR CD3ε

BD, Cat. # 553058
0.5 mg/mL stock

! -!goat α-armenian hamster IgG (GαAH), unconjugated
Jackson ImmunoResearch, Cat. # 127-005-099
1.8 mg/mL stock

Supporting Protocols:
! -!In Vivo / Ex Vivo > Splenocyte Preparation
! -!In Vivo / Ex Vivo > Tissue Dissociation
! -!Cell Culture > Cell Counting
! -!Peptide > In Vitro Peptide Transduction

Protocol:
! 1)!count cells

see supporting protocol
! 2)!pre-treatment with peptide (if included in experimental design)

see supporting protocol
! 3)!prepare cells
! 3.1)!centrifuge required number of cells for 5 min. at 1,500 rpm 

(4°C)
! 3.2)!aspirate supernatant
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! 3.3)!resuspend cells in ice-cold RPMI at required concentration
0.5 mL volume per reaction

! 3.4)!transfer 0.5 mL per reaction to designated microcentrifuge 
tube(s)

! 3.5)!incubate on ice for ≥ 10 min.
! 4)!incubate with 2C11 (for stimulation)

keep on ice throughout
! 4.1)!add 2.5 µg of 2C11 (5 µg/mL final)
! 4.2)!vortex to mix
! 4.3)!incubate for 30 min. on ice to allow binding
! 5)!wash cells
! 5.1)!centrifuge for 5 min. at 1,500 rpm (4°C)
! 5.2)!aspirate supernatant using pipet tip
! 5.3)!resuspend pellet in 0.5 mL of ice-cold RPMI
! 6)!incubate with goat anti-armenian hamster (GαAH) cross-linking 

antibody
keep on ice throughout

! 6.1)!add 2.5 µg of GαAH antibody (5 µg/mL final)
! 6.2)!vortex to mix
! 6.3)!incubate for 15 min. on ice to allow binding
! 7)!stimulate cells

optimal kinetics should be determined empirically for each 
investigator

! 7.1)!for non-stim. control, keep tube on ice
! 7.2)!place tubes in 37°C water bath for designated time points 

(e.g., 0.5, 1, 3, 5 min.)
! 7.3)!return tube(s) to ice immediately following incubation at 

37°C
! 7.4)!continue with downstream assay (e.g., phosphoflow, lysis)
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PMA / Ionomycin (IM) Stimulation
for investigating TCR-independent signaling events (positive control for TCR-
dependent stimulation)

Equipment:
! -!humidified, 5% CO2, 37°C incubator
! -!refrigerated centrifuge
! -!37°C water bath
! -!vortex
! -!lab timer
! -!bucket with ice

Materials:
! -!Jurkat cells (≤ 20x106 cells)

seed sufficient number of flasks in advance according to 
experimental design

! -!cultured to ≤ 106 cells/mL
! -!serum starved overnight
! -!primary lymphocytes (≤ 80x106 cells)

harvest sufficient number of cells according to experimental design
! -!freshly isolated
! -!rested inside incubator for ≤ 4 hours prior to stimulation

keep in 50 mL polypropylene tube (rather than polystyrene) to 
prevent loss of cell yield due to adherence

! -!Wash Medium / RPMI-1640
! -!prepare aliquot in 50 mL Falcon tube
! -!keep on ice
! -!microcentrifuge tubes
! -!100x PMA/IM

see Buffers & Solutions
! -!keep on ice

Supporting Protocols:
! -!Cell Culture > Jurkat Maintenance
! -!Cell Culture > Jurkat Serum Starvation
! -!In Vivo / Ex Vivo > Splenocyte Preparation
! -!In Vivo / Ex Vivo > Tissue Dissociation
! -!Cell Culture > Cell Counting

Protocol:
! 1)!count cells
! 2)!prepare cells
! 2.1)!centrifuge required number of cells for 5 min. at 1,000 / 

1,500 rpm (4°C)
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! 2.2)!aspirate supernatant
! 2.3)!resuspend cells in ice-cold RPMI at required concentration

0.5 mL volume per reaction
! 2.4)!transfer 0.5 mL per reaction to designated microcentrifuge 

tube(s)
! 2.5)!incubate on ice for ≥ 10 min.
! 3)!add 5 µL of 100x PMA/IM to designated tubes
! 4)!vortex to mix
! 5)!for non-stim. control, keep tube on ice
! 6)!place stimulation tube(s) in 37°C water bath for 15 min.
! 7)!continue immediately with assay

328



Indo-1 Assay
for measuring calcium flux in Jurkat cells upon TCR stimulation

Equipment:
! -!PTI fluorimeter, monochromator-based

- excitation:  355 nm
- temperature control (37°C) for cuvette chamber
- emission range:  350 - 550 nm (at 5 nm intervals)

! -!2 independent PMTs
for acquisition at 400 nm and 470 nm

! -!bucket with ice
! -!refrigerated centrifuge
! -!humidified, 37°C, 5% CO2 incubator
! -!37°C water bath
! -!4-sided cuvette, 3 mL capacity
! -!micro stir bar

Materials:
! -!Jurkat cells (6x106 cells per cuvette / condition)
! -!Indo-1 stock, 1,000x

see Buffers & Solutions
! -!stored at -20°C
! -!RPMI-1640
! -!keep on ice
! -!1 mM CaCl2 / PBS

- calcium imaging buffer
- see Buffers & Solutions

! -!keep on ice
! -!PBS
! -!Kimwipes
! -!OKT3

anti-TCR antibody
! -!UPC10

isotype control antibody
! -!OKT9

control antibody
! -!30 mM EGTA / 300 mM Tris-HCl, pH 7.4

see Buffers & Solutions
! -!equilibrate to 37°C before use
! -!50 mL centrifuge tubes

Supporting Protocols:
! -!Cell Culture > Cell Counting
! -!Peptide > In Vitro Peptide Transduction
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Protocol:

Figure 38:  Indo-1 reporter of calcium flux in non-stimulated (OKT9) versus 
stimulated (OKT3) Jurkat cells as a function of time.

! 1)!load Jurkat cells intracellularly with Indo-1
- need > 5x106 cells per cuvette / condition
- prepare samples in triplicate
- include non-Indo-1-loaded Jurkat cells to determine background 
autofluorescence

! 1.1)!count cells
see supporting protocol

! 1.2)!aliquot required number of cells to 50 mL centrifuge tube(s)
! 1.3)!centrifuge for 5 min. at 1,000 rpm (4°C)
! 1.4)!discard supernatant
! 1.5)!resuspend at 5x106 cells/mL in RPMI
! 1.6)!combine cell suspension into single 50 mL tube
! 1.7)!add Indo-1 at 1x

2 µg/mL final
! 1.8)!place tube upright inside incubate for 30 min.
! 1.8.1)!loosen cap to allow gas exchange
! 2)!wash cells

to remove excess Indo-1
! 2.1)!centrifuge for 5 min. at 1,000 rpm (4°C)
! 2.2)!discard supernatant
! 2.3)!resuspend cells in equal volume of RPMI (5x106 cells/mL)
! 2.4)!return to incubator for 30 min. as before

to allow cells to secrete excess Indo-1
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! 3)!optional:  peptide treatment
see supporting protocol

! 4)!replace medium with calcium imaging buffer
! 4.1)!centrifuge cells for 5 min. at 1,000 rpm (4°C)
! 4.2)!aspirate / discard supernatant
! 4.3)!resuspend cells at 5x106 cells/mL in ice-cold 1 mM CaCl2 / 

PBS
! 4.4)!aliquot > 5x106 cells to separate tubes for each cuvette / 

condition
! 4.5)!centrifuge cells for 5 min. at 1,000 rpm (4°C)
! 4.6)!keep pellet on ice until just before use
! 5)!equilibrate to 37°C
! 5.1)!just prior to use, aspirate / discard supernatant
! 5.2)!resuspend 5x106 cells in 2.5 mL of 1 mM CaCl2 / PBS

2x106 cells/mL final
! 5.3)!equilibrate for 10 min. in 37°C water bath
! 5.4)!wash cuvette with PBS between samples
! 5.5)!transfer 5x106 cells / 2.5 mL to a 3 mL capacity 4-sided 

cuvette
wash cuvette 

! 5.6)!add micro stir bar
! 5.7)!place cuvette inside fluorimeter with gentle stirring for 3 min.

to equilibrate to 37°C
! 5.8)!optional:  add 250 µL of 30 mM EGTA / 300 mM Tris-HCl, 

pH 7.4
to chelate extracellular calcium for investigation of 
intracellular calcium release

! 6)!stimulation / data acquisition
including non-stimulation control

! 6.1)!add OKT3 / control antibody directly to cuvette at 10 µg/mL 
final

! 6.2)!immediately begin acquiring data at 400 nm and 470 nm
! 7)!data analysis
! 7.1)!in Excel, average traces from non-Indo-1-loaded cells to 

determine background autofluorescence
! 7.2)!subtract background from each experimental sample
! 7.3)!determine 400/470 nm ratio for each sample
! 7.4)!plot traces of 400/470 nm ratio for each sample in Prism 

and compare for each treatment
non-stimulated, stimulated, peptide-treated and 
stimulated, etc.
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In Vitro Kinase Assay
- use of a heterologous cell line for expression of Itk is important to avoid the 
possibility of dimerization and trans-phosphorylation via association with 
endogenous Itk
- since Itk is a substrate for auto-phosphorylation, no additional substrate is 
required to be added to the reaction for assessing kinase activity

Equipment:
! -!refrigerated centrifuge
! -!refrigerated microcentrifuge
! -!tube rotator
! -!keep at 4°C
! -!37°C water bath
! -!bucket with ice

Materials:
! -!HEK293 transfectants
! -!protein G sepharose beads
! -!kinase reaction buffer
! -!prepared fresh (same day)

see 'Buffers and Solutions'
! -!keep on ice
! -!α-Itk antibody

for immunoprecipitation
! -!microcentrifuge tubes
! -!α-phospho-tyrosine antibody

for immunoblotting

Supporting Protocols:
! -!Cell Culture > HEK293 Cell Line Maintenance
! -!Cell Culture > HEK293 Transfection with Lipofectamine
! -!Protein Biochemistry > HEK293 Lysis
! -!Protein Biochemistry > Immunoprecipitation
! -!Protein Biochemistry > Protein G Sepharose Preparation
! -!Protein Biochemistry > SDS-PAGE
! -!Protein Biochemistry > Immunoblotting
! -!Protein Biochemistry > Transblotting
! -!Protein Biochemistry > Immunoblotting
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Protocol:

Figure 39:  In vitro kinase assay of HEK293 cells transfected with Itk(WT)-CY 
and Itk(K390R)-CY.
! Cellular lysates were prepared and incubated with 5 µg of anti-GFP 
followed by 30 µL of protein G sepharose.  Immune complexes were washed, 
resuspended in kinase reaction buffer for 10 min. at 37°C, resolved by SDS-
PAGE and analyzed by immunoblotting.

! 1)!transfect HEK293 with kinase transgene
see 'Cell Culture > HEK293 Transfection with Lipofectamine'

! 1.1)!incubate for 24 hours
! 2)!lyse cells for 1 hr. on tube rotator

see 'Protein Biochemistry > HEK293 Lysis'
! 3)!incubate for 2 hrs. with immunoprecipitation antibody (α-Itk)

see 'Protein Biochemistry > Immunoprecipitation'
! 4)!incubate for 1 hr. with protein A/G sepharose beads

see 'Protein Biochemistry > Immunoprecipitation'
! 5)!wash immune complex in kinase reaction buffer
! 5.1)!gently aspirate supernatant using P1000 micropipette and 

tip
! 5.2)!resuspend pellet in 1 mL of ice-cold kinase reaction buffer
! 5.3)!centrifuge for 10 sec at 14,000 rpm in microcentrifuge
! 5.4)!gently remove supernatant using P1000 micropipette and tip
! 6)!resuspend immune complex in 100 µL of ice-cold kinase reaction 

buffer
! 7)!incubate for 10 min. in 37°C water bath

to activate kinase
! 8)!proceed immediately to resolve by SDS-PAGE

see 'Protein Biochemistry > SDS-PAGE'
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! 9)!transfer to PVDF and detect by immunoblotting using anti-phopho-
specific antibody

see 'Protein Biochemistry > Transblotting' and 'Protein Biochemistry 
> Immunoblotting'
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Phosphoflow, Part I
stimulation, fixation and permeabilization

Equipment:
! -!refrigerated centrifuge
! -!vortex
! -!bucket with ice
! -!lab timer
! -!-20 / -80°C freezer

Materials:
! -!Jurkat cells (106 cells per staining tube / condition)
! -!cultured to ≤ 106 cells/mL
! -!serum starved overnight
! -!primary lymphocytes (2x106 cells per staining tube / condition)
! -!freshly isolated
! -!rested inside incubator for ≤ 4 hours prior to stimulation

keep in 50 mL polypropylene tube (rather than polystyrene) to 
prevent loss of cell yield due to adherence

! -!FACS tubes, 5 mL
! -!100% methanol (ACS grade)
! -!keep on ice
! -!FACS buffer
! -!keep on ice

Supporting Protocols:
! -!Cell Culture > Jurkat Maintenance
! -!Cell Culture > Jurkat Serum Starvation
! -!In Vivo / Ex Vivo > Splenocyte Preparation
! -!In Vivo / Ex Vivo > Tissue Dissociation
! -!Jurkat α-TCR Antibody Stimulation
! -!Splenocyte α-TCR Antibody Stimulation
! -!PMA / IM Stimulation

Protocol:
! 1)!stimulate cells

see supporting protocol(s) for details
! 2)!fix cells
! 2.1)!immediately following stimulation, add equal volume (0.5 

mL) of ice-cold 2% paraformaldehyde to each tube
! 2.2)!vortex / mix
! 2.3)!incubate for 10 min. on ice
! 2.4)!centrifuge for 5 min. at 1,000 / 1,500 rpm (4°C)
! 2.5)!decant to remove supernatant
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retain residual volume
! 3)!permeabilize

perform in microcentrifuge tubes
! 3.1)!vortex to resuspend pellet in residual volume
! 3.2)!add 1 mL of ice-cold methanol (ACS grade) to each tube

add methanol to cells in suspension rather than to 
undisturbed pellet to reduce clumping

! 3.3)!vortex to mix
! 3.4)!incubate for ≥ 20 min. on ice
! 4)!store at -20°C overnight or at -80°C for several months if needed

References:
! (142)
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Phosphoflow, Part II
blocking and staining

Equipment:
! -!refrigerated centrifuge
! -!vortex
! -!-20 / -80°C freezer
! -!flow cytometer for analysis
! -!bucket with ice
! -!lab timer

Materials:
! -!Jurkat cells (106) / primary lymphocytes (2x106)

cell number per tube / staining condition
! -!stimulated
! -!fixed
! -!permeabilized
! -!stored at -20 / -80°C in microcentrifuge tube(s)
! -!FACS tubes, 5 mL
! -!FACS buffer
! -!keep on ice
! -!blocking antibody

select to match species of phospho-specific antibody
0.22 mg/mL final

! -!mouse gamma globulin
Jackson ImmunoResearch, Cat. # 015-000-002
11.0 mg/mL

! -!dilute 1:10 in FACS buffer to prepare 1.1 mg/mL stock
! -!phospho-specific staining antibodies

- determine optimal staining concentration from titration experiment 
(e.g., 0.3 µg/mL final)
- protect from light

! -!PE mouse α-phosphotyrosine
BD, Cat. # 558008

! -!Alexa Fluor 647 mouse α-ERK1/2 pT202/pY204
BD, Cat. # 612593
1.5 µg/mL

! -!PE-Cy7 mouse α-ERK1/2 pT202/pY204
BD, Cat. # 560116

! -!Alexa Fluor 647 mouse α-Itk pY511
BD, Cat. # 558134
1.5 µg/mL

! -!PE mouse α-Itk pY511
BD, Cat. # 558129
1.5 µg/mL
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! -!Alexa Fluor 488 mouse α-PLCγ1 pY783
BD, Cat. # 557884

! -!Alexa Fluor 647 mouse α-human PLCγ1 pY783
BD, Cat. # 557883

! -!isotype control staining antibodies
- dilute in FACS buffer to match concentration of phospho-specific 
antibody
- protect from light

! -!Alexa Fluor 488 mouse IgG1
Invitrogen, Cat. # MG120
0.1 mg/mL

! -!Alexa Fluor 647 mouse IgG1
Invitrogen, Cat. # MG121
0.1 mg/mL

! -!PE mouse IgG1
Invitrogen, Cat. # MG104
0.1 mg/mL

! -!PE-Cy7 mouse IgG1
Invitrogen, Cat. # MG112
0.1 mg/mL

! -!surface marker antibodies
protect from light

! -!PE anti-mouse TCR-β, clone H57-597
BioLegend, Cat. # 109208
0.2 mg/mL

! -!PB anti-mouse CD4
BioLegend, Cat. # 100531, clone RM4-5
0.5 mg/mL

Supporting Protocol:
! -!Phosphoflow, Part I
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Protocol:

Figure 40:  TCR and time-dependent Erk activation in Jurkat cells.

! 1)!plan experiment
! 1.1)!determine spectral compatibility among phospho-specific 

and surface marker antibodies (if required)
! 1.2)!determine ability of instrument to excite / detect each 

fluorophore
! 1.3)!prepare spreadsheet listing staining conditions (including 

relevant controls) for each tube
100 µL final volume per tube (80 µL of cell suspension + 
20 µL of 5x antibody solution)

! 1.4)!prepare 5x master mix for tubes receiving common 
antibodies

to reduce variation in staining
! 1.4.1)!dilute in FACS buffer as needed
! 2)!prepare cells

complete through FACS analysis from this point forward
! 2.1)!remove cells from freezer
! 2.2)!vortex microcentrifuge tube to resuspend
! 2.3)!transfer 1-2x106 cells to designated FACS tubes
! 3)!wash cells 3x
! 3.1)!add 3 mL of FACS buffer (wash)

volume of FACS buffer should be ≥ 2x methanol volume to 
prevent precipitation of BSA

! 3.2)!vortex / mix
! 3.3)!centrifuge for 5 min. at 1,000 / 1,500 rpm (4°C)
! 3.4)!decant / discard supernatant
! 3.5)!repeat for a total of 3 washes
! 4)!block cells
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! 4.1)!add 80 µL of FACS buffer to tube
! 4.2)!vortex / resuspend
! 4.3)!transfer 80 µL of cell suspension to new FACS tube

equivalent volumes needed for consistent blocking
! 4.4)!add 20 µL of 1.1 mg/mL blocking antibody to each tube

100 µL final volume per tube
! 4.5)!vortex / mix
! 4.6)!incubate for 30 min - 1 hr. at room temp.
! 5)!wash cells 2x
! 5.1)!add 3 mL of FACS buffer (wash)
! 5.2)!vortex / mix
! 5.3)!centrifuge for 5 min. at 1,000 / 1,500 rpm (4°C)
! 5.4)!decant / discard supernatant
! 5.5)!repeat for a total of 2 washes
! 6)!stain cells
! 6.1)!add 80 µL of FACS buffer to tube
! 6.2)!vortex / resuspend
! 6.3)!transfer 80 µL of cell suspension to new FACS tube

equivalent volumes needed for consistent staining
! 6.4)!add 20 µL of 5x antibody master mix including the following 

components:
- surface marker antibody (or isotype control), if required
- phospho-specific antibody (or isotype control)
- 100 µL final volume per tube

! 6.5)!vortex / mix
! 6.6)!incubate for 30 min. - 1 hr. at room temp. in dark
! 7)!wash cells 2x
! 7.1)!add 3 mL of FACS buffer (wash)
! 7.2)!vortex / mix
! 7.3)!centrifuge for 5 min. at 1,000 / 1,500 rpm (4°C)
! 7.4)!decant / discard supernatant
! 7.5)!repeat for a total of 2 washes
! 8)!add 300 µL of FACS buffer per tube
! 9)!vortex / mix
! 10)!acquire FACS data

complete within same day
! 10.1)!acquire ≤ 50,000 events per tube
! 11)!analyze FACS data
! 11.1)!calculate ratio of MFI of stimulated to non-stimulated 

control cells stained with the same phospho-specific 
antibody

References:
! (142)
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5.2.7. Protein Biochemistry
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Jurkat / Primary Lymphocyte Lysis
proceed immediately following stimulation

Equipment:
! -!refrigerated centrifuge
! -!refrigerated microcentrifuge
! -!tube rotator
! -!keep at 4°C
! -!microcentrifuge tube rack

for assistance in lysis
! -!bucket with ice

Materials:
! -!15 / 50 mL centrifuge tubes
! -!Jurkat cells / primary lymphocytes, required number per 

microcentrifuge tube
keep on ice

! -!stimulated / non-stimulated
! -!transfected / non-transfected
! -!complete NP-40 lysis buffer (CLB)
! -!including protease inhibitors
! -!keep on ice
! -!NP-40 lysis buffer
! -!keep on ice
! -!laemmli sample buffer (LB), 2x

Supporting Protocol:
! -!Cell Culture > Jurkat Maintenance
! -!Cell Culture > Jurkat Serum Starvation

Protocol:
- perform on lab bench
- keep cells at 4°C during and following lysis

! 1)!centrifuge cells for 5 min. at 1,000 (Jurkat cells) / 1,500 (primary 
lymphocytes) rpm for 5 min (4°C)

! 2)!aspirate / discard supernatant
! 3)!resuspend pellet in 500 µL of ice-cold complete NP-40 lysis buffer
! 4)!scratch tube against microcentrifuge tube rack to disrupt / lyse cells
! 5)!rotate for at least 1 hour to complete lysis
! 6)!centrifuge for 20 min. at 14,000 rpm in refrigerated microcentrifuge; 

pellet contains cellular debris, 'lysate' refers to cytoplasmic proteins 
contained in supernatant

! 7)!for resolving by SDS-PAGE:
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! 7.1)!aliquot 10 µL of lysate to new microcentrifuge tube
! 7.2)!add 10 µL of 2x laemmli sample buffer, reduces proteins
! 7.3)!mix well, lysate samples can be stored overnight at 4°C
! 8)!for immunoprecipitation, proceed immediately with protocol
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HEK293 Lysis

Equipment:
! -!refrigerated centrifuge
! -!refrigerated microcentrifuge
! -!tube rotator
! -!keep at 4°C
! -!microcentrifuge tube rack

for assistance in lysis
! -!bucket with ice

Materials:
! -!HEK293 transfectants, culture plate(s) of required size and confluency
! -!PBS, molecular biology grade
! -!keep on ice
! -!transfer pipets
! -!cell scrapers
! -!microcentrifuge tube
! -!complete NP-40 lysis buffer (CLB)
! -!including protease inhibitors
! -!keep on ice
! -!laemmli sample buffer (LB), 2x

Supporting Protocols:
! -!Cell Culture > HEK293 Maintenance
! -!Cell Culture > HEK293 Transfection

Protocol:
- protocol assumes 10 cm diameter (60 cm2) cell culture plate
- scale volumes proportionally for various-sized culture vessels based on 
surface area
- perform on lab bench
- keep cells at 4°C during and following lysis

! 1)!18-48 hours post-transfection, remove plate(s) from incubator
! 2)!decant medium
! 3)!wash cells 2x with 10 mL of cold PBS
! 4)!aspirate excess PBS
! 5)!add 500 µL of ice-cold complete NP-40 lysis buffer
! 6)!use cell scraper to aid in cell detachment and lysis
! 7)!transfer cell lysate to labeled microcentrifuge tube
! 8)!scratch tube against microcentrifuge tube rack to disrupt / lyse cells
! 9)!rotate for at least 1 hour to complete lysis
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! 10)!centrifuge for 20 min. at 14,000 rpm in refrigerated microcentrifuge; 
pellet contains cellular debris, 'lysate' refers to cytoplasmic proteins 
contained in supernatant

! 11)!for resolving by SDS-PAGE:
! 11.1)!aliquot 10 µL of lysate to new microcentrifuge tube
! 11.2)!add 10 µL of 2x laemmli sample buffer, reduces proteins
! 11.3)!mix well; lysate samples can be stored overnight at 4°C
! 12)!for immunoprecipitation, proceed immediately with protocol
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Protein G Sepharose Preparation

Equipment:
! -!biosafety cabinet (TC hood)
! -!microcentrifuge

Materials:
! -!Protein G Sepharose 4 Fast Flow, 5 mL

- GE Healthcare, Cat. # 17-0618-01
- supplied in 20% ethanol storage buffer

! -!store at 4°C
! -!NP-40 lysis buffer
! -!microcentrifuge tubes, sterile
! -!parafilm

Protocol:
work inside TC hood to prevent contamination

! 1)!resuspend stock well
! 2)!aliquot 0.5 mL per microcentrifuge tube
! 3)!wash 3x
! 3.1)!resuspend in 1 mL of NP-40 (wash #1)
! 3.2)!centrifuge at 12,000 g (max speed) for 30 seconds
! 3.3)!aspirate / discard supernatant
! 4)!estimate volume of pellet and resuspend in equal volume of NP-40 

lysis buffer to prepare 50% slurry
! 5)!seal cap with parafilm to reduce moisture loss during storage
! 6)!store at 4°C
! 7)!mix well before use
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Immunoprecipitation (IP)

Equipment:
! -!vortex
! -!tube rotator
! -!keep at 4°C
! -!microcentrifuge

Materials:
! -!cellular lysate stored in microcentrifuge tube
! -!keep on ice
! -!Complete Lysis Buffer (CLB), 1x
! -!keep on ice
! -!laemmli sample buffer (LB), 2x
! -!pre-clearing antibody

normal isotype of species used for IP
! -!IP antibody
! -!NP-40, 1x

Supporting Protocol:
! -!Lysis
! -!Protein G Sepharose Preparation

Protocol:
proceed immediately following preparation of cellular lysate

! 1)!pre-clear lysate (optional)
! 1.1)!add 5 µg of species-specific IgG to new microcentrifuge 

tube
! 1.2)!add complete volume of lysate

avoid removing pellet
! 1.3)!tumble for ~2 hours on tube rotator (4°C)

if required, incubate overnight
! 1.4)!add 30 µL of protein sepharose (A/G) to each tube

sepharose settles quickly – vortex stock prior to use
! 1.5)!tumble for 1 hour on tube rotator (4°C)
! 1.6)!centrifuge for 10 sec at 14,000 rpm in microcentrifuge

- pellet contains non-specific immune complex
- supernatant contains pre-cleared lysate (retain)

! 2)!incubate with IP antibody
! 2.1)!add 5 µg of IP antibody to separate microcentrifuge tube
! 2.2)!add complete volume of lysate; avoid removing pellet
! 2.3)!tumble for ≥ 2 hours on tube rotator (4°C)

for convenience, incubate overnight
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! 3)!incubate with protein sepharose A/G
! 3.1)!add 30 µL of protein sepharose A/G to IP sample

sepharose settles quickly – vortex stock prior to use
! 3.2)!tumble for ~2 hours on tube rotator (4°C)

if required, incubate overnight
! 3.3)!centrifuge for 10 sec at 14,000 rpm in microcentrifuge

pellet contains immune complex
! 4)!wash immune complex (optional)
! 4.1)!gently aspirate supernatant using P1000 micropipette and 

tip
! 4.2)!resuspend pellet in 1 mL of 1x NP-40 lysis buffer (wash #1)
! 4.3)!centrifuge for 10 sec at 14,000 rpm in microcentrifuge
! 4.4)!repeat for a total of 2 washes
! 4.5)!centrifuge for 10 sec at 14,000 rpm in microcentrifuge
! 4.6)!gently remove supernatant using P1000 micropipette and tip
! 5)!for resolving by SDS-PAGE, reduce immune complex
! 5.1)!add 10 µL of 2x laemmli sample buffer to pellet in tube 

containing immune complex
! 5.2)!continue immediately with SDS-PAGE protocol
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Acrylamide Gel Preparation

Equipment:
! -!glass base for gel assembly
! -!gel apparatus 

assemble in sequential order (listed from back to front)
! -!gel backing
! -!alumina plate

select correct size
! -!spacers, 2 each

select correct thickness
! -!glass plate

select correct size
! -!clamps, 4 each
! -!comb

select correct thickness
! -!dI water squirt bottle
! -!vortex
! -!refrigerator

Materials:
! -!70% ethanol squirt bottle
! -!Acrylamide Gel Buffer, 10 mL

- for plug and running gel
- see 'Buffers & Solutions'

! -!select required % acrylamide gel needed for resolution of 
protein(s) of interest based on molecular weight

! -!prepare fresh
! -!APS, 10%

- polymerizing agent
- see 'Buffers & Solutions'

! -!prepare fresh
! -!TEMED

- polymerizing agent
- see 'Buffers & Solutions'

! -!Stacking Gel, 5 mL
see 'Buffers & Solutions'

! -!prepare fresh
! -!blotting paper
! -!microcentrifuge tubes
! -!Whatman filter paper
! -!1x Running Buffer

see 'Buffers & Solutions'
! -!plastic wrap
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Premium Saran

Protocol:
! 1)!clean components of gel apparatus with 70% ethanol solution
! 2)!assemble gel apparatus (see 'Equipment' above for details)
! 3)!prepare Acrylamide Gel Buffer and Stacking Gel Buffer (see 'Buffers 

& Solutions')
! 4)!prepare gel plug

proceed immediately after adding polymerizing agents
! 4.1)!transfer 1 mL of Acrylamide Gel Buffer to microcentrifuge 

tube
! 4.1.1)!add 10 µL of 10% APS
! 4.1.2)!add 5 µL of TEMED
! 4.2)!vortex
! 4.3)!pipet 1 mL between alumina and glass plates

add 50% volume to each side of apparatus
! 4.4)!allow ~ 5 mins. to polymerize
! 5)!cast running gel
! 5.1)!add to remaining 9 mL of Acrylamide Gel Buffer:

to polymerize gel
! 5.1.1)!45 µL of 10% APS
! 5.1.2)!9 µL of TEMED
! 5.2)!vortex
! 5.3)!pipet 6-7 mL between alumina and glass plates

add 50% volume to each side of apparatus
! 5.4)!add dI H2O above stacking gel to top of alumina plate

applies pressure to form horizontal line across gel
! 5.5)!allow ~ 30 mins. to polymerize
! 6)!wick away dI H2O above gel using folded Whatman filter paper
! 7)!cast stacking gel
! 7.1)!add to 5 mL of Stacking Gel

to polymerize gel
! 7.1.1)!25 µL 10% APS
! 7.1.2)!10 µL TEMED
! 7.2)!pipet to top of alumina plate
! 7.3)!add gel comb

select comb with appropriate thickness to ensure tight fit 
for proper well formation

! 7.4)!allow ≤ 30 mins. to polymerize completely
! 8)!add 1x Running Buffer to apparatus between gel backing and 

alumina plate
! 9)!for short term storage, wrap gel apparatus in plastic wrap

to retain moisture
! 9.1)!keep in refrigerator for 2-3 days
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SDS-PAGE
sodium dodecyl sulfate – polyacrylamide gel electrophoresis

Equipment:
! -!gas line
! -!bunsen burner and stand
! -!gel base
! -!power supply for gel apparatus

limits:  500 V, 40 mA, 10 W
run at 12-18 mA

! -!vortex

Materials:
! -!beaker containing tap water and boiling chips
! -!clamps for microcentrifuge tubes
! -!lysate samples
! -!keep at 4°C
! -!IP samples

proceed immediately following IP protocol
! -!protein ladder

dual colored for identification of protein of interest
! -!acrylamide gel

see supporting protocol for details
! -!prepared fresh or stored in refrigerator
! -!1x Running Buffer

Supporting Protocols:
! -!Lysis
! -!Immunoprecipitation
! -!Acrylamide Gel Preparation

Protocol:
! 1)!denature lysate and/or IP samples
! 1.1)!boil water in beaker containing boiling chips
! 1.1.1)!pre-heat for 10 min. in microwave oven
! 1.1.2)!bring to complete boil using bunsen burner
! 1.2)!apply clamps to microcentrifuge tubes

prevents sample loss due to caps popping
! 1.3)!boil lysate and IP samples for 5 mins.
! 1.4)!allow tubes to cool before removing caps
! 1.5)!centrifuge all tubes for 30 sec at 14,000 rpm

for IP samples:
- sepharose beads contained in pellet
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- IP antibody, target and associated proteins contained in 
supernatant

! 2)!assemble gel apparatus and base
! 2.1)!insert completely assembled gel apparatus to base

adjust position of lower clamps to facilitate
! 2.2)!add 1x Running Buffer to apparatus between gel backing 

and alumina plate
! 2.3)!add 1x Running Buffer to gel base
! 2.4)!remove comb when completely submerged in buffer
! 2.5)!add protein ladder and samples to designated wells
! 2.6)!connect wires from power supply to gel apparatus
! 2.7)!program settings for power supply

limits:  500 V, 40 mA, 10 W
! 3)!run gel
! 3.1)!run gel at 12-18 mA
! 3.2)!monitor gel for leaks

if necessary, add 1x Running Buffer
! 3.3)!after achieving desired separation, turn off power to gel 

apparatus
! 3.4)!detach gel apparatus from base
! 3.5)!remove backing from gel apparatus
! 3.6)!discard Running Buffer in sink
! 3.7)!proceed immediately with trans-blotting protocol
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Trans-blotting

Equipment:
! -!trans-blotter apparatus
! -!base (negative electrode)
! -!top (positive electrode)
! -!wires for connection to power supply
! -!power supply for trans-blotter apparatus

volts:  14
limit:  0.4 mA
timer:  1.0 hr

! -!glass baking dish
! -!blotting tray

Materials:
! -!acrylamide gel apparatus

proceed immediately following electrophoresis
! -!PVDF membrane
! -!methanol, molecular biology grade
! -!Western Transfer Buffer
! -!blotting paper

Supporting Protocols:
! -!SDS-PAGE

Protocol:
! 1)!activate PVDF membrane
! 1.1)!soak PVDF membrane in methanol (in blotting tray)
! 1.2)!discard methanol
! 1.3)!wash with dI H2O
! 2)!soak 2 pieces of blotting paper and PVDF membrane in Western 

Transfer Buffer in glass baking dish
! 3)!assemble trans-blotter apparatus in order listed below (from bottom 

to top)
- keep all layers saturated in WTB
- roll each layer with glass rod to remove air bubbles

! 3.1)!add blotting paper to base of trans-blotter (negative 
electrode)

! 3.2)!add acrylamide gel
! 3.2.1)!flip upside down

take extreme care removing gel from apparatus 
to prevent tearing

! 3.3)!add PVDF membrane
! 3.4)!add blotting paper
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! 3.5)!attach / tighten top of trans-blotter (positive electrode)
! 4)!connect wires from power supply to trans-blotter apparatus
! 5)!program settings for power supply

volts:  14
limit:  0.4 mA
timer:  1.0 hr – will stop automatically

! 6)!remove PVDF membrane
confirm transfer of colored ladder to PVDF membrane

! 7)!store membrane in drawer between two pieces of dry blotting paper 
until immunoblotting

no longer need to keep membrane wet after transfer
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Immunoblotting (IB)

Equipment:
! -!developer (in dark room)
! -!rocker platform
! -!lab timer

Materials:
! -!PVDF membrane containing transferred proteins
! -!ballpoint pen
! -!ultrafine point Sharpie marker
! -!1° antibody

epitope-specific
! -!2° antibody, HRP-conjugated

specific for species and isotype of 1° antibody
! -!Blocking Buffer

see 'Buffers & Solutions'
! -!Blotting Solution

see 'Buffers & Solutions'
! -!blotting tray
! -!ECL (enhanced chemiluminescent) substrate

Thermo Scientific, Cat. # 34080
! -!film folder
! -!film, 8 x 10"
! -!protect from light
! -!forceps
! -!methanol, molecular biology grade
! -!plastic wrap

Premium Saran
! -!razor blade
! -!scissors
! -!TBST

see 'Buffers & Solutions'
! -!Thimerasol

Supporting Protocol:
! -!Trans-blotting

Protocol:
- plan order of serial blotting (e.g., phosphotyrosine blotting followed by 
loading control)
- once hydrated, keep membrane wet throughout protocol
- equilibrate buffers to room temperature prior to use
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! 1)!prepare membrane
make annotations using ballpoint pen

! 1.1)!mark location of protein ladder bands
! 1.2)!write initials and date on edge of membrane
! 1.3)!wet membrane with methanol (in blotting tray)
! 1.4)!wash 3x with dI H2O
! 2)!blocking
! 2.1)!add 15 mL of Blocking Buffer
! 2.2)!incubate for ~1 hour with gentle rocking
! 2.3)!discard Blocking Buffer
! 3)!blotting with 1° antibody, epitope-specific
! 3.1)!dilute antibody in Blotting Solution
! 3.2)!add antibody solution to membrane
! 3.2.1)!retain 15mL Falcon tube for storage
! 3.3)!incubate for 1 hour with gentle rocking
! 3.4)!transfer antibody solution to original tube for re-blotting (if 

needed)
! 4)!wash, repeat 3x
! 4.1)!add TBST
! 4.2)!incubate for 5 min. with gentle rocking
! 4.3)!discard TBST
! 5)!blotting with 2° antibody, HRP-conjugated
! 5.1)!dilute antibody in Blotting Solution
! 5.2)!add antibody solution to membrane
! 5.3)!incubate for 30 minutes with gentle rocking
! 6)!wash, repeat 3x
! 6.1)!add TBST
! 6.2)!incubate for 10 min. with gentle rocking
! 6.3)!discard TBST
! 7)!react with ECL substrate
! 7.1)!add 3mL of solution 1
! 7.2)!add 3mL of solution 2
! 7.3)!mix briefly, allow sufficient contact with membrane
! 7.4)!transfer membrane to plastic wrap (use forceps)
! 7.5)!wrap membrane; trim excess plastic using razor blade
! 8)!develop film in dark room
! 8.1)!bring membrane, film, scissors, timer and film folder
! 8.2)!turn on developer and allow to warm-up prior to use
! 8.3)!cut film in half along length
! 8.4)!clip upper-left corner of film

for identification of orientation relative to membrane
! 8.5)!place film directly above membrane and close lid of folder
! 8.6)!expose film for various time intervals

e.g., 10 seconds, 1, 5, 10 minutes, etc.
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! 8.7)!insert film in developer
! 8.8)!label film with initials, date, blotting antibody, and exposure 

time
use ultrafine point Sharpie marker

! 8.9)!scan and catalog for analysis and archival
! 9)!serial blotting
! 9.1)!wash membrane 3x for 10 min. with TBST

to remove luminescent product/signal
! 9.2)!for strong signal, wash overnight on rocker
! 9.3)!expose film for various time intervals to verify removal of 

signal
if necessary, strip membrane

! 9.4)!repeat blotting with different 1° antibody and continue with 
protocol
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Detection of Itk Activation by Immunoblotting

Equipment:
! -!humidified, 5% CO2, 37°C incubator
! -!tube rotator
! -!bucket with ice
! -!lab timer

Materials:
! -!Jurkat cells (20x106 cells per tube / condition)
! -!serum starved overnight

see supporting protocol
! -!stimulated via TCR (and non-stim. control)

see supporting protocol
! -!stimulated with PMA/IM (and non-stim. control)

see supporting protocol
! -!primary lymphocytes (60-80x106 cells per tube / condition)
! -!freshly isolated
! -!rested inside incubator for ≤ 4 hours prior to stimulation

keep in 50 mL polypropylene tube (rather than polystyrene) to 
prevent loss of cell yield due to adherence

! -!stimulated via TCR (and non-stim. control)
see supporting protocol

! -!stimulated with PMA/IM (and non-stim. control)
see supporting protocol

! -!normal rabbit IgG
pre-clear antibody

! -!protein G sepharose (PGS)
! -!rabbit anti-Itk

immunoprecipitation antibody
! -!4G10

anti-phosphotyrosine immunoblotting antibody
! -!2F12

anti-Itk immunoblotting antibody
! -!HRP Goat Anti-Mouse

detection antibody
! -!ECL substrate

Supporting Protocols:
! -!T Cell Stimulation / Itk Activation > Jurkat α-TCR Antibody Stimulation
! -!T Cell Stimulation / Itk Activation > Primary Lymphocyte α-TCR 

Antibody Stimulation
! -!Jurkat / Primary Lymphocyte Lysis
! -!Immunoprecipitation
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! -!SDS-PAGE
! -!Immunoblotting

Protocol:
! 1)!lyse cells immediately following stimulation
! 2)!pre-clear lysate

see supporting protocol
! 2.1)!add 5 µg of normal rabbit IgG per tube
! 2.2)!incubate on tube rotator for 2 hrs. at 4°C
! 2.3)!add 30 µL of protein G sepharose
! 2.4)!incubate on tube rotator for 1 hr at 4°C
! 3)!immunoprecipitate

see supporting protocol
! 3.1)!add 5 µg of rabbit anti-Itk to each tube
! 3.2)!incubate overnight (~16 hrs.) on tube rotator at 4°C
! 3.3)!add 30 µL of protein G sepharose
! 3.4)!incubate for 1 hr. on tube rotator at 4°C
! 4)!resolve immune complex by SDS-PAGE

see supporting protocol
! 5)!transfer to PVDF membrane

see supporting protocol
! 6)!block membrane for 1 hour at room temp on rocker
! 7)!immunoblot for phosphotyrosine
! 7.1)!incubate with 4G10 at 1:1,000 for 1 hr at room temp.
! 7.2)!wash 3x for 5 min each
! 7.3)!incubate with HRP Goat Anti-Mouse at 1:5,000 for 30 min. 

at room temp.
! 7.4)!wash 3x for 10 min each
! 8)!wash membrane 3x for 30 min each; expose film for ~1 min to 

confirm removal of signal
wash overnight if necessary

! 9)!immunoblot for Itk (loading control)
! 9.1)!incubate with 2F12 at 1:1,000 for 1 hr at room temp.
! 9.2)!wash 3x for 5 min each
! 9.3)!incubate with HRP Goat Anti-Mouse at 1:5,000 for 30 min. 

at room temp.
! 9.4)!wash 3x for 10 min each

References:
! (2)
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5.2.8. Microscopy / FACS
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Surface Staining for FACS Analysis

Equipment:
! -!microcentrifuge
! -!bucket with ice
! -!refrigerator
! -!refrigerated centrifuge
! -!vortex
! -!waste container
! -!containing 10% bleach when full
! -!lab timer
! -!flow cytometer and computer with BD FACS Diva installed

e.g., Canto or Aria

Materials:
! -!single cell suspension

keep on ice
! -!cell line
! -!primary tissue

spleen, lymph nodes, lung or thymus
! -!lyse RBCs

except from lung tissue
! -!FACS tubes
! -!microcentrifuge tubes
! -!2% paraformaldehyde / PBS
! -!keep on ice
! -!FACS buffer
! -!keep on ice
! -!anti-CD16 / CD32

Fc blocking antibody
! -!fluorescently-labeled antibodies (including isotype control antibodies)
! -!quick spin vial to recover maximum volume
! -!protect from light
! -!Kimwipes
! -!CST beads
! -!dI water

Supporting Protocol:
! -!Cell Culture > Cell Counting

Protocol:
! 1)!prepare spreadsheet listing each tube / sample and staining 

antibodies required
including non-stained and single-color control samples
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! 1.1)!for each fluorescently-labeled antibody, check flow 
cytometer for available laser for excitation and detection 
filter

! 1.2)!if performing multi-color staining, check fluorescent spectra 
for compatibility

! 2)!prepare cell suspension
106 cells per FACS tube / staining condition

! 2.1)!count cells
see supporting protocol

! 2.2)!centrifuge for 5 min. at 1,500 rpm
! 2.3)!discard supernatant
! 2.4)!resuspend in FACS buffer at 20x106 cells/mL
! 2.5)!for primary cells, incubate with 0.5-1 µg of anti-CD16 / CD32 

for 5-10 min. on ice prior to staining
to block Fc receptors

! 2.6)!aliquot 50 µL (106 cells) to designated FACS tubes
! 3)!prepare staining antibody solution

0.03-2 µg of antibody per 106 cells
! 3.1)!dilute to 0.6 - 40 µg/mL in FACS buffer

titrate antibody to determine optimal concentration
! 3.1.1)!prepare common batch for identical staining 

conditions
! 3.2)!aliquot 50 µL (0.03-2 µg) to designated FACS tubes
! 4)!vortex to mix
! 5)!incubate for 20-45 min. in dark on ice or at 4°C in refrigerator
! 6)!wash cells

to remove unbound antibody
! 6.1)!add 2 mL of FACS buffer to each tube
! 6.2)!vortex (wash)
! 6.3)!centrifuge for 5 min. at 1,000-1,500 (4°C)
! 6.4)!decant supernatant to waste container
! 6.4.1)!wick away excess supernatant using Kimwipe
! 6.5)!repeat for a total of 2-3 washes
! 7)!optional:  fix cells
! 7.1)!add 100 µL of ice-cold 2% paraformaldehyde/PBS to each 

tube
! 7.2)!vortex to resuspend
! 7.3)!incubate for 10 min. in dark on ice or at 4°C in refrigerator
! 8)!wash cells

to remove paraformaldehyde
! 8.1)!add 2 mL of FACS buffer to each tube
! 8.2)!vortex (wash)
! 8.3)!centrifuge for 5 min. at 1,000-1,500 (4°C)
! 8.4)!decant supernatant to waste container
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! 8.4.1)!wick away excess supernatant using Kimwipe
! 8.5)!repeat for a total of 2-3 washes
! 9)!add 300-500 µL of FACS buffer to each tube
! 10)!vortex to resuspend
! 11)!store on ice or at 4°C in refrigerator until FACS analysis

- for live cells, acquire FACS data immediately after staining
- for fixed cells, acquire FACS data within 2-3 days

! 12)!acquire FACS data
! 12.1)!perform CST calibration prior to running samples
! 12.1.1)!add dI water to FACS tube
! 12.1.2)!add 2 drops of CST beads
! 12.1.3)!vortex
! 12.1.4)!run on instrument
! 12.2)!start stream

check for proper instrument performance
! 12.3)!setup experiment / tubes
! 12.4)!set up parameters / voltages
! 12.5)!vortex each tube prior to loading
! 12.6)!identify cell population on FSC, SSC dot plot
! 12.7)!adjust flow rate as needed
! 12.8)!identify fluorescent populations on respective dot plots

adjust voltages if needed
! 12.9)!collect ≥ 10,000 events per sample
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Viability Assay with 7-AAD
viability exclusion dye

Equipment:
! -!bucket with ice
! -!refrigerated centrifuge
! -!vortex
! -!waste container
! -!containing 10% bleach when full
! -!lab timer
! -!flow cytometer

for analysis

Materials:
! -!cells
! -!stained for surface markers
! -!FACS tubes
! -!FACS buffer
! -!keep on ice
! -!7-AAD, 100x

- BioLegend, Cat. # 420404
- detect in PerCP channel:
! - ex:  488 nm
! - em:  682/33 nm
- can be used in conjunction with FITC and/or PE

! -!stored at 4°C in dark

Supporting Protocol:
! -!Surface Staining for FACS Analysis

Protocol:
perform in FACS tubes

! 1)!wash cells
! 1.1)!add 1 mL FACS buffer to each tube
! 1.2)!vortex / wash
! 1.3)!centrifuge for 5 min. at 1,000 / 1,500 rpm (4°C)
! 1.4)!discard supernatant
! 2)!resuspend ~106 cells in 100 µL of ice-cold FACS buffer
! 3)!add 1 µL of 100x 7-AAD (1x final)
! 4)!incubate on ice for 10 min. in dark
! 5)!wash cells
! 5.1)!add 1 mL FACS buffer to each tube
! 5.2)!vortex / wash
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! 5.3)!centrifuge for 5 min. at 1,000 / 1,500 rpm (4°C)
! 5.4)!discard supernatant
! 6)!resuspend cells in 300 µL of ice-cold FACS buffer
! 7)!proceed immediately with FACS analysis

do not fix with paraformaldehyde
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Coating Microscopy Slides / Cover Glass with Poly-L-Lysine
for attachment of cells to glass slides or cover glass

Equipment:
! -!waste container
! -!containing 10% bleach when full

Materials:
! -!0.01% (w/v) poly-L-lysine (pLL) / H2O

see 'Buffers & Solutions'
! -!microscope slides, 25 x 75 x 1 mm

Fisher, Cat. # 12-544-7
! -!for cover glass method:
! -!cover glass, 18 x 18 x 1 mm

Fisher, Cat. # 12-548-A
! -!tissue culture dishes, 35 x 10 mm

BD, Cat. # 353001
! -!ultrapure water

Protocol:
prepare excess number of slides prior to experiment

! 1)!for coating slides:
! 1.1)!add 50 µL of 0.01% pLL / H2O per slide
! 1.2)!spread evenly in center area using pipet tip
! 2)!for coating cover glass:
! 2.1)!add 1 cover glass per culture dish
! 2.2)!add 1 mL of 0.01% pLL / H2O to each dish

make sure cover glass is completely covered
! 2.3)!discard pLL
! 3)!incubate at room temp. for ≤ 30 min.
! 4)!wash 3x with ultrapure water
! 5)!allow to dry completely (≤ 1 hr.)
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Growing / Transfecting HEK293 on Cover Glass

Equipment:
! -!humidified, 37°C, 5% CO2 incubator
! -!biosafety cabinet (TC hood)
! -!waste container

for decontamination of discarded culture
! -!containing 10% bleach when full
! -!lab timer

Materials:
! -!cover glass (inside culture dishes)

see supporting protocol for details
! -!coated with poly-L-lysine
! -!microscopy slides, 25 x 75 x 1 mm (1 per cover glass)

Fisher, Cat. # 12-544-7
! -!straight-edge razor

for removing cover glass from culture dishes
! -!optional:  35 mm MatTek culture dishes 

contain embedded cover glass
! -!293 Wash Medium
! -!293 Transfection Medium
! -!293 Growth Medium
! -!293 Starvation Medium
! -!microcentrifuge tube (1 per transfection)
! -!plasmid DNA
! -!PBS
! -!2% paraformaldehyde / PBS
! -!keep on ice
! -!mounting medium

Invitrogen, Cat. # P7481
! -!pre-warm to 37°C before use
! -!nail polish
! -!slide folder

Supporting Protocol:
! -!Coating Microscopy Slides / Cover Glass with Poly-L-Lysine

Protocol:
! 1)!seed dish
! 1.1)!add 2 mL of 293 Growth Medium to each dish
! 1.2)!add ~250,000 cells
! 1.3)!incubate until cover glass is 50-80% confluent
! 2)!prepare DNA-Lipofectamine complexes
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prepare separately for each dish
! 2.1)!add 100 µL of 293 Wash Medium to microcentrifuge tube
! 2.2)!add 1 µg of DNA to tube
! 2.3)!add 10 µL of Lipofectamine 2000 to tube
! 2.4)!incubate for 45 min. at room temp.
! 3)!transfect cells
! 3.1)!add 800 µL of 293 Wash Medium to tube containing DNA-

Lipofectamine complexes
dilute just prior to adding to cells

! 3.2)!add diluted DNA-Lipofectamine complexes to cells grown in 
dish

! 3.3)!return dish to incubator for 1 hr.
! 4)!replace medium
! 4.1)!discard medium following transfection

to remove excess DNA-Lipofectamine complexes
! 4.2)!add 2 mL of fresh 293 Growth Medium
! 4.3)!return dish to incubator for 24 hrs.
! 5)!optional:  serum starve
! 5.1)!discard medium
! 5.2)!add 2 mL of fresh 293 Starvation Medium
! 5.3)!return to incubator for 3 hrs.
! 6)!wash with PBS
! 6.1)!discard medium
! 6.2)!add 2 mL of PBS
! 6.3)!discard PBS
! 7)!fix
! 7.1)!add 100 µL of 2% paraformaldehyde / PBS
! 7.2)!wait 15 min.
! 8)!wash with PBS as before
! 9)!remove cover glass from bottom of dish
! 10)!apply mounting medium / seal slides
! 10.1)!add 10 µL of mounting medium directly above cells
! 10.2)!invert cover glass with attached cells onto slide
! 10.3)!seal coverslip at each corner with nail polish

do not seal along edges yet
! 10.4)!allow mounting medium to cure overnight at room temp. in 

dark
! 10.5)!seal edges of cover glass using nail polish
! 11)!store slides at 4°C in slide folder
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Antibody Adsorption to Microspheres
for localization / conjugation assays

Equipment:
! -!tube rotator
! -!deli fridge
! -!bench-top microcentrifuge
! -!hemacytometer

Materials:
! -!6 µm diameter polystyrene (PS) microspheres

- Polysciences, Cat. # 07312
- 2.59% (w/v) stock (25.9 mg/mL)
- provided in water without preservatives
- 1 year shelf life
- use aseptic technique

! -!microcentrifuge tubes, sterile
! -!antibody for adsorption

stock solution in buffer without carrier protein (e.g., BSA)
! -!OKT3
! -!OKT9
! -!UPC10
! -!FITC-conjugated secondary antibody

for staining to determine efficiency of antibody adsorption by FACS 
analysis

! -!Microsphere Blocking Buffer
0.1% BSA/PBS (1 mg/mL)

! -!Microsphere Storage Buffer
0.05% BSA/PBS (0.5 mg/mL)

! -!FACS Buffer
! -!keep on ice
! -!FACS tubes

Supporting Protocols:
! -!General > Measurement of Antibody Concentration by Absorbance
! -!Cell Culture > Cell Counting

Protocol:
microspheres adsorb protein non-specifically, therefore it is important to add 
antibody from a stock solution that does not include carrier protein

formula for calculation of microsphere surface saturation is as follows:  S = 
[6 / (p*D) ] *C
where S = surface saturation (mg protein / g of microspheres;
ρ = density of microspheres (e.g., 1.05 g/cm3)
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D = diameter of microspheres in microns (e.g., 6 µm)
C = capacity of microsphere surface for given protein (e.g., 2.5 mg/m2 for IgG, 
3 mg/m2 for BSA)

example calculation for coating 6 µm microspheres with IgG:
S = [6 / (1.05 * 6)] * 2.5 = 2.4 mg

- therefore, 2.4 mg of antibody needed to coat 1 g of microspheres
- multiply by recommended 10x excess for providing driving force for 
adsorption results in 24 mg for 1 g of microspheres (i.e., 120 µg of antibody 
for 5 mg of microspheres)

! 1)!determine concentration of antibody stock solution
see supporting protocol

! 2)!prepare antibody / microsphere mixture
500 µL total volume in microcentrifuge tube

! 2.1)!add 120 µg of antibody
0.24 mg/mL final concentration

! 2.2)!add calculated volume of PBS
! 2.3)!add 5 mg of microspheres

- add microspheres to diluted antibody for even 
distribution of adsorption
- 1% (10 mg/mL) final concentration of microspheres

! 2.4)!mix
! 3)!tumble on tube rotator for 24 hours at 4°C

to adsorb antibody to microspheres
! 4)!block microspheres

to saturate exposed hydrophobic surfaces of the microspheres
! 4.1)!centrifuge at 1,200 g for 15 min.
! 4.2)!carefully aspirate supernatant using pipet tip
! 4.3)!resuspend antibody-coated microspheres in 1 mL of 

Blocking Buffer
! 4.4)!tumble on tube rotator overnight at 4°C
! 5)!reconstitute in Storage Buffer
! 5.1)!centrifuge at 1,200 g for 15 min.
! 5.2)!carefully aspirate supernatant using pipet tip
! 5.3)!resuspend in 1 mL of Storage Buffer
! 6)!determine final # microspheres / mL using hemacytometer

see 'Cell Counting' protocol for details
! 7)!verify efficient antibody adsorption for each microsphere preparation 

by FACS analysis prior to use in cell-based assay
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Figure 41:  FACS analysis of microspheres coated with antibody.
! OKT3-coated microspheres were stained with FITC-conjugated goat 
anti-mouse antibody and analyzed by FACS to determine efficiency of OKT3 
adsorption as compared to control microspheres coated with BSA.

! 7.1)!for each sample, add 1 mL of FACS buffer to 
microcentrifuge tube

! 7.2)!aliquot 106 antibody-coated microspheres to tube
! 7.3)!add fluorophore-conjugated secondary antibody at 5 µg/mL 

final
! 7.4)!tumble for 30 min. at 4°C
! 7.5)!wash 2x with FACS buffer
! 7.5.1)!centrifuge at 1,200 g for 15 min.
! 7.5.2)!carefully aspirate supernatant using pipet tip
! 7.5.3)!resuspend in 1 mL of FACS buffer (wash)
! 7.5.4)!repeat
! 7.6)!centrifuge at 1,200 g for 15 min.
! 7.7)!carefully aspirate supernatant using pipet tip
! 7.8)!resuspend in 1 mL of FACS Buffer
! 7.9)!transfer microspheres to designated FACS tubes
! 7.10)!acquire FACS data
! 7.11)!analyze FACS data
! 7.11.1)!prepare dot plots with negative gate determined 

by BSA-coated control microspheres
! 7.11.2)!display overlapping histogram to comparatively 

assess efficiency of antibody adsorption
! 8)!store at 4°C for ≤ 2 weeks

References:
! (94, 143)
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Jurkat–Microsphere/OKT3 Conjugation
for localization studies only (reflective property of microspheres interferes with 
detection of FRET)

Equipment:
! -!refrigerated centrifuge
! -!bucket with ice
! -!37°C water bath

Materials:
! -!Jurkat cells cultured to ≤ 106 cells/mL
! -!serum starved overnight

see supporting protocol
! -!OKT3- and UPC10/OKT9-coated microspheres

see supporting protocol for details
! -!microscope slides, 25x75x1 mm

Fisher, Cat. # 12-544-7
! -!coated with poly-L-lysine in advance

see supporting protocol
! -!microcentrifuge tubes
! -!RPMI
! -!keep on ice

Supporting Protocols:
! -!Cell Culture > Jurkat Serum Starvation
! -!Antibody Adsorption to Microspheres
! -!Coating Microscopy Slides / Cover Glass with Poly-L-Lysine

Protocol:
for each experimental condition, combine according to ratio below:
106 Jurkat cells : 2x106 microspheres

! 1)!serum starve Jurkat cells overnight
see supporting protocol for details

! 2)!adsorb antibody to microspheres
see supporting protocol for details

! 3)!coat microscopy slides with poly-L-lysine
see supporting protocol for details

! 4)!prepare OKT3- or UPC10/OKT9-coated microspheres
see supporting protocol for details

! 4.1)!adjust concentration to 2x in RPMI
e.g., 8x106 microspheres/mL

! 4.2)!equilibrate on ice
! 5)!prepare Jurkat cells
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! 5.1)!adjust concentration to 2x in RPMI
e.g., 4x106 cells/mL

! 5.2)!equilibrate on ice
! 6)!mix microspheres and cells

prepare in microcentrifuge tube
! 6.1)!add microspheres (e.g., 2x106 microspheres / 250µL)
! 6.2)!add cells (e.g., 106 cells / 250µL)
! 6.3)!mix gently
! 6.4)!keep on ice
! 7)!promote contact of microspheres and cells
! 7.1)!centrifuge for 5 min. at 100 g (500 rpm) at 4°C
! 7.2)!carefully remove supernatant using pipet tip

- do not disturb pellet
- leave ~100µL volume

! 7.3)!incubate for 30 min. on ice
allow conjugate formation to occur

! 8)!stimulate
proceed quickly between steps

! 8.1)!transfer microcentrifuge tube(s) to 37°C water bath
! 8.2)!incubate for various time-points

e.g., 1, 3, 5, 10, 30 minutes
! 8.3)!return tube(s) to ice
! 8.4)!proceed immediately with 'Cell Attachment and Fixation on 

Slides / Cover Glass'

References:
! (94, 143)
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Surface Staining with Cy5 NHS Ester
- for surface labeling of Raji cells (antigen presenting cell line for Jurkat cells 
along with super-antigen) for FRET and/or localization experiment(s)
- surface labeling can be used to generate a region of interest (ROI) at the 
contact site between an APC and a T cell expressing CFP / YFP
- do not label APCs with other fluorescent molecules that may contaminate 
FRET channel

Equipment:
! -!biosafety cabinet / TC hood
! -!-20°C freezer
! -!refrigerated centrifuge
! -!bucket with ice

Materials:
! -!Raji cells

APCs for Jurkat in the presence of super-antigen
! -!cultured to ≤ 106 cells/mL
! -!Cy5 Mono-Reactive Dye Pack

- GE Healthcare / Amersham Biosciences, Cat. # PA25001
- kit contains 5 dye packs
- each pack contains ~30 nmols and is intended for one labeling 
reaction (i.e., for labeling 1 mg of protein)

! -!stored at 4°C
! -!protected from light
! -!anhydrous DMSO

Sigma, Cat. # 276855; 100 mL
! -!protect from moisture
! -!50 mL centrifuge tube
! -!PBS, cell culture grade
! -!prepare aliquot
! -!keep on ice
! -!Raji Growth Medium

cRPMI + 10% FBS
! -!prepare aliquot
! -!keep on ice

Supporting Protocol:
! -!In Vivo / Ex Vivo:  Mononuclear Cell Isolation Using Density Gradient

Protocol:
for staining 1-5x106 cells
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Figure 42:  Jurkat cells surface stained with Cy5 NHS ester.

! 1)!reconstitute Cy5 NHS ester
! 1.1)!dissolve 1 dye pack (see notes above) in 30 µL of 

anhydrous DMSO
succinimidyl ester will gradually hydrolyze in the presence 
of water

! 1.2)!store unused reconstituted dye in dark at -20°C for 1 month
if protected from moisture

! 2)!optional:  isolate viable cells by separation with histopaque
- see supporting protocol
- dead cells become stained very bright intracellularly and can 
interfere with image analysis

! 3)!transfer cells for staining to 50 mL centrifuge tube
wider surface area at bottom is better for more uniform staining

! 4)!centrifuge for 5 min. at 1,000 rpm (4°C)
! 5)!discard supernatant
! 6)!wash cells with PBS
! 6.1)!resuspend / wash pellet in 10 mL of PBS
! 6.2)!centrifuge for 5 min. at 1,000 rpm (4°C)
! 6.3)!discard supernatant
! 7)!resuspend cells prior to staining in 500 µL of ice-cold PBS
! 8)!add 5 µL of Cy5 dye as prepared above

can increase to 10 µL if dye is old
! 8.1)!protect from light
! 9)!mix immediately
! 10)!incubate in dark for 10 min. on ice
! 10.1)!mix frequently during incubation
! 11)!wash cells 2x with PBS
! 12)!wash cells 1x with Raji Growth Medium

to quench un-reacted dye
! 13)!proceed with imaging experiment

- can use cells immediately if it is determined that Cy5 does not 
interfere with T cell activation
- alternatively, return cells to incubator overnight to allow re-
expression of surface / MHC proteins needed for T cell activation
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! - however, avoid longer incubations that may result in 
bright internalized granules containing dye that may interfere with 
image analysis

References:
! (144)
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Jurkat-Raji/SEE Conjugation
for localization and/or FRET assay(s)

Equipment:
! -!refrigerated centrifuge
! -!humidified, 5% CO2 37°C incubator
! -!bucket with ice
! -!37°C water bath

Materials:
! -!Jurkat cells

106 cells per reaction
! -!nucleofected with fluorescent-protein reporter construct

see supporting protocol
! -!serum starved overnight (optional)
! -!Raji cells

106 cells per reaction
! -!surface stained with Cy5 NHS Ester

see supporting protocol
! -!staphylococcal enterotoxin E (SEE)

- super-antigen for binding to Raji MHC
- Toxin Technologies, Cat. # ET404

! -!microscope slides, 25x75x1 mm
Fisher, Cat. # 12-544-7

! -!coated with poly-L-lysine in advance
see supporting protocol

! -!microcentrifuge tubes
! -!RPMI
! -!keep on ice
! -!4% paraformaldehyde
! -!keep on ice

Supporting Protocols:
! -!Surface Staining with Cy5 NHS Ester
! -!In Vivo / Ex Vivo > Mononuclear Cell Isolation Using Density Gradient
! -!Cell Culture > Jurkat Amaxa Nucleofection
! -!Cell Culture > Jurkat Serum Starvation
! -!Coating Slides with Poly-L-Lysine
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Protocol:
for each experimental condition, combine according to ratio below:
106 Jurkat cells : 106 Raji cells

Figure 43:  Jurkat–Raji/SEE conjugates.
! Jurkat–Raji conjugates formed in the presence or absence of SEE, 
respectively.  Fluorescence micrographs to the right of each DIC image 
display Itk-CY localization and SEE-dependent polarization at the 
immunological synapse.

! 1)!pulse surface-labeled Raji cells with SEE
! 1.1)!optional:  isolate viable cells by separation with histopaque

- see supporting protocol
- dead cells become stained very bright intracellularly and 
can interfere with image analysis

! 1.2)!centrifuge for 5 min. at 1,000 rpm (4°C)
! 1.3)!resuspend cells at 2x106 cells/mL in RPMI
! 1.4)!for each reaction, transfer 106 cells / 0.5 mL per 

microcentrifuge tube
! 1.5)!add SEE at 2 µg/mL final

or without SEE for non-stimulation control
! 1.6)!place inside incubator for 1 hr.

uncap tubes to allow gas exchange
! 2)!prepare nucleofected Jurkat cells
! 2.1)!optional:  isolate viable cells by separation with histopaque

- see supporting protocol
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- dead cells become stained very bright intracellularly and 
can interfere with image analysis

! 2.2)!centrifuge for 5 min. at 1,000 rpm (4°C)
! 2.3)!resuspend cells at 2x106 cells/mL in RPMI
! 2.4)!keep on ice until Raji cells are ready for conjugation
! 3)!Jurkat-Raji conjugation
! 3.1)!for each reaction, transfer 106 / 0.5 mL Jurkat cells to tube 

containing 106 / 0.5 mL SEE-pulsed Raji cells
! 3.2)!pipet up and down to mix
! 3.3)!centrifuge for 5 min. at 200 g / 1,000 rpm (4°C)
! 3.4)!aspirate 900 µL of supernatant

leaving behind 100 µL and pellet
! 3.5)!carefully aspirate supernatant using pipet tip

- do not disturb pellet
- leave ~100 µL volume

! 3.6)!incubate for 30 min. on ice
to allow conjugate formation to occur

! 4)!stimulation
proceed quickly between steps

! 4.1)!transfer microcentrifuge tube(s) to 37°C water bath
! 4.2)!incubate for 10 min.
! 4.3)!return tube(s) to ice
! 4.4)!proceed immediately with 'Cell Attachment and Fixation on 

Slides'

References:
! (145-149)
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Cell Attachment and Fixation on Slides / Cover Glass

Equipment:
! -!bucket with ice

keep cells at 4°C during attachment if attaching to cover glass (inside 
culture dishes)

! -!37°C water bath
for reducing viscosity of mounting medium prior to use

! -!lab timer

Materials:
! -!cells for attachment
! -!keep on ice
! -!microscopy slides, coated with poly-L-lysine

see supporting protocol for details
! -!cover glass, 18 x 18 x 1 mm

Fisher, Cat. # 12-548-A
! -!cover glass (inside culture dishes), coated with poly-L-lysine

- see supporting protocol for details
- optional:  equilibrate culture dishes on ice prior to attachment

! -!microscopy slides, 25 x 75 x 1 mm (1 per cover glass)
Fisher, Cat. # 12-544-7

! -!straight-edge razor
for removing cover glass from culture dishes

! -!2% (w/v) paraformaldehyde (PFA) in PBS
! -!keep on ice
! -!1x PBS
! -!keep on ice
! -!Kimwipes
! -!mounting medium

Invitrogen, Cat. # P7481
! -!pre-warm at 37°C before use
! -!nail polish
! -!slide folder

Supporting Protocol:
! -!Coating Microscopy Slides / Cover Glass with Poly-L-Lysine

Protocol:
! 1)!attach cells to pLL-coated slides / cover glass
! 1.1)!gently resuspend cells prior to attachment
! 1.1.1)!for conjugates, use razor blade to remove end of 

200 µL pipet tip

380



to reduce shear forces while adding conjugates 
to slide

! 1.2)!add ~105 cells to each slide / cover glass
add 10 µL of 10x106 cells/mL concentrated suspension

! 1.3)!spread evenly in small, circular area using pipet tip
! 1.4)!allow cells to attach for 5 min.

do not allow to dry completely
! 2)!fix with paraformaldehyde
! 2.1)!gently add 100µL of ice-cold 2% PFA/PBS to perimeter of 

area containing attached cells
! 2.2)!distribute PFA evenly over cells using pipet tip

avoid disturbing attached cells
! 2.3)!incubate for 10 min.
! 2.4)!wash 3x with 1mL of ice-cold PBS

- removes non-attached cells
- do not pipet directly on cells

! 2.5)!allow to dry for ≤ 30 min.
! 2.6)!wick away excess PBS using Kimwipe
! 3)!continue with further staining (if required)
! 4)!apply mounting medium / seal slides
! 4.1)!add 10 µL of mounting medium directly above cells
! 4.2)!gently place cover glass on top of cells / invert cover glass 

with attached cells onto slide
! 4.3)!seal coverslip at each corner with nail polish

do not seal along edges yet
! 4.4)!allow mounting medium to cure overnight at room temp. in 

dark
! 4.5)!seal edges of cover glass using nail polish
! 5)!store slides at 4°C in slide folder
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Actin Polymerization Assay

Equipment:
! -!37°C water bath
! -!refrigerated centrifuge
! -!bucket with ice

Materials:
! -!Jurkat - OKT3-coated microsphere conjugates

- including BSA / OKT9-coated microsphere conjugates for negative 
control
- see supporting protocol for details

! -!attached to slides
see supporting protocol

! -!fixed with paraformaldehyde
see supporting protocol

! -!PBS
! -!keep on ice
! -!Permeabilization Buffer

- 0.1% (v/v) Triton X-100 / PBS
- see 'Buffers & Solutions'

! -!Blocking Buffer
- 1% BSA / PBS
- see 'Buffers & Solutions'

! -!keep on ice
! -!Texas Red Phalloidin Staining Buffer

- 5 U/mL Texas Red Phalloidin in Blocking Buffer
- Texas Red is optimally excited at 591 nm and has an emission peak 
at 608 nm
- see 'Buffers & Solutions'

! -!mounting medium, pre-warm to 37°C before use
Invitrogen, Cat. # P7481

Supporting Protocols:
! -!Coating Microscopy Slides / Cover Glass with Poly-L-Lysine
! -!Jurkat-Microsphere/OKT3 Conjugation/Stimulation
! -!Cell Attachment and Fixation on Slides / Cover Glass

Protocol:
continue following fixation of conjugates on slides

! 1)!permeabilize cells
! 1.1)!gently add 200 µL of ice-cold permeabilization buffer to area 

surrounding cells
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do not pipet directly on attached conjugates
! 1.2)!distribute evenly over cells using pipet tip

take care to avoid disturbing attached cells
! 1.3)!incubate for 5 min. at room temp.
! 2)!wash 2x with 1 mL of ice-cold PBS

do not pipet directly on attached conjugates
! 3)!block cells prior to staining
! 3.1)!gently add 200 µL of ice-cold blocking solution to area 

surrounding cells
! 3.2)!distribute evenly over cells using pipet tip

take care to avoid disturbing attached cells
! 3.3)!incubate for 20 min. at room temp.
! 4)!wash 2x with 1 mL of ice-cold PBS

do not pipet directly on attached conjugates
! 5)!stain cells

Figure 44:  Jurkat cell stained with TR phalloidin.

! 5.1)!gently add 200 µL of ice-cold Texas Red Phalloidin Staining 
Buffer to area surrounding cells

! 5.2)!distribute evenly over cells using pipet tip
take care to avoid disturbing attached cells

! 5.3)!incubate for 20 min. in dark at room temp.
! 6)!wash 2x with 1 mL of PBS
! 7)!apply mounting medium / seal slide

see supporting protocol
! 8)!store slides at 4°C in slide folder

References:
! (91, 94, 115, 143, 145, 146, 150-157)
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5.2.9. FRET
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Image Acquisition

Equipment:
! -!eppifluorescence microscope, Zeiss

upright
! -!63x objective, water immersion

Zeiss
! -!automatic rotating turret containing filter cubes
! -!CFP filter cube (DD channel)

donor excitation / donor emission
ex:  436 nm +/- 10
dichroic:  455 nm
em:  480 nm +/- 20

! -!YFP filter cube (AA channel)
acceptor excitation / acceptor emission
ex:  500 nm +/- 10
dichroic:  515 nm
em:  535 nm +/- 15

! -!FRET filter cube (DA channel)
donor excitation / acceptor emission
ex:  436 nm +/- 10
dichroic:  455 nm
em:  535 nm +/- 15

! -!DIC filter cube
! -!TRITC filter cube

ex:  545 nm +/- 15
dichroic:  565 nm
em:  610 nm +/- 38

! -!slider containing neutral density filters
for reducing light intensity

! -!Apotome
for acquiring deconvolved images

! -!camera, 14-bit grayscale
! -!computer
! -!Axiovision 4.2 software installed
! -!external hard drive

for storage of images
! -!dI water bottle and transfer pipet

for objective
! -!slide folder
! -!lab timer

Materials:
! -!transfectants expressing donor and/or acceptor fluorescent protein(s) 

including the following:
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fixed and mounted on microscopy slides
! -!CFP-only (single color control)
! -!YFP-only (single color control)
! -!CFP-YFP (pYC)

FRET positive control (CFP and YFP co-expressed on same 
molecule separated by short linker

! -!CFP + YFP
FRET negative control (CFP and YFP co-expressed on 

separate molecules)
! -!FRET biosensor with protein of interest
! -!stimulated / non-stimulated
! -!CD / DVD

for saving images
! -!lab notebook

for recording log of images acquired at microscope

Supporting Protocols:
! -!Cell Culture > Jurkat Amaxa Nucleofection
! -!Microscopy / FACS > Jurkat-Raji/SEE Conjugation/Stimulation
! -!Surface Staining with Cy5 NHS Ester
! -!Microscopy / FACS > Cell Attachment and Fixation on Slides / Cover 

Glass

Protocol:
! 1)!set up microscope
! 1.1)!turn on power for fluorescent bulb
! 1.1.1)!adjust bulb strength to 100%
! 1.2)!turn on power for computer
! 1.3)!turn on power for microscope
! 1.4)!connect camera to microscope using plug
! 1.5)!open Axiovision software
! 1.5.1)!select 'Multidimensional Acquisition > Load > CFP-

YFP FRET > OK'
! 1.5.2)!create folder on hard drive and name with current 

date
for storage of images

! 2)!scan slide for fluorescent cells
! 2.1)!slide neutral density into light path
! 2.2)!select 40x objective
! 2.3)!place slide on stage
! 2.4)!turn on 'Hal' for transmitted light
! 2.5)!focus on cells in DIC channel
! 2.6)!switch to YFP channel to search for fluorescent cells
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- YFP is less sensitive to photobleaching as compared to 
CFP
! - therefore, scan slide for fluorescent cells using YFP 

channel when possible
- reduce YFP photobleaching by always using neutral 
density filter and turning off reflector when not in use

! 3)!acquire YFP reference image
capture image using fixed exposure time for comparing brightness / 
expression level from cell to cell

! 3.1)!switch to 63x objective
! 3.2)!adjust focus as needed
! 3.3)!capture YFP image using fixed exposure time

determined exposure time from 'representative' image in 
terms of brightness / expression level

! 3.4)!record image number and identification in notebook
! 4)!acquire sensitized emission images

- includes CFP, YFP and FRET images used to calculate E-FRET
- acquire control images from cells expressing CFP-only, YFP-only 
and pYC

! 4.1)!adjust exposure times proportionally for CFP, YFP and 
FRET images

- ratio of exposure times for CFP : YFP : FRET images 
must remain constant in order to calculate / compare E-
FRET from cell to cell
- for good image quality, need ≥ 1,000 and < 10,000 
average pixel counts for all images (range 0 - 16,384 pixel 
counts for 14-bit camera)
- CFP requires ~2x longer exposure time compared to 
YFP when expressed at 1:1 stoichiometry

! 4.2)!run FRET acquisition program to capture series of images 
as follows:  CFP, YFP, FRET, DIC, Cy5 (for imaging APC / 
Raji cell)

! 4.3)!record image number and identification in notebook
! 5)!acquire Apotome image

- used for images of conjugates to define ROI at contact site
- acquires images above and below focus plane to mechanically 
deconvolve eppifluorescence image

! 5.1)!slide Apotome into light path
! 5.2)!run Apotome acquisition program
! 5.3)!record image number and identification in notebook
! 6)!acquire pre / post acceptor photobleaching images

- for determination of G parameter from cells expressing pYC
- use separate slide designated for photobleaching to avoid 
unintended photobleaching of cells outside of field
- acquire control images from cells expressing CFP-only and YFP-
only
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! 6.1)!run FRET acquisition program prior to photobleaching YFP
! 6.2)!turn on YFP reflector to photo-bleach YFP by ≥ 80%

- determine time required in advance using cells 
expressing YFP-only (e.g., 10 min.)
- use timer to remain consistent from cell to cell

! 6.3)!run FRET acquisition program after photobleaching YFP
! 6.4)!record image number and identification in notebook
! 7)!save all images as 16-bit '.tif' files

de-select check boxes in window
! 8)!burn images to DVD

References:
! (158)
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Initial Image Processing
image alignment and background subtraction

Equipment:
! -!computer
! -!Image J software installed
! TurboReg plugin installed

Materials:
! -!raw fluorescence images

16-bit (1388 x 1040 pixels) grayscale images (.tif file extension) in the 
following channels:

! -!CFP
! -!YFP
! -!FRET
! -!Cy5

for Raji cells

Supporting Protocol:
! -!FRET Image Acquisition

Protocol:
! 1)!open 16-bit raw fluorescence image from within Image J

File > Open
! 2)!align correlated raw fluorescence images

except YFPafter images depending on extent of photobleaching
! 2.1)!convert images for alignment into stack

Image > Stack > Convert Images to Stack
! 2.2)!run TurboReg plugin to align images
! 2.3)!convert stack back into individual images
! 3)!convert images to 32-bit
! 4)!adjust brightness / contrast
! 5)!subtract background

proceed independently for each raw image
! 5.1)!create ROI in cell-free area of background
! 5.2)!record mean pixel count
! 5.3)!subtract mean background value from entire raw image
! 6)!save processed images
! 7)!continue with further analysis

References:
! (158)
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Binary Mask Generation
for removing background and/or defining synapse ROI

Equipment:
! -!computer
! -!Image J software installed

Materials:
! -!fluorescence image(s)
! -!for defining synapse ROI, fluorescence images acquired using 

Apotome
! -!YFP image

for defining Jurkat cell
! -!Cy5 image

for defining Raji cell

Supporting Protocol:
! -!Image Acquisition

Protocol:
! 1)!open fluorescence image from within Image J

File > Open
! 2)!duplicate image
! 3)!adjust brightness / contrast as needed to visualize fluorescent cell of 

interest
Image > Adjust > Brightness/Contrast

! 4)!adjust threshold to select cell of interest in red
Image > Adjust > Threshold

! 5)!select 'Apply > OK'
- image is converted to 8-bit
- cell is given value of 0
- background is given value of 255

! 6)!select 'Edit > Invert'
- cell is given value of 255
- background is given value of 0

! 7)!select 'Image > Math > Subtract' and enter 254
- cell is given value of 1
- background is given value of 0

! 8)!adjust brightness / contrast as needed so that cell of interest appears 
white with  a black background

! 9)!save 8-bit binary image as 'mask'
! 10)!for defining synapse ROI, multiply YFP and Cy5 mask images

contact site is given value of 1
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Image Analysis for Acceptor Photobleaching Method
FRET efficiency measured by donor recovery after acceptor photobleaching

Equipment:
! -!computer
! -!Image J software installed

Materials:
! -!raw images of cell expressing the following fluorescently-tagged 

proteins:
16-bit (1388 x 1040 pixels) grayscale images (.tif file extension) in the 
following channels:
CFP, YFP and DIC

- acquired before and after acceptor photobleaching
! - including images acquired after photobleaching the same cell at 

different time points
- aligned
- background subtracted

! -!CFP
! -!YFP
! -!CFP-YFP
! -!CFP + YFP
! -!biosensor with protein of interest
! -!stimulated / non-stimulated

Supporting Protocols:
! -!Image Acquisition
! -!Initial Image Processing
! -!Binary Mask Generation
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Protocol:

Figure 45:  FRET efficiency of positive control (CFP-YFP) as determined by 
acceptor photobleaching method.

Figure 46:  FRET efficiency of negative control (CFP + YFP) as determined by 
acceptor photobleaching method.
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! 1)!determine correction factor for CFP photobleaching effect (if any)
- proceed for cells expressing CFP-only
- corrects for cross-excitation of CFP during YFP photobleaching
- value depends on YFP photobleaching time interval

correction factor = IDD before / IDD after
! 1.1)!create ROI within cell
! 1.2)!record mean pixel count for CFPbefore and CFPafter images
! 1.3)!normalize by dividing all values by CFPbefore value for each 

time interval
! 1.4)!plot % photobleaching efficiency versus time interval
! 1.5)!repeat for several cells / images
! 1.6)!determine correction factor required for given time interval 

using equation above

Figure 47:  Progressive CFP 'bystander' photobleaching versus exposure time 
to YFP excitation light.

! 2)!apply correction factor for CFP photobleaching effect (if required)
! 2.1)!multiply entire raw CFPafter image by correction factor
! 3)!calculate YFP photobleaching efficiency

YFP photobleaching efficiency (%):  1 - (IAA after / IAA before)
! 3.1)!select YFPbefore image
! 3.2)!create ROI within cell
! 3.3)!save ROI
! 3.4)!record mean pixel count
! 3.5)!repeat from above for YFPafter image
! 3.6)!substitute mean ROI values into equation described above
! 4)!calculate FRET efficiency

Eapp (%) = 1 - (CFPbefore / CFPafter)
! 4.1)!select CFPbefore image

393



! 4.2)!create saved ROI within cell
! 4.3)!record mean pixel count
! 4.4)!repeat from above for CFPafter image
! 4.5)!substitute mean ROI values into equation described above
! 5)!generate FRET efficiency image

for display (i.e., not calculation) purposes
! 5.1)!create 32-bit ratio image by dividing CFPbefore image by 

CFPafter image
! 5.1.1)!select 'Process > Image Calculator > Image 1 > 

CFPbefore'
! 5.1.2)!select 'Operation > Divide'
! 5.1.3)!select 'Image 2 > CFPafter > 32-bit result > OK'
! 5.2)!create new 32-bit image
! 5.2.1)!add '1' to entire image
! 5.3)!subtract ratio image from '1' image
! 5.4)!continue with final image processing

References:
! (158)
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Image Analysis for E-FRET Method
FRET efficiency calculated from sensitized emission (FRET) image

Equipment:
! -!computer
! -!Image J software installed
! -!TurboReg plugin installed
! -!E-FRET macro installed

Materials:
! -!raw images of cells expressing the following fluorescently-tagged 

proteins:
16-bit (1388 x 1040 pixels) grayscale images (.tif file extension) in the 
following channels:
CFP, YFP, FRET and DIC

- aligned
- background subtracted

! -!CFP
! -!YFP
! -!CFP-YFP
! -!CFP + YFP
! -!CFP-YFP

for calculation of G parameter
- acquired before and after acceptor photobleaching
! - including images acquired after photobleaching the 

same cell at different time points
! -!biosensor with protein of interest
! -!stimulated / non-stimulated

Supporting Protocols:
! -!Image Acquisition
! -!Initial Image Processing
! -!Image Analysis for Acceptor Photobleaching Method
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Protocol:

Figure 48:  FRET efficiency of representative Jurkat cell expressing CFP-YFP 
as determined by E-FRET method.

Figure 49:  FRET efficiency of representative Jurkat cell expressing CFP + 
YFP as determined by E-FRET method.
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! 1)!calculate spectral bleed-through constants
- requires CFP, YFP and FRET images
- for cells expressing YFP / acceptor (A)-only
! - bleed-through to FRET (DA) channel:  a = IDA(A) / IAA(A)
! - bleed-through to donor (DD) channel:  b = IDD(A) / IAA(A)
- for cells expressing CFP / donor (D)-only
! - bleed-through to acceptor channel (AA) channel:  c = IAA(D) / 

IDD(D)
! - bleed-through to FRET (DA) channel:  d = IDA(D) / IDD(D)

! 1.1)!create ROI within cell
! 1.2)!record mean pixel count in each channel
! 1.3)!substitute mean ROI values into relevant equations 

described above
! 1.4)!repeat for several cells / images and determine average 

value

Figure 50:  YFP bleed-through.
! Jurkat cells expressing (acceptor) imaged in CFP, YFP and FRET 
channels; bleed-through to FRET channel calculated from selected ROIs.
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Figure 51:  CFP bleed-through.
! Jurkat cells expressing CFP (donor) imaged in CFP, YFP and FRET 
channels; bleed-through to FRET channel calculated from selected ROIs.

Figure 52:  Linearity of bleed-through constants 'a' and 'd' as a function of 
expression level.
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! 2)!calculate bleed-through-corrected FRET (Fc)
Fc (corrected FRET) = IDA - a*IAA - d*IDD
(assumes that b = c = 0)

Figure 53:  Calculation of Fc from representative fluorescence images.
! Jurkat cells expressing CFP + YFP or CFP-YFP and imaged in CFP, 
YFP and FRET channels; Fc calculated from selected ROIs.

! 2.1)!select CFP image
! 2.2)!create ROI within cell
! 2.3)!save ROI
! 2.4)!record mean pixel count
! 2.5)!repeat from above for YFP and FRET images
! 2.6)!substitute mean ROI values into equation described above
! 3)!calculate G parameter from ROI within cell

- requires set of images (CFP, YFP and FRET) acquired before and 
after YFP photobleaching (see supporting protocol)
- proceed for cells expressing CFP-YFP (constitutive FRET 
construct)
- correlates FRET efficiency as measured by acceptor 
photobleaching and sensitized emission methods, respectively

G = (Fc before - Fc after) / (IDD after - IDD before)
! 3.1)!calculate Fc as described above for 'before photobleaching' 

set of images
! 3.2)!calculate Fc as described above for 'after photobleaching' 

set of images
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! 3.2.1)!apply correction factor to CFPafter image to correct 
for photobleaching effect (if any)

see supporting protocol
! 3.3)!substitute mean ROI values into equation described above
! 3.4)!repeat for several cells / images and determine average 

value

Figure 54:  Calculation of G parameter from Jurkat cells expressing CFP-YFP.

! 4)!define ROI at Jurkat-Raji contact site
- for calculation of E-FRET of stimulated cells
- use images acquired using Apotome (mechanically deconvolved 
image) for precise definition of contact site

! 4.1)!generate binary mask for Jurkat cell expressing biosensor 
from YFP image

see supporting protocol
! 4.2)!generate binary mask for Cy-5 surface-labeled Raji cell from 

Cy5 image
see supporting protocol

! 4.3)!multiply YFP mask image by Cy5 mask image
- contact site is given value of 1
- background is given value of 0

! 4.4)!save resulting image as 'ROI mask'
! 4.5)!use wand tool to select ROI at contact site
! 4.6)!save ROI
! 5)!calculate E-FRET from selected ROI

R = Fc / IDD

Eapp = R / (R + G)
! 5.1)!calculate Fc as described above
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! 5.2)!substitute mean ROI values into equation above to 
determine 'R'

! 5.3)!substitute R into equation above to determine Eapp
! 6)!generate E-FRET image

for display (i.e., not calculation) purposes
! 6.1)!create 32-bit Fc image
! 6.1.1)!multiply YFP image by 'a' parameter
! 6.1.2)!multiply CFP image by 'd' parameter
! 6.1.3)!subtract image generated from product of YFP*a 

from FRET image
! 6.1.4)!subtract image generated from product of CFP*d 

from above image
! 6.2)!create Fc/IDD ratio image
! 6.3)!duplicate above image
! 6.3.1)!add G value to entire image
! 6.4)!divide Fc/IDD ratio image by above image
! 7)!create and multiply images by binary mask

for display purposes
! 7.1)!duplicate raw image (CFP, YFP, or FRET)
! 7.2)!name image as 'bin'
! 7.3)!adjust threshold and select cell in red

pixel count in cell is '255' 
! 7.4)!continue with final image processing

References:
! (158)
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Final Image Processing
for displaying processed images

Equipment:
! -!computer
! -!Image J software installed

Materials:
! -!fluorescence image(s) for mask generation
! -!image(s) for display
! -!fluorescence image(s)
! -!calculated / derived image(s)

Supporting Protocol:
! -!Binary Mask Generation

Protocol:
! 1)!generate binary mask

for removing background
! 2)!apply binary mask to selected image(s)
! 2.1)!open image(s)
! 2.2)!multiply by binary mask
! 2.2.1)!select 'Process > Image Calculator > Image 1 > 

mask'
! 2.2.2)!select 'Operation > Multiply'
! 2.2.3)!select 'Image 2 >  CFP/YFP/FRET/ratio > 32-bit 

result > OK'
! 2.3)!save resulting 32-bit image
! 2.4)!repeat for additional images
! 3)!apply lookup table (LUT)
! 3.1)!select 'Image > Lookup Tables >'

e.g., Fire
! 3.2)!adjust brightness for cell of interest

define min and max
! 3.3)!draw saved ROI to display on image
! 4)!crop image(s) for display

e.g., 250 x 250 pixels
! 5)!annotate cropped images
! 5.1)!add calibration bar
! 5.1.1)!select 'Analyze > Tools > Calibration Bar > OK'

converts to RGB image
! 5.2)!add image description
! 5.3)!add pixel count for ROI
! 6)!save final RGB image
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5.2.10. Cytokine Detection
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Primary Lymphocyte α-TCR Antibody Stimulation
30-hour stimulation of naive splenocytes to assess cytokine secretion

Equipment:
! -!bucket with ice
! -!refrigerated centrifuge
! -!tissue culture hood
! -!humidified, 37°C, 5% CO2 incubator
! -!-20 / -80°C freezer

Materials:
! -!splenocyte suspension

do not lyse RBCs
! -!freshly isolated
! -!purified using CD4+ negative isolation kit (optional)
! -!96-well plate, round-bottom

Sarstedt, Cat. # 83.1837
! -!T Cell Medium (TCM)
! -!antibodies
! -!anti-CD3ε, clone 145-2C11

BD, Cat. # 553058
0.5 mg/mL stock

! -!anti-mouse CD28, clone 37.51
BD, Cat. # 553295
0.5 mg/mL stock

! -!goat anti-armenian hamster IgG
Jackson ImmunoResearch, Cat. # 127-005-099
1.8 mg/mL stock

! -!1,000x Brefeldin A (BFA)
BioLegend, Cat. # 420601

! -!dilute 1:10 in TCM to prepare 100x working concentration
! -!GolgiStop / Monensin

BD, Cat. # 554724

Supporting Protocol:
! -!Peptide > In Vitro Peptide Transduction

Protocol:
! 1)!optional:  pre-treatment with peptide
! 2)!prepare cells
! 2.1)!centrifuge require number of cells for 5 min. at 1,500 rpm 

(4°C)
! 2.2)!discard supernatant
! 2.3)!resuspend at 5x106 cell/mL in TCM
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! 2.4)!add 106 lymphocytes (200 µL) per well of round-bottom 
plate

! 3)!1° TCR stimulation
! 3.1)!add anti-TCR and anti-CD28 antibodies

do not add to wells designated for non-stimulation control
! 3.1.1)!add 2C11 at 5 µg/mL final

2 µL of 0.5 mg/mL stock
! 3.1.2)!add anti-CD28 at 5 µg/mL final

2 µL of 0.5 mg/mL stock
! 3.2)!gently resuspend each well
! 3.3)!keep in refrigerator for 30 min.

for binding
! 3.4)!add cross-linking antibody

do not add to wells designed for non-stimulation control
! 3.4.1)!add goat anti-armenian hamster IgG at 5 µg/mL 

final
! 3.4.2)!gently resuspend each well
! 3.5)!keep in refrigerator for 15 min.

for binding
! 4)!place in TC incubator for 24 hours
! 5)!2° TCR stimulation
! 5.1)!add anti-TCR and anti-CD28 antibodies

do not add to wells designed for non-stimulation control
! 5.1.1)!add 2C11 at 5 µg/mL final

2 µL of 0.5 mg/mL stock
! 5.1.2)!add anti-CD28 at 5 µg/mL final

2 µL of 0.5 mg/mL stock
! 5.2)!gently resuspend each well
! 5.3)!gently tap plate to mix

do not resuspend
! 5.4)!keep in TC hood for 15 min. (room temp.)

for binding
! 5.5)!add cross-linking antibody

do not add to wells designed for non-stimulation control
! 5.5.1)!add goat anti-armenian hamster IgG at 5 µg/mL 

final
! 5.5.2)!gently resuspend each well
! 5.6)!keep in TC hood for 15 min. (room temp.)

for binding
! 6)!for cytokine analysis by ICCS:
! 6.1)!add Brefeldin A or GolgiStop at 1x final

including non-stimulation control well(s)
! 6.2)!place in TC incubator for 6 hours
! 6.3)!proceed with ICCS protocol
! 7)!for cytokine analysis by ELISA
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! 7.1)!place in TC incubator for 6 hours
! 7.2)!harvest supernatants
! 7.2.1)!gently resuspend each well
! 7.2.2)!transfer cell suspensions to labeled microcentrifuge 

tubes
! 7.2.3)!centrifuge for 10 min. at 1,500 rpm (4°C)
! 7.2.4)!gently aspirate supernatants
! 7.2.5)!transfer to new microcentrifuge tubes
! 7.3)!store at -20°C / -80°C until cytokine analysis by ELISA

References:
! (2)
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Primary Lymphocyte PMA/IM Stimulation
30-hour stimulation of naive splenocytes to assess cytokine secretion

Equipment:
! -!bucket with ice
! -!refrigerated centrifuge
! -!tissue culture hood
! -!humidified, 37°C, 5% CO2 incubator
! -!-20 / -80°C freezer

Materials:
! -!primary lymphocytes

do not lyse RBCs
! -!freshly isolated
! -!purified using CD4+ negative isolation kit (optional)
! -!T Cell Medium (TCM)
! -!96-well plate, round-bottom

Sarstedt, Cat. # 83.1837
! -!100x PMA/IM
! -!1,000x Brefeldin A (BFA)

BioLegend, Cat. # 420601
! -!dilute 1:10 in TCM to prepare 100x working concentration
! -!GolgiStop / Monensin

BD, Cat. # 554724

Protocol:
! 1)!prepare cells
! 1.1)!centrifuge require number of cells for 5 min. at 1,500 rpm 

(4°C)
! 1.2)!discard supernatant
! 1.3)!resuspend at 5x106 cell/mL in TCM
! 1.4)!add 106 lymphocytes (200 µL) per well of round-bottom 

plate
! 2)!PMA/IM stimulation
! 2.1)!add PMA/IM at 1x final

do not add to wells designated for non-stimulation control
! 2.2)!gently resuspend each well
! 3)!for cytokine analysis by ICCS:
! 3.1)!add Brefeldin A or GolgiStop at 1x final

including non-stimulation control well(s)
! 3.2)!place in TC incubator for 6 hours
! 3.3)!proceed with ICCS protocol
! 4)!for cytokine analysis by ELISA
! 4.1)!place in TC incubator for 6 hours
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! 4.2)!harvest supernatants
! 4.2.1)!gently resuspend each well
! 4.2.2)!transfer cell suspensions to labeled microcentrifuge 

tubes
! 4.2.3)!centrifuge for 10 min. at 1,500 rpm (4°C)
! 4.2.4)!gently aspirate supernatants
! 4.2.5)!transfer to new microcentrifuge tubes
! 4.2.6)!store at -20°C / -80°C until cytokine analysis by 

ELISA

References:
! (2, 159)
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Reconstitution of Recombinant Cytokines
for use in skewing / differentiation

Equipment:
! -!-20°C / -80°C freezer

Materials:
! -!murine rIL-2

PeproTech, Cat. # 212-12
100 µg/mL / H2O [stock]
0.5 µg/mL / TCM [100x working]
5 ng/mL / TCM [1x final]

! -!murine rIL-4
PeproTech, Cat. # 214-14
100 µg/mL / H2O [stock]
1 µg/mL / TCM [100x working]
10 ng/mL / TCM [1x final]

! -!murine rIL-12
PeproTech, Cat. # 210-12
200 µg/mL / PBS [stock]
0.1 µg/mL / TCM [100x working]
1 ng/mL / TCM [1x final]

Protocol:
! 1)!centrifuge stock vial prior to opening
! 2)!reconstitute lyophilized stock in H2O or PBS as indicated
! 3)!dilute to working concentration in TCM
! 4)!store at -20°C or -80°C

References:
! (100)
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2C11 Adsorption to 96-well Plates

Equipment:
! -!humidified, 37°C, 5% CO2 incubator

Materials:
! -!clone 2C11

anti-CD3ε
BD, Cat. # 553058
0.5 mg/mL

! -!PBS, tissue culture grade
! -!microcentrifuge tube
! -!paper towels
! -!round-bottom 96-well plates

Sarstedt, Catalog # 83.1837

Protocol:
! 1)!dilute 2C11 to 1 µg/mL [final] in PBS

e.g., add 2 µL of 0.5 mg/mL [stock] to 1 mL PBS
! 2)!add 30 µL of 2C11 to each well
! 3)!cover plate and incubate plate for ~2 hrs. in 37°C incubator
! 4)!optional:  keep in refrigerator overnight
! 5)!wash wells 3x with PBS
! 5.1)!add 200 µL of PBS to each well (wash #1)
! 5.2)!invert plate on stack of paper towels to aspirate
! 5.3)!repeat for a total of 3 washes
! 6)!remove residual PBS from wells using sterile pipet tips
! 7)!proceed with plate-bound stimulation
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In Vitro Splenocyte Differentiation
5 day in vitro priming followed by re-stimulation

Equipment:
! -!bucket with ice
! -!humidified, 37°C, 5% CO2 incubator
! -!refrigerated centrifuge
! -!hemacytometer
! -!-80°C freezer

Materials:
! -!splenocyte suspension
! -!prepared fresh
! -!keep on ice
! -!T Cell Medium (TCM)
! -!round-bottom 96-well plates (2:  1 each for 1° and 2° stimulation)

Sarstedt, Cat. # 83.1837
! -!coated with 2C11 antibody

see supporting protocol
! -!PBS, cell culture grade
! -!antibodies
! -!anti-CD3ε (2C11)

BD, Cat. # 553058
0.5 mg/mL

! -!anti-mouse CD28 (37.51)
BD, Cat. # 553295
0.5 mg/mL

! -!rat anti-mouse IL-12
BD, Cat. # 554475
1 mg/mL

! -!rat anti-mouse IL-4
BD, Cat. # 554433
0.5 mg/mL

! -!recombinant cytokines
see supporting protocol

! -!murine rIL-2, 100x
500 ng/mL / TCM

! -!murine rIL-4, 100x
1 µg/mL / TCM

! -!murine rIL-12, 100x
100 ng/mL / TCM

! -!microcentrifuge tubes
! -!1,000x Brefeldin A (BFA)

BioLegend, Cat. # 420601
! -!dilute 1:10 in TCM to prepare 100x working concentration
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! -!GolgiStop / Monensin
BD, Cat. # 554724

Supporting Protocols:
! -!Plate-Bound 2C11
! -!Splenocyte Preparation
! -!Recombinant Cytokine Reconstitution
! -!Cell Culture > Cell Counting

Protocol:

Figure 55:  In vitro skewing model.
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Figure 56:  Measurement of cytokine secretion after Th0, Th1 or Th2 skewing 
in vitro, respectively.

! 1)!1° stimulation
day 0

! 1.1)!adsorb 2C11 at 1 µg/mL final to designated wells of 96-well 
plate for 2 hrs and wash with PBS

see supporting protocol
! 1.2)!adjust splenocyte concentration to 106 cells/mL in TCM
! 1.3)!add 2x106 cells (200 µL) per well containing plate-bound 

2C11
! 1.4)!add soluble anti-CD28 at 1 µg/mL final
! 1.4.1)!dilute 0.5 mg/mL stock to 0.1 mg/mL in PBS
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! 1.4.2)!add 2 µL per well
! 2)!add neutralizing antibody

day 0
! 2.1)!for Th 1 conditions:  add Th2 neutralizing antibody
! 2.1.1)!add anti-IL-4 at 5 µg/mL final
! 2.2)!for Th 2 conditions:  add Th1 neutralizing antibody
! 2.2.1)!add anti-IL-12 at 20 µg/mL final

4 µL of 1 mg/mL stock per well
! 2.2.2)!mix each well using micropipettor and tip
! 2.2.3)!return plate to incubator for 24 hours
! 3)!addition of recombinant cytokine

day 1
! 3.1)!Th 0 / 1 / 2 conditions
! 3.1.1)!add mrIL-2 at 5 ng/mL final

2 µL of 100x stock per well
! 3.2)!Th 1 conditions
! 3.2.1)!add mrIL-12 at 1 ng/mL final
! 3.3)!Th 2 conditions
! 3.3.1)!add mrIL-4 at 10 ng/mL final
! 3.4)!gently tap edges of plate to mix
! 3.5)!return plate to incubator for 4 days

for proliferation and differentiation
! 4)!replace 50% medium as needed

days 3/4
! 4.1)!carefully remove / discard 100 µL per well

do not disturb cells
! 4.2)!add 100 µL fresh TCM
! 4.3)!return plate to incubator
! 5)!harvest differentiated splenocytes

day 5
keep cells and medium at 4°C throughout

! 5.1)!gently resuspend each well
! 5.2)!transfer to sterile, pre-labeled microcentrifuge tubes
! 5.3)!wash 3x

removes cytokines from medium prior to restimulation
! 5.3.1)!wash with 1mL of ice-cold TCM
! 5.3.2)!centrifuge for 5 min at 1500 rpm (4°C)
! 5.3.3)!aspirate / discard supernatant
! 5.4)!resuspend in estimated volume of TCM for counting using 

hemacytometer
! 5.5)!adjust concentration to 2.5 x105 cells/mL in TCM
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! 6)!2° stimulation
day 5

! 6.1)!adsorb 2C11 at 1 µg/mL final to designated wells of 96-well 
plate for 2 hrs and wash with PBS

see supporting protocol
! 6.2)!add 5x104 cells (200 µL) per well containing plate-bound 

2C11
! 6.3)!gently tap edges of plate to mix
! 6.4)!return to incubator for 24 hours

for cytokine production / secretion
! 7)!assay

day 6
! 7.1)!for cytokine analysis by ICCS:
! 7.1.1)!add Brefeldin A or GolgiStop at 1x final

including non-stimulation control well(s)
! 7.1.2)!place in TC incubator for final 6 hours
! 7.1.3)!proceed with ICCS protocol
! 7.2)!for ELISA
! 7.2.1)!gently resuspend each well
! 7.2.2)!transfer cell suspensions to labeled microcentrifuge 

tubes
! 7.2.3)!centrifuge for 10 min at 1500 rpm (4°C)
! 7.2.4)!gently aspirate supernatants
! 7.2.5)!transfer to new microcentrifuge tubes
! 7.2.6)!store supernatants at -80°C until cytokine analysis 

by ELISA

References:
! (100, 101, 160)
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ELISA
enzyme-linked immunosorbent assay

Equipment:
! -!microplate spectrophotometer
! -!computer with Softmax Pro installed
! -!multi-channel pipettor

Materials:
! -!samples
! -!stored at -20°C / -80°C
! -!buffers

equilibrate to room temp. prior to use
! -!PBS / Coating Buffer
! -!Blocking Buffer
! -!Reaction Buffer
! -!Wash Buffer
! -!Stop Solution
! -!96-well ELISA plate(s)
! -!plate cover(s)
! -!parafilm
! -!pipet tips, racked
! -!pipet basins
! -!15 mL centrifuge tubes
! -!microcentrifuge tubes
! -!paper towels
! -!recombinant standard
! -!stored at -80°C
! -!dilute in Reaction Buffer
! -!streptavidin (HRP-conjugated)
! -!dilute in Reaction Buffer
! -!TMB substrate
! -!IL-4

sensitivity:  4 pg/mL
! -!capture:  clone 11B11

eBioscience, Cat. # 14-7041; 250x
2 µg/mL [final] in Coating Buffer

! -!standard:  1 µg/mL mrIL-4
eBioscience, Cat. # 14-8041-62
500 pg/mL - 7.8 pg/mL, diluted serially in Reaction Buffer 1:2

! -!detection:  biotin clone BVD6-24G2
eBioscience, Cat. # 13-7042; 250x
2 µg/mL [final] in Reaction Buffer

! -!IL-5
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sensitivity:  4 pg/mL
! -!capture:  clone TRFK5

eBioscience, Cat. # 13-7051; 250x
2 µg/mL [final] in Coating Buffer

! -!standard:  1 µg/mL mrIL-5
eBioscience, Cat. # 14-8051-62
5,000 pg/mL - 6.9 pg/mL, diluted serially in Reaction Buffer 
1:3

! -!detection:  biotin clone TRFK4
eBioscience, Cat. # 13-7051; 250x
BioLegend, Cat. # 504402; 0.5 mg/mL (250x)
2 µg/mL [final] in Reaction Buffer

! -!IL-13
sensitivity:  4 pg/mL

! -!capture:  clone eBio13A
eBioscience, Cat. # 14-7133; 250x
2 µg/mL [final] in Coating Buffer

! -!standard:  1 µg/mL mrIL-13
eBioscience, Cat. # 14-8131-62
10,000 pg/mL - 13.7 pg/mL, diluted serially in Reaction Buffer 
1:3

! -!detection:  biotin clone eBio1316H
eBioscience, Cat. # 13-7135; 250x
2 µg/mL [final] in Reaction Buffer

! -!IFN-γ
! -!capture:  clone R4-6A2

BD, Cat. # 551216; 250x
eBioscience, Cat. # 14-7312-85; 0.5 mg/mL (250x)
4 µg/mL [final] in Coating Buffer

! -!standard:  mrIFN-γ
eBioscience, Cat. # 14-8311-63
10,000 pg/mL - 13.7 pg/mL, diluted serially in Reaction Buffer 
1:3

! -!detection:  biotin clone XMG1.2
BD, Cat. # 554410; 250x
eBioscience, Cat. # 13-7311-85; 0.5 mg/mL (250x)
2 µg/mL [final] in Reaction Buffer
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Protocol:
! 1)!coat plate with capture antibody
! 1.1)!dilute in coating buffer / PBS according to recommendations

prepare in 15 mL tube
! 1.2)!transfer to pipet basin
! 1.3)!add 50 µL per well
! 1.4)!tap plate to cover each well evenly
! 1.5)!cover plate
! 1.6)!seal plate with parafilm
! 1.7)!incubate overnight at 4°C
! 2)!block plate
! 2.1)!remove plate from refrigerator
! 2.2)!decant plate in sink
! 2.3)!wash 3x with 300 µL wash buffer per well
! 2.4)!tap plate on top of paper towels to remove excess liquid
! 2.5)!add 150 µL of blocking buffer to each well

3x volume of coating solution
! 2.6)!incubate for 1.5 - 2 hrs. at room temp.
! 3)!add standards / samples
! 3.1)!equilibrate samples / standards to room temp.
! 3.2)!prepare 7 standard concentrations by performing serial 

dilutions in reaction buffer according to recommendations
! 3.3)!decant plate in sink
! 3.4)!wash 3x with 300 µL wash buffer per well
! 3.5)!tap plate on top of paper towels to remove excess liquid
! 3.6)!add 50 µL of standards / samples to designated wells
! 3.7)!incubate for 1.5 - 2 hrs. at room temp.
! 4)!add biotin-conjugated detection antibody
! 4.1)!dilute biotin-conjugated detection antibody in reaction buffer 

according to recommendations
prepare in 15 mL Falcon tube

! 4.2)!decant plate in sink
! 4.3)!wash 3-5x with 300 µL wash buffer per well
! 4.4)!tap plate on top of paper towels to remove excess liquid
! 4.5)!add 50 µL of detection antibody solution per well
! 4.6)!incubate for 1.5 - 2 hrs. at room temp.
! 5)!add streptavidin-HRP
! 5.1)!dilute streptavidn-HRP to 1x in reaction buffer

prepare in 15 mL Falcon tube
! 5.2)!decant plate in sink
! 5.3)!wash 3-5x with 300 µL wash buffer per well
! 5.4)!tap plate on top of paper towels to remove excess liquid
! 5.5)!add 50 µL of streptavidin-HRP per well
! 5.6)!incubate for 3/4 to 1 hr. at room temp.
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! 6)!add substrate
! 6.1)!equilibrate substrate solution to room temp. prior to use
! 6.2)!decant plate in sink
! 6.3)!wash 5-7x with 300 µL wash buffer per well
! 6.4)!tap plate on top of paper towels to remove excess liquid
! 6.5)!add 50 µL of 1x substrate solution to each well
! 6.6)!observe development of blue product in wells containing 

standards / samples
! 6.7)!incubate for ≤ 30 min. at room temp.
! 7)!add stop solution
! 7.1)!add 25 µL of stop solution to each well

observe color change from blue to yellow product
! 7.2)!measure absorbance at 450 nm and 650 nm
! 7.2.1)!subtract absorbance at 650 nm from each well

to normalize for optical differences in plastic from 
well to well
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ELISPOT
ELISA Spot Assay
- cytokine captured at location of production by cell on filter plate
- allows for quantification of # of cytokine producing cells

Equipment:
! -!multi-channel pipettor
! -!humidified, 37°C, 5% CO2 incubator
! -!biosafety cabinet (tissue culture hood)
! -!Zeiss ELISpot reader, automated
! -!with KS ELISpot software installed

Materials:
! -!MultiScreen HTS 96-well plates

Millipore, Cat. # MSIPS4510
! -!PBS

for dilution of capture antibody
! -!Wash Buffer

0.05% Tween-20 / PBS
! -!ELISPOT Blocking Buffer

1% BSA / PBS + 0.05% Tween-20, pH 7.4
! -!primary lymphocytes

see supporting protocol
! -!prepare fresh
! -!lyse RBCs
! -!keep on ice
! -!IL-4
! -!capture:  clone 11B11

eBioscience, Cat. # 14-7041; 125x
4 µg/mL [final] in PBS

! -!detection:  biotin clone BVD6-24G2
eBioscience, Cat. # 13-7042; 1,000x
0.5 µg/mL [final] in ELISPOT Blocking Buffer

! -!IL-5
! -!capture:  clone TRFK5

eBioscience, Cat. # 14-7052; 125x
4 µg/mL [final] in PBS

! -!detection:  biotin clone TRFK4
eBioscience, Cat. # 13-7051; 500x
1 µg/mL [final] in ELISPOT Blocking Buffer

! -!IL-10
! -!capture:

4 µg/mL [final] in PBS
! -!detection:

2 µg/mL [final] in ELISPOT Blocking Buffer
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! -!IL-13
! -!capture:  clone eBio13A

eBioscience, Cat. # 14-7133; 125x
4 µg/mL [final] in PBS

! -!detection:  biotin clone eBio1316H
eBioscience, Cat. # 13-7135; 500x
1 µg/mL [final] in ELISPOT Blocking Buffer

! -!IFN-γ
! -!capture:  clone R4-6A2

BD, Cat. # 551216; 250x
4 µg/mL [final] in PBS

! -!detection:  biotin clone XMG1.2
BD, Cat. # 554410; 250x
2 µg/mL [final] in ELISPOT Blocking Buffer

! -!HRP-streptavidin, 250x stock
BD, Cat. # 51-9002812

! -!parafilm
! -!pipet tips, racked
! -!filter pipet tips
! -!pipet basins, sterile

for dispensing capture antibody
! -!pipet basins, non-sterile

for spot development

Supporting Protocols:
! -!In Vivo / Ex Vivo > Splenocyte Preparation
! -!Tissue Dissociation
! -!OVA System > OVA Restimulation (in vitro)
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Protocol:

Figure 57:  Detection of IL-4 producing cells by as measured by ELISpot 
assay.
! On day 0, a C57BL/6 mouse was sensitized with OVA/alum.  After 7 
days, splenocytes were restimulated on an ELISPOT plate coated with anti-
IL-4 capture antibody.  Spots were developed according to protocol below 
after being cultured in vitro for 4 days.

! 1)!coat ELISPOT plate with capture antibody
work in tissue culture hood

! 1.1)!dilute capture antibody in PBS to 2-4 µg/mL final in PBS
see recommendations above

! 1.2)!add 50 µL to designated wells of ELISPOT plate
! 1.3)!firmly tap edges of plate to cover bottom of each well 

completely
! 1.4)!cover plate and seal with parafilm
! 1.5)!place in refrigerator overnight
! 2)!block ELISPOT plate

work in tissue culture hood
! 2.1)!decant capture antibody solution from ELISPOT plate

 carefully remove residual volume using pipet tips
! 2.2)!add 150 µL ELISPOT Blocking Buffer to each well
! 2.3)!cover plate and place inside 37°C tissue culture incubator 

for 2 hrs.
! 3)!seed ELISPOT plate

see 'OVA Restimulation (in vitro)' supporting protocol
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! 3.1)!cover plate and place inside 37°C tissue culture incubator 
for 2-4 days

cytokine-specific kinetics
! 4)!develop ELISPOT plate

work at lab bench
! 4.1)!incubation with detection antibody
! 4.2)!decant cell suspension from each well
! 4.3)!carefully remove residual volume using pipet tips
! 4.4)!add 300 µL of wash buffer to designated wells (wash #1)
! 4.5)!decant wash buffer
! 4.6)!repeat for a total of 3 washes
! 4.7)!dilute biotin-conjugated detection antibody to 0.5 - 2 µg/mL 

final in ELISPOT blocking buffer
see recommendations above

! 4.8)!incubate for 2 hrs. at room temp. in dark
! 5)!incubation with streptavidin-HRP
! 5.1)!decant detection antibody solution from each well

carefully remove residual volume using pipet tips
! 5.2)!add 300 µL of wash buffer to designated wells (wash #1)
! 5.3)!decant wash buffer
! 5.4)!repeat for a total of 3 washes
! 5.5)!dilute streptavidin-HRP stock 1:250 in ELISPOT blocking 

buffer
! 5.6)!add 50 µL of streptavidin-HRP solution to designated wells
! 5.7)!incubate for 45 min. at room temp. in dark
! 6)!substrate addition
! 6.1)!decant streptavidin-HRP solution from each well

 carefully remove residual volume using pipet tips
! 6.2)!add 300 µL of wash buffer to designated wells (wash #1)
! 6.3)!decant wash buffer
! 6.4)!repeat for a total of 5 washes
! 6.5)!add 100 µL ELISPOT substrate solution to designated wells
! 6.6)!incubate for 5 - 30 min.

monitor plate for development of spots
! 6.7)!decant substrate solution
! 6.8)!remove plastic backing from plate
! 6.9)!wash plate with running tap water
! 6.10)!allow plate to dry overnight
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ICCS, Part I
surface staining (e.g., CD4) followed by fixation

Equipment:
! -!vortex
! -!refrigerated centrifuge
! -!bucket with ice
! -!refrigerator

Materials:
! -!lymphocytes
! -!stimulated / non-stimulated
! -!incubated with Brefeldin A / GolgiStop at 1x for 6 hours
! -!FACS Buffer
! -!keep on ice
! -!FACS tubes (1 per staining condition)
! -!blocking agent

- select to match species of staining antibody
- prepare for multiple tubes (100 µL each) at 1% (w/v) final in FACS 
Buffer
- keep on ice

! -!normal rat serum
Jackson ImmunoResearch, Cat. # 012-000-001
60 mg/mL

! -!staining antibodies
- prepare for multiple tubes (200 µL each) at 2.5 µg/mL final in FACS 
Buffer
- keep on ice

! -!Alexa Fluor 647 rat anti-mouse CD4
BioLegend, Cat. # 100530
0.5 mg/mL stock
ex:  633 / 635 nm
em:  668 nm

! -!Pacific Blue rat anti-mouse CD4
BioLegend, Cat. # 100531
0.5 mg/mL stock
ex:  405 nm
em:  455 nm

! -!PE anti-TCRβ, clone H57-597
BioLegend, Cat. # 109208

! -!APC anti-TCRβ, clone H57-597
BioLegend, Cat. # 109211

! -!PBS
! -!keep on ice
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! -!2% paraformaldehyde / PBS
! -!keep on ice

Supporting Protocols:
! -!Cell Culture > Cell Counting
! -!Primary Lymphocyte Stimulation
! -!In Vitro Splenocyte Differentiation

Protocol:
keep cells on ice throughout to reduce secretion of intracellular cytokines

! 1)!perform cell count
see supporting protocol

! 2)!aliquot cells to designated FACS tubes
! 2.1)!add 4x106 cells to each tube
! 2.2)!add 2 mL of ice-cold FACS Buffer
! 2.3)!vortex / wash
! 2.4)!centrifuge for 5 min. at 1,500 rpm (4°C)
! 2.5)!discard supernatant
! 3)!optional:  block

this step is important if cells were stimulated using a secondary / 
cross-linking antibody that may capture the antibody used for 
surface staining and thus create a high background signal

! 3.1)!add 100 µL of ice-cold 1% (w/v) normal rat serum in FACS 
Buffer to each tube

! 3.2)!vortex / resuspend
! 3.3)!block on ice for 20 min.
! 4)!stain cells
! 4.1)!add 2 mL of ice-cold FACS Buffer to each tube
! 4.2)!vortex to wash
! 4.3)!centrifuge for 5 min. at 1,500 rpm (4°C)
! 4.4)!discard supernatant
! 4.5)!add 200 µL of ice-cold 2.5 µg/mL staining antibody in FACS 

Buffer to each tube
! 4.6)!vortex / resuspend
! 4.7)!stain on ice for 20 min. in dark
! 5)!fix cells
! 5.1)!add 2 mL of ice-cold PBS to each tube
! 5.2)!vortex / wash
! 5.3)!centrifuge for 5 min. at 1,500 rpm (4°C)
! 5.4)!discard supernatant
! 5.5)!add 500 µL of 2% paraformaldehyde / PBS to each tube
! 5.6)!vortex / resuspend
! 5.7)!fix on ice for 10 min. in dark
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! 6)!wash cells
! 6.1)!add 2 mL of ice-cold FACS Buffer to each tube

to quench paraformaldehyde
! 6.2)!centrifuge for 5 min. at 1,500 rpm (4°C)
! 6.3)!discard supernatant
! 6.4)!add 500 µL ice-cold FACS Buffer to each tube
! 6.5)!vortex / resuspend
! 6.6)!store at 4°C in dark

proceed with Intracellular Cytokine Staining (ICCS) 
protocol within 24 hours

References:
! (159)
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ICCS, Part II
permeabilization and intracellular cytokine staining

Equipment:
! -!vortex
! -!refrigerated centrifuge
! -!bucket with ice
! -!refrigerator

Materials:
! -!lymphocytes (4x106 per FACS tube)
! -!stimulated (and non-stimulated control)
! -!incubated with Brefeldin A / GolgiStop at 1x for 6 hours
! -!stained for expression of surface protein(s)
! -!fixed
! -!FACS Buffer
! -!keep on ice
! -!FACS tubes (1 per staining condition)
! -!Permeabilization Buffer

see Buffers & Solutions
! -!Blocking Buffer

see Buffers & Solutions
! -!staining antibodies

! ⁃ prepare for multiple tubes (50 µL each) at 2.5 µg/mL final in 
Blocking Buffer

! ⁃ keep on ice
! -!AlexaFluor 647 rat isotype control

BioLegend, Cat. # 400526
ex:  633 / 635 nm
em:  668 nm

! -!AlexaFluor 647 rat anti-mouse CD4
ex:  633 / 635 nm
em:  668 nm

! -!AlexaFluor 488 rat isotype control
BioLegend, Cat. # 400417
ex:  488 nm
em:  519 nm

! -!AlexaFluor 488 rat anti-mouse IFN-γ
BioLegend, Cat. # 505813
ex:  488 nm
em:  519 nm

Supporting Protocol:
! -!ICCS, Part I
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Protocol:
- saponin must be present in all staining and washing buffers as it is a 
reversible permeabilization agent
- stain with isotype-control antibody to determine background and for defining 
negative gate for FACS analysis

Figure 58:  Measurement of IFN-γ expression by ICCS method.
! BL/6 splenocytes left untreated (A) or stimulated with PMA/IM for 6 hrs. 
(B) were surface stained for TCRβ and IFNγ according to ICCS protocol 
described above.

! 1)!permeabilize cells
! 1.1)!add 2 mL of ice-cold FACS Buffer to each tube
! 1.2)!centrifuge for 5 min. at 1,500 rpm (4°C)
! 1.3)!discard supernatant
! 1.4)!add 1 mL of Permeabilization Buffer to each tube
! 1.5)!vortex / resuspend
! 2)!block
! 2.1)!transfer 2x106 cells to new FACS tube for intracellular 

staining
! 2.2)!centrifuge for 5 min. at 1,500 rpm (4°C)
! 2.3)!aspirate supernatant
! 2.4)!add 50 µL of Blocking Buffer to each tube
! 2.5)!vortex / resuspend
! 2.6)!incubate for 30 min. on ice in dark
! 3)!stain cells
! 3.1)!add 1 mL of Blocking Buffer to each tube
! 3.2)!centrifuge for 5 min. at 1,500 rpm (4°C)
! 3.3)!aspirate / supernatant
! 3.4)!add 50 µL of ice-cold 2.5 µg/mL staining antibody in 

Blocking Buffer to each tube
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! 3.5)!incubate for 30 min. on ice in dark
! 4)!wash (2x)
! 4.1)!add 1 mL of Permeabilization Buffer to each tube
! 4.2)!vortex / wash
! 4.3)!centrifuge for 5 min. at 1,500 rpm (4°C)
! 4.4)!discard supernatant
! 4.5)!repeat
! 4.6)!add 300-500 µL of FACS Buffer to each tube
! 4.7)!vortex / resuspend
! 5)!store at 4°C in dark

complete FACS analysis within 24 hours

References:
! (159)
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5.2.11. Lung Inflammation / Asthma
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Serum Immunoglobulin (Ig) Detection by ELISA
total and/or OVA-specific for IgG, IgE

Equipment:
! -!microplate spectrophotometer
! -!computer with Softmax Pro installed
! -!multi-channel pipettor

Materials:
! -!C57BL/6J mice (6-12 weeks old)
! -!sensitized with OVA/alum

see supporting protocol
! -!challenged

see supporting protocol
! -!serum collected

see supporting protocol
! -!serum samples stored at -20°C / -80°C

- for IgG1, 1:1,000-10,000 starting, diluted serially 1:4 in PBS
- for other isotypes, 1:100 starting, diluted serially 1:4 in PBS

! -!buffers
equilibrate to room temp. prior to use

! -!PBS
! -!Blocking Buffer
! -!Reaction Buffer
! -!Wash Buffer
! -!Stop Solution
! -!96-well ELISA plate(s)
! -!plate cover(s)
! -!parafilm
! -!pipet tips, racked
! -!pipet basins
! -!15 mL centrifuge tubes
! -!microcentrifuge tubes
! -!paper towels
! -!capture
! -!goat anti-mouse IgG

- for IgG1, IgG2a, IgG2c, IgG3
- SouthernBiotech, Cat. # 1010-01; 1 mg/mL (1,000x)
- 1 µg/mL final in PBS

! -!anti-mouse IgG2b
- SouthernBiotech, Cat. # 553396; 0.5 mg/mL (250x)
- 2 µg/mL final in PBS

! -!goat anti-mouse IgE
- SouthernBiotech, Cat. # 1110-01; 1 mg/mL (200x)
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- 5 µg/mL final in PBS
! -!OVA/PBS

- prepare at 0.5 mg/mL in PBS; 50x
- 10 µg/mL final in PBS

! -!standard
! -!mouse IgG1, clone 15H6

- SouthernBiotech, Cat. # 0102-01; 1 mg/mL
- 10 ng/mL starting, diluted serially 1:2 in PBS

! -!mouse IgG2a, clone HOPC-1
- SouthernBiotech, Cat. # 0103-01; 1 mg/mL
- 10 ng/mL starting, diluted serially 1:2 in PBS

! -!mouse IgG2b, clone A-1
- SouthernBiotech, Cat. # 0104-01; 1 mg/mL
- 1,000 ng/mL starting, diluted serially 1:2 in PBS

! -!mouse IgG2c
- Bethyl Laboratories - ALEXIS, Cat. # RS110-112; 0.55 mg/
mL
- 10 ng/mL starting, diluted serially 1:2 in PBS

! -!mouse IgG3
- BD, Cat. # 553486; 0.5 mg/mL
- 5 ng/mL starting, diluted serially 1:2 in PBS

! -!mouse IgE, clone 15.3
- SouthernBiotech, Cat. # 0114-01; 0.25 mg/mL
- 200 ng/mL starting, diluted serially 1:2 in PBS

! -!detection
! -!biotin goat anti-mouse IgA

- SouthernBiotech, Cat. # 1040-08; 0.5 mg/mL (5,000x)
- 0.1 µg/mL final in Reaction Buffer

! -!biotin goat anti-mouse IgM
- SouthernBiotech, Cat. # 1020-08; 0.5 mg/mL (5,000x)
- 0.1 µg/mL final in Reaction Buffer

! -!biotin goat anti-mouse IgG
- SouthernBiotech, Cat. # 1034-08; 0.5 mg/mL (5,000x)
- 0.1 µg/mL final in Reaction Buffer

! -!biotin goat anti-mouse IgG1
- SouthernBiotech, Cat. # 1070-08; 0.5 mg/mL (5,000x)
- 0.1 µg/mL final in Reaction Buffer

! -!biotin goat anti-mouse IgG2a
- SouthernBiotech, Cat. # 1080-08; 0.5 mg/mL (5,000x)
- 0.1 µg/mL final in Reaction Buffer

! -!biotin anti-mouse IgG2b, clone R12-3
- Pharmingen, Cat. # 553393
- 2 µg/mL final in Reaction Buffer

! -!biotin goat anti-mouse IgG2c
- SouthernBiotech, Cat. # 1079-08; 0.5 mg/mL (5,000x)
- 0.1 µg/mL final in Reaction Buffer
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! -!biotin goat anti-mouse IgG3
- SouthernBiotech, Cat. # 1100-08; 0.5 mg/mL (5,000x)
- 0.1 µg/mL in Reaction Buffer

! -!biotin rat anti-mouse IgE, clone 23G3
- SouthernBiotech, Cat. # 1130-08; 0.5 mg/mL (5,000x)
- 0.1 µg/mL in Reaction Buffer

! -!streptavidin (HRP-conjugated)
dilute to 1x in Reaction Buffer

! -!TMB substrate

Supporting Protocols:
! -!In Vivo / Ex Vivo > Retroorbital Blood Collection
! -!Cytokine Detection > ELISA

Protocol:

Figure 59:  Detection of mouse immunoglobulin by ELISA.

! 1)!coat plate with anti-mouse Ig isotype antibody / OVA
- for detection of total Ig, coat both sample and standard wells with 
anti-mouse isotype Ig
- for detection of OVA-specific Ig, coat sample wells with OVA and 
standard wells with anti-mouse isotype Ig

! 1.1)!dilute anti-mouse Ig isotype antibody to final concentration 
in PBS

- see above for recommended titer
- prepare in 15 mL tube

! 1.2)!dilute OVA to 10 µg/mL final in PBS
prepare in 15 mL tube

! 1.3)!transfer to pipet basin
! 1.4)!add 50 µL per well
! 1.5)!tap plate to cover each well evenly
! 1.6)!cover plate
! 1.7)!seal plate with parafilm
! 1.8)!incubate overnight at 4°C
! 2)!block plate
! 2.1)!remove plate from refrigerator
! 2.2)!decant plate in sink
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! 2.3)!wash 3x with 300 µL wash buffer per well
! 2.4)!tap plate on top of paper towels to remove excess liquid
! 2.5)!add 150 µL of blocking buffer to each well

3x volume of coating solution
! 2.6)!incubate for 1.5 - 2 hrs. at room temp.
! 3)!prepare dilutions of standard

purified mouse Ig isotype
! 3.1)!prepare starting concentration in PBS

see above for recommended titer
! 3.2)!prepare 7 standard titers by diluting serially 1:2 in PBS
! 4)!prepare dilutions of samples
! 4.1)!equilibrate serum samples to room temp.
! 4.2)!prepare starting concentration in PBS

see above for recommended titer
! 4.3)!prepare 7 sample titers by diluting serially 1:4 in PBS
! 5)!add standards / samples to plate
! 5.1)!decant plate in sink
! 5.2)!wash 3x with 300 µL wash buffer per well
! 5.3)!tap plate on top of paper towels to remove excess liquid
! 5.4)!add 50 µL of standards / samples to designated wells
! 5.5)!incubate for 1.5 - 2 hrs. at room temp.
! 6)!add detection antibody

biotin anti-mouse Ig isotype antibody
! 6.1)!dilute biotin anti-mouse Ig isotype antibody to final 

concentration in reaction buffer
- see above for recommended titer
- prepare in 15 mL Falcon tube

! 6.2)!decant plate in sink
! 6.3)!wash 3-5x with 300 µL wash buffer per well
! 6.4)!tap plate on top of paper towels to remove excess liquid
! 6.5)!add 50 µL of detection antibody solution per well
! 6.6)!incubate for 1.5 - 2 hrs. at room temp.
! 7)!continue with ELISA protocol as described for cytokine detection
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Bronchoalveolar Lavage
perform on assay day

Equipment:
! -!bucket with ice
! -!light source for dissection
! -!dissection board
! -!cannula
! -!polyethylene tubing

- Intramedic, Cat. # 427411
- I.D. 0.58 mm; O.D. 0.965 mm; length 30.5 m

! -!23G needle
! -!sharp surgical scissors (1)
! -!forceps (2)
! -!refrigerated centrifuge
! -!vortex
! -!-20°C / -80°C freezer

for storage of BALF supernatant

Materials:
! -!C57BL/6J mice (6-12 weeks old)
! -!sensitized with OVA/alum

see supporting protocol
! -!challenged with OVA

see supporting protocol
! -!PBS
! -!keep on ice
! -!microcentrifuge tubes (2 per mouse)

- for collection of BALF from lavage #1 (1 per mouse)
- for storage of BALF supernatant from lavage #1 (1 per mouse)

! -!label with mouse ID
! -!FACS tubes with caps (1 per mouse)

- for collection of BALF from lavage #s 2-5
- 5 mL round-bottom (12 x 75 mm)
- BD, Cat. # 352054

! -!label with mouse ID
! -!surgical suture

- size 4-0 silk
- CA Surgical Instruments & Supplies, Cat. # SP116

! -!cut piece for each mouse
! -!1 mL syringe

BD, Cat. # 309602
! -!ACK Lysis Buffer
! -!FACS Buffer
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! -!keep on ice
! -!TCM

cRPMI + 10% FBS
! -!keep on ice

Supporting Protocols:
! -!OVA System > OVA/Alum Sensitization
! -!OVA System > OVA Challenge
! -!In Vivo / Ex Vivo > Mouse Euthanasia Using Isoflurane
! -!In Vivo / Ex Vivo > Mouse Dissection
! -!Cell Culture > Cell Counting

Protocol:
- BALF collected from lavage #1 contains the highest titer of cytokines and the 
supernatant is retained for cytokine analysis by ELISA

- BALF collected from lavage #s 2-5 are pooled to increase the cell number 
for preparation of cytospin slides and/or FACS analysis

! 1)!sacrifice mouse
- proceed serially for each mouse
- see supporting protocol

! 2)!perform chest cavity dissection
- see supporting protocol
- do not use pins to open rib cage

! 3)!perform tracheotomy
! 3.1)!using forceps, separate muscle at midline covering trachea
! 3.2)!using forceps, remove membrane above trachea at cartilage 

ring
avoid rupturing blood vessels on either side of trachea

! 3.3)!using forceps, puncture membrane below trachea
! 3.4)!thread surgical suture below trachea using forceps
! 3.5)!make single, small incision through trachea at cartilage ring
! 3.6)!insert cannula through opening of trachea and extend ~1 

mm
! 3.7)!fasten cannula in place by tying knot with surgical suture
! 4)!lavage #1

keep on ice following collection
! 4.1)!fill syringe with 1 mL of cold PBS
! 4.2)!attach to cannula
! 4.3)!depress plunger to dispense PBS into lungs

confirm proper delivery by observing expansion of lungs
! 4.4)!steadily withdrawal plunger to aspirate BALF
! 4.5)!dispense BALF from lavage #1 to designated 

microcentrifuge tube
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! 4.6)!detach syringe from cannula
! 5)!lavage #s 2-5

keep on ice following collection
! 5.1)!repeat 4x as for lavage #1
! 5.2)!dispense BALF from lavage #s 2-5 into same FACS tube
! 6)!repeat from above for each mouse
! 7)!centrifuge microcentrifuge and FACS tubes containing BALF for 5 

min. at 1,500 rpm (4°C)
proceed in parallel for all BALF samples

! 8)!for each mouse, transfer supernatant from microcentrifuge tube 
(containing BALF from lavage #1) to separate microcentrifuge tube

retain BALF cells in pellet
! 8.1)!store BALF supernatant samples at -20 / -80°C

for cytokine measurement by ELISA
! 9)!discard supernatants from FACS tubes

retain BALF cells in pellet
! 10)!lyse RBCs

see supporting protocol
! 10.1)!add 200 µL of ACK lysis buffer to each tube
! 10.2)!for each mouse, transfer cells from microcentrifuge tube to 

corresponding FACS tube
! 10.3)!incubate for 5 min. at room temp.
! 10.4)!add 2 mL of ice-cold FACS buffer to each tube
! 10.5)!centrifuge for 5 min. at 1,500 rpm (4°C)
! 10.6)!discard supernatant
! 11)!resuspend BALF cells in 300 µL of FACS buffer / TCM

optional:  resuspend BALF cells in TCM and store overnight at 
4°C

! 12)!perform cell count
see supporting protocol

! 13)!keep cells on ice
! 14)!proceed to prepare cytospin slides and/or FACS staining
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Cytospin Preparation
- perform on assay day
- modified Wright-Giemsa stain

Equipment:
! -!centrifuge with FACS tube adaptors
! -!Shandon Cytoclips

- Thermo Scientific, Cat. # 59910052
- for assembling slide / filter card / funnel

! -!Shandon Cytospin 2 centrifuge
! -!dI water supply
! -!staining dishes
! -!slide rack for staining
! -!slide folder
! -!refrigerator

Materials:
! -!BALF cell suspension
! -!collected fresh (≤ 24 hours)
! -!keep on ice
! -!FACS buffer
! -!microcentrifuge tubes (1 per mouse / sample)
! -!glass slides (1 per mouse / sample)

- 25 x 75 x 1 mm
- Fisher, Cat. # 12-544-7

! -!single cytology funnels with attached cards and caps (1 per mouse / 
sample)

Biomedical Polymers, Inc., Cat. # BMP-CYTO-S50 / VWR, Cat. # 
80094-254

! -!Hema 3 stain set
- Protocol, Cat. # 122-911 / Fisher, Cat. # 22-122-911
- fixative solution, Solution I, Solution II

! -!coverslips, No. 1 (1 per mouse / sample)
- 18 x 18 mm
- Fisher, Cat. # 12-548-A

! -!Permount mounting medium
Fisher, Cat. # SP15-100

Supporting Protocol:
! -!Bronchoalveolar Lavage
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Protocol:
! 1)!prepare in advance for each mouse / sample:
! 1.1)!label microcentrifuge tubes

for aliquot of 105 BAL cells for slide attachment
! 1.2)!label glass slides

- write on frosted area of slide with pencil
- include date and mouse ID

! 1.3)!set aside coverslips
! 1.4)!set aside cytology funnels (with attached cards and caps)
! 2)!aliquot 105 cells to designated microcentrifuge tube for each mouse / 

sample
! 3)!adjust to 400 µL final volume per tube with FACS buffer
! 4)!assemble slide / filter card / funnel using Shandon Cytoclip

listed in order from back to front
! 5)!attach 105 cells / 400 µL to each slide using Cytospin 2 centrifuge
! 5.1)!add cell suspension to funnel
! 5.2)!attach cap
! 5.3)!centrifuge for 5 min at 600 rpm (low acceleration)

display reads '05' for 5 minutes and '60' for 600 rpm
! 5.4)!remove slides from adaptors
! 6)!allow cells to air dry for 5-10 mins.
! 7)!place slides in rack for staining
! 8)!stain cells using Hema 3 stain set

proceed in order below
! 8.1)!pour solutions into respective staining dishes
! 8.2)!dip slides 5x into fixative solution
! 8.3)!dip slides 5x into Solution I
! 8.4)!dip slides 5x into Solution II
! 8.5)!rinse slides in running dI water
! 9)!remove slides from staining rack
! 10)!allow to air dry for 5-10 mins.
! 11)!add 10 µL of Permount mounting medium over cells
! 12)!apply coverslip
! 13)!allow to mounting medium to cure
! 14)!store slides in folder in refrigerator

protect from light
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Lung Tissue Fixation
- perform on assay day
- extract separate lung lobes for fixation and preparation of cell suspension, 
respectively

Equipment:
! -!light source for dissection
! -!forceps (1)
! -!scissors (1)
! -!beaker with 70% ethanol

for sterilizing surgical instruments
! -!bucket with ice

Materials:
! -!C57BL/6J mice (6-12 weeks old)
! -!sensitized with OVA/alum
! -!challenged with OVA
! -!10 cm diameter petri dishes (1 per group)

Corning, Cat. # 430167
! -!fill with PBS
! -!PBS, sterile
! -!scintillation vials, 20 mL (1 per mouse / sample)

Fisher, Cat. # 03-337-5
! -!label on cap with mouse ID and assay date
! -!add 15 mL of 10% zinc formalin to each vial
! -!10% zinc formalin

Protocol, Cat. # 313-095 (Fisher, Cat. # 23-313-095)

Supporting Protocols:
! -!In Vivo / Ex Vivo > Mouse Euthanasia Using Isoflurane
! -!In Vivo / Ex Vivo > Mouse Dissection
! -!Bronchoalveolar Lavage (optional)

Protocol:
proceed serially for each mouse

! 1)!sacrifice mouse
see supporting protocol

! 2)!perform chest cavity dissection
see supporting protocol

! 3)!perform lavage (optional)
see supporting protocol

! 4)!use forceps and scissors to harvest lung lobe(s)
! 5)!place in petri dish containing PBS
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! 6)!gently rinse tissue
! 7)!transfer single lung lobe to labeled vial containing formalin
! 8)!seal with screw cap
! 9)!store in dark at room temp.
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Lung Cell Preparation
- perform on assay day
- extract separate lung lobes for fixation and preparation of cell suspension, 
respectively

Equipment:
! -!light source for dissection
! -!bucket with ice
! -!forceps (2)
! -!sterilize in beaker with 70% ethanol
! -!scissors (1)
! -!sterilize in beaker with 70% ethanol
! -!beaker with 70% ethanol

for sterilizing surgical instruments
! -!37°C tissue culture incubator
! -!lab timer
! -!refrigerated centrifuge
! -!vortex

Materials:
! -!C57BL/6J mice (6-12 weeks old)
! -!sensitized with OVA/alum
! -!challenged with OVA
! -!10 cm diameter petri dishes (1 per group)

Corning, Cat. # 430167
! -!PBS, sterile
! -!FACS tubes (1 per mouse / sample)
! -!label with mouse ID
! -!TCM

cRPMI + 10% FBS
! -!3.5 cm diameter petri dishes (1 per mouse)

for mincing lung tissue
! -!collagenase, 100 mg/mL (30 µL per mouse)
! -!DNAse I, 10 mg/mL (10 µL per mouse)
! -!FACS Buffer
! -!keep on ice
! -!TCM

cRPMI + 10% FBS
! -!keep on ice

Supporting Protocols:
! -!In Vivo / Ex Vivo > Mouse Euthanasia Using Isoflurane
! -!In Vivo / Ex Vivo > Mouse Dissection
! -!Bronchoalveolar Lavage (optional)

442



! -!In Vivo / Ex Vivo > Tissue Dissociation
! -!Cell Culture > Cell Counting

Protocol:
do not perform RBC lysis for lung cells

! 1)!sacrifice mouse
see supporting protocol

! 2)!perform chest cavity dissection
see supporting protocol

! 3)!perform lavage (optional)
see supporting protocol

! 4)!harvest lung tissue
! 4.1)!use forceps and scissors to harvest lung lobe(s)
! 4.2)!place in 10 cm diameter petri dish containing PBS
! 4.3)!gently rinse tissue
! 4.4)!transfer single lung lobe to labeled FACS tube containing 

TCM
! 4.5)!keep at 4°C
! 5)!mince lung tissue

proceed serially for each tissue sample
! 5.1)!decant lung tissue and TCM to 3.5 cm diameter petri dish

retain FACS tube
! 5.2)!using pair of forceps, mince tissue into small pieces (1-2 

mm)
! 5.3)!return minced tissue and TCM to retained FACS tube
! 5.4)!tap tube to collect minced tissue at bottom
! 5.5)!keep at 4°C
! 6)!digest with collagenase and DNAse

proceed in parallel for all tissue samples
! 6.1)!add 30 µL of 100 mg/mL collagenase stock to each tube

3 mg/mL final
! 6.2)!add 10 µL of 10 mg/mL DNAse I stock to each tube

100 µg/mL final
! 6.3)!vortex tube to mix
! 6.4)!place in 37°C tissue culture incubator for 1 hour

to enzymatically digest tissue
! 7)!dissociate tissue into cell suspension

see supporting protocol
! 8)!add 4 mL of FACS Buffer / TCM
! 9)!vortex / resuspend cells
! 10)!count cells

see supporting protocol
! 11)!adjust to desired cell concentration
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DLN Preparation
mediastinal draining lymph nodes

Equipment:
! -!light source for dissection
! -!biosafety cabinet (TC hood)
! -!forceps (2)

sterilize in beaker with 70% ethanol
! -!fine point (1)
! -!standard (1)
! -!beaker with 70% ethanol

for sterilizing surgical instruments
! -!bucket with ice

Materials:
! -!C57BL/6J mice (6-12 weeks old)
! -!sensitized with OVA/alum
! -!challenged with OVA
! -!Kimwipes
! -!TCM

cRPMI + 10% FBS
! -!15 mL conical tubes (1 per group)

Supporting Protocols:
! -!In Vivo / Ex Vivo > Mouse Euthanasia Using Isoflurane
! -!In Vivo / Ex Vivo > Mouse Dissection
! -!Bronchoalveolar Lavage (optional)
! -!In Vivo / Ex Vivo > Tissue Dissociation
! -!In Vivo / Ex Vivo > RBC Lysis
! -!Cell Culture > Cell Counting

Protocol:
! 1)!add 10 mL of ice-cold TCM to 15 mL tube for each group

prepare inside TC hood
! 1.1)!keep on ice
! 2)!sacrifice mouse

see supporting protocol
! 3)!perform chest cavity dissection

see supporting protocol
! 3.1)!separate rib cage using pins
! 4)!perform lavage (optional)

see supporting protocol
! 5)!harvest DLN
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! 5.1)!fold Kimwipe into quarters and aspirate blood from chest 
cavity

! 5.2)!using fine point forceps, harvest mediastinal lymph nodes
- small, spherical and shiny in appearance
- 2 each on left and right sides
- 1 at midline

! 5.3)!transfer to tube with TCM
pool with additional mice from same treatment group to 
increase cell number

! 6)!dissociate DLN to prepare cell suspension
see supporting protocol

! 7)!lyse RBCs
see supporting protocol

! 8)!resuspend in 0.5 mL of TCM
! 9)!count cells

see supporting protocol
! 10)!optional:  store overnight at 4°C

References:
! (161)
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FACS Staining for Eosinophils and Macrophages
using BALF and/or lung cells

Equipment:
! -!flow cytometer for analysis

e.g., BD Canto or Aria
! -!refrigerated centrifuge
! -!bucket with ice

Materials:
! -!BALF cell suspension

see supporting protocol
! -!lung cell suspension

see supporting protocol
! -!FACS buffer
! -!keep on ice
! -!FACS staining tubes
! -!antibodies

confirm sufficient stock prior to staining cells
! -!rat anti-mouse CD16/CD32 (Mouse BD Fc Block)

BD, Cat. # 553141; 0.5 mg/mL
! -!PE rat anti-Siglec-F

BD, Cat. # 552126; 0.2 mg/mL
ex:  488 nm laser
em:  585/42 filter

! -!PerCP-Cy5.5 rat anti-mouse CD45
BD, Cat. # 550994; 0.2 mg/mL
ex:  488 nm laser
em:  670 LP filter

! -!FITC hamster anti-mouse Cd11c
BD, Cat. # 557400; 0.5 mg/mL
ex:  488 nm laser
em:  530/30 filter

! -!2% paraformaldehyde / PBS, keep on ice
! -!USB drive

Supporting Protocols:
! -!Bronchoalveolar Lavage
! -!BALF Processing
! -!Harvesting Lung Tissue
! -!Lung Cell Preparation
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Protocol:
for staining ≤ 106 BALF or lung cells

! 1)!create spreadsheet listing all samples and staining conditions 
including the following:

- unstained sample
- single-color control samples (prepare from OVA/alum sensitized 
and challenged mouse / mice)
- experimental samples for each mouse / group

! 2)!for each mouse / sample, transfer 100 µL of BALF or lung cells to 
new FACS tube

! 3)!add 0.5 µg (1 µL) Fc blocking antibody to each sample
! 4)!incubate for 5 min.
! 5)!add 0.5 µg of eosinophil markers to each sample
! 5.1)!add 2.5 µL of anti-Siglec-F antibody
! 5.2)!add 2.5 µL of anti-CD45 antibody
! 5.3)!add 1 µL of anti-CD11c antibody
! 6)!incubate for 45 min. in refrigerator (in dark at 4°C)
! 7)!add 2 mL FACS buffer per tube (wash)
! 8)!centrifuge for 5 min. at 1,500 rpm (4°C)
! 9)!discard supernatant

invert tube
! 10)!resuspend in 100 µL of 2% PFA/PBS per sample
! 11)!incubate for 10 min. in refrigerator (in dark at 4°C)
! 12)!add 2 mL FACS buffer per tube to wash
! 13)!centrifuge for 5 min. at 1,500 rpm (4°C)
! 14)!discard supernatant

invert tube
! 15)!resuspend cells in 300 µL of FACS buffer
! 16)!store samples in refrigerator until analysis (in dark at 4°C)
! 17)!acquire FACS data within 72 hours

example voltages for FACS acquisition:
FSC:!! ! 175
SSC:!! ! 450
FITC:!! ! 450
PE:! ! ! 450
PerCP-Cy5.5:! 400

! 17.1)!select 'medium' or 'high' flow rate
! 17.2)!for BALF cells, collect ≥ 10,000 CD45+ events
! 17.3)!for lung cells, collect ≥ 20,000 CD45+ events
! 17.4)!export FCS files
! 17.5)!save to USB drive
! 18)!analyze FACS data
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Figure 60:  Identification and quantification of eosinophils and macrophages 
by FACS.

! 18.1)!determine compensation parameters from single-color 
control samples

- e.g., FITC - PE = 3.0%
- e.g., PE - FITC = 14.0%
- perform separately for BAL cells and lung cells

! 18.2)!create dot plot with SSC on y-axis and FSC on x-axis
! 18.3)!create CD45 PerCP-Cy5.5 histogram
! 18.3.1)!select biexponential display for x-axis
! 18.3.2)!draw gate on CD45+ events
! 18.3.2.1)!label as 'CD45'
! 18.4)!create dot plot with Siglec-F PE on y-axis and Cd11c FITC 

on x-axis
! 18.4.1)!select biexponential display for x- and y-axes
! 18.4.2)!select 'Show Population' > 'CD45 PerCP-Cy5.5'

to display CD45+ events
! 18.4.3)!draw Siglec-F+, Cd11c- gate
! 18.4.3.1)!label as 'eos'
! 18.4.3.2)!record eosinophil (eos) percentage
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! 18.4.3.2.1)!label on graph as '% (Siglec-F+ 
Cd11c-) / CD45+'

! 18.4.4)!draw Siglec-F+, Cd11c+ gate
! 18.4.4.1)!label as 'Mac'
! 18.4.4.2)!record macrophage (Mac) percentage
! 18.4.4.2.1)!label on graph as '% (Siglec-F+ 

Cd11c+) / CD45+'

References:
! (133)
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FACS Staining for T Cells
using BALF cells

Equipment:
! -!flow cytometer for analysis

e.g., BD Canto or Aria
! -!refrigerated centrifuge
! -!bucket with ice

Materials:
! -!BALF cell suspension
! -!FACS buffer
! -!keep on ice
! -!FACS staining tubes
! -!antibodies
! -!PerCP-Cy5.5 rat anti-mouse CD45

BD, Cat. # 550994; 0.2 mg/mL
ex:  488 nm laser
em:  670 LP filter

! -!PE-Cy7 hamster anti-mouse CD3ε, clone 145-2C11
BD, Cat. # 552774; 0.2 mg/mL
ex:  488 nm laser
em:  780/60 nm laser

! -!USB drive

Supporting Protocols:
! -!Bronchoalveolar Lavage
! -!BALF Processing

Protocol:
for staining ≤ 106 BALF cells

! 1)!prepare in advance:
! 1.1)!create spreadsheet listing all samples and staining 

conditions including the following:
- unstained sample
- single-color control samples (prepare from OVA/alum 
sensitized and challenged mouse / mice)
- experimental samples for each mouse / group

! 1.2)!confirm sufficient stock of antibodies
! 2)!for each mouse, transfer 100 µL of BALF cell suspension to new 

FACS tube
! 3)!add 0.5 µg (1 µL) Fc blocking antibody to each sample
! 4)!incubate for 5 min.
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! 5)!add 0.5 µg of eosinophil markers to each sample
! 5.1)!add 2.5 µL of anti-CD45 antibody
! 5.2)!add 2.5 µL of anti-CD3ε antibody
! 6)!incubate for 45 min. in refrigerator (in dark at 4°C)
! 7)!add 2 mL FACS buffer per tube to wash
! 8)!centrifuge for 5 min. at 1,500 rpm (4°C)
! 9)!discard supernatant

invert tube
! 10)!resuspend in 100 µL of 2% PFA/PBS per sample
! 11)!incubate for 10 min. in refrigerator (in dark at 4°C)
! 12)!add 2 mL FACS buffer per tube to wash
! 13)!centrifuge for 5 min. at 1,500 rpm (4°C)
! 14)!discard supernatant

invert tube
! 15)!resuspend cells in 300 µL of FACS buffer
! 16)!store samples in refrigerator until analysis (in dark at 4°C)
! 17)!acquire FACS data within 72 hours

example voltages for FACS acquisition:
FSC:!! ! 175
SSC:!! ! 450
PerCP-Cy5.5:! 500
PE-Cy7:! ! 500

! 17.1)!select 'medium' or 'high' flow rate
! 17.2)!collect ≥ 20,000 CD45+ events
! 17.3)!export FCS files
! 17.4)!save to USB drive
! 18)!analyze FACS data
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Figure 61:  Identification and quantification of BAL T cells by FACS.

! 18.1)!determine compensation parameters from single-color 
control samples

e.g., PE-Cy7 - PerCP-Cy5.5 = 12.0%
e.g., PerCP-Cy5.5 - PE-Cy7 = 6.0%

! 18.2)!create CD45 PerCP-Cy5.5 histogram
! 18.2.1)!select biexponential display for x axis
! 18.2.2)!draw gate on CD45+ events
! 18.2.2.1)!label as 'CD45'
! 18.3)!create dot plot with SSC on y-axis and FSC on x-axis
! 18.3.1)!select 'Show Population' > 'CD45 PerCP-Cy5.5'

to display CD45+ events
! 18.3.2)!draw gate on lymphocytes by scatter profile
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! 18.3.2.1)!label as 'FSC SSC'
! 18.4)!create dot plot with PE-Cy7 on x-axis and FSC on y-axis
! 18.4.1)!select biexponential display for x axis
! 18.4.2)!select 'Show Population' > 'FSC SSC'

to display CD45+ SSC+ FSC+ events
! 18.4.3)!draw CD3e PE-Cy7+ gate based on CD45 PerCP-

Cy5.5 single-color control sample
'negative' gate

! 18.4.3.1)!label as 'CD3e'
! 18.4.4)!create statistics view and select to display % 

grandparent
! 18.4.4.1)!record percentage of CD3ε+ events as a 

percentage of CD45+ events
! 18.4.4.1.1)!label on graph as '% CD3ε+ / 

CD45+'

References:
! (133)
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Histological Examination
mucus severity score and inflammation score

Equipment:
! -!microtome

at histology lab
! -!slide folder
! -!light microscope with 40x objective

Materials:
! -!lung tissue specimens
! -!stored in formalin
! -!for mucus analysis:
! -!PAS (Schiff's reagent)

stain for mucus
! -!hematoxylin

nuclear counter-stain
! -!for inflammation analysis:
! -!hematoxylin

nuclear stain
! -!eosin

stains cytoplasm

Supporting Protocols:
! -!Lung Tissue Fixation

Protocol:
- tissue embedding, sectioning and staining performed at pathology lab
- stain separate slides cut from same tissue for mucus and inflammation

! 1)!embed lung tissue in paraffin
save tissue block for re-cutting and further staining if needed

! 2)!make 5 µm sections around middle of tissue
! 3)!stain for mucus:
! 3.1)!stain for 5 min. with Schiff's reagent
! 3.2)!rinse in cold water
! 3.3)!stain with hematoxylin

counter-stain
! 3.4)!skip acid
! 4)!stain for inflammation:
! 4.1)!stain with hematoxylin
! 4.2)!rinse in cold water
! 4.3)!stain with eosin
! 5)!assign unique, random code number to each slide
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! 6)!evaluate slides
! 6.1)!view slides using 40x objective of light microscope
! 6.2)!qualitatively assess staining quality in reference to positive 

and negative control slides
! 6.3)!focus on cross-section of individual bronchioles
! 6.4)!for mucus analysis, assign score to each bronchiole 

according to the percentage of the total circumference 
staining bright pink / fuchsia as follows:

score!! ! description
0! ! ! 0% +
1! ! ! ≤ 10% +
2! ! ! ≤ 25% +
3! ! ! ≤ 50% +
4! ! ! ≤ 75% +
5! ! ! 100%

! 6.5)!for inflammation analysis, assign score to each bronchiole 
according to the degree of inflammatory infiltrate tangential 
to the circumference as follows:

score!! ! description
0! ! ! no cellular infiltrate
1! ! ! 1 cell layer deep
2! ! ! 2-4 cell layers deep
3! ! ! 5-7 cell layers deep
4! ! ! > 7 cell layers deep

! 7)!create spreadsheet listing scores for each mouse
! 8)!decode slides to reveal mouse / group identity
! 9)!calculate average score for each mouse
! 10)!graph average scores +/- SEM for each group

References:
! (69, 162)
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Airway Hyperresponsiveness (AHR)

Equipment:
! -!Scireq FlexiVent system

- small rodent ventilator
- Part # FV-BU; Serial # 1062328
- for technical assistance, call 877-5-SCIREQ

! -!transducer
! -!nebulizer
! -!Y tubing

used to connect components
! -!monometer
! -!PC computer
! -!FlexiVent software installed

- Version 5.3
- Service Pack 2; Build 532

! -!dissection board
! -!scale

to weigh mice
! -!endotracheal tube (cannula), 18 gauge

- BD Medical, Cat. # 408208
- with beveled end to facilitate cannulation
- keep clean and free of obstructions – replace as needed

Figure 62:  Image of blunt vs. bevelled cannula for tracheotomy.
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Materials:
! -!C57BL/6 mice (6-12 weeks old)

including negative control and experimental groups
! -!sensitized with OVA/alum

see supporting protocol
! -!challenged with OVA

see supporting protocol
! -!pins for dissection board
! -!ketamine / xylazine cocktail
! -!prepare fresh
! -!27G 1/2 " needle (1)

for ketamine / xylazine administration -- reuse for multiple mice
! -!methacholine doses (100 µL / dose / mouse)

0, 3, 6, 12 & 24 mg/mL
! -!prepare dilutions of stock solution in PBS
! -!1 mL syringes (6)
! -!one for each dose of methacholine

reuse for multiple mice
! -!one for ketamine / xylazine injection

reuse for multiple mice
! -!paper towels
! -!curved forceps (1)
! -!straight forceps (1)
! -!surgical scissors
! -!surgical suture
! -!70% ethanol spray bottle
! -!USB drive
! -!timer

Supporting Protocols:
! -!OVA/Alum Sensitization (i.p.)
! -!OVA Challenge (i.n. or aerosol)
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Protocol:
! 1)!connect components for FlexiVent system according to figures below

begin by administering anesthesia (see below) during system setup

Figure 63:  FlexiVent system overview.
! Diagram courtesy of Zineb Idrissi and Dr. Annette Roubichaud of 
SCIREQ.

Figure 64:  Identification of tubing used for FlexiVent system.
! Confirm that the arrow on the Aeroneb adapter is pointing from the 
module towards the subject.
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Figure 65:  Proper setup for FlexiVent system.

! 2)!start computer
! 2.1)!turn on power to power strip controlling FlexiVent system 

and computer
! 2.2)!turn on power to computer and monitor
! 2.3)!simultaneously press control, option & delete to get login 

window
! 2.4)!log in to computer (control, option & delete)
! 3)!launch FlexiVent software
! 3.1)!select 'Start a new experiment from template'
! 3.2)!select 'Wei tem' > 'Open'
! 3.3)!name and save experiment to 'My flexivent data'
! 3.4)!name operator
! 3.5)!select 'OK'
! 4)!create new subject
! 4.1)!name subject
! 4.2)!enter weight (e.g., 25 g)

enter actual mass as determined from scale
! 4.3)!enter gender (e.g., female)
! 4.4)!select 'OK'
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! 5)!prime nebulizer
perform once at beginning of each session

! 5.1)!label and fill each 1 mL syringe with respective dose of 
methacholine (100 µL per dose per mouse)

! 5.2)!follow software prompts
! 5.3)!detach nebulizer from base
! 5.4)!dispense 100 µL of PBS to nebulizer
! 5.5)!firmly re-attach nebulizer
! 6)!perform channel calibration

perform once at beginning of each session
! 6.1)!select to calibrate cylinder and airway pressure
! 6.2)!select Calibration Method > two collected points
! 6.3)!attach manometer and use attached syringe to adjust 

pressure to 0 and 300 mm H2O as directed
! 7)!perform dynamic tube calibration

repeat for each subject / mouse
! 7.1)!connect endotracheal cannula to end of Y tubing
! 7.2)!add 100 µL of PBS to nebulizer during calibration to avoid 

having air leak during closed tube calibration
leave PBS in reservoir for baseline (0 mg/mL 
methacholine) reading during data acquisition

! 7.3)!select all perturbation signals for calibration
! 7.4)!follow software prompts for:
! 7.4.1)!closed tube calibration

block end of cannula with finger when directed
! 7.4.2)!open tube calibration
! 7.5)!below TLC section of report; verify that RS > 2000 and that 

RT < 0.5
! 7.5.1)!RS refers to resistance of system and RT refers to 

resistance of tubing
! 7.5.2)!tighten connections and repeat if necessary
! 8)!anesthetize mouse

preform in advance for subsequent mice
! 8.1)!proceed individually for each mouse

allow 30 min. for each mouse
! 8.2)!inject 200 µL of ketamine / xylazine intraperitoneally

reduce likelihood of overdose by slowly delivering 50 µL 
aliquots followed by monitoring until entire volume is 
dispensed

! 8.3)!allow ≥ 20 min. for anesthetic to take effect
mice must be passive (no breathing efforts) when 
connected to ventilator

! 8.4)!weigh mouse on scale and record mass in grams
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! 9)!perform surgery to reveal trachea
! 9.1)!use pins to secure mouse to dissection board facing up
! 9.2)!spray furn above trachea with ethanol prior to surgery
! 9.3)!remove skin and connective tissue above trachea
! 9.4)!expose trachea using forceps
! 10)!perform tracheotomy

take care to avoid rupturing trachea
! 10.1)!thread surgical suture below trachea
! 10.2)!create small incision through trachea at cartilage ring
! 10.3)!hold curved forceps below trachea
! 10.4)!insert cannula with luer end aligned with the tip of the 

subject's nose according to diagram below and with 
beveled end of cannula against bottom of trachea

Figure 66:  Proper placement of cannula relative to head of mouse.
! Diagram courtesy of Zineb Idrissi and Dr. Annette Roubichaud of 
SCIREQ.

! 10.5)!secure cannula using surgical suture
! 11)!connect mouse to ventilator
! 11.1)!assess reflex response by squeezing front and hind paws 

using forceps
! 11.1.1)!desired depth of anesthesia is reached when:
! 11.1.1.1)!respiratory rate is regular and relaxed
! 11.1.1.2)!withdrawal reflex is absent
! 11.1.1.3)!there is no response to an external 

stimulus
! 11.2)!adjust height of dissection board using folded paper towels 

to match height of tube on ventilator
! 11.3)!connect cannula to end of Y tubing
! 11.4)!tuck end of cannula below skin for proper placement

to allow unobstructed air flow
! 11.5)!move head aside to make room for cannula
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Figure 67:  Proper connection of mouse to FlexiVent system via endotracheal 
cannula.

! 12)!acquire data
! 12.1)!execute ventilation script

e.g., select script 'AN-MI v5.3'
! 12.2)!start ventilation
! 12.2.1)!confirm that mouse is passive (breathing efforts 

absent) and breathing in rhythm with ventilator
! 12.2.1.1)!if needed, detach cannula from Y tubing, 

adjust position of cannula inside trachea, 
reconnect to Y tubing and restart 
ventilation

! 12.2.1.2)!if needed, inject supplemental ketamine / 
xylazine i.p. (1/2 dose max) and wait until 
desired effect

! 12.3)!when prompted, dispense 100 µL of PBS in nebulizer
or, use remaining PBS in reservoir from dynamic tube 
calibration above

! 12.4)!ensure proper baseline reading before proceeding to first 
methacholine dose

if required, detach from ventilator, adjust / replace 
cannula and reattach
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! 12.5)!when prompted, select 'OK' to continue with next dose
series of methacholine doses are as follows:  0, 3, 6, 12 
and 24 mg/mL

! 12.6)!use folded paper towels to wick away remaining volume 
from nebulizer

! 12.7)!when prompted, enter methacholine dose
! 12.8)!repeat for each dose of series
! 12.9)!stop ventilation after final dose
! 12.10)!sacrifice mouse by cervical dislocation
! 13)!for additional subjects / mice, select Edit > Subject > Replace
! 13.1)!name new subject
! 13.2)!repeat from 'dynamic tube calibration' above
! 14)!analyze / validate data
! 14.1)!select File > Export > Export parameters > Export All
! 14.2)!save in ASC II format to custom folder using default file 

name
separator character:  tab

! 14.3)!copy files below located at the path 'My Documents > My 
FlexiVent data' to personal USB drive

- experiment file
- raw data file
- parameters file

! 14.4)!open exported parameters file using spreadsheet 
application on personal computer

! 14.5)!for each subject / mouse, create a list of the highest 
resistance value (units of 'cmH2O.s/mL') for each dose of 
methacholine

! 14.6)!for each group, calculate the average resistance value (+/- 
SEM) for each dose of methacholine

! 14.7)!display cumulative data as a graph of resistance versus 
methacholine dose

! 14.7.1)!connect each datapoint with a line and display 
SEM
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5.2.12. OVA System
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OVA/Alum Sensitization (i.p.)
- perform in vivarium
- for short / 10 day protocol, sensitize on day 0
- for long / 16 day protocol, sensitize on days 0 & 5

Materials:
! -!C57BL/6J mice (6-12 weeks old)

3-4 mice per group
! -!OVA/alum, 2:1 (v/v) for sensitization

see 'Buffers & Solutions'
! -!PBS/alum

for negative control group

Supporting Protocol:
! -!In Vivo / Ex Vivo > Intraperitoneal Injection

Protocol:
20 µg OVA / 2 mg alum per mouse

! 1)!mix OVA/alum well prior to filling syringe
! 2)!fill syringe for injection(s)

see supporting protocol
! 3)!deliver 150 µL intraperitoneally to upper-right quadrant

see supporting protocol

References:
! (11, 163)
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OVA Challenge (i.n.)
- for short / 10 day protocol, challenge on days 7-9
- for long / 16 day protocol, challenge on days 12-15

Equipment:
! bucket with ice

Materials:
! -!C57BL/6J mice (6-12 weeks old)

- OVA/alum sensitized group
- PBS/alum sensitized group (control)
- experimental groups as needed

! -!0.5 mg/mL OVA/PBS
see 'Buffers and Solutions'

! -!keep on ice

Supporting Protocols:
! -!OVA/Alum sensitization (i.p.)
! -!In Vivo / Ex Vivo > Intranasal Treatment
! -!Anesthesia Machine Setup

Protocol:
for short / 10 day protocol, 10 µg OVA per mouse per challenge day

! 1)!set up anesthesia machine
see supporting protocol

! 2)!deliver 20 µL bolus of 0.5 mg/mL OVA/PBS by intranasal treatment
see supporting protocol

! 3)!repeat for 3-4 daily challenges
allow ~24 hours between consecutive challenges

References:
! (11, 163)
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OVA Challenge (aerosol)
- for short / 10 day protocol, challenge mice for 20 min. per day with 1% OVA/
PBS on days 7-9
- for long / 16 day protocol, challenge mice for 20 min. per day with 1% OVA/
PBS on days 12-15
- allow ~24 hours between consecutive challenges

Equipment:
! -!lab timer

Materials:
! -!C57BL/6J mice (6-12 weeks old)

- OVA/Alum sensitized group
- PBS/Alum sensitized group (control)
- experimental groups as needed

! -!~20 mL, 1% (10 mg/mL) OVA/PBS
! -!fine tip sharpie marker, red

for labeling tails to distinguish groups

Supporting Protocols:
! -!OVA/Alum Sensitization (i.p.)
! -!In Vivo / Ex Vivo > Aerosol Treatment

Protocol:
! 1)!dispense 1% OVA/PBS solution in medicine cup of nebulizer

see supporting protocol
! 2)!connect nebulizer components

see supporting protocol
! 3)!label tails to distinguish different groups using sharpie marker

re-label for each challenge day if needed
! 4)!place mice for challenge inside induction chamber
! 5)!set timer to allow 20 minutes exposure to aerosolized OVA
! 6)!repeat for 3-4 daily challenges

allow ~24 hours between consecutive challenges

References:
! (69)
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OVA Restimulation (in vitro)
restimulation of splenocytes, DLN cells or lung cells to assess in vitro cytokine 
production by ELISA

Equipment:
! -!biosafety cabinet / TC hood
! -!refrigerated centrifuge
! -!humidified, 5% CO2, 37°C incubator
! -!-20 / -80°C freezer

Materials:
! -!C57BL/6 mice (6-12 weeks old)

optimal strain for lung inflammation
! -!sensitized with OVA/Alum

see supporting protocol
! -!challenged with OVA

see supporting protocol
! -!BALB/c mice (6-12 weeks old)

optimal strain for systemic Th2 production
! -!sensitized with OVA/Alum

see supporting protocol
! -!for ELISA:
! -!96-well culture plate, round-bottom

- Sarstedt (Cat. # 83.1837)
- to promote cell-cell contact for antigen presentation

! -!microcentrifuge tubes (2 per condition)
- for collecting cell suspension for centrifugation (1)
- for storage of cell culture supernatant (1)

! -!label each tube
! -!for ELISPOT:
! -!96-well filter plate

Millipore, Cat. # MSIPS4510
! -!TCM

cRPMI + 10% FBS
! -!keep on ice
! -!10 mg/mL OVA/PBS

100 µL per tube
! -!stored at -80°C

Supporting Protocols:
! -!In Vivo / Ex Vivo > Splenocyte Preparation
! -!Lung Inflammation / Asthma > Lung Cell Preparation
! -!Lung Inflammation / Asthma > DLN Preparation
! -!In Vivo / Ex Vivo > Tissue Dissociation
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! -!In Vivo / Ex Vivo > RBC Lysis
! -!Cell Culture > Cell Counting

Protocol:
culture conditions (# of cells per well of 96-well plate):
- 106 splenocytes / 200 µL = 5x106 cells/mL
- 105 DLN cells / 200 µL = 0.5x106 cells/mL (for IL-5 and IL-13)
- 106 DLN cells / 200 µL = 5x106 cells/mL (for IL-4 and IL-5)
- 106 lung cells / 200 µL = 5x106 cells/mL
- 50 µg/mL OVA (for DLN or lung cells cultures)
- 100 µg/mL OVA (for splenocyte cultures)

! 1)!prepare cell suspension
! 1.1)!dissociate tissue to prepare cell suspension

see supporting protocol
! 1.2)!lyse RBCs (except for lung cells)

see supporting protocol
! 1.3)!count cells

see supporting protocol
! 2)!add 2x cell suspension to designated wells

- including for non-stimulation control wells
- prepare wells in duplicate or triplicate depending on available cell 
number

! 2.1)!adjust cell concentration to 2x in TCM
! 2.2)!add 100 µL to designated wells
! 3)!add 2x OVA solution to designated wells

add medium for non-stimulation control wells
! 3.1)!dilute 10 mg/mL OVA/PBS to 2x final concentration in TCM
! 3.2)!add 100 µL to designated wells
! 4)!incubate for 2-4 days

cytokine-specific kinetics:
- 2 days for detection of IFN-γ
- 4 days for detection of IL-4, IL-5, IL-13

! 5)!harvest supernatants
! 5.1)!resuspend each well

combine cell suspension from replicate wells
! 5.2)!transfer to designated microcentrifuge tubes
! 5.3)!centrifuge for 5 min. at 1,500 rpm (4°C)
! 5.4)!transfer supernatant to new microcentrifuge tube

for storage
! 6)!store tubes in -20 / -80°C freezer until cytokine analysis by ELISA

References:
! (164)
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5.3. Vendor List
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Airgas West
3737 Worsham Avenue
Long Beach, CA  90808
www.airgas.com
800-2-Airgas

American Type Culture Collection
ATCC
10801 University Boulevard
Manassas, VA  20110
www.atcc.org
800-638-6597

AnaSpec
34801 Campus Drive
Fremont, CA  94555
www.anaspec.com
800-452-5530

Baker Company, Inc.
P.O. Drawer E
161 Gatehouse Road
Sanford, Maine  04073
www.bakerco.com
800-992-2537

Bangs Laboratories
9025 Technology Dr.
Fishers, IN  46038-2886
www.bangslabs.com
800-387-0672

BD Biosciences
2350 Qume Drive
San Jose, CA  95131
www.bdbiosciences.com
877-232-8995

BD Medical
1 Becton Drive
Franklin Lakes, NJ  07417
www.bd.com
201-847-6800

Bio-Rad
1000 Alfred Nobel Drive
Hercules, CA  94547
www.bio-rad.com
800-424-6723

BioLegend
9727 Pacific Heights Blvd.
San Diego, CA  92121
www.biolegend.com
877-246-5343

Biomedical Polymers, Inc.
42 Liinus Allain Ave.
Gardner, MA  01440
www.biomedicalpolymers.com
800-253-3684

BioPioneer
3956 Sorrento Valley Blvd. Suite 200
San Diego, CA  92121
858-232-9588

Biotechnical Services, Inc.
BTS
9373 Activity Road, Suite J
San Diego, CA  92126
www.biotechserv.com
800-274-0287
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Calbiochem / EMD Millipore
290 Concord Rd.
Billerica, MA  01821
www.emdmillipore.com
800-645-5476

Carl Zeiss AG
Carl-Zeiss-Strasse 22
73447 Oberkochen,  
Germany
www.zeiss.com

Cell Signaling Technology
3 Trask Lane
Danvers, MA  01923
www.cellsignal.com
877-616-2355

Dako
6392 Via Real
Carpinteria, CA  93013
www.dako.com
800-235-5763

Denville Scientific, Inc.
3005 Hadley Road
South Plainfield, NJ  07080
www.denvillescientific.com
800-453-0385

eBioscience, Inc.
6042 Cornerstone Court W
San Diego, CA  92121
www.ebioscience.com
858-642-2058

EMD Millipore
290 Concord Road
Billerica, MA  01821
www.emdmillipore.com
978-715-4321

EMD Millipore Chemicals
290 Concord Rd.
Billerica, MA  01821
www.emdmillipore.com/chemicals
866-645-5476

Epitomics
863 Mitten Road, Suite 103
Burlingame, CA  94010-1303
www.epitomics.com
877-772-2622

Fermentas Life Sciences / Thermo 
Scientific
798 Cromwell Park Drive, Suites R-S
Glen Burnie, MD  21061
www.fermentas.com
800-340-9026

Fisher HealthCare
9999 Veterans Memorial Drive
Houston, TX  77038
www.fishersci.com
800-766-7000

Fisher Scientific, Inc.
81 Wyman Street
Waltham, MA  02454
www.fishersci.com
800-766-7000
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Fort Dodge Animal Health / Pfizer
9225 Indian Creek Parkway
Building 32, Suite 400
Overland Park, KS  66210
animalhealth.pfizer.com
973-660-5000

GE Healthcare Life Sciences
800 Centennial Avenue
Piscataway, NJ  08855-1327
www.gelifesciences.com
800-526-3593

GL Biochem, Ltd.
519 Zi Yue Road
Shanghai 200241,  
China
www.glschina.com
86-21-61263322

GraphPad Software
2236 Avenida de la Playa
La Jolla, CA  92037
www.graphpad.com
858-454-5577

HyClone / Thermo Fisher 
Scientific, Inc.
925 West 1800
South Logan, UT  84321
www.thermoscientific.com
435-792-8000

Invitrogen / Life Technologies
1600 Faraday Avenue
Carlsbad, CA  92008
www.invitrogen.com
800-955-6288

Jackson ImmunoResearch
872 West Baltimore Pike
West Grove, PA  19390
www.jacksonimmuno.com
800-367-5296

Jackson Laboratory
600 Main Street
Bar Harbor, Maine  04609
jaxmice.jax.org
800-422-MICE

LabRepCo
101 Witmer Road, Suite 700
Horsham, PA  19044
www.labrepco.com
800-521-0754

Lloyd, Inc.
P.O. Box 130
Shenandoah, IA  51601
www.lloydinc.com
800-831-0004

Lonza
Muenchensteinerstrasse 38
CH-4002 Basel,  
Switzerland
www.lonza.com
800-521-0390

MatTek Corporation
200 Homer Avenue
Ashland, MA  01721
www.mattek.com
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Mediatech Cellgro / Corning, Inc.
9345 Discovery Blvd.
Manassas, VA  20109
www.cellgro.com
800-235-5476

Miltenyi Biotec
2303 Lindbergh Street
Auburn, CA  95602
www.miltenyibiotec.com

Mo Bio Laboratories
2746 Loker Avenue West
Carlsbad, CA  92010
www.mobio.com
800-606-6246

Molecular Devices, LLC
1311 Orleans Drive
Sunnyvale, CA  94089-1136
www.moleculardevices.com
800-635-5577

MP Biomedicals
29525 Fountain Parkway
Solon, OH  44139
www.mpbio.com
800-854-0530

New England BioLabs
240 County Road
Ipswich, MA  01938
www.neb.com
800-632-5227

Pacific Pathology
9292 Chessapeake Dr., Suite 100
San Diego, CA  92123
United States of America
www.pacificpathology.com
858-576-9630

Pall Life Sciences
25 Harbor Park Drive
Port Washington, NY  11050
800-645-6532

Pierce / Thermo Fisher Scientific, 
Inc.
3747 N Meridian Rd.
Rockford, IL  61101
www.piercenet.com
800-874-3723

Polysciences, Inc.
400 Valley Road
Warrington, PA  18976-2522
www.polysciences.com
800-523-2575

R&D Systems Inc.
614 McKinley Place NE
Minneapolis, MN  55413
www.rndsystems.com
800-343-7475

Roboz Surgical Instruments Co, 
Inc.
P.O. Box 10710
Gaithersburg, MD  20898-0710
www.roboz.com
800-424-2984
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Roche Applied Science
P.O. Box 50414
9115 Hague Road
Indianapolis, IN  46250-0414
www.roche-applied-science.com

Rockland Immunochemicals, Inc.
P.O. Box 326
Gilbertsville, PA  19525
800-656-7625

SAFC Biosciences
13804 W. 107th Street
Lenexa, KS  66215
www.safcglobal.com
913-469-5580

Santa Cruz Biotechnology
2145 Delaware Avenue
Santa Cruz, CA  95060
www.scbt.com
800-457-3801

Sarstedt AG & Co.
Sarstedtstraße
Postfach 1220
51582 Nümbrecht,  
Germany
www.sarstedt.com
800-257-5101

Scireq, Inc.
6600 St-Urbain, Suite 300
Montreal, QC  H2S 3G8
Canada
www.scireq.com
877-572-4737

SeqXcel
11526 Sorrento Valley Road, Ste. B2
San Diego, CA  92121
www.seqxcel.com
858-481-7569

Sigma Aldrich
3050 Spruce St.
St. Louis, MO  63103
www.sigmaaldrich.com
800-325-3010

Southern Biotech
P.O. Box 26211
Birmingham, AL  35260
www.southernbiotech.com
800-722-2255

Tree Star, Inc.
340 A Street #101
Ashland, OR  97520
www.flowjo.com
800-366-6045

TW Medical Veterinary Supply / 
Animal Health International
3610 Lohman Ford Road
Lago Vista, TX  78645-8068
www.twmedical.com
888-787-4483

Upstate / EMD Millipore
300 5th Ave., 6th Floor
Waltham, MA  02451
www.millipore.com
800-645-5476
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Ushio America, Inc.
5440 Cerritos Ave
Cypress, CA  90630
www.ushio.com
800-838-7446

VetEquip
P.O. Box 10785
Pleasanton, CA  94588-0785
www.vetequip.com
800-466-6463

VWR
1310 Goshen Parkway
West Chester, PA  19380
www.vwr.com
800-932-5000

Worthington Biochemical Corp.
730 Vassar Ave
Lakewood, NJ  08701
www.worthington-biochem.com
800-445-9603
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5.4.1. Antibodies

AF 488 anti-IFNγ, clone XMG1.2
! BioLegend; Cat. #:  505813; 100 µg

AF 647 anti-IFNγ, clone XMG1.2
! BioLegend; Cat. #:  505814; 100 µg

anti-CD28, syrian hamster IgG2 λ1, clone 37.51
! BD; Cat. #:  553295; 0.5 mg

anti-Itk, clone 2F12
! Millipore/Upstate; Cat. #:  05-476; 100 µL
! for immunoblotting

anti-LAT, clone 2E9
! Millipore; Cat. #:  05-561; 100 µg

anti-mouse IFN-γ, clone R4-6A2; 1.0 mg/mL
! BD; Cat. #:  551216; 1 mL
! ELISA capture, 250x; ELISPOT capture, 250x

anti-mouse IL-12, clone C17.8; 1 mg/mL
! eBioscience; Cat. #:  16-7123-85; 500 µg

anti-mouse IL-13, clone eBio13A; 0.5 mg/mL
! eBioscience; Cat. #:  14-7133-81; 50 µg
! ELISA capture, 250x; ELISPOT capture, 125x

anti-mouse IL-13, clone eBio13A; 0.5 mg/mL
! eBioscience; Cat. #:  14-7133-85; 500 µg
! ELISA capture, 250x; ELISPOT capture, 125x

anti-mouse IL-4, clone 11B11; 0.5 mg/mL
! eBioscience; Cat. #:  14-7041-85; 500 µg
! ELISA capture, 250x; ELISPOT capture, 125x

anti-mouse IL-5, clone TRFK5; 0.5 mg/mL
! eBioscience; Cat. #:  14-7052-81; 50 µg
! ELISA capture, 250x; ELISPOT capture, 125x
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anti-mouse IL-5, clone TRFK5; 0.5 mg/mL
! eBioscience; Cat. #:  14-7052-85; 500 µg
! ELISA capture, 250x; ELISPOT capture, 125x

anti-phosphotyrosine,clone 4G10
! Millipore/Upstate; Cat. #:  05-321; 100 µg

anti-TCR CD3ε, armenian hamster IgG1 κ, clone 2C11; 0.5 mg/mL
! BD; Cat. #:  553058; 0.5 mg

APC anti-TCRβ, clone H57-597
! BioLegend; Cat. #:  109211; 100 µg

biotin anti-mouse IFN-γ, clone XMG1.2; 0.5 mg/mL
! BD; Cat. #:  554410; 1 mL
! ELISA detection, 250x; ELISPOT detection, 250x

biotin anti-mouse IL-13, clone eBio1316H; 0.5 mg/mL
! eBioscience; Cat. #:  13-7135-81; 50 µg
! ELISA detection, 250x; ELISPOT detection, 500x

biotin anti-mouse IL-13, clone eBio1316H; 0.5 mg/mL
! eBioscience; Cat. #:  13-7135-85; 500 µg
! ELISA detection, 250x; ELISPOT detection, 500x

biotin anti-mouse IL-4, clone BVD6-24G2; 0.5 mg/mL
! eBioscience; Cat. #:  13-7042-85; 500 µg
! ELISA detection, 250x; ELISPOT detection, 1,000x

Biotin anti-mouse IL-5, Clone TRFK4
! BioLegend; Cat. #:  504402; 500 µg
! ELISA detection; ELISPOT detection

biotin anti-mouse IL-5, clone TRFK4; 0.5 mg/mL
! eBioscience; Cat. #:  13-7051-81; 50 µg
! ELISA detection, 250x; ELISPOT detection, 500x

biotin anti-mouse IL-5, clone TRFK4; 0.5 mg/mL
! eBioscience; Cat. #:  13-7051-85; 500 µg
! ELISA detection, 250x; ELISPOT detection, 500x

biotin rat anti-mouse IgE, clone 23G3; 0.5 mg/mL
! SouthernBiotech; Cat. #:  1130-08; 0.5 mg
! ELISA detection, 5,000x
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DyLight 405 goat anti-armenian hamster; 1.0 mg/mL
! Rockland; Cat. #:  620-146-440; 100 µg

FITC hamster anti-mouse Cd11c, clone HL3; 0.5 mg/mL
! BD; Cat. #:  557400; 0.1 mg

FITC-conjugated goat anti-mouse
! Upstate / Millipore; Cat. #:  12-506; 0.5 mg

goat anti-armenian hamster; 1.8 mg/mL
! Jackson ImmunoResearch; Cat. #:  127-005-099; 1.5 mg

goat anti-mouse IgE, 1.0 mg/mL
! SouthernBiotech; Cat. #:  1110-01; 1.0 mg
! ELISA capture, 200x

goat anti-syrian hamster; 1.3 mg/mL
! Jackson ImmunoResearch; Cat. #:  107-005-142; 1.0 mg

HRP goat anti-mouse IgG, 0.8 mg/mL
! Jackson ImmunoResearch; Cat. #:  115-035-146; 1.5 mL

mouse anti-IFN-γ, clone R4-6A2; 0.5 mg/mL
! eBioscience; Cat. #:  14-7312-85; 500 µg
! ELISA capture

mouse IgE, clone 15.5; 0.25 mg/mL
! SouthernBiotech; Cat. #:  0114-01; 0.25 mg
! ELISA standard

mouse IgG2a,κ, clone UPC10
! Sigma; Cat. #:  M5409; 100 µg
! isotype control

PE anti-TCRβ, clone H57-597
! BioLegend; Cat. #:  109208; 200 µg

PE rat anti-mouse Siglec-F; 0.2 mg/mL
! BD; Cat. #:  552126; 0.1 mg

PE-Cy7 hamster anti-mouse CD3ε, clone 145-2C11; 0.2 mg/mL
! BD; Cat. #:  552774; 0.1 mg
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PerCP-Cy5.5 rat anti-mouse CD45; 0.2 mg/mL
! BD; Cat. #:  550994; 0.1 mg

Purified anti-mouse/human IL-5, Clone TRFK5
! BioLegend; Cat. #:  504302; 500 µg
! ELISA capture; ELISPOT capture

rabbit anti-human SLP-76 (aa 230-260)
! Cell Signaling; Cat. #:  4958S; 100 µL

rabbit polyclonal IgG anti-Itk; 1.0 mg/mL
! Millipore/Upstate; Cat. #:  06-546; 250 µg
! for IP

rat anti-mouse CD16/CD32 (Fc block), clone 2.4G2; 0.5 mg/mL
! BD; Cat. #:  553141; 0.1 mg
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5.4.2. Chemicals

2-Mercaptoethanol
! Sigma; Cat. #:  M7522-100ML; 100 mL

2x YT media
! BD; Cat. #:  244020; 500 g

7-AAD
! BioLegend; Cat. #:  420404; 500 tests
! protect from light

acetyl-β-methylcholine
! Sigma; Cat. #:  A2251-25G; 25 g

acetyl-β-methylcholine
! Sigma; Cat. #:  A2251-25G; 25 g

AEC
! Sigma; Cat. #:  A6926-50TAB; 50 tablets

agar, granulated
! Fisher; Cat. #:  BP-1423-500; 500 g

anhydrous DMSO
! Sigma; Cat. #:  276855; 100 mL
! protect from moisture

BSA, fraction V, 98% purity
! EMD Chemicals; Cat. #:  2930; 100 g

BSA, fraction V, 98% purity
! Fisher; Cat. #:  BP1600-100; 100 g

carbon dioxide
! Airgas; Cat. #:  CD USP50; 50 lb.

collagenase D
! Roche Applied Science; Cat. #:  11088858001; 100 mg

collagenase D
! Roche Applied Science; Cat. #:  11088874103; 1 g
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collagenase, type 4
! Worthington Biochemical Corp.; Cat. #:  LS004186; 100 mg

DMF
! Sigma; Cat. #:  D4551-250ML; 250 mL

DNAse (deoxyribonuclease) I
! Sigma; Cat. #:  DN25-10MG; 10 mg

DNAse (deoxyribonuclease) I
! Sigma; Cat. #:  DN25-100MG; 100 mg

ethanol, 200 proof, molecular biology grade
! Fisher; Cat. #:  AC615095000; 500 mL

ethanol, 95%, denatured (general purpose)
! Fisher; Cat. #:  S73985A; 3.8 L

ethanol, 95%, denatured (general purpose)
! EMD; Cat. #:  EX0280-3; 4 L

glycine
! Fisher; Cat. #:  BP381-1; 1 kg
! FW:  75.07

hydrogen peroxide, 30% w/v, ACS grade
! VWR; Cat. #:  BDH3690; 500 mL

Imject alum
! Pierce / Thermo Scientific; Cat. #:  77161; 50 mL
! adjuvant

Indo-1, AM
! Molecular Probes; Cat. #:  I-1223; pack
! 20 x 50 µg

isoflurane
! TW Medical Veterinary Supply; Cat. #:  21233484; 100 mL
! store in chemical fume hood

isopropanol, ACS grade
! Fisher; Cat. #:  BP2632-4; 4 L
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ketamine HCl (Ketaset III), 100 mg/mL
! Fort Dodge Animal Health; Cat. #:  NDC 0856-4403-01; 10 mL

LB broth, Lennox
! BD; Cat. #:  240230; 500 g

liquid nitrogen, low pressure
! Airgas; Cat. #:  160LT22; 160 L

methanol, ACS grade
! Sigma; Cat. #:  179337-500ML; 500 mL

methanol, ACS grade
! Fisher; Cat. #:  A412-1; 1 L

methanol, ACS grade
! VWR; Cat. #:  BDH1135-1LP; 1 L

mouse recombinant IFN-γ
! eBioscience; Cat. #:  14-8311-63; 10 µg
! ELISA standard

mouse recombinant IL-13; 0.1 mg/mL
! eBioscience; Cat. #:  14-8131-62; 5 µg
! ELISA standard; dilute to 1 µg/mL in ELISA blocking buffer;
! prepare aliquots and store at -80°C

mouse recombinant IL-4; 0.1 mg/mL
! eBioscience; Cat. #:  14-8041-62; 5 µg
! ELISA standard; dilute to 1 µg/mL in ELISA blocking buffer;
! prepare aliquots and store at -80°C

mouse recombinant IL-5
! eBioscience; Cat. #:  14-8051-62; 5 µg
! ELISA standard

ovalbumin, grade V
! Sigma; Cat. #:  A-5503; 10 g

oxygen, E-tank
! Airgas; Cat. #:  OX USPE; E-tank
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phosphoric acid, ACS grade
! Fisher; Cat. #:  A242-1; 1 L
! CAS #:  7664-38-2

poly-L-lysine, 0.1%
! Sigma; Cat. #:  P8920-100ML; 100 mL

SEE (staphylococcal enterotoxin E)
! Toxin Technologies; Cat. #:  ET404; 100 µg

sodium acetate
! Fisher; Cat. #:  S209-500; 500 g

TMB ELISA substrate solution, 1x
! eBioscience; Cat. #:  00-4201-56; 100 mL

Tris base
! Fisher; Cat. #:  BP152-500; 500 g
! FW:  121.14

xylazine (AnaSed), 20 mg/mL
! Lloyd Laboratories; Cat. #:  4811; 20 mL

485



5.4.3. Consumables

1 L vacuum filtration units, 0.22 µm
! Nalgene; Cat. #:  567-0020; case of 12

1 mL filter tips, 100/rack
! Axygen; Cat. #:  TF-1000-R-S; pack of 10

1 mL pipet tips, bulk, non-sterile
! VWR; Cat. #:  82028-564; pack of 1,000

1 mL serological pipets, disposable, individually-wrapped, pyrogen-free
! Fisher; Cat. #:  13-678-11B; case of 1,000

10 mL serological pipets, disposable, individually-wrapped, pyrogen-free
! Fisher; Cat. #:  13-678-27F; case of 500

10 mL serological pipets, disposable, individually-wrapped, pyrogen-free
! Fisher; Cat. #:  13-678-11E; case of 200

10 µL pipet tips, bulk, non-sterile
! VWR; Cat. #:  82028-528; pack of 1,000

10% zinc formalin
! Protocol; Cat. #:  313-095; 1 gallon

100 cell dividers for freezer boxes
! Fisher; Cat. #:  03-395-457; pack of 12

115 mL vacuum filtration units; 45 µm, PES
! Nalgene; Cat. #:  124-0045; pack of 6

12-well culture plates
! Corning Costar; Cat. #:  3513; case of 50

15 mL centrifuge tubes w/ screw caps
! BD Falcon; Cat. #:  352097; case of 500

15 mL centrifuge tubes w/ screw caps
! Denville; Cat. #:  C1018-P; case of 500

150 cm² flasks, w/ membrane cap
! Corning; Cat. #:  430825; case of 50
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150 mL vacuum filtration units, 0.22 µm, PES
! Nalgene; Cat. #:  565-0020; case of 12

18 gauge tubing adaptor
! BD Medical; Cat. #:  408208; pack of 25
! tracheal cannula

20 µL filter tips, 96/rack
! Axygen; Cat. #:  TF-20-R-S; pack of 10

200 µL filter tips, 96/rack
! Axygen; Cat. #:  TF-200-R-S; pack of 10

200 µL gel-loading pipet tips, bulk, non-sterile
! Fisher; Cat. #:  02-707-181; pack of 1,000

200 µL pipet tips, bulk, non-sterile
! Fisher; Cat. #:  02-681-134; pack of 1,000

24-well culture plates
! Corning Costar; Cat. #:  3524; case of 100

25 cm2 flasks
! Corning; Cat. #:  430168; case of 500

25 mL serological pipets, disposable, individually-wrapped, pyrogen-free
! Fisher; Cat. #:  13-678-11; case of 200

25 mL serological pipettes, disposable, individually-wrapped, pyrogen-
free
! VWR; Cat. #:  89130-900; case of 200

250 mL vacuum filtration units, 0.22 µm, PES
! Nalgene; Cat. #:  568-0020; case of 12

250 mL vacuum filtration units, 0.22 µm, PES
! Denville Scientific; Cat. #:  F5225; case of 12

27G 1/2” needles
! BD; Cat. #:  305109; pack of 100

5 mL serological pipets, disposable, individually-wrapped, pyrogen-free
! Fisher; Cat. #:  13-678-27E; case of 500
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5 mL serological pipets, disposable, individually-wrapped, pyrogen-free
! Fisher; Cat. #:  13-678-11D; case of 200

50 mL centrifuge tubes, 25/rack
! BD Falcon; Cat. #:  352098; case of 500

50 mL vacuum filter tubes
! Millipore; Cat. #:  SCGP00525; pack of 25

500 mL vacuum filter units, 0.22 µm, 75 mm, PES
! Nalgene; Cat. #:  566-0020; case of 12

500 mL vacuum filter units, 0.22 µm, 75 mm, PES
! Denville Scientific; Cat. #:  F5227; case of 12

6x gel loading dye
! NEB; Cat. #:  B7021S; each

70 µm nylon strainers
! Fisher; Cat. #:  22-363-548; case of 50

75 cm2 flasks, w/ membrane cap
! Corning; Cat. #:  430641; case of 100

96-well filter plates
! Millipore; Cat. #:  MSIPS4510; pack of 10
! ELISPOT plates

96-well plates, round bottom
! Sarstedt; Cat. #:  83.1837; case of 100

alcohol prep pads
! Fisher; Cat. #:  06-669-62; case of 4,000

bench paper (absorbent surface liner), 20”x30’ roll
! Fisher; Cat. #:  14-127-47; case

BioTrace PVDF membrane, 30 cm x 3 m
! Pall Life Science; Cat. #:  66543; each
! thickness: 165 µm; pore size: 0.45 µm

blotting pads, 11x18 cm
! VWR; Cat. #:  28297-994; pack of 50
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broken glass disposal boxes
! Fisher; Cat. #:  12-009-7A; pack of 6

broken glass disposal boxes
! VWR; Cat. #:  56617-801; pack of 6

C57BL6/J mice, female, 6 weeks
! Jackson Laboratory; Cat. #:  000664; each

C57BL6/J mice, female, 8 weeks
! Jackson Laboratory; Cat. #:  000664; each

caps for culture tubes, 16 mm diameter
! KimKap; Cat. #:  73660 16; case of 1,000

CD4 Negative Isolation Kit
! Invitrogen; Cat. #:  114-16D; 4 mL

cryogenic vial closures, blue
! Nalgene; Cat. #:  5045-0003; pack of 100

cryogenic vial closures, green
! Nalgene; Cat. #:  5045-0004; pack of 100

cryogenic vial closures, red
! Nalgene; Cat. #:  5045-0005; pack of 100

cryogenic vial closures, white
! Nalgene; Cat. #:  5045-0000; pack of 100

cryogenic vial closures, yellow
! Nalgene; Cat. #:  5045-0002; pack of 100

cryogenic vials, 1.2 mL, pack of 25
! Nalgene; Cat. #:  5000-0012; case of 500

cryogenic vials, 2.0 mL, pack of 25
! Nalgene; Cat. #:  5000-0020; case of 500

culture tubes, 16 x 100 mm, disposable glass
! Fisher; Cat. #:  14-961-29; case of 1,000
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Cy5 monoreactive kit
! GE Healthcare; Cat. #:  PA25001; kit
! kit contains 5 packs for labeling 1 mg of protein each

DH5α E. coli, sub-cloning efficiency, chemically competent
! Invitrogen; Cat. #:  18265-017; 2 mL

DMEM, 500 mL
! Mediatech Cellgro; Cat. #:  15-013-CV; pack of 6

DNA ladder, 2-log; 1,000 µg/mL
! NEB; Cat. #:  N3200L; 500 gel lanes

electroporation cuvettes, 4 mm gap
! Molecular BioProducts; Cat. #:  5540; pack of 50

ELISA plates, 96 well
! BD; Cat. #:  353279; case of 100

FACS tubes, 5 mL, sterile, round-bottom, 12x75 mm
! BD; Cat. #:  352054; pack of 125

film, 8”x10”
! Kodak; Cat. #:  8646770; pack of 50 sheets
! protect from light

film, 8”x10”
! Denville Scientific; Cat. #:  E3018; pack of 100 sheets
! protect from light

freezer boxes, fiberboard, w/ covers
! Fisher; Cat. #:  11-678-24A; pack of 12

glass coverslips, No. 1, 18 x 18 mm
! Fisher; Cat. #:  12-548-A; 1 oz. pack

glass slides, 25 x 75 x 1 mm
! Fisher; Cat. #:  12-544-7; gross of 144

grade 1 filter paper, 15.0 cm diameter
! Whatman; Cat. #:  1001-150; pack of 100

Hema 3 staining solutions, 3x 500 mL
! Protocol; Cat. #:  122-911C; pack of 3
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HEPES, 1 M, 100 mL
! Mediatech Cellgro; Cat. #:  25-060-CI; pack of 6

histopaque, 100 mL
! Sigma; Cat. #:  10771-100ML; 100 mL

incandescent projector lamp bulb; BLC, INC 120V, 30W
! Ushio; Cat. #:  1000060; each
! for light microscope in TC room

L-Glutamine, 200 mM, 100 mL
! Mediatech Cellgro; Cat. #:  25-005-CI; pack of 6

laboratory labeling tape, yellow 3/4” width x 500” length
! VWR; Cat. #:  89097-996; pack of 4 rolls

laboratory wipes, 4.4”x8.4”
! Kimwipe; Cat. #:  34155; pack of 60

laboratory wipes, 4.5”x8.4”
! VWR; Cat. #:  82003-820; case of 60

large nitrile gloves, pack of 100
! Fisher; Cat. #:  19-130-1597D; case of 10

Lipofectamine 2000 transfection reagent
! Invitrogen / Life Technologies; Cat. #:  11668-027; 0.75 mL

medium nitrile gloves, pack of 100
! Fisher; Cat. #:  19-130-1597C; case of 10

medium nitrile gloves, pack of 100
! Denville Scientific; Cat. #:  G4162; case of 10

microcentrifuge tubes, 1.8 mL, assorted, 500/pack
! Axygen; Cat. #:  MCT-150-A; case of 10

Mouse T Cell Nucleofector Kit
! Lonza; Cat. #:  VPA-1006; 25 reactions

Natelson blood collecting tubes
! Kimble Chase; Cat. #:  42F604; pack of 100
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Natelson blood collecting tubes
! Fisher; Cat. #:  02-668-15; pack of 100

pasteur pipets, glass
! Fisher; Cat. #:  13-678-8A; pack of 250

PBS, 500 mL, cell culture grade
! Mediatech; Cat. #:  21-040-CV; pack of 6

PCR tubes, 0.2 mL, thin wall, clear
! Axygen; Cat. #:  PCR-02-C; pack of 1,000

penicillin-streptomycin, 100 mL
! Mediatech Cellgro; Cat. #:  30-002-CI; pack of 6
! 100x; 10,000 I.U./mL penicillin; 10,000 µg/mL streptomycin

Permount mounting medium
! Fisher; Cat. #:  SP15-100; 100 mL

petri dishes, 100 x 20 mm
! Corning; Cat. #:  430167; case of 500

pipet basins, 50 mL capacity, bulk packaging
! Fisher; Cat. #:  13-681-500; case of 100

pipet basins, 50 mL capacity, bulk packaging
! VWR; Cat. #:  89094-684; case of 100

Platinum Taq DNA Polymerase High Fidelity
! Invitrogen; Cat. #:  11304-011; 100 rxns

Precision Plus Protein Dual Color Standard
! Bio-Rad; Cat. #:  161-0374; 500 µL
! 50 applications

ProLong anti-fade mounting medium
! Invitrogen; Cat. #:  P7481; 1 kit

Protein G Sepharose 4 Fast Flow Media
! GE Healthcare; Cat. #:  17-0618-01; 5 mL

red biohazard bags, 25” x 35”
! Fisher; Cat. #:  01-828D; pack of 200
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RPMI-1640, w/o L-Glutamine, 500 mL
! Mediatech Cellgro; Cat. #:  15-040-CV; pack of 6

scintillation vials, borosilicate glass, 20 mL
! VWR; Cat. #:  66022-060; case of 500

single cytology funnels with cards
! Biomedical Polymers, Inc.; Cat. #:  BMP-CYTO-S50; pack of 50

small nitrile gloves, pack of 100
! Fisher; Cat. #:  19-130-1597B; case of 10

Stopcock one-way luer lock
! Promega; Cat. #:  A7261; 10 each
! for vacuum manifold

SuperSignal West Pico ECL substrate
! Pierce; Cat. #:  34080; 500 mL

SuperSignal West Pico ECL substrate
! Pierce; Cat. #:  34077; 100 mL

syringe filters, 0.22 µm
! Nalgene; Cat. #:  190-2520; case of 50

syringes, 1mL
! BD; Cat. #:  309602; pack of 100

transfer pipets, 1 mL, bulk packaging
! Fisher; Cat. #:  13-711-9D; case of 500

transfer pipets, 1 mL, individually wrapped
! Fisher; Cat. #:  13-711-20; case of 500

UltraClean 15 UltraBind
! Mo Bio Laboratories; Cat. #:  121003001; each

UltraClean 15 UltraSalt
! Mo Bio Laboratories; Cat. #:  121003002; each

UltraClean 15 UltraWash
! Mo Bio Laboratories; Cat. #:  121003003; each
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VaporGuard charcoal filter
! Vet Equip; Cat. #:  931401; each

water, 500 mL, cell culture grade
! HyClone / Thermo Scientific; Cat. #:  SH30529.02; each

weighing paper, 3”x3”
! VWR; Cat. #:  12578-121; pack of 500

weighing paper, 3”x3”
! Fisher; Cat. #:  09-898-12A; pack of 500

Wizard Maxipreps DNA Purification Resin
! Promega; Cat. #:  A7401; 500 mL

Wizard MegaColumns
! Promega; Cat. #:  A7421; 50 each

Wizard MiniColumns
! Promega; Cat. #:  A7211; 250 each

X-large nitrile gloves, pack of 100
! Fisher; Cat. #:  19-130-1597E; case of 10

X-small nitrile gloves, pack of 100
! Fisher; Cat. #:  19-130-1597A; case of 10
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